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Preface to AcqKnowledge Software Guide 
Welcome 

Welcome to the AcqKnowledge Software Guide. The MP System is a complete data acquisition system 
that includes both hardware and software for the acquisition and analysis of life-science data. You can use 
the MP System for data acquisition, analysis, storage, and retrieval. 
AcqKnowledge software not only makes data collection easier, but also allows you to perform analyses 
quickly and easily that are impossible on a chart recorder. You can edit data, cut and paste sections of 
data, perform mathematical and statistical transformations, and copy data to other applications (such as a 
drawing program or spreadsheet). 
The MP System can operate on either a Macintosh® or a PC with Windows® (including notebooks). The 
MPWS system is designed to run on Macintosh® computers running Mac OS X or better. The MPWSW 
system is designed to operate with PC compatibles running Windows®. 
Running in the Macintosh® or Windows® environment, AcqKnowledge uses the familiar point-and-click 
interface common to all Macintosh® and Windows® applications. Complex tasks such as digital filtering 
or fast Fourier transformations are now as easy as choosing a menu item or clicking your mouse. 
This manual covers use of AcqKnowledge software with an MP System and details BIOPAC equipment 
available for a variety of applications. If the application you desire is not addressed, just visit the 
BIOPAC web site at H1Hhttp://www.biopac.comH to download one of our many Application Notes, or call to 
request a hard copy. 
 

See also: 
• BIOPAC Installation Guide 

 Document shipped with the software CD and see also Install_Guide.txt on CD. 
• BIOPAC Hardware Guide.pdf 

(provides details on MP System modules, transducers, electrodes, etc., and setup and calibration) 
• BIOPAC Research Catalog 
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What’s new for Windows AcqKnowledge 3.9 
BONUS!  

 

AcqKnowledge 3.9 for Windows 
includes a courtesy copy of our 
new Specialized Analysis 
package under the Transform 
menu. See page X242H333X for details. 

 New Calculation Channels: 
 Filter: Comb Band Stop (base frequency and its overharmonics)—page X243H75 X 
 Fourier Linear Combiners—page X244H88 X 
 Adaptive Filter—page X245H89 X 

 New Transformations: 
 Digital Filters: Adaptive Filter—page X246H224X 
 IIR Filter: Comb Band Stop—page X247H225X 
Filter out a fundamental frequency and its overharmonics (integer multiples of the base) 

 Fourier Linear Combiners (FLC)—page X248H228X 
 Power Spectral Density—page X249H255X 
 DWT Wavelet Transformation—page X250H261 X 

 Additional File Import/Export Options:  
 Excel Spreadsheet Export—page X251H203X 
 Raw File Import/Export—X252H194X 

 Igor Pro Experiment—page X253H194X/ X254H202X 
 Expression logic additions:—page X255H81 X 

 Source—Sample, Pi, True (1), False (0) 
 Function—and, equal, if (2-way), less, not, or, xor (exclusive), ceiling, floor, is infinity, conditional (3-
way), not a number, floating point modulus, measurement 

 Specialized Analysis—page X256H333X 
 Heart Rate Variability 
 Gastric Wave (electrogastrogram) 

 Automatic MP Firmware Update—page X257H131X 
 Paste/Copy Acquisition Settings—page X258H215X 

 
Note New features for AcqKnowledge 3.9 for Windows apply to the English language 

version of the software only. AcqKnowledge software also is available for the 
following languages: Chinese Simplified, Chinese Traditional, French, Italian, 
Japanese, Spanish, and Turkish. H2HContact BIOPACH to learn more about version 3.8.  
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What’s new for AcqKnowledge 3.9 for Mac OS™ X 
BONUS! AcqKnowledge 3.9 for Mac OS X includes a courtesy copy of our new Specialized Analysis 

package under the Transform menu. See  details starting on page X259H333X. 
 
In AcqKnowledge 3.9.2 
 Specialized Analysis Additions & Enhancements: 

 Respiration—page X260H382X 
• Penh Analysis—page X261H384 X 
• Pulmonary Airflow—page X262H385X 
• Compliance & Resistance—page X263H382X 

 Neurophysiology: Amplitude/Half-Width Spike Discriminator to Locate Spikes—page X264H380X 
 Heart Rate Variability: Locate R-waves Using Events—page X265H337 X 

 Calculation Channel Additions & Enhancements 
 Metachannels: Use a single calculation channel to perform a chained computation—page X266HXX267H62X 
 Filter: Comb Band Stop  (base frequency and its overharmonics)—page X268H75 X  
 Rescale: adjust calibration values of analog channels—page X269H90 X; also in Automator—page X270H19X 

 Transformation Additions & Enhancements: 
 Delay: add time delays to signals—page X271H250X 
 Filter: Comb Band Stop—page X272H225X 
 Rescale: adjust calibration values of analog channels—page X273H250X 

 Spectrum Analyzer (real-time and post-acquisition FFT)—page X274H306X 
 Digital Filter Enhancements—page X275H75 X (general explanation)  

 Cutoff frequency: Calculation channels FIR, IIR, Comb Band Stop 
 Transformations FIR, IIR, Comb Band Stop, and Derivative 
 Automator: Digital Filter-FIR/IIR, Comb Band Stop, and Derivative 

 # of coefficients: Transformations: FIR and  Derivative 
 Automator: Digital Filter-FIR and Derivative 

 Clustering (K-means) Options 
 Export Clustering results to Excel Option —page X276H282X 
 3D Scatterplot Background Modification—page X277H282X 

 Measurements: Event Amplitude Maximum and Minimum—page X278H175X 
 Network data transfer: allow applications running on other computers attached to the same network to 

gain access to data from AcqKnowledge as it is being acquired—page X279H313X 
 Data Management Features 

 Data snapshot details—page X280HXX281HXX282H50 XX283HXX284HX 
 European Data Format (EDF) file import/export—pages X285H195 X/X286H205X 
 Batch Acquisitions Resume function—page X287HXX288HXX289H189X 
 Selection Palette Options (Paste to Journal, Change Measurement Units)—page X290H304X 
 Recently Used Transformations Submenu—page X291H219X 
 3D Dialog Positions—Tile, Stack, and Cascade 
 “Cancel” Button Added to Specialized Analysis Transformations 
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Plus, from AcqKnowledge 3.9.1 
 Manual Stimulator Control—page X292H109X 
 Specialized Analysis New Pkgs. & 

Enhancements—page  X293H333X 
 Clustering (K-means)—page X294H279X 
 Template Options 

 Remove Projection Template—page X295H235 X 
 Normalized Correlation Coefficient—page 

X296H236X 
 Adaptive Template Matching—page X297H236 X 

 File Format Options 
 BSL File Import—page X298H190 X 
 Excel Spreadsheet Export—page X299H203X 
 Spotlight Importer for Graph Files—X300H19 X 
 WAV Files—Import, page X301H195X; Export, page 

X302H204X 

 Text Annotations—page X303H144 X 
 Stacked Plot Display Mode— X304H33 X 
 Jump-to Tool—page X305H144X 
 Selection Palette—page X306H303 X 
 Play Channel Data as Audio—page X307H122X 
 Event Journal Summary Features—page X308H171X 
 Selected Range Printing in Journal—page X309H207X 
 Resampling Interpolation Options—page X310H247X 
 Automator Integration & Scripting—page X311H19 X 
 Mouse Scrollwheel Support— X312H40 X 
 Mac on Intel Compatibility—page X313H18 X 

 
Plus, from AcqKnowledge 3.9.0 
 All the new features of AcqKnowledge 3.8—

page X314H8 X 
 New Calculation Channels: 

 Fourier Linear Combiners—page X315H88 X 
 Adaptive Filter—page X316H89 X 

 New Transformations: 
 Digital Filters: Adaptive Filter—page X317H224X 
 Fourier Linear Combiners (FLC)—page X318H228X 
 Nonlinear Modeling—page X319H253X 
 Autoregressive (AR) Modeling—page X320H254X 
 Power Spectral Density—page X321H255X 
 AR Time Frequency Analysis—page X322H256 X 
 DWT Wavelet Transformation—page X323H261 X 
 Principal Component Analysis—page X324H262X 
 Independent Component Analysis—page X325H262X 

 Additional File Import/Export Options: 
 Igor Pro Experiment—page X326H194X/ X327H202X 
 PhysioNet—page X328H194X/ X329H202X 

 Batch Files for Acquisition Automation—page 
X330H188X 

 Event Coding & Measurement Automation—
page X331H164X 

 Cycle (Peak) Detector Interface—page X332H264X 
 Expression logic additions:—page X333H81 X 

 Source—Sample, Pi, True (1), False (0) 
 Function—and, equal, if (2-way), less, not, or, 
xor (exclusive), ceiling, floor, is infinity, 
conditional (3-way), not a number, floating 
point modulus, measurement 

 Replay Mode to simulate acquisition—page X334H33 X 
 QuickTime™ movie creation options—page X335H51X 
 Flexible print range: visible area, selected area, 

or entire file—page X336H208X 
 “Friendly” grid scaling & Adaptive Scaling—

X337H140X 
 Journal Preferences, new options—page X338H312X 
 Multiple undo (adjustable)—page X339H210

X
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Using this Manual 
The AcqKnowledge Software Guide is divided into four parts: 
Part A Getting Started 
 You should look through Getting Started whether you’re new to computer-based data acquisition 

systems or an old hand at physiological monitoring. Use this section to acquaint yourself with how 
the system works and the most frequently used features. 

Part B Acquisition Functions 
 Explains data acquisition features and gives a detailed summary of different acquisition parameters. 

Provides an in-depth description of the commands used to determine acquisition rate, acquisition 
duration, and specialized functions such as triggering, averaging, and online calculation of different 
values. 

Part C Analysis Functions 
 Details information on analysis features; covers the range of post-acquisition analysis functions and 

transformations available with the MP System. Describes how to edit data, take measurements and 
perform basic file management options (save, print, etc). 

Part D Appendices 
 Answers frequently asked questions, offers hints for working with files, includes information on 

upgrading from previous versions, provides technical information about the MP System and other 
information about the AcqKnowledge software. 

 
See also: 

BIOPAC Installation Guide 
This guide was included with the software CD. It tells you how to install the hardware and software, 
and how to be up and running with the MP System in just a few minutes. 
 
Hardware Guide 
BIOPAC MP Hardware Guide.pdf gives practical examples of how the MP acquisition unit is used 
with different components for common types of data acquisition, and includes sample results and 
applications for widely used test procedures. Provides instructions for connecting external devices to 
the MP System (electrodes, transducers, amplifiers, etc.).  
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User Support System 
 
User Support System files can be found on your hard drive in BIOPAC Systems, Inc/AcqKnowledge 3.x/User 
Support Systems in the Program Files or Applications folder. 
 
 -- AcqKnowledge Software Guide.pdf is the software support document 
  
 -- BIOPAC MP Hardware Guide.pdf is the hardware guide (with specifications) 
  
The User Support files can also be opened directly from the CD. 
 
The files are in PDF format, and can be read by Adobe Acrobat Reader. 

• If you don't currently have Adobe Acrobat Reader, you can download it 
for FREE at www.adobe.com under the Adobe Acrobat Reader site. 

 
The Samples folder in the BIOPAC program folder contains sample files and graph template Quick Start files 
for a variety of applications. Quick Start templates establish the channel setup and acquisition parameters 
required for a variety of applications. 
 

• To open sample files, choose File>Open then Browse to the BIOPAC Samples folder. 
 

• To open a graph template Quick Start file, choose File>Open then Browse to the BIOPAC Samples 
folder and change “Files of type” (“Enable” on Mac) to “Graph Template” and then select the desired 
file. 
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Where do I find help? 
The Introductory sections are intended to provide you with enough information to get up and running with the 
MP System, and familiarize you with some basic AcqKnowledge functions. There are far more features than 
described in the first few pages, so here is a guide for how to continue using this manual. 

 Help menu 
You can get help from the online Help menu, which includes basic information about standard 
AcqKnowledge functions and links to the tutorial, software guide and hardware guide for online 
searchable Help while you are running AcqKnowledge, plus links to the BIOAPC web site. 

 Application Notes 
The BIOPAC web site at H3Hhttp://www.biopac.comH has more than 50 available Application Notes. 
Download the Application Note you need, or call to request a hard copy. 

 Acquiring data 
For more specific information on different types of acquisitions, see Part B—Acquisition Functions. It 
covers basic acquisition parameters in detail, and describes some acquisition features (such as peak 
detection techniques and online Calculation channels) not covered in the Getting Started section. 

 AcqKnowledge 
Information about how to edit, display and transform data can be found in Part C—Analysis 
Functions. It explains how to import and export data, how to save files, and other file management 
commands. This section also explains how to use all of the post-acquisition features of the 
AcqKnowledge software. 

 Connecting input devices 
To find out how specific modules connect to the MP acquisition unit, turn to the BIOPAC MP 
Hardware Guide PDF file. This section describes how to connect signal-conditioning modules to the 
MP acquisition unit and how to connect electrodes and transducers to the modules. 

 Working with large files 
Many users need to perform high speed (i.e., fast sampling rates) or long duration acquisitions. These 
types of acquisitions tend to generate large (several megabytes) data files that can be difficult to load, 
store, and view. The MP System can handle such acquisitions—see the Appendices for information 
on how to optimize your setup for these types of acquisitions. 

 Troubleshooting 
Includes a list of the most frequently asked questions regarding the MP System. Check this section 
(Appendix A) for commonly encountered problems and solutions. 
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IMPORTANT SAFETY NOTICE 
BIOPAC Systems, Inc. instrumentation is designed for educational and research-oriented life science 
investigations. BIOPAC Systems, Inc. does not condone the use of its instruments for clinical medical 
applications. Instruments, components, and accessories provided by BIOPAC Systems, Inc. are not intended 
for the diagnosis, mitigation, treatment, cure, or prevention of disease. 
The MP acquisition unit is an electrically isolated data acquisition system, designed for biophysical 
measurements. 
Exercise extreme caution when applying electrodes and taking bioelectric measurements while using the 
MP System with other external equipment that also uses electrodes or transducers that may make electrical 
contact with the Subject. Always assume that currents can flow between any electrodes or electrical contact 
points. 
Extreme caution is also required when performing general stimulation (electrical or otherwise) on a subject. 
Stimulation currents should not be allowed to pass through the heart. Keep stimulation electrodes far from 
the heart and located close together on the same side of the subject’s body. 
It is very important (in case of equipment failure) that significant currents are not allowed to pass through 
the heart. If electrocautery or defibrillation equipment is used, it is recommended that you disconnect the 
BIOPAC Systems, Inc. instrumentation from the Subject. 
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Human Anatomy & Physiology Society Position Statement on Animal Use 
Adopted July 28, 1995 

  It is the position of the Human Anatomy and Physiology Society that dissection and the manipulation 
of animal tissues and organs are essential elements in scientific investigation and introduce students to the 
excitement and challenge of their future careers. 

The Human Anatomy and Physiology Society (HAPS) is a national organization of science educators 
dedicated to the task of providing instruction of the highest quality in human anatomy and physiology. A 
fundamental tenet of science is the ordered process of inquiry requiring careful and thoughtful observation by 
the investigator. As subdivisions of biology, both anatomy and physiology share a long history of careful and 
detailed examination, exploration and critical inquiry into the structure and function of the animal body. 
Consistent with the origins and nature of scientific inquiry, HAPS endorses the use of animals as essential to 
the laboratory experiences in both human anatomy and human physiology. 

Historically, the principal tool of investigation in anatomy has been dissection. A properly directed 
dissection experience goes beyond naming structures and leads the student to conclusions and insights 
about the nature and relatedness of living organisms that are not otherwise possible. To succeed in their 
future careers, students must become thoroughly familiar with anatomical structures, their design features 
and their relationships to one another. Dissection is based on observational and kinesthetic learning that 
instills a recognition and appreciation for the three-dimensional structure of the animal body, the 
interconnections between organs and organ systems, and the uniqueness of biological material. While 
anatomical models, interactive computer programs, and multimedia materials may enhance the dissection 
experience, they should not be considered as equivalent alternatives or substitutes for whole animal 
dissection. 

HAPS supports the use of biological specimens for anatomical study provided their use is in strict 
compliance with federal legislation and the guidelines of the National Institutes of Health and the United 
States Department of Agriculture and that such use fulfills clearly defined educational objectives. 

Physiology experiments involving live animals provide an excellent opportunity to learn the basic 
elements specific to scientific investigation and experimentation. It is here that students pose questions, 
propose hypotheses, develop technical skills, collect data, and analyze results. It is here that they learn to 
remain focused on the details of procedure and technique that may influence the outcome of the experiment 
and the responses of the animal. When faced with unexpected and even erroneous results, students develop 
and improve their critical thinking and problem solving skills. 

Computer simulations and video programs are useful tools that help students acquire a basic 
understanding of physiologic principles. However, due to the inherent variability and unpredictable nature of 
biological responses, such programs fail to fully depict the uniqueness of living organisms and should not be 
viewed as equivalent alternatives or substitutes for live animal experiments. HAPS supports the use of 
biological specimens in physiology experiments provided their use is in strict compliance with federal 
legislation and the guidelines of the National Institutes of Health and the United States Department of 
Agriculture and that such use fulfills clearly defined educational objectives. 

Science educators have in common a respect and reverence for the natural world and therefore have 
a responsibility to share this with their students. They must communicate the importance of a serious 
approach to the study of anatomy and physiology. HAPS contends that science educators should retain 
responsibility for making decisions regarding the educational uses of animals. Furthermore, it opposes any 
legislation that would erode the educator's role in decision making or restrict dissection and animal 
experimentation in biology. 
Used with permission of:  The Human Anatomy and Physiology Society (HAPS) 

222 South Meramec, Suite 203, St. Louis, MO 63105 
1-800-448-HAPS 
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Part A—Getting Started 
Chapter 1 MP Systems Overview 

Part A - Getting Started covers the basics of data acquisition and analysis with an MP System. All of the material in 
this section is covered in more detail in subsequent sections (see Using this Manual, page X340H191X). 
Overview 
The MP System is a computer-based data acquisition system that performs many of the same functions as a chart 
recorder or other data viewing device, but is superior to such devices in that it transcends the physical limits 
commonly encountered (such as paper width or speed). Data collection generally involves taking incoming signals 
(usually analog) and sending them to the computer, where they are (a) displayed on the screen and (b) stored in the 
computer’s memory (or on the hard disk). These signals can then be stored for future examination, much as a word 
processor stores a document or a statistics program saves a data file. Graphical and numerical representations of the 
data can also be produced for use with other programs. 
There are two MP Systems available—MP150 or MP100—with the following distinctions: 

Function  MP150  MP100  
Aggregate Sample Rate 

Internal MP Buffer: 400kHz 70kHz 
To Cpt. Memory or Disk: 300kHz 16kHz 

Internal Buffer Size: 6M bytes 16k bytes 
A/D Converter Signal/Noise Ratio: 86 dB typical 90 dB typical 
D/A Resolution: 16 bits 12 bits 
D/A Output rate: Independent of A/D rate Synchronous with A/D rate 
Communication to Computer: Ethernet (10 base T, UDP USB 

 and DLC Type II) 
The MP System can be used on a Macintosh® or on a PC with Windows®. The system utilizes the same hardware, 
excepting the computer interface. The software has the same “look and feel” on both the Macintosh® and the PC. 

 For the Mac®, the system is referred to as “MPWS” 
 For PC with Windows®, the system is referred to as “MPWSW” 

Your MP System consists of several major components, including hardware and software. The AcqKnowledge 
software included with your system allows you to edit your data and control the way it appears on the screen, and 
performs four general functions: 

(a) Control the data acquisition process; 
(b) Perform real-time calculations (such as digital filtering and rate detection); 
(c) Perform post-acquisition transformations (such as FFT’s and math functions); 
(d) Handle file management commands (saving, printing, and the like). 

The heart of the MP System is the MP data acquisition unit, which takes incoming signals and converts them into 
digital signals that can be processed with your computer. The MP acquisition unit connects via: 

 Ethernet for MP150 unit 
 USB for MP100 unit  

The system also includes a Universal Interface Module (UIM100C) for connecting external devices to the MP 
acquisition unit. Connect chart recorders, pre-amplified signals, and digital signals such as those from triggers or 
event counters/recorders. The UIM100C connects to the front of the MP acquisition unit via two cables (Analog and 
Digital). As a rule, both cables should be connected. The connectors for each of the two cables are different, so there 
is only one way the UIM100C can be connected to the MP acquisition unit. 
A wall transformer is included with the MP System to convert AC mains power into DC power suitable for system 
operation and safety. 
 
Unpacking 
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Please confirm that your MP System was delivered with one of each of the following items:  

MPWSW for PC with Windows® MPWS for the Macintosh® 
MP System acquisition unit 

 MP100 or MP150 
MP System acquisition unit 

 MP100 or MP150 

Universal Interface Module (UIM100C) Universal Interface Module (UIM100C) 

MP100 only: 25-pin female to 25-pin female 
cable (0.6 meter) 

MP100 only: 25-pin female to 25-pin female 
cable (0.6 meter) 

MP150 only: 37-pin female to 37-pin female 
cable (0.6 meter) 

MP150 only: 37-pin female to 37-pin female 
cable (0.6 meter) 

DC wall adapter 
 MP100: 12 VDC @ 1 Amp (120 or 240 V) 
 MP150: 12 VDC @ 2 Amp (120 or 240 V) 

DC wall adapter 
 MP100: 12 VDC @ 1 Amp (120 or 240 V) 
 MP150: 12VDC @ 2 Amp (120 or 240 V) 

MP150: Ethernet card and two cables 
MP100: USB1W PC USB (2.0) adapter 

MP150:  Ethernet card and two cables 
MP100: USB1M Mac USB (2.0) adapter 

AcqKnowledge software CD (v3.9) with 
License Agreement and Registration Card 

AcqKnowledge software CD (v3.9) with 
License Agreement and Registration Card 

When you have unpacked and are ready to install your MP System, refer to the “BIOPAC Install Guide” that was 
packaged with your software. 
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MP System Requirements 
Suggested minimum system requirements are detailed below. Recommendations are included to optimize system 
performance; more memory and a faster system will enhance MP System performance. If you plan to acquire data 
for more than a few hours and/or are sampling at more than 1,000 samples per second, see the H4HDisk SpaceH note. 

Windows For AcqKnowledge 3.9.0 
OS Requires Windows XP 

Port 

Requires Ethernet (UDP) for MP150 or USB for MP100 
To use an MP150 with UDP communication on a network with a non-Windows DHCP server, you 

must use firmware 1.1.12 or greater for the MP unit to properly be assigned an IP address. This is also 
true for any DHCP system with non-Windows operating systems, such as Unix, Linux, Mac OS X, 
and other DHCP-aware devices. 

Hard Disk Requires 128 MB to store the software and online manuals; additional 1 GByte recommended for data 
storage 

RAM 128 MB recommended 

Processor CPU with at least 128 MHz clock speed recommended; math coprocessor for 80386-based machines 

  
Macintosh For AcqKnowledge 3.9 

OS Requires Mac OS X 10.3 or higher see H5HMac on IntelH and H6HMac OS  10.4 TigerH Notes 

Port Requires Ethernet (DLC) for MP150 or USB for MP100 

Hard Disk Requires 128 MB to store the software and online manuals; additional 1 GByte recommended for data 
storage 

RAM 128 MB recommended 

Processor PowerPC G3 (or higher); minimum recommended processor is a 500Mhz G4 

MP150 DLC Limitations 
UDP is the default communication for MP150 units, but DLC communiaction will also work. Use Preferences to 
establish the communication type. An administrator password is required in order to access the Ethernet network 
under Mac OS X. Without an administrator password, AcqKnowledge 3.9 can only be used in the “No 
Hardware” mode for data analysis. 
 The only setup that requires DLC Communication is multiple MP150s performing online averaging 

simultaneously with independent external triggers. 
Disk Space 

With any program, you will need disk space to store your data files. Although BIOPAC saves files in a format as 
compact as possible, some users may generate data files of several dozens of megabytes. To acquire data for long 
periods (more than a few hours) and/or sample at relatively fast rates (more than 1,000 samples per second), you 
should have as much available disk space as possible (or have access to a removable storage device). See your 
BIOPAC Software Guide for hints on working with large files. 

Mac on Intel Compatibility  
AcqKnowledge has been updated to a Universal Binary. This allows it to run natively on both PowerPC and 
Intel-based Macintosh computers. AcqKnowledge also integrates directly with operating system features when 
running on Mac on Intel-based computers, such as Automator and Spotlight. 
Some features are not yet available for Mac on Intel-based computers due to the lack of third-party support. 
These features include: 

• MP100 support (requires Intel-compatible Keyspan drivers). 
• MATLAB File Exchange (requires Mac on Intel support from MATLAB and The MathWorks).  

o If MATLAB File Exchange is required, the application can be run in emulation mode by 
checking the “Open with Rosetta” checkbox in the Get Info inspector of the Finder. 

Contact BIOPAC Systems for more details on when these features may become available. 
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Mac OS X 10.4 “Tiger” 
Spotlight Importer for Graph Files 

“Tiger” includes a feature named Spotlight. Spotlight is a new way to search for data on your computer. 
AcqKnowledge includes a Spotlight Importer that allows Spotlight to extract and search information from 
AcqKnowledge graph files including: 
 - Graph title - Duration of the recorded data in the graph 
 - Text included in the Journal - Labels of data channels in the graph 
For example, if you record the names of your subjects in a graph's Journal, Spotlight will now be able to 
locate the graph file based upon that name extracted from the Journal. If you keep enough information in the 
channel labels and journal of your graph file, graphs can now be located and grouped using the Spotlight 
search features in ways not possible without Mac OS X 10.4. 
The Spotlight importer only supports files generated by Mac AcqKnowledge 3.7.0 or higher. 

• Older Mac AcqKnowledge or any Windows AcqKnowledge files must be resaved to disk using a 
compatible Mac AcqKnowledge file format. 

Automator Integration and Scripting Support 
This feature is available only when AcqKnowledge is running on Mac OS X 10.4 “Tiger”. 
Mac OS X 10.4 includes a visual scripting environment called “Automator.” Automator allows for drag and 
drop creation of “Workflows.” Each workflow is a series of steps that is performed in another application. 
Each individual step is called an action. An action encapsulates a simple operation within another 
application, such as opening a text file in TextEdit or applying a filter within Photoshop. 
Over 40 actions have been written to allow AcqKnowledge to be controlled from Automator workflows. 
Using these actions, workflows can be constructed to perform sequences of transformations, automating 
post-acquisition analysis, performing experimental protocols, and other repetitive operations. 
Workflows can be constructed using Automator. It is also possible to create, edit, and execute workflows 
directly from within the AcqKnowledge environment using the new “Workflow” menu. The Workflow menu 
allows you to create workflows that can be specific to your user account or shared by all AcqKnowledge 
users. These workflows can then be edited in the Automator environment. Each workflow created using 
Workflow > New Workflow will appear at the bottom of the Workflow menu each time AcqKnowledge is 
launched. By simply selecting the name of the workflow from the Workflow menu, AcqKnowledge will 
execute the workflow.  
Workflows executed from the Workflow menu should begin with either an “Open Graphs” or a “Get Active 
Graphs” action. Workflows intended for use outside of the AcqKnowledge environment (e.g. used as Folder 
Actions) should begin with a “Launch Application” action to start AcqKnowledge followed by an “Open 
Graphs” or a “Get Active Graphs” action.  
Mac AcqKnowledge 3.9.2 and later 
Digital filter options have been as follows: 

Cutoff freq: digital filter-FIR, digital filter-IIR, comb band stop, and derivative 
• Sampling rate—Sets the frequency to a fraction of the sampling rate and automatically updates 

when the sample rate is modified. 
• Line frequency—Uses the line frequency at which the data was recorded. 

# of coefficients: digital filter-FIR and derivative 
• Optimize for sample rate and cutoff—Estimate the number of coefficients as four times the 

sampling rate divided by the cutoff frequency of the filter. Optimize does not necessarily 
produce the best quality filter, but takes less time. 

Rescale: To apply textual changes to a channel's units, apply the "Replace Active Channel Units" action. 
Delay 
For more information about Automator and help constructing workflows, see the Apple website at: 
H7Hhttp://www.apple.com/macosx/features/automator/H 
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MP System Features 
In conjunction with your computer, the MP System is a complete system for acquiring almost any form of 
continuous data, whether digital or analog. The MP System can perform a range of recording tasks, from high-speed 
acquisitions to long duration acquisitions. Generally speaking, for physiological applications, the MP System is 
limited only by the speed of your computer and the available memory or disk space. Features of the MP System 
include: 

Easy to use The MP System offers the same convenient and easy-to-use features which 
Macintosh® and Windows® users are accustomed to. Since the MP System 
software runs under these environments, you can run other applications while you 
are collecting data. In terms of hardware setup the MP System uses simple plug-in 
connectors and standard interface cables.  
You don’t need a degree in electronics to set up your system! 

Flexible The MP System can be configured for a wide variety of applications, from single 
channel applications to multiple-device measurements (up to 16 analog and 16 
digital, or multiple MP150s). You control the length of acquisition, the rate at 
which data is collected, how data is stored, and more...all with a few clicks of the 
mouse button. Whether you’re measuring alpha waves or collecting zoological 
data, the MP System can meet your needs. 

Menu flexibility You can easily customize menu displays to show only the functions you are 
using, thereby reducing the risk of error or confusion in your lab. This function is 
extremely powerful for laboratories working to GLP guidelines. It is also useful 
for teaching applications where instructors can hide unnecessary menu items. See 
Appendix D—Customizing Menu Functionality. 

High Speed Sampling Sample rates up to 400 KHz aggregate (MP150), 70 KHz aggregate (MP100) 

Arbitrary Sample 
Rates 

Apply different sample rates between channels or operate the STM100C 
stimulator at a different rate than the acquisition sample rate 

View & Control 
Multiple MP150s 

View and control multiple MP150 units over a local area network (LAN). 

Calculation Channel 
Presets 

Customize your recording for specific measurements. 

Template files AcqKnowledge “Quick Start” templates are available for over 40 applications. Just 
open the template file and start the acquisition—appropriate settings are 
established for the selected application. 

Online Calculation Although the MP System provides an extensive array of measurements and 
transformations you can apply to collected data, sometimes you need to perform 
computations while data is being collected. The online Calculation functions 
allow you to calculate new channels based on incoming signals. This feature 
allows you to compute BPM, for instance, based on raw ECG data. 

Online filtering Many times, it is preferable to filter data as it is being collected, rather than 
having to wait until after the fact, so now you can apply filters to incoming data 
and view the results in real time. That means online monitoring of data filtered to 
suit your needs. 

Online measurements The MP System can instantly compute over a dozen measurements and 
computations for any given data point(s). These options are available from pull-
down menus and include mean, peak-to-peak, value, standard deviation, 
frequency, and BPM. 
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Measurement 
Validation 

You can validate measurements with the ValidateMeasurements.acq sample file 
that was included with the software. The measurement definitions (page X341H151X) 
include measurement formulas and “Sample data file” explanations. 

Preview your data Similar to chart recorders, the MP System allows you to change both the vertical 
scale and the horizontal scale. You can change the amplitude scale or the time 
scale to any value you wish, or you can have the MP System automatically scale 
them for you. 

Replace (or augment) 
a chart recorder 

Whether you want to replace a chart recorder or simply supplement an existing 
setup, the MP System is fully compatible with most major recording devices. 
What’s more, the MP System is compatible with most popular input devices, so 
you can continue using the same transducers, electrodes and sensors. 

Simplified editing It used to be that once your data was collected, the only way to edit it was with 
scissors and adhesive tape. Now you can delete unimportant sections of your data 
with a keystroke. You can “paste” together sections from different waves, or 
simply edit out noise spikes from individual waves. 

Append mode For some applications, data only needs to be recorded during some portions of a 
long experiment. AcqKnowledge has an “Append” mode that lets you pause the 
acquisition for as long as you wish, and resume the acquisition as many times as 
needed. In this mode, you can start and stop a recording as you would with a chart 
recorder. Appending data saves on storage space and processing time for 
transformations. 

Digital filtering All data contains measurement error and noise. Now you can reduce or eliminate 
that error by using the digital filters and smoothing transformations included in 
the MP System. You can smooth data across any number of samples, or filter out 
noise from any frequency or bandwidth you wish. 

Digital Output You can control external devices when an input or calculation channel meets 
trigger conditions you specify. Use the Control channels to output a pulse when 
the signal on an analog channel falls above or below a given threshold. 

X/Y plotting You can view and acquire data in the form of an X/Y plot, with one channel on 
the horizontal axis and another on the vertical axis. This allows you to explore 
relationships between different channels and opens up a whole range of 
applications, from chaos plots to respiration analysis to vectorcardiograms. 

Histogram function You can easily examine the variability and the measures of central tendency of 
any waveform data with the histogram function. Set the plotting options to suit or 
let the software determine the “best fit” for graphing your data. 

Math functions In many cases, simply collecting raw data is not enough. AcqKnowledge has an 
array of built-in mathematical functions ranging from simple absolute value to 
computation of integrals, derivatives, and operations involving multiple 
waveforms (such as subtracting one wave from another). You can even chain 
multiple functions together to form complex equations. 

Annotation AcqKnowledge has a Journal you can use to append comments concerning your 
input data, either online or after the fact. This is especially useful for noting the 
characteristics of an acquisition (what was involved, what manipulations took 
place, and the like) for future reference. 
See also: Text annotation, page 144 
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Triggering If you need to measure response times or start data collection only after some 

event has occurred, the MP System allows you to trigger an acquisition in a 
number of different ways. You can trigger on the level of a signal, or with an 
external synchronizing trigger. 

Event marker  Many times, especially during a long acquisition or in a laboratory setting, it is 
useful to make a note of when specific events occurred so that these events (such 
as when a manipulation occurred) can be recorded and any changes in the data 
can be noted. The marker function allows you to insert symbols in the record and 
add text for each marker. These can be added either while data is being collected 
or after the fact. Marker functionality can be automated for sequential application 
or customized for Function keys. 

File compatibility You can save your data in a number of different formats. Save data to a word 
processor program like Microsoft Word®, spreadsheet software like Microsoft 
Excel®, a drawing program. You can output your data in either text or graphical 
form, and AcqKnowledge can even read-in raw data from a text file. Open 
(import) or save as (export) MATLAB™ and Igor Pro Experiments, or raw 
(binary) data for low level exchange. 

Pattern recognition Using an advanced pattern search/recognition algorithm, the MP System can 
automatically find a specific pattern within waveforms. This is useful for finding 
abnormal waveforms (such as irregular ECG waves) within a data file. 

Peak detection AcqKnowledge has a built-in algorithm to find either positive or negative peaks 
from any size data file. You can even search for all the peaks with one command 
and automatically log statistics like peak time and area to the journal. 

Printing The MP System provides a range of printing options, and allows you to fit your 
data on one page or many. You can print several graphs per page, even if you 
only have one-channel recordings. Since the MP System runs on the Macintosh or 
under Windows, no special printer drivers are required. 

Report generation AcqKnowledge has many features to simplify report generation. Use the Journal 
for notes and quickly copy and paste graph data or measurements to the journal or 
to another program. Cascade event markers to prevent print overlap and select the 
range of data to print and which options to display (measurements, markers, etc.). 
Use the Playback mode to simulate acquisition for presentations. 

User Support Whether you have a question about compatibility with your existing equipment or 
you need to develop a specialized measurement device, BIOPAC’s Applications 
Department can address the problem. 



Part A — Getting Started 23 

AcqKnowledge Software Guide 

Application Features 
See Appendix G for basic descriptions of these Application Features. 

Use your MP System with AcqKnowledge software for a wide array of applications, such as: 
Active Electrodes 
Allergies 
Amplitude Histogram 
Anaerobic Threshold 
Animal studies 
Auditory Evoked Response 

(AER) 
Automate Acquisition Protocols 
Automated Data Analysis 
Automatic Data Reduction 
Autonomic Nervous System 

Studies 
Biomechanics Measurements 
Blood Flow / Blood Pressure 

/Blood Volume 
Body Composition Analysis 
Breath-By-Breath Respiratory 

Gas Analysis 
Cardiac Output 
Cardiology Research 
Cell Transport 
Cerebral Blood Flow 
Chaos Plots 
Common Interface Connections 
Connect to MP Systems 
Control Pumps and Valves 
Cross- and Auto-correlation 
Current Clamping 
Defibrillation & Electrocautery 
Dividing EEG into Specific 

Epochs 
ECG Analysis 
ECG Recordings, 12-Lead 
ECG Recordings, 6-Lead 
EEG Spectral Analysis 
Einthoven’s Triangle 
EMG and Force 
EMG Power Spectrum Analysis 
End-tidal CO2 
Episode Counting 
Ergonomics Evaluation 
Event-related Potentials 
Evoked Response 
Exercise Physiology 
External equipment, controlling 
Extra-cellular Spike Recording 
Facial EMG 
FFT & Histograms 
FFT for Frequency Analysis 
Field Potential Measurements 
Fine Wire EMG 
Forced Expiratory Flow & 

Volume 

Gait Analysis 
Gastric Myoelectric Activity 
Gastric Slow Wave Propagation 
Gastrointestinal Motility 

Analysis 
Hardware Flexibility 
Heart Rate Variability 
Heart Sounds 
Histogram Analysis 
Imaging Equipment, Interfacing 
Indirect Blood Pressure 

Recordings 
Integrated (RMS) EMG 
Interface with Existing 

Equipment 
Interface with Third-party 

transducer 
Invasive Electrode 

Measurements 
Ion-selective Micro-electrode 

Interfacing 
Iontophoresis 
Irritants & Inflammation 
Isolated Inputs & Outputs 
Isolated Lung Studies 
Isometric Contraction 
Isotonic Contraction 
Jewett Sequence 
Langendorff Heart Preparations 
Laser Doppler Flowmetry 
Left Cardiac Work 
Long-term Monitoring 
Lung Volume Measurement 
LVP 
Median & Mean Frequency 

Analysis 
Micro-electrode signal 

amplification 
Migrating Myoelectric Complex 
Motor Unit Action Potential 
Movement Analysis 
MRI Applications 
Multi-Channel Sleep Recording 
Nerve Conduction Studies 
Neurology Research 
Noninvasive Cardiac Output 
Noninvasive Electrode 

Measurements 
Nystagmus Investigation 
Oculomotor Research 
Off-line ECG Averaging 
Online Analysis 
Online ECG Analysis 
Orthostatic Testing 
Peripheral Blood Flow 

Peristaltic (Slow Wave) Propagation 
Planted Tissue 
Pressure Volume Loops 
Psychophysiology 
Pulsatile Tissue Studies 
Pulse Rate Measurement 
Pulse Transit Time 
Range of Motion 
Real-time EEG Filtering 
Real-time EEG Filtering 
Recurrent Patterns 
Regional Blood Flow 
Relative BP Measurement 
Remote Monitoring 
Respiration Monitoring 
Respiratory Exchange Ratio 
Rheumatology 
Saccadic Eye Movements 
Sexual Arousal Studies 
Signal Averaging 
Simultaneous Monitoring 
Single Channel Analysis 
Single-fiber EMG 
Software-controlled Stimulator 
Somatosensory Evoked Response 
Spectral Analysis 
Spike Counting 
SpO2 Analysis 
Stand Alone Amplifiers 
Standard Operating Procedures 
Startle Eye Blink Tests 
Startle Response 
Stimulator, software-controlled 
Systemic Vascular Resistance 
Template Analysis 
Tissue Bath Monitoring 
Tissue Conductance Measurement 
Tissue Magnitude & Phase Modeling 
Tissue Resistance & Reactance 
Ussing Chamber Measurements 
Ventricular Late Potentials 
Vestibular Function 
Video Capture, Synchronous 
Visual Attention 
Visual Evoked Response 
VO2 Consumption 
Volume/Flow Loop Relationships 
Working Heart Preparations 
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MP System Application Notes 
BIOPAC has prepared a wide variety of application notes as a useful source of information concerning certain 
operations and procedures. The notes are static pages that provide detailed technical information about either 
a product or application. A partial list of Application Notes follows. You can view or print application notes 
directly from the Support section of the BIOPAC website H8Hwww.biopac.comH. 

APP NOTE Application 
#AH101  Transducer Calibration and Signal Re-Scaling 
#AH102  Biopotential Amplifier Testing w/ CBLCAL 
#AH103  Remote Monitoring System (TEL100C) 
#AS105 Auditory Brainstem Response (ABR) Testing 
#AS105b ABR Testing for Jewett Sequence 
#AS108 Data Reduction of Large Files 
#AS109 3-, 6-, and 12-Lead ECG 
#AH110  Amplifier Baseline (Offset) Adjustment 
#AS111 Nerve Conduction Velocity 
#AH114  TSD107A* Pneumotach Transducer 
#AH114b  TSD107B* Pneumotach Transducer 
#AS115 Hemodynamic Measurements—Part I 
#AS116 Hemodynamic Measurements—Part II 
#AS117 Pulse Transit Time and Velocity Calculation 
#AS118 EMG Signal Analysis 
#AS119 EMG Power Spectrum Analysis 
#AS120 X/Y Loop Area Analysis 
#AS121 Waveform Data Reduction 
#AS122 Power Spectrum Analysis 
#AH125  Pulse Oximeter Module Operation 
#AH127  Precision Force Transducers 
#AH128  Active Electrode Specifications and Usage 
#AS129 Heart Rate Variability 
#AH130 Blood Pressure Measurement 
#AS131 Averaging Mode 
#AH132 TSD105A Variable Force Transducer 
#AH135 TSD117 Pneumotach Transducer 
#AH136 BAT100 Instructions 
#AH140 Angular Measurements with Goniometers 
#AH141 Tri-Axial Accelerometer Calibration 
#AS142  AcqKnowledge Rate Detector Algorithm 
#AS143 Importing AcqKnowledge Data Into Excel 
#AH144 Hand Dynamometer Calibration 
#AH145 TSD101B Respiratory Effort Transducer  
#AS148 Automated ECG Analysis 
#AH149 O2100C Module 
#AH150 O2100C Module—Sample application 
#AH151 CO2100C Module 
#AH152 CO2100C Module—Sample Application 
#AH153 Physiological Sounds Microphone 
#AH154 HLT100C High Level Transducer 
#AS158 Analysis of Inspired and Expired Lung Volume 
#AH159 TSD116 Series Hand Switch and Foot Switch 
#AH160 Gas Analysis Module Response Time 
#AS161 Automated Tissue Bath Analysis 
#AH162 Stimulation Features 
#AS168 Analysis of Intraventricular Pressure Wave Data (LVP Analysis) 
#AS169 Speech Motor Control 
#AH170 LDF100A Laser Doppler Flow Module 
#AH175 Using the STMISOC Stimulus Isolator 
#AS177 ECG Analysis using the Offline Averaging Mode 
#AS183 VO2 Measurement 
#AH186 Psychological Assessment using the TSD115 
#AH187 Electrodermal Response (EDR) using the GSR100 or TEL100 
#AH190 Using the MCE100C Micro-electrode Amplifier 
#AS191 Cardiac Output Measurement using the EBI100C and AcqKnowledge 
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 Chapter 2 AcqKnowledge Overview 
Overview 

 
The MP System software is called AcqKnowledge and performs two basic functions: acquisition and analysis. 
The acquisition settings determine the basic nature of the data to be collected, such as the amount of time data 
will be collected for and at what rate data will be collected. All of the acquisition parameters can be found 
under the MP menu. The other menu commands pertain to analysis functions such as viewing, editing, and 
transforming data. 
Note:  Some very minor differences exist between the Macintosh and the PC-compatible screen displays and 

keystroke/mouse functionality. These differences are noted throughout this section. 

Menu Functionality See Page 

MP150 or 
MP100 

Set up Channels, Set up Acquisition, Set up Triggering, Set up Stimulator, 
Show Input Values, Manual Control, Auto Plot, Scroll, Warn on Overwrite, 
Organize Presets. Select Network Adapter, MP150 Serial Number, About 
MP150 

X342H53X 

File New, Open, Close, Save/Save As, Print, Printer Setup, Exit X343H187X 

Edit Undo, Cut, Copy, Paste, Clear/Clear All, Select All, Insert Waveform, 
Duplicate Waveform, Remove Waveform, Clipboard (copy measurement, copy 
wave data, copy graph), Journal (paste measurements, paste wave data) 

X344H209X 

Transform Digital Filters, Math Functions, Template Functions, Integral, Derivative, 
Integrate, Smoothing, Difference, Histogram, Resample, Equation Generator 
(Expression), Waveform Math, FFT, Find Peak, Find Rate 

X345H217X 

Display Tile Waveforms, Autoscale Waveform, Overlap Waveforms, Compare 
Waveforms, Autoscale Horizontal, Zoom, Reset, Set Wave position, Wave 
color, Horizontal Axis, Show, Statistics, Preferences, Size Window, Set Font 

X346H294X 

Window Controls the position of windows on the monitor X347H317X 

Help Provides online support files (PDFformat and web links). X348H317X 



26 AcqKnowledge Software Guide 

Visit the online support center at www.biopac.com 

Launching the AcqKnowledge software 
The first step is to launch the software by double-clicking on the AcqKnowledge icon. You may receive a 
message regarding the hardware. 
PC users: 

 

 

If you receive the above warning when you launch AcqKnowledge, there are two possibilities: You have not 
properly connected everything and/or you have not powered up the MP System. 

 To use AcqKnowledge without an MP acquisition unit, press the “No Hardware” button. 
When AcqKnowledge is first launched, the user must pick an available MP150 unit from the Select MP150 
Serial number dialog. The dialog lists all MP150 units that are powered ON and sitting on the same local area 
network. If you are using more than one MP150 unit or working across a network, you will need to 
lock/unlock an MP150 to acquire data (see Appendix E on page X349H328 X for details). The selected MP unit will 
listed in the upper left of the graph display as “Connected to:” if the  Show/Hide Hardware toolbar icon is 
enabled. 
Macintosh USB users: 

 
You may receive a message similar to the preceding prompt. Use the pull-down menu to select a connection 
port, or choose the No Hardware option. Options are generated based on your system configuration (printer 
port, modem port, USB port, etc.). If hardware is not detected, check all connections and power sources. 
Unplug the USB adapter, wait a few minutes, then replug the adapter or try a different USB port. 
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Assuming everything is properly connected and there 
are no conflicts, AcqKnowledge will open as follows: 

 PC MPWSW System: an empty AcqKnowledge 
graph window will be generated. 

A “window” is the term used for the area on your 
computer’s screen where data is displayed and/or 
manipulated. The graph window on the screen is 
designed to provide you with a powerful yet easy-to-use 
interface for working with data. 
At this point, you can use this window, create a new 
window, or open an existing window. 

 To create a new graph window, access the File 
menu and select New. It’s a good idea to create 
a new graph window for each acquisition. 

Journal 
AcqKnowledge includes an “electronic notepad” or journal, which allows you to record notes and data 
associated with a graph file. You can use the journal at the same time you are acquiring data. Every graph file 
has a graph-specific journal file permanently linked to it. (Mac OS X users can also generate independent 
journals for data view or protocols, see page X350H48 X). To display the graph-specific journal, 

o select the journal icon  from the toolbar 
o Display > Show > Journal on Windows 
o File > New >Graph-specific Journal on Mac OS X. 

The journal will appear at the bottom of the graph window. Once a journal is open, you can enter text, data, or 
both. 

o To enter text, just click the cursor in the journal area and begin typing. AcqKnowledge will 
automatically “wrap” the text to fit the screen width. This is especially useful for noting the date and 
time of a recording, what was involved, and so forth. You may also paste measurements and 
waveform data into the journal. 

o To paste measurements into an open journal, select the desired area or point and choose Paste 
measurements from the Edit>Journal menu. This will paste all visible measurement window data into 
the journal. 

o To paste waveform data into the journal, select the desired area and choose Paste Wave Data from the 
Edit>Journal menu. This will insert a text file of your waveform into the journal, where points and 
trends can be analyzed. 

The graph-specific journal is saved with the graph file, but can be saved as a separate file via File > Save 
Journal Text As. 
Acquisition 
Once you have connected your system setup and input devices, try a sample acquisition. The most basic and 
commonly used options are under the MP menu. For any acquisition, you will need to specify: 

— How many channels there are and which channels contain data (Set up Channels). 
— At what rate the MP will acquire the data (Sampling rate). 
— How long the acquisition will last (Acquisition length). 
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Setting up channels 
To tell the MP System how many channels will be acquired (or collected), select Set up Channels from the 
MP menu. This will generate the Input Channels dialog. 

   
Acquire When the Acquire box is checked for a given channel that means data will be collected on that 

channel. 
Plot Determines if data will be plotted in real-time during the acquisition. If the plot box is unchecked, 

data will still be recorded for that channel, but the waveforms can only be plotted after the 
acquisition is over. 

Values Enables you to bring up a window that will display (numerically and/or graphically) the values 
for each channel in real time. These values are displayed in a separate window from the main 
graph window. The default is to collect one channel of data on channel A1, and to plot and list 
values for this channel. Usually, you will want to check all three boxes for each channel you 
acquire data on. 

Channel This is a dynamic alpha-numeric heading, based on the type of channel selected: Analog (or 
continuous), Calculation, or Digital. In the sample above, “A1” indicates Analog channel one. 

 Calculation channels are used for online computations and transformations of other channels. 
These channels are set up just as analog and digital channels but also have additional dialog boxes 
for you to specify what types of transformations and computations you would like to perform. For 
a detailed summary of Calculation channel options, see the Calculation Channel section 
beginning on page X351H61X. 

 In contrast to analog data, Digital channels collect binary data that represent when a measuring 
instrument is “on” or “off.” An example of when this could be useful is for recording whether a 
switch is open or closed, as in reaction time studies or control applications. You can control 
whether digital channels are acquired, plotted, and have values listed the same way you do for 
analog channels. 

Label To the right of each channel number is an editable label for each channel, where you can type in a 
label (up to 38 characters) that identifies what each channel is measuring. 

Presets Calculation channels include Presets as a quick way to get started—choose a preset and the 
software automatically sets the gain, offset, etc. appropriate for the selected application. See page 
X352H56X for details and a list of available presets. 

Channel The channel sample rate is a function of the acquisition sample rate: all channel sample rate 
Sample options are equal to or less than the acquisition sample rate (as established via “MP150  
Rate  >Set up Acquisition”). The options are a specific power of 2 less than the acquisition 
 sample rate. Channel sample rate info is included in the Display>Statistics dialog. Use 
  the pull-down menu to set the channel sample rate. See page X353H57X for details. 
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Setting up acquisitions 
Once you have set up the channel parameters, the next 
step is to specify the acquisition settings. You can do 
this by choosing Set up Acquisition from the MP 
menu. This generates a dialog box that will describe 
the type of acquisition about to be performed. There 
are a number of options here, but the basic parameters 
involve specifying:  

a) How data should be collected and stored 
b) The data collection rate 
c) The acquisition duration (total length) 

Storage Record and Save once to Memory is the default acquisition option. Under this option, the 
MP System automatically records data into a single continuous file, and stores the data in 
computer memory (RAM) during the acquisition. 
The third popup menu at the top of the dialog (which defaults to Memory) allows you to 
specify where the data should be stored during the acquisition. You will probably want to 
choose Memory or Disk storage. Computer memory (RAM) is usually faster (but less 
abundant) than disk space. If your system uses any virtual memory, AcqKnowledge will use 
as much as possible. You may also store data directly to the MP acquisition unit; the MP150 
can store 4MB, the MP100 can store up to 16,367 samples of data. 

 The advantage of storing to the MP acquisition unit is that much faster 
sampling rates may be obtained. 

 The disadvantages of saving data to the MP acquisition unit are that there is 
limited storage space and that data is not displayed on the screen while it is 
being collected. When the acquisition has stopped, however, the data will 
be automatically displayed on the screen. 

The other option under storage is Averaging, which allows you to take repeated trials of the 
same data. For more information on this feature, see the averaging section on page X354H99X.  

Rate Acquisition Sample Rate is analogous to “mm/sec” on a chart recorder, and refers to how 
many samples the MP System should take each second. As the MP System takes more and 
more samples per second, the representation of the signal becomes more accurate. However, 
as the sampling rate increases, so does the demand for system resources (memory, disk 
space, etc.). There is a “point of diminishing return” in terms of sampling rate for almost all 
types of analog signals, where sampling above a given threshold adds relatively little 
information. 
The MP System’s sampling rate has a lower bound of 2 samples per hour, and an upper 
bound of 400 kHz aggregate for the MP150 or 70 kHz aggregate for the MP100. The 
MP100 will accept Custom rates, but the MP150 must use a pre-defined rate. 
Choose the best acquisition sample rate from the pop-up list. 
Note:  Channel sample rates are variable based on the acquisition sample rate. All channel 

sample rate options are equal to or a specific power of 2 less than the acquisition 
sample rate. 

Duration The final acquisition parameter is Acquisition Length (Total Length), which controls how 
long an acquisition will last. This can be scaled in seconds, minutes, hours, milliseconds or 
number of samples. You can set this value either by entering a number in the acquisition 
length  box, or by moving the scroll box left or right. 
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Starting an acquisition 
Once you have specified which channels will contain data and have defined the channel characteristics, the 
next step is to start the acquisition. If a file window is not already open, choose File > New (or File > New > 
Graph on a Mac). 
Status 
In the lower right corner of the screen, next to the Start button, you should see a circlular status light. The 
status light indicates the communication link between your computer and the MP acquisition unit. 

 If the MP acquisition unit is properly connected to the computer and is turned on, the circle will be solid 
and green (on monochrome displays, the circle will appear solid). 

 If the MP acquisition unit is not properly connected or not communicating with the computer, under 
Windows® OS the circle will be solid and gray (on monochrome displays, the circle will appear unfilled) 
and under Mac OS® X the circle may not appear at all or a different symbol, such as double arrows, may 
be used if the application crashed during acquisition. 

Start 
To start an acquisition, position the cursor over the  button and click the mouse button, or select “Alt 
+ Spacebar” on the PC or “Ctrl+ Spacebar” on the Mac. If there are no input devices (e.g., electrodes or 
transducers) connected to the MP System, it will collect a small value of random signal “noise” with a mean 
of about 0.0 Volts. 

 For information on how to connect measurement devices to the MP System, see the BIOPAC MP 
Hardware Guide.pdf. 

 You may also start an acquisition using a variety of “triggers,” which are discussed on page X355H104 X. 
 Graphs that open without a Start Button 

o Advanced Averaging Experiment 
o Compressed Graphs 
o Mac OS X only:  Igor Pro Experiment, PhysioNet, DWT, IDWT, PCA, IPCA, ICA, IICA, AR 

Model separate graph output, Nonlinear Modeling separate graph output, HRV 
tachogram output, Chaos > Plot Attractor, Chaos > Detrended Fluctuation 
Analysis 

o MatLab Graphs 
o Merge Graphs 
o Original Data Snapshot 
o Raw Data Files (Mac GLP Only) 
o Text Files 
o Transformations: FFT (phase and Magnitude); IFFT; Rate (new graph option) 

Off-Line Averaging; Filter Response Histogram 
Once an acquisition has started, the Start button in the acquisition window will change to Stop, and two 
opposing arrows will blink, indicating that data is being collected. Also, the “BUSY” indicator light on the 
front of the MP acquisition unit will illuminate, showing that data is being collected. 
Stopping an Acquisition 
To stop an acquisition at any time, click on the  button in the lower right corner of the screen or select 
“Alt + spacebar” on the PC or “Control + Spacebar” on the Mac. 
An acquisition will stop automatically when it has recorded an amount of data equal to that indicated in the 
Total Length box. To save this data file, choose the Save command from the File menu. 
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Display modes 
The three main display modes are Chart mode, Scope mode, and X/Y mode. Data can be displayed in a 
number of different modes. You may change the way data appears on the screen at any time, even during an 
acquisition. To change the display mode, click on the corresponding icon in the toolbar. 

 Chart mode  
Chart mode is the default display mode. 
Chart mode plots data much as it might appear on a 
chart recorder, with time on the horizontal axis. 
Each channel of data is in its own “track” across the 
screen, with borders between channels. The 
waveforms will not cross boundaries into the tracks 
of adjacent channels. 
If a waveform is plotted off the scale of the channel 
track, choose autoscale waveforms and 
AcqKnowledge will select the “best fit” for 
waveforms to their tracks. 

 

 Scope mode  
Scope mode plots data much as it might appear on an 
oscilloscope, with time on the horizontal axis. 
Scope mode is similar to Chart mode, except that 
there are no borders between different channels. 
 To help emphasize the selected wave in Scope 
mode, select the “Gray non-selected waves” 
Preference (via Display>Preferences). 

Waveforms can overlap. The autoscale waveforms 
command will automatically separate the waveforms 
in the graph window. 
Note: When only one waveform is present, the scope 
and chart modes are identical.  

 X/Y mode  
X/Y mode plots data from two channels against each 
other, with the values from one channel on the 
horizontal axis and the values from another channel 
on the vertical axis. Plotting a channel against itself 
displays a straight line. 
X/Y mode can be useful for chaos investigations and 
respiration studies.  
Note: You can select Display > Show >Last dot only 

to plot only the most recently acquired data 
point. This is most useful when viewing data as 
it is being collected and when this data is 
displayed in X/Y mode.  
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 X/Y mode continued 
Plotted channels 
To change the channel being plotted along the X-axis, click in the channel label area above the waveform. 
To change the channel being plotted along the Y-axis, click in the channel label area left of the waveform. 
A popup menu of all currently plotted channels will be generated. Choose a channel from the list to plot it 
on the selected axis. 
Toolbar icons 
The center cluster of toolbar items is specific to X/Y mode. The left two buttons in this group are shortcuts 
for the Autoscale vertical and Autoscale horizontal functions. Adjacent to these buttons are two buttons that 
perform the center vertical and center horizontal functions.  
Tools 
Cursor In X/Y mode, the I-beam tool in the lower right hand corner of the graph window changes 

into a crosshair. When the crosshair is moved into the graph window, the coordinates of the 
crosshair are displayed in the upper left corner of the graph window. The X value refers to 
the coordinate of the crosshair in terms of the horizontal axis, and the Y value describes the 
location of the cursor in terms of the vertical scale. 

 
X/Y plot with BPM on X-axis and lagged BPM on Y-axis 

Autoscale In X/Y mode, the Autoscale waveform function changes to read Autoscale vertical, which 
plots the vertical channel so that it takes up two-thirds of the vertical channel space. This 
function controls the “height” of the data being plotted in the graph window. 

 Similarly, the Autoscale horizontal function plots the waveform so that the waveform is 
plotted in the center two-thirds of the window. This function controls the “width” of the data 
being plotted in the graph window.  
Autoscale commands adjust the center point and the range of data displayed. To manually 
change the scale, click in either the horizontal or vertical scale area. In this case, the scale at 
the bottom edge of the graph windows (which usually reflects time) is the scale for the X 
variable, and the vertical scale controls the scale for the channel plotted on the Y-axis. 

Center In X/Y mode, since only two channels can be displayed at a time, tile waveforms and 
compare waveform are replaced with Center horizontal and Center vertical. These two Center 
commands change the midpoint of the horizontal and vertical scales (respectively) so that the 
midpoint of the scale is equal to the mean value (average) for that channel. These features are 
useful for centering the display so that it is easier to interpret. 

Ch. # Box  In X/Y mode, the channel numbering boxes are disabled. 
Meas. Menu In X/Y mode, the measurement popup menus are disabled. 
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 Overlap Segment mode 
Windows Only—The Overlap Segment mode is enabled 
for acquisitons set to Append (except when in X/Y 
mode). When this option is selected from the Toolbar, all 
appended segments are overlapped in the display, but 
only one segment is selected (“active”). Set the selected 
segment color via Display > Active Segment Color. 
 Right-click and drag Show Segment… to generate a 

menu of segments and change the selected segment. 
 Display > Show segments will also generate a list of 

segments. 
 To view an individual segment, click on the Chart 

mode icon. 
For Mac equivalent, see Stacked Plot mode 
on page X356H33 X. 

The selected segment is used for all enabled software functions. This means that autoscaling can easily 
create what looks like a mess if the selected segment is not appropriate for scaling the largest segment. In 
compound action potential graphs in Overlap Segment, the last segment will most often be the largest, so if 
you select the last segment before autoscaling you will likely get the expected result. The Transform menu 
is disabled in Overlap Segment mode. 

 Playback Mode (Replay) 
Mac only—Playback mode will replay a graph file stored on disk in real time 
to simulate acquisition. Analog and digital channels are replayed as stored in 
the graph file, but calculation channels can be reconfigured to reproduce 
online calculation channels that have no offline equivalents. Calculation 
channels from the original graph can be modified, extended, or removed 
without affecting the data stored on disk in the original graph file. 

1. Select File > Open File for Playback. 
2. Locate a graph file and then click Open. 
3. A new graph window will be generated. 

 The “Connected to…: hardware menu will indicate that the 
graph will be “acquiring” data from the specified file and the 
Start button will change to a light orange “Replay.” 

4. Press Replay to begin playback. 
5. Select Playback > Exit Playback mode to return to acquisition status. 

 
Use Playback to 
experiement with different 
calculation channels 
settings on the same data 
or to recreate an 
experiment for 
demonstration purposes. 

Playback mode has millisecond timing accuracy and allows for reconfiguration of most acquisition 
parameters. Exceptions include: 

 Length is limited to the amount of data in the file 
 Acquisition Sample Rate is fixed (use Channel Sample Rate to downsample) 
 Number of analog and digital channels is fixed  
 Save last, MP, and Averaging modes are disabled 
 “Append” will replay the same data. 

See the AcqKnowledge Demo file under the Help menu as a sample of data playback. 
 

 Stacked Plot Mode—Mac only—For Windows equivalent, see Overlap Segment mode on page X357H33 X.  

Click on the Stacked Plot mode icon to display the Stacked Plot controls beneath the toolbar: 
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A commonly used data visualization technique for examining the evolution of waveform morphology is the 
2D waterfall plot or “stacked plot.” A stacked plot draws multiple traces for a single waveform on top of each 
other, or “slices.” Each individual slice is a time-shifted plot of the original waveform. The slices toward the 
bottom of the plot occur earlier in time then the slices toward the top. 
Data can be acquired in stacked plot mode, but it is processor intensive. If acquisition setup includes high 
sampling rates or control channels with low latency, acquire in chart or scope mode and switch to stacked plot 
mode after acquisition. 
The slices can be aligned at any type of events in the graph. This allows for alignment at appended segments 
(similar to the “overlap mode” feature) but also at locations found through other means. For example, an ECG 
waveform can be aligned at the start of the T-wave to examine how the T wave evolves in time. 

Active slice In stacked plot mode, there is a single slice that is called the “active slice.” By default 
it is drawn in a black color (which can be changed in the stacked plottin drawing 
options). The values on the axes in the graph, grid, displayed events and text 
annotations, selections, and any transformations all apply to the active slice. The 
active slice can be changed using the navigation buttons in the graph toolbar. 

Vertical Separation The vertical separation between consecutive slices is expressed as a percentage of the 
entire visible area. This percentage is kept constant through zooming and scrolling 
operations. 

Stacked Plot Options 

 
Display > Show > Stacked 
Plot Options 

 
Display > Show > Stacked Plot 
Options > Slicing Event 

 
Display > Show > Stacked Plot Options> Drawing Options 

Use Stacked Plot Options to activate slices or visually distinguish the active slice from other slices being 
drawn in Stacked Plot mode. 
Automatic baseline  Adjusts the baseline of each inactive slice to overlap the baseline of the active slice 

prior to the application of any vertical separation. This helps compensate for baseline 
drift in a signal. If it is disabled, no baseline compensation will be applied and the 
stacked plot may exhibit visual vertical segment ordering problems resulting from 
baseline drift (but in this mode can be used as a tool to examine basline drift). 

Gray inactive slices Draws the active slice with a solid pen and draws inactive slices with a dashed gray 
pattern pen. The gray pattern alternates pixels between the chosen waveform color 
and the white background and has the effect of lightening the inactive slices. 

Bold active slice Draws the active slice with a thicker pen. In step and line plot modes, plotting 
normally occurs with a one pixel wide pen. Inactive slices will remain one pixel wide 
while the active slice will have the thicker pen as indicated in the edit field. When the 
waveform is in dot plot mode, the pixel width will be added to the waveform's default 
dot size to increase the dot size for the active slice. 

Change active slice… Draws the active slice in a different color than the chosen waveform color. When 
enabled, the same color is used for the active slice of each waveform in the graph. 
The color can be changed by clicking on the colorwell to the right of the checkbox to 
generate a standard color picker. 
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Automatically jump… Each time the active slice is changed the left edge of the plot area will be changed to 
match the start of the newly activated slice. When disabled, each time the active slice 
is changed the display will be adjusted in such a way that the time interval between 
slice starting positions and the display origin is kept constant (similar to the “Relative 
zoom hold” feature of Windows Overlap mode). 

Functionality in Stacked Plot mode 
Autoscaling 

When a graph is displayed in stacked plot mode, all autoscaling and related display operations (tile, 
compare, overlap) will examine the visible data of the active slice only. It will not be possible to perform 
autoscaling operations using the data of any inactive slice. 

Autoscale Horizontal 
In stacked plot mode, autoscale horizontal will make the active slice occupy the entire visible area. The 
slicing event corresponding to the beginning of the slice will be placed at the left edge of the screen and 
the next slicing event (or last sample point of the waveform if the active slice is the last slice) will be 
placed at the right edge of the screen. The vertical offset will remain unaffected. 

Data Views 
Different data views may have independent Stacked Plot settings. All settings are independent including 
drawing preferences, slicing events, vertical separation, and active slice settings. Stacked plot settings are 
stored individually for each data view in the graph file and will be restored when the graph file is opened 
from disk. 
Any graph-wide operation that may affect the active slice will update all data views that are configured to 
use stacked plot mode. This includes operations that affect the data (e.g. transformations) or events (e.g. 
waveform editing). 

Graphs Containing No Slices 
It is possible that graphs may not contain any slices whatsoever if no events match the slicing event 
criteria. If a graph in Stacked Plot mode contains no active slices, it will be drawn as if the graph was in 
regular chart mode with the following differences: 
All data is drawn using any active slice settings given in the stacked plot drawing options. 
The “Active slice” index will read “N/A”. 
The previous/next/choose slice graph toolbar buttons and “Display > Show > Stacked Plot Options” menu 
items will be disabled. 
It will be possible to view all data from t = 0 to the final data sample of the graph using the horizontal 
scrollbar. 
All autoscaling operations will function as if chart mode was active. Autoscale horizontal will make all of 
the data of the selected waveform visible on screen. 
If the table of available slices was being displayed prior to the removal/editing of the last matching slicing 
event, the table will be emptied and the “OK” button dimmed. The cancel button will remain active for 
the table sheet to be dismissed. 
The slicing event, vertical separation, and drawing menu items and toolbar controls will remain active. 

Data Views 
A “Data View” window is used to provide an alternate view of the same data. You can present data in two or 
more modes for comparison, such as X/Y plots and chart plots. To compare responses in real time, turn off 
Autoplot in one Data View (e.g., Dose 1) and continue Autoplotting in another (e.g., Dose 2).  
To create a new Data View for the active (selected) graph, choose 

 File > New > New Data View or 
 Display > Create Data View 

This will generate a new window displaying the active graph’s data, and will name the new window “Data 
View of ‘Filename’” . 
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TIP Mac AcqKnowledge 3.9.1 and later users can use the Jump-to tool (see page X358H144 X) to correlate data 
views. 
Data Views share fundamental data characteristics such as channel labels, markers, and sampling rates, but 
can be customized for the following: 

 horizontal scale, precision, and offset 
 vertical scale, precision, and offset 
 measurements, including number of 

rows, precision, visibility, and use of 
interpolation 

 grid settings, including spacing, 
visibility, and locking state 

 selected area 
 autoplotting 
 hidden channels 

 autoscrolling 
 channel button display state 
 wave color 
 marker display state 
 channel order 
 plot mode 
 channel drawing mode (step, line, or dot, 

including dot plot size and type) 
 hardware “connected to” display 

The Data View window can be used like any other graph window. The menus and controls can be used to 
change how the data is presented. An acquisition can be started or stopped in any of the Data Views for a 
graph, and any transformations performed on the data in the Data View will be reflected in the graph and all 
of the other Data Views. Printing a graph from a Data View will use the display settings of that Data View for 
outputting the graph. 
When a file is saved to disk, the display configuration of any Data Views that are open are saved into the 
graph file. When the graph file is reopened, all of the Data Views and their display settings will be restored. 

 Data Views are saved with the data file only if they are open at the time the original graph is closed 
and saved. 

 Closing a Data View causes this view to be lost; it is not saved with original file. 
 Closing a Data View that was previously saved with a data file will not be saved if the data file is 

saved after closing the Data View. 
 Closing a Data View will not invoke a warning that the Data View will not be saved. 
 Original Data Snapshot is not merged into the newly created data file. 
 Windows: Journal and modification logs will be displayed with the data files. 
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Toolbars 
Many of the most commonly used features in AcqKnowledge can easily be executed with a mouse click. The 
toolbar contains shortcuts for some of the most frequently used AcqKnowledge commands; icons are grayed 
out when they are not applicable. Click Display >Show >Tool Bar to view the icons. 
Icons vary slightly between PC and Mac but functionality is the same. Click on an icon to activate it. 

PC  

Mac   
PC MAC FUNCTION 

  Change display to scope mode. 

  Change display to chart mode (default). 

  
Change display to X/Y mode. 

  
PC = Change display to Overlap Segment mode (see page X359H33X). 
Mac = Change to Stacked Plot mode (see page X360H33X) 

  Autoscale selected waveform only. 

  Autoscale waveforms along the horizontal axis. 

  
Center waveforms vertically in the active window. 

  Center waveforms horizontally in the active window (X/Y 
mode only). 

  Find the peak of a selected area. 

  Find the next peak (after peak has been defined). 

  Show/Hide gridlines in the graph window. 

  Show/Hide measurement pop-up windows. 

  Show/Hide channel selection boxes. 
  Channel selection boxes appear above the data window 

and indicate the channel(s) being used to record data. 
 To select a channel, depress the corresponding channel 

number box (CH 1 is selected here). 
 To hide a channel, Ctrl-click (PC) or Option-click (Mac). 

A slash mark will cover the channel box and the channel 
will be hidden. 

  Show/Hide markers and marker menu icons. 
Marker menu icons: 

PC—  Mac—  
-- 

 
Text Annotation display (see page) 

  Show/Hide graph-specific journal. 
Mac—Journal must be open for icon to work. 

  Produce a list of Student Lab-type files in the current folder. 
Other folders can be selected by: 

  PC—choosing “Browse” from top of the list. 
Mac—choosing the “Select” folder. 

  
Rewind—deletes the last recorded segment. Ctrl+Rewind 
(Windows) or Option+Rewind (Mac OS X) deletes all 
recorded data, similar to the Append “Reset” button. 

  
Show/Hide Hardware “Connected to:”  in the graph display; 
also functions via Display > Show > Hardware. 

 
Keyboard shortcuts 
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Menu Windows Mac OS X  
AcqKnowledge menu n/a  

Exit   Q 
Hide AcqKnowledge   H 

File menu   
New Graph Ctrl-N  N 
Open Ctrl-O  O 
Close Ctrl-W  W 
Save (graph) Ctrl-S  S 
Print Ctrl-P  P 
Quit Ctrl-Q  

Edit menu   
Undo (when applicable) Ctrl-Z   Z 
Cut Ctrl-X  X 
Copy Ctrl-C  C 
Paste Ctrl-V  V 
Clear (journal) del none 
Duplicate Waveform none  D 
Select All none  A 
Journal>Paste meas. Ctrl-M  M 
Journal>Paste wave Ctrl-D  / 

Transform menu   
Find peak/cycle Ctrl-F  F 
Find next peak/cycle Ctrl-E  E 
Find all peaks/cycles Ctrl-R  R 
Find rate Ctrl-A none 

Display menu   
Zoom back Ctrl-“-” (minus key from num pad)  - 
Zoom forward Ctrl-“+”(plus key from num pad)  + 

Start/Stop Acquisition Alt-spacebar Ctrl -spacebar 
MP menu   

Autoplot on Ctrl-T  T 
Cursors   

I-beam  Ctrl-I  I 
Arrow (pointer) None—Ctrl-B will close program  B 
Zoom Ctrl-G  G 

 
 

Cursor Location Mac only—In chart, scope, or stacked plot mode (e.g., all but 
X/Y) these keyboard shortcuts can be used to scroll to various 
parts of the graph: 
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Menu Windows Mac OS X  
Home Jumps to t = 0 (e.g. places first sample of data flush with left of 

screen) 
End Jumps to the end of the currently selected waveform (e.g. 

places last sample of data of the selected waveform flush with 
right of screen) 

Page Up Scrolls backward in time one full screen (e.g. places leftmost 
sample of previous visible area at the right of the new visible 
area) 

Page Down Scrolls forward in time one full screen (e.g. places rightmost 
sample of previous visible area at the left of the new visible 
area) 
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Mouse Controls 
Right-click Shortcuts—Windows only  

The following options can also be located via the right mouse button. 

Graph window: 

 

Journal window:  

 

Horizontal scale: 

 
(Update screen interval 
options) 

Mouse Scrollwheel Support— Mac only 

The scrollwheel operates on whatever window is underneath the mouse; this window does not need to be 
the topmost window. This makes it convenient to use scrollwheels when multiple graph windows are 
open or when the scrollbars in a graph window are unavailable due to a sheet being displayed for the 
graph. Many third-party mice and some Apple mice sport scrollwheels (or scrolling balls or trackpads) to 
allow for quick access to navigating through a document. Mice may provide two separate controls, one 
for scrolling vertically and one for scrolling horizontally. 
AcqKnowledge now supports horizontal and vertical scrolling using the scrollwheels on the mouse. 
Scrolling is supported in graph windows, journal windows, the event list in the event palette (Mac only), 
and a number of other dialogs and sheets that contain scrollable lists. To increase the scroll speed, hold 
down the “Option” key while using the scrollwheel. 
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Contextual Menus 

 

Mac OS X only The graph window has contextual menus (similar to right-
click functionality on a PC). To access these menus, hold down the Control 
key and click the mouse button. 

 If the mouse is over a portion of the graph that has a context menu 
available, the cursor will change to an arrow with a menu. 

The contextual menus available are: 
Waveforms Set plot mode, select transformations, show Statistics 
Measurements Copy to clipboard or journal, toggle interpolation 

on/off 
Markers Insert, delete, paste summary to Journal 

  
Horizontal Scroll Change update interval 

Contextual menu items correspond to the AcqKnowledge main menu state. 
Application menu customization has a corresponding effect on contextual 
menu display. If a contextual menu item does not have a corresponding 
application menu item, the menu customization file identifier will begin with 
“IDM_CM.” 
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Analysis 
For purposes of illustration, you should open an existing file that contains actual data. Sample files were 
installed with the software. Select File > Open and choose a file from the list in the dialog box. 

 If you have the MPWS (Mac), open the file called 4chData 
 If you have the MPWSW (PC), open the file called 4chData.acq 

The screen should resemble the following sample file display. 

 
Sample File Display 

The sample graph displays four different types of data, and there is a border between the waveforms. 
To the left of each waveform is a vertical strip containing a text string that can be used to help identify each 
waveform. 
The time scale along the bottom denotes when the data was recorded relative to the beginning of the 
acquisition. 

 Only the last eight seconds of the total data record are visible, although the file 
contains the complete record. 

 The data displayed on the left edge of the graph represent events that occurred about 
22 seconds into the record, and the data displayed at the right edge of the screen 
represent events that occurred about 30 seconds after the acquisition was started. 

The maximum vertical scale range is from +10 to -10 Volts. 
 This reflects the maximum input voltage the MP can accept and is a greater range 

than you will usually encounter. 
 The display scale can be adjusted to virtually any value range, as demonstrated in 

the graph window above. 
As indicated by the horizontal scale, only a few seconds of data are displayed on the screen. If you choose 
Statistics from the Display menu (on the menu bar), you can determine the total length of the record. 
To view data that was collected earlier in the record, you can use the horizontal scroll bar to move to different 
points in the record. The horizontal scroll bar allows you to move around in a data file, just as the scroll bar in 
a word processor allows you to move to different points in a document. 
Alternatively, you can position the cursor in the horizontal scale area (where the numerical values are listed) 
and click the mouse button. This will generate the following dialog box (see page X361H137X for details). 
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The (Time) Scale box allows you to change the amount of data that appears on the screen at any given time. 
In the sample dialog box, this is set to 2 seconds per division. The divisions on the screen are indicated by the 
four vertical lines, thus displaying eight seconds at a time (two seconds per division times four divisions). By 
entering a larger value in this box, more of the record will be displayed on the screen at any given time. 
Conversely, entering a smaller value in this box will cause a shorter segment of data to be displayed on the 
screen.  

 To display the entire waveform (in terms of duration), a shortcut is to choose Autoscale horizontal 
from the Display menu. The Autoscale horizontal command fits the entire data file into the window, 
regardless of the total length of the acquisition. 

The Initial Offset box lets you “jump” to a different point in the time display. Changing the value in this box 
allows you to display data beginning at a certain point in the record. For instance, if you want to see the data 
at the beginning of this record, you would tell AcqKnowledge to display data with an initial offset of 0 
seconds, which would result in the following: 

As you can tell from the time scale, the first 
data displayed (at the left edge of the screen) 
was collected at the beginning of the 
acquisition. Also, the scroll box has moved to 
the left, indicating that the data on the screen 
represents data collected earlier in the record. 
If you click in the horizontal scale area again, 
the same dialog will appear, and this time the 
value in the start box should have changed to 
reflect the new section of data being 
displayed on the screen. 
 

Hold relative position is an option available only in the Append acquisition mode. When checked, the display 
for appended acquisitions will show the same relative position with respect to the start of acquisition (see 
unlocked grids section for more detail). 
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All of the options described thus far describe ways to change the time scale of data in one way or another. 
AcqKnowledge also allows you to change the vertical scaling, or amplitude of each waveform. Clicking on 
the vertical scale area produces a dialog box (see page X362H139X for details). 

   
The vertical scale dialog box allows you to change the range of amplitude values displayed (scale) and set the 
value that appears in the center of the vertical scale (midpoint). 
Scale—In the sample dialog box, the units are set to 3 mVolts per division. As with the horizontal scale, there 
are four divisions on the vertical axis, so this setting should show 12 mVolts range of data. 
Midpoint—The box below this controls the midpoint of this range. In this case, the midpoint is set to 2 
mVolts, which means that this channel will display the range from - 4 mVolts to + 8 mVolts. 
You can vary the midpoint and apparent magnitude of each waveform by changing the values in each box. By 
changing the value in the scale box, a smaller value has the effect of increasing the apparent amplitude. 
Entering a number about half the current value will cause the amplitude of the wave to appear to double.  
As with the time scale, you can have AcqKnowledge automatically come up with the best fit in terms of 
midpoint and units per division. To do this, select the Autoscale waveform command from the Display menu, 
and the amplitude and offset of each wave will be adjusted to fit their sections. 
Any changes you make in terms of rescaling (either horizontal or vertical) will only affect the way data is 
displayed, and will not change the basic characteristics of your data file. 
Selecting a waveform 
Although all four waves are displayed at once, you may want to operate on only one channel at a time. To do 
this, you need to select the channel you wish to work with. Selecting a channel allows you to highlight all or 
part of that waveform, and enables you to perform transformations on a given channel. 
In the upper left corner of the graph window there is a series of boxes that represent each channel of data. The 
numbers in the boxes correspond to the channel used to acquire the data (the specifics of setting up channels 
are discussed on page X363H28X). In the sample waveforms shown previously, ECG channels are represented by 
channels 1 and 2, with respiration on channel 4 and blood pressure on channel 5. 

To select one of these channels, position the  cursor over the box that corresponds to the channel you wish 
to select and click the mouse button. 

You can also select a channel by positioning the  cursor on the waveform of interest and clicking the 
mouse button. 
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Hide a Channel 
To “hide” a waveform, hold down the appropriate key and click on the channel box: 

 Hold down CTRL key on PCs 
 Hold down OPTION key on Macs 

You may view a hidden waveform by keeping the appropriate key pressed and clicking on the channel box 
again. 
 
Zoom 
Another way to examine data is to use the “zoom” tool. The zoom tool allows you to select any portion of any 
wave and magnify it as much as possible. To use the zoom tool, click on the  icon in the lower right 
portion of the screen. As you move the mouse into the graph area, you will see it change from an arrow  to 
a crosshair (+). Start by positioning the cursor in one corner of the box, holding down the left mouse button, 
and dragging the crosshair horizontally, vertically, or diagonally to form a “box” which encompasses the area 
you need to zoom in on. When you release the mouse button, AcqKnowledge will automatically adjust the 
horizontal and vertical scales. To “unzoom,” choose Zoom back from the Display menu. 
 
Selecting an area 
Once you have selected a channel, you can “edit” parts of that channel by selecting a section of the waveform. 
The options available to you include cutting, copying, and pasting sections of waveforms. You can also 
transform and analyze entire waveforms or specific sections of waveforms. 
For any of these functions, you will need to select (or highlight) an area to be operated on. If you want to 
select a section of a waveform, position the cursor over the  icon in the lower right hand corner of the 
screen and click the mouse button. Now move the cursor to the first point in the area that you wish to select. 
As you move the cursor into the graph area, you will see it change from an arrow cursor to a standard I-beam 
editing tool. 

To highlight a section of a waveform, position the  cursor at the left edge of the area you wish to select and 
hold down the mouse button. Now move the mouse to the right until you have selected the desired area. 

To select more than one screen of data, position the  cursor at the left edge of the section to be highlighted, 
then click and hold the mouse button. Use the scroll bars to move to a different point in the record, and when 
you reach the desired endpoint (right edge) of the selected area, hold down the Shift key while you position 
the cursor and click the mouse button. Selecting an area this way will also allow you to “fine tune” the 
selected area to include only a specific range of data. 
Once a channel has been selected and a section of that area highlighted, you can operate on and edit that 
section of the waveform. The editing commands behave much the same way as the editing functions in a word 
processor. You can cut, copy, delete or paste sections of data as defined by the selected area. In most cases 
(depending on available memory) you may undo an edit by choosing Undo from the Edit menu, or by using 
the shortcuts of +Z on Macs (MPWS) or CTRL + Z on PCs (MPWSW). 
Selecting a portion of a waveform also allows you to apply transformations to 
a particular area, rather than the entire area or all waveforms. Selecting an area 
also allows you to take snap measurements for parameters such as delta T, 
mean, standard deviation, frequency, and so forth. The measurement options 
are discussed in the next section. 
Transforming data 
AcqKnowledge includes a vast library of functions, which can transform data 
or perform mathematical Calculations on waveform data. All of these options 
can be found under the Transform menu, and are discussed in detail in the 
Transform Menu Commands section beginning on page X364H217X. 
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When performing transformations, keep in mind that when a section of a waveform is highlighted, the 
transformation will apply to that section. Also, if no area is defined, AcqKnowledge will always select a 
single data point. Some transformations (spectral analysis and digital filtering, for instance) can only be 
performed on a selected area, so if a single point is selected the entire waveform will be transformed. 
 

Measurements 
Once you have selected a channel to work 
with, you can quickly and easily take 
measurements on each wave. The 
measurements appear in the row of boxes 
across the top of the graph window. You 
can specify the number of measurement 
boxes to show and the display precision in 
the “Preferences” dialog of the Display 
menu. Each measurement consists of three 
parts: (a) the channel selection, (b) the 
measurement function, and (c) the result or 
actual measurement value.  

The pull-down channel selection allows you to calculate a measurement either for the selected channel (SC) 
or from a numbered channel in the record. To switch between the channel options, click in the channel 
window. The pull-down menu shows the channel numbers and labels for all channels in the file. By default, 
each measurement will reflect the contents of the selected channel. 
The pull-down measurement menu allows you to choose between different types of measurements. To choose 
a measurement, click on the measurement popup menu and select a measurement from the list. 

 Some measurements (such as Time or Value) look at only a single data point whereas other 
measurements (such as mean and delta T) examine a range of data on the selected channel. 

 Some of the measurements that depend on a selected area (such as delta T) look at differences in the 
horizontal axis measurement whereas other range measurements (such as peak-peak) use the vertical 
scale information in calculating measurements. 

For a complete description of each of the measurement functions, turn to page X365H147X The final component of a 
measurement window is the measurement result. 

 When an area is selected (or if the selected area is changed) the measurement result automatically 
updates to reflect the change.. 

 

In this example, results for the selected 
channel (SC) are: 
 Time 17.28 sec 
 delta t 0.00000 sec 
 freq 0.10157 Hz 
 bpm 6.09446 BPM. 
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Markers (Events) 

 

In many instances it is useful to have the software “note” an 
occurrence or event during an acquisition so it can be referenced later. 
For instance, you may want to note when a treatment began or when 
an external event occurred so you can examine any possible reaction. 
The software uses “markers“ which are placed above the data to 
record events.  

AcqKnowledge distinquishes between Append Markers and Event Markers, and allows you to pre-program 
and automate each. Markers appear at the top of the graph window, and can be edited, displayed, or hidden 
from view. 
 “Append markers” are automatically inserted each time you record a segment in “Append” mode 
 “Event markers” can be inserted during an acquisition or after recording (off-line) 

You can automatically insert event markers during an acquisition by pressing the F9 key on a PC or Esc on 
Mac. This will insert a marker at the exact time the key is pressed and will activate the text line entry so you 
can immediately enter a comment to be associated with the marker. Use Marker Preferences to change or add 
function key assignment(s). 

To enter an event marker after recording, click the cursor in the area beneath the marker area. This will insert 
a marker. To add text describing the event, click the cursor in the marker box and key the desired text. To 
view the text associated with a marker, position the selection tool over the marker and click the mouse 
button. To move from marker to marker, paste marker information to the journal, etc., use the Marker tools. 

For a detailed description of markers and marker functions, including options to pre-establish marker labels 
and set function keys for different labels, see Markers on page X366H161X for Windows/PC and Events on page X367H164X 
for Mac OS X. 
See also: Text Annotation, page X368H144X. 
 
Grids 

   
Grid superimposes a set of horizontal and vertical lines on the graph window. The grid is designed to allow 
for easy measurements, since the grid lines correspond to horizontal and vertical scale divisions. The grid can 
be locked (analysis, printing) or unlocked (visual aid). 

To activate the grid display, choose Display> Show > Grid or click on the  toolbar icon. 

 To display minor grid lines, use Ctrl- . 
 To customize grid line and color and optimize the display and print features, choose Display > Show > 

Grid Options. 
For more information about using and printing grids, see page X369H179X for Windows/PC and page X370H183X for Mac OS 
X. 
Note: The Scale dialogs change when grid lines are locked. See page X371H137X for details on Horizontal Scale and 

page X372H139X for details on Vertical Scale. 
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Journals 
The Journal is a general-purpose text editor built into AcqKnowledge that works like an “electronic notepad” 
for you to record notes and data and save text and/or numeric values to review later. 

 

Graph-specific journal—Journal is saved with graph; 
preferable for retaining notes and analysis within a graph 
file. Display settings are independent. To save a graph-
specific Journal independent of its graph, use File > Save 
Journal Text As option. 
Independent Journal—Mac only Journal is saved into its 
own file, separately from graphs; preferable when 
performing analysis on multiple graphs at the same time. 
Independent journals allow multiple journal windows to 
be open at the same time (each graph view can have its 
own journal associated with it), but only one Independent 
Journal can be used at a time.  

To display the Journal, select the  icon from the toolbar (toggles graph-specific journal only), or 
 Windows: Choose Display > Show > Journal 
 Mac: Choose File > New > Graph-Specific Journal or Independent Journal  

Once a Journal is open, you can enter text, data, or both. To enter text, just begin typing when the journal is 
open. AcqKnowledge will automatically “wrap” the text to fit the screen width. 

 There are Time Stamp, Date Stamp and Auto Time functions available in the journal window. 
The Time and Date stamps refer to the computer’s clock to record the time and date, respectively, directly 
into the Journal. The Auto Time function records the time at the instant the carriage return is pressed, which is 
useful for tagging commands as data is collected. Additional icons are available for: 

 Clear the journal without saving  Save journal as a text file 

 Open a text file to add to the existing journal  Print the journal 
You may also paste measurements and data into an open Journal. To paste measurements into an open 
Journal, select an area and choose “Paste measurements” from the Edit>Journal menu. Paste to Journal 
functions only work if a Journal is open and vary for each journal type: 

 Graph-specific journals can only receive measurements and wave data from their associated graph 
view 

 Independent Journals can receive measurements and wave data from any open graph. Results will be 
put into both the graph-specific journal and the independent journal. 

Additionally, by changing the Journal Preferences (page X373H312X), you can simultaneously record measurement 
name and units. For Marker Journal Summary preferences, see page X374H163X. 
To paste waveform data into a Journal, select an area and choose “Paste Wave Data” from the Edit>Journal 
menu. Allow several seconds for the text file to be written. The result is a text file of your wave data pasted 
into your active journal.  
A useful feature of the Journal is that it works in connection with the Peak Detector and other measurement 
functions to paste in values from waveform data for further analysis. 
In the example above, the peak-to-peak and delta t measurements were pasted from the open graph window to 
the Journal. See the Journal paste section on page X375H216X for more information on how to paste information to 
Journal files. 
Mac only: Use Save as/Open Journal Template to retain SOP text or standardize lab and/or computer details 
for record keeping. 
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Saving data 
Once data has been collected, it can be saved as a file and opened later. The data file can be moved, copied, 
duplicated and deleted just like any other computer file. By default, files are saved as AcqKnowledge files, 
which are a proprietary format designed to store information in a format as compact as possible. Although 
these files can only be opened from within AcqKnowledge, the data in these files can be exported either as a 
text file or as a graphic image. 
Exporting data to a text file allows you to examine the data using other programs, such as a spreadsheet or 
statistical analysis package. Saving data as a graphic (.WMF for MPWSW or PICT for MPWS) enables you 
to work with the data in graphic format. 
One of the most useful applications of this is the ability to edit and place AcqKnowledge data as it appears on 
the screen. You can use this feature to paste graphs into word processors, drawing programs, and page layout 
programs. To learn more about these options, turn to the Save As section beginning on page X376H197X. 
 
Embed Archive “Snapshot” 
Each embedded archive is essentially a “snapshot” of the original acquired data that is stored with the graph 
file so you can easily view them together at a later time to compare results to original waveforms or 
intermediate stages of analysis. Append markers are not preserved in Embedded Archive files. 

IMPORTANT: Archive functions do not create a new file—they are not backup functions.  
Original data is copied and pasted to the end of the original file.  
You cannot use this feature to recover lost or damaged original data. 

There are two ways to create an embedded archive: 

1.  Automatic after acquisition: Display > Preferences > General > Snapshot 
data after acquisition 
Toggle the “Snapshot data…” option in Display > Preferences > General. When this is enabled, a date-
stamped archive of the data in the graph when acquisition stopped is created. In Append mode, the 
entire graph is archived with each Append, old data as well as the newly acquired data.  
This is a memory intensive function; each archive that is added to a graph file will increase its size on 
disk by approximately 40%. When prompted, click OK to proceed.  

 
2. Manual: Edit > Create Original Data Snapshot 

A snapshot is then taken of the data at that point in time and 
stored with the graph. Manual archives allow you to 
preserve intermediate stages in a complex analysis for 
future reference. You will be prompted for a comment to 
describe the archive. This description will be used in the 
header when you display the archive. 
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To view the embedded archive(s) associated with a graph file, choose Display > Show All Data Snapshots. 
This will open a new graph window for each archive associated with the graph. The time portion of the 
Filename for each graph is from the computer clock (saved with semi-colons because you cannot save a file 
with colons in the filename). The “Data Snapshot from…” graph will open with no Start button.  

Manual Archive: description and time 
Original file 
Automatic Archive: time only 

Mac 3.9.2 and later only—Snapshots will also retain the following in addition to the data: 

 Events - Text annotations  
 Graph-specific journals 
 AcqKnowledge GLP Modification logs (ACK100W-G and ACK100M-G only)  

 
Printing 
In some cases, it is important to have a hard copy of the 
data. AcqKnowledge allows you to produce high-
resolution plots of graphs much as they appear on-
screen. To print a file, choose Print from the File menu. 
This will print the contents of the screen on the selected 
printer. To print the entire file, choose Autoscale 
Horizontal from the Display menu first.  
You must print a journal as a separate command from 
print graph file. 
An example of the print dialog is shown here. Often, 
you may want to instruct AcqKnowledge to print the 
contents of a file across several pages. To do that, 
change the value in the Total pages box (under Print Setup > AcqKnowledge 3.9 on Mac OS X). Entering “4” 
in this box, for instance, will place the length of the page evenly across four pages when printing. 
To find out more about the print command, turn to the Print section beginning on page X377H207X. 



Part B — Acquisition Functions: The MP Menu 51 

AcqKnowledge Software Guide 

QuickTime Movies of Acquisitions 
You can create a QuickTime movie of AcqKnowledge window 
content during or after acquisition (from a graph file saved on 
disk). Capture waveform plotting, results of autoscaling, 
autoscrolling, and any other visual changes to the graph window 
that occur during acquisition. 

 By postponing QuickTime creation, you can make sure 
data is clean and optimize settings to reduce file size—
QuickTime movies can be gigabytes in size and it’s a 
hassle to accidentally run out of disk space in the middle of 
an acquisition. 

Flattening—QuickTime movies are generated in the 
“Animation” format with no compression codec used and 
flattened at the end of the acquisition. Flattened movies are 
cross-platform compatible with Windows™ PCs. Due to 
limitations of QuickTime 6, flattening may take 10 minutes. 
Save Quick Time Movie Options 

Location—The disk where the movie is saved should have several gigabytes free space available for movies 
longer than 3 minutes. 
Autoscale final frame—Creates the last frame of the movie after an Autoscale Horizontal operation so the last 
frame of the movie shows all of the data from the start of the acquisition to the end. 
Maximum frame rate—Sets an upper bound for the frame rate at which screen shots of the graph window will 
be taken. 

 Higher frame rates generate larger movie files. 
 This is only a maximum frame rate—the actual frame rate will vary. A lower frame rate may result from 
CPU load, network latencies, other programs running in the background, or any operation that causes a 
hitch in the smooth plotting of data or autoscrolling. 

Optimize graph size and display settings 
The actual dimensions of the movie will be taken from the size of the graph window, so optimizing the 
display will help reduce file size and emphasize signal representation(s). 

 Optimize graphs size 
o Select Display > Size Window and enter the smallest reasonable size for the visual dimensions of 

the movie (e.g. 400x300). 
o The smaller the size of the graph window, the smaller the resulting movie will be (in both size on 

disk and visual dimensions). 
o Do not resize the graph window while a QuickTime capture is in process. 

 Optimize display settings for the reduced graph size 
o Hide toolbars, events, hardware menu, measurements, etc. 
o Set the scales such that details of the waveform(s) will be discernable in the small graph window 

plotting area. 
o Perform autoscaling as necessary to get appropriate vertical scales for the entire data file. 
o Optimize the horizontal scale for the reduced display region. 
o Set precision of the axes (usually 2-3). 
o Set the “Initial time offset” of the horizontal axis to zero, either through clicking on the axis or 

scrolling all the way to the left. 
Create a QuickTime file from a Saved Graph File 
Preferred Method —This procedure requires two acquisitions 
Stage 1 

1. Select File > Open File for Playback (the MP menu will change to “Playback”). 
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2. Select the file containing the source data for the video. 
3. Disable (uncheck) Playback > Capture to QuickTime. 
4. Set the acquisition storage mode to “Save once to Memory” (Playback > Set Up Acquisition). 
5. Press “Replay” in the graph window and wait for acquisition to terminate. 

 This acquires all of the original data into the graph window so all of the data is present for 
determination of vertical scaling appropriate for the entire acquisition. 

Stage 2 
6. Optimize graph window size and display settings to reduce movie file size. 
7. Select Edit > Select All. 
8. Select Edit > Clear All. 
9. Enable (check) Playback > Capture to QuickTime. 
10. Press “Replay” in the graph window. 
11. Set options in the “Save QuickTime Movie” dialog and then click Save. 

 Watch for error dialogs and wait for playback acquisition to finish. 
 Wait for the QuickTime file to flatten (may take 10 minutes). 

12. Open the movie in QuickTime Player and check for any problems. 
13. If necessary, go back to the playback graph window and repeat from Step 6. 

Create QuickTime file during Acquisition 
Riskiest method—You are more likely to run out disk space 

1. Enable MP1#0 > Capture to QuickTime. 
2. Optimize graph window size and display settings to reduce movie file size. 
3. Press Start in the AcqKnowledge graph window. 
4. Set options in the “Save QuickTime Movie” dialog and then click Save. 
5. Stop acquisition (automatically or via the Stop button). 

a. The QuickTime file will automatically be saved (separately from the acquisition). 
b. Save the graph file. 

Playback 
Use Playback mode to replay (or simulate) acquisition using a previously acquired graph file. The data in a 
graph file can be used to simulate an MP unit that returns the data of the analog and digital channels stored in 
the graph file; calculation channel settings can be altered from the ones contained in the graph file. See the 
AcqKnowledge Demo file under the Help menu as a sample. 

1. Select File > Open File for Playback. 
2. Locate a graph file and then click Open. 
3. A new graph window will be generated. 

 The “Connected to…: hardware menu will indicate that the graph will be “acquiring” data from 
the specified file and the Start button will change to a light orange “Replay.” 

4. Press Replay to begin playback. 
5. Select Playback > Exit Playback mode to return to MP menu and acquisition options. 
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Part B—Acquisition Functions: The MP Menu 
Overview 
The AcqKnowledge software adds acquisition and control capability to the complete MP System. This section 
describes the commands and procedures used to establish the various acquisition parameters for the MP 
System, including how to: 

 Set up channels for data acquisitions 
 Control acquisition parameters such as sampling rate and duration 
 Perform online calculations and digital filters 
 Set acquisitions to begin on command from a mouse click or external trigger 
 Display values numerically and graphically during an acquisition 
 Output waveforms and digital signals during an acquisition 
 Control the on-screen waveform display characteristics 

Some of the basic functions involved in setting up an acquisition were covered in Part A—Getting Started, 
but this section will cover them in more detail, as well as describe some additional features. All the 
commands covered here can be found under the MP menu. 
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Acquisitions 
Acquisition is defined as data collection from an external source (such as electrodes connected to an 
amplifier). 

 Before you begin an acquisition, make sure the MP acquisition unit is turned on and connected to 
your computer. Please refer to the BIOPAC Hardware Guide for more information on connections. 

To begin collecting data: 
1. Launch the AcqKnowledge application (you can double click on the AcqKnowledge icon). 
2. Open a new graph window that will display data as it is being collected. 

 To do this on the MPWSW (PC), choose New from the File menu. 
 To do this on the MPWS (Mac), choose New from the File menu and then select 

the Graph Window option. 
3. You should see a window similar to the following: 

 
4. After you have opened up a new graph window, you must setup the specific channels you want to 

acquire before starting the acquisition. 
 See the Set up Channels chapter (page X378H55X) for details. 

5. In addition to setting up channels, you must setup the acquisition parameters (such as sampling rate, 
acquisition length, and data storage options. 

 See the Set up Acquisition chapter (page X379H89 X) for details. 

Edit menu functionality during acquisition 
Mac OS X only—The following Edit menu functions may move or alter memory and cannot be performed 
during acquisition: Undo, Cut, Clear, Clear All, Paste, Insert Waveform, Duplicate waveform, and Remove 
Waveform. 
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Chapter 3  Set up Channels 
Set up Channels—The Basics 
Before you collect data, you need to specify how many channels you will be collecting data on, and at what 
rate data is to be collected. Both of these functions are accomplished through menu items and dialog boxes. 
To enable collection on a given channel, select Set up Channels from the MP menu. 

 
Notice that the checkboxes next to Analog channel 1 are already selected. This is the default at startup. For 
each additional channel you wish to collect data on, there are three options for channel setup: acquire, plot, 
and values. These options appear as boxes on the left side of the Input Channels dialog box. There are 16 
rows of boxes, which correspond to the 16 Analog inputs the UIM100C can accept. To change the options for 
any channel, click in either the channel label box or the acquire/plot/values boxes. As you do this, a solid 
circle will appear between the Values box and the label area. This indicates that the options for that particular 
channel can be edited. 
Channel Type 
To specify the channel type—Analog, Calculation or Digital—click in the circle next to its name. 
Acquire 
The first option is whether or not you wish to collect data on that channel. Unless you specify otherwise, the 
MP System will only collect data on channel 1. To collect data on other channels, position the cursor over the 
Acquire box (on the far left) and click the left mouse button. 
With the MP System, To leave hardware connected to the MP acquisition unit, but have the software 
essentially “ignore” the channel by leaving the acquire box unchecked. Thus, if an input device (such as an 
ECG100C amplifier) is set to channel 7, data from that channel will not be collected unless the Acquire box is 
checked. 
Plot 
The second option is for plotting data. You will need to specify a Plot option for each channel. The Plot 
option determines whether or not data will be plotted on the screen for each channel. Checking this option 
instructs the software to plot data on your computer’s screen. 
When this box is left unchecked, data will still be collected (assuming the Acquire box is checked) but it will 
not be displayed during the acquisition. 
In most cases, you will want to check this option. However, in large-scale acquisitions (i.e., many channels 
and/or high sampling rates) you may want to uncheck this option for some channels to allow for faster display 
rates (see Appendix B—Hints for working with large files). 
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Values 
The third option enables incoming data values to be displayed either numerically and/or in a “bar chart” 
format in a separate window during an acquisition. Checking this option allows you to open a window (by 
selecting Show Input Values... under the MP menu) that displays the numeric value for each input with the 
“Values” option checked. This option is especially useful for tracking slowly changing values such as heart 
rate, respiration rate, or concentrations of chemicals in a substance. For more information on how input values 
are displayed, please turn to page X380H118X. 
Channel 
Click in the circle next to the channel designation (i.e. A1) to make that channel active (“selected”) so its 
settings can be established or edited. 
Label 

You may attach an editable “label” to each channel. 
These labels allow you to provide a brief name for each 
channel. To change the label for any channel, position the 
cursor in the area to the right of the channel numbers (A1 
through A16) under the label heading and enter a text 
label. You may key up to 38 characters on PC or 40 on 
Mac and these labels will appear next to the channel label 
boxes in the graph window. You can change the label in 
the Set up Channel dialog at any time, or right-click on 
the active channel label in the graph window to generate 
the Assign Channel Label dialog after acquisition. 

 

 
Mac: Click on label to change label text. 
Click on vertical scale to change units text. 

Presets 
Calculation Presets are like “templates” for calculation channels. Each 
Preset stores: 
    a) Calculation channel type 
    b) parameters for that Calculation 
    c) channel-specific scaling 
    d) channel-specific sampling rate 
    e) channel name. 
Calculation Presets establish settings to target application-specific 
analysis. Presets exist for a broad range of analysis functions. Start with 
existing presets for a specific species or protocol—for example, human 
vs. small animal, or stationary vs. exercising measurements. Mac OS X 
includes Presets for Fourier Linear Combiners and Adaptive Filtering. 
Just click on the icon under the Presets head and scroll to select the 
desired preset.  
The Channel Setup dialog contains a “Preset” pop-up menu by each 
channel that lists the current Preset or, if no Preset has been selected for 
that channel, the Calculation type (Integrate, Difference, etc.). When 

you select a Preset for a particular channel, the channel is configured with the settings associated with that 
Preset.  
The Setup dialog has a “Presets” pop-up menu that contains all of the Presets for the Calculation type being 
configured. For instance, if a Difference Calculation channel is being configured, all Presets for the 
Difference Calculation will be listed. 
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When you select a Preset, the Setup dialog is updated with the corresponding information. 
 The Setup dialog reads “none” if the channel configuration doesn’t match any Preset. The menu will 

flip to “none” when the settings for a channel are changed such that they no longer match a Preset.  
 You can create a new Preset from existing Calculation channels. Click on “Setup” to display the 

Calculation Setup dialog and click on the “New Preset” button. The settings will be applied to the 
current channel, and you will be prompted to enter a name for the new Preset. You cannot duplicate a 
Preset name, which also means that you cannot use the default name of a Calculation channel type 
(Integrate, Difference, etc.). The new Preset will be included in the pop-up menus and saved with the 
file. 

 To reorder channel Presets (by type, use, etc.), choose “Organize Channel Presets” from the 
MP150/100 menu. A dialog will be generated and you can drag items to the desired position or use 
the up/down and top/bottom buttons as appropriate (see page X381H128X). 

 Presets are not applicable to and therefore not selectable on Analog or Digital channels. 
Channel Sample Rate  
The Variable Sampling Rate feature allows different channels of data to be down-sampled from the 
acquisition sampling rate; calculation channel must use sampling rate less than or equal to the source channel. 
Choosing lower sampling rates for signals where meaningful data falls below the Nyquist frequency of the 
acquisition sampling rate allows more data to be stored in memory or on disk. 

 Offline operations that involve multiple channels must use the same sampling rate for all Source and 
Destination channels. These operations include waveform editing, Waveform math, Expression 
calculations and Template functions; notable exceptions are “Off-line Averaging” under Find Peak and 
“Reset via a Control Channel” under Integrate. 

 When wave data is copied to the clipboard or journal, data values will be inserted at the highest 
sampling rate (channels with a lower sampling rate will snap to the left). 

 To set an arbitrary channel sample rate for analysis, use Transform > Resample (see page X382H247 X). 
 There is no restriction on the acquisition length when using Variable Sampling Rates on a Mac. 
 Averaging is not allowed with Variable Sampling 

Rate enabled under AcqKnowledge for Windows. 
 When Variable Sampling Rates are used in 

conjunction with the Append mode, and the mode is 
started and stopped manually, it is statistically 
possible that, prior to the next pass of the Append, 
extra data points may be inserted in various data 
channels to “line up” the data (see sample on page 
X383H57X). These extra data points simply replicate the last 
sample in any affected channel. 
To minimize the impact of the extra data points: 
a) Make sure the lowest sampling rate is on the order 

of 10Hz or higher, or 
b) Don’t use Variable Sampling Rates. 
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AcqUKnowledge U QUICK STARTS  
Quick Start templates (.gtl graph template files) were installed to the Sample folder for PC users. You can use a 
Quick Start file to establish the settings required for a particular application or as a good starting point for 
customized applications. See Open As Graph Template on page X384H193X for details.  

Q## Application(s) Feature 
1 EEG 

Sleep Studies 
Real-time EEG Filtering 
Real-time EEG Filtering 

2 EEG Evoked Responses 
3 EEG 

Evoked Response 
Event-related Potentials 
Event-related Potentials 

4 Evoked Response Nerve Conduction Studies 
5 Evoked Response Auditory Evoked response & Jewett Sequence 
6 Evoked Response Visual Evoked Response 
7 Evoked Response Somatosensory Evoked Response 
9 Evoked Response Extra-cellular Spike Recording 
10 Psychophysiology Autonomic Nervous System Studies 
12 Psychophysiology Sexual Arousal Studies 
13 EBI 

Cardiovasc. Hemodynamics 
Exercise Physiology 

Cardiac Output 
Noninvasive Cardiac Output Measurement 
Noninvasive Cardiac Output  

15 EOG Nystagmus Investigation 
16 EOG Saccadic Eye Movements 
17 Plethsymography Indirect Blood Pressure Recordings 
18A Plethsymography Arousal - Female 
18B Plethsymography Arousal - Male 
19 Sleep Studies Multiple-channel Sleep Recording 
20 Sleep Studies 

ECG 
Cardiovasc. Hemodynamics 

Online ECG Analysis 
Online ECG Analysis 
ECG Analysis 

21 Sleep Studies SpO2 Analysis 
22 ECG Einthoven’s Triangle & 6-lead ECG 
23 ECG 12-lead ECG Recordings 
24 ECG Heart Sounds 
25 Cardiovasc. Hemodynamics Online Analysis 
26 Cardiovasc. Hemodynamics Blood Pressure 
27 Cardiovasc. Hemodynamics Blood Flow 
28 Cardiovasc. Hemodynamics LVP 
31 NIBP Psychophysiology 
32 In vitro Pharmacology Tissue Bath Monitoring 
33 In vitro Pharmacology Pulsatile Tissue Studies 
34 In vitro Pharmacology Langendorff & Working Heart Preparations 
35 In vitro Pharmacology 

Pulmonary Function 
Isolated Lung Studies 
Animal Studies 

38 Pulmonary Function Lung Volume Measurement 
39 Exercise Physiology Respiratory Exchange Ratio 
40 EMG Integrated (RMS) EMG 
41 EMG EMG and Force 
42 Biomechanics Gait Analysis 
43 Remote Monitoring Biomechanics Measurements 
44 Biomechanics Range of Motion 

See Appendix G for detailed applications and features 
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Set up Channels—Advanced 
The previous section covered the basic options used in almost all acquisitions. In addition to the features 
described above, a number of other options are available in terms of setting up channels. These advanced 
features are also found under the Set up Channels menu item. 
Most acquisitions involve collecting analog signals and then displaying them on screen. It is frequently 
useful, however, to collect other types of data (digital data, for instance) or to perform transformations on 
analog data as it is being acquired. Channels containing digital signals and transformed analog signals can be 
collected in addition to the 16 analog channels. 
In the upper right hand corner of the Set up Channels dialog box, you will see the words Analog, Digital, and 
Calc. These refer to (respectively) analog channels, digital channels, and Calculation channels. The general 
features (acquiring, plotting, and the like) are the same for each type of channel, although there are 
considerable differences between the type of data each channel is designed to handle. You may acquire up to 
16 channels each of analog, digital, and Calculation channels. Analog and digital channels may be acquired in 
any combination, and the only requirement for Calculation channels is that you have at least one input 
channel (either analog or digital). 
Analog channels 
Analog channels are the most common type of acquired channel and should be used to acquire any data with 
“continuous” values. Examples of this include nearly all physiological applications where input devices 
(transducers and electrodes) produce a continuous stream of varying data. The range of values for analog 
channels is ±10 Volts. 
AcqKnowledge also allows you to rescale the signal on analog channels to more meaningful numbers. As an 
example, imagine a temperature transducer is connected to an SKT100C amplifier with a gain setting of 
5°/Volt, and output set to channel 1. Ordinarily, the values from the amplifier would be read in as Volts or 
milliVolts. For this acquisition, you need to express the signal from the transducer in terms of degrees 
Fahrenheit. To calibrate the transducer, bring it to two known temperatures. At the first temperature, take a 
voltage reading by selecting Show input values from the MP menu (see page X385H118 X for a description of the 
Show Input Values options). At 90° F, you will get a reading of 0 Volts. The transducer is then brought to a 
temperature of 95° F, and you will get a reading of +1 Volts. 
To have AcqKnowledge scale the incoming signal to degrees F, click in the Scaling button in the Input 
Channels dialog box (on the Macintosh, click on the Setup button). 

  
Scaling dialog box set up to rescale Volts to degrees Fahrenheit and Use Mean Value 

The Input Volts and Scale value (MAP value on Mac OS X) boxes reflect the value of the incoming signal 
and how it will be plotted on the screen, respectively. Thus, an incoming signal of +1 Volts would be plotted 
as 95° F, whereas a signal of 0 Volts would be plotted as 90° F. AcqKnowledge will perform linear 
extrapolation for signal levels falling outside this range (i.e., -2 Volts will be scaled to 80 ° F), as well as 
perform similar interpolation for values between this range. Enter these numbers in the Change scaling box, 
type in “degrees F” for Units, and click the OK button. 
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As a shortcut for scaling channels, use the Cal 1 and Cal 2 buttons. Clicking on either one of these buttons 
will read the current voltage for the channel you have selected. In the above example, you could have simply 
set the transducer to a known temperature, clicked on the Cal 1 button, and then entered the temperature in the 
Scale value (MAP value) box for Cal 1. 
You would then need to bring the transducer to another known temperature that is considerably higher or 
lower than the first and click Cal 2 and again enter the new known temperature in the Scale value (MAP 
value) box for Cal 2. AcqKnowledge calculates the slope and offset from the two points entered. Each data 
sample from channel 1 will now be scaled according to the slope and offset calculations previously made. 
When an acquisition is performed, the amplitude scale (vertical axis) will reflect the rescaled units. 

It is important to note that Cal 1 and Cal 2 cannot be used when data is being acquired. In 
other words, a channel must be calibrated before it can be acquired. To set the calibration for 
a given channel, connect the input device to the MP acquisition unit and power up the MP 
System, and then perform your calibration before starting data acquisition. 

The Calibrate all channels at the same time option is used when identical types of transducers or 
signals are being simultaneously recorded on two or more channels. If this option is selected, when 
Cal 1 or Cal 2 is pressed, the “Input Volts” box will be updated for all active channels. 

 For example, if recording from 10 force transducers, all 10 transducers could be loaded with 
a specific weight, and then all the channels could be simultaneously calibrated by pressing 
the Cal 1 or Cal 2 button. 

The Use mean value option is useful if the input voltage signal is noisy around a mean value. The 
“Input Volt” value returned will be the mean value over the specified number of samples. When this 
option is selected, a Settings… button is activated generates a Scaling parameters prompt for the 
number of samples. 
The data is sampled at approximately 10,000 Hz. If 100 samples are selected, it will take about a 
second to collect that number of samples. It may be helpful to use a larger number of samples as long 
as the signal has a Gaussian distribution around a mean value. If the signal is drifting slowly or 
otherwise unstable, a larger number of samples in the mean may result in an inaccurate sampling. 
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Digital channels 
In contrast to analog channels, digital channels are designed to collect data from a signal source with only two 
values (0 and 1). This type of data can be useful in recording whether a switch is open or closed, and 
ascertaining if a device is on or off. Input values for digital channels have two values, +5 Volts and 0 Volts. 
The MP interprets +5 Volts as a digital 1 and interprets 0 Volts as a digital 0. Since digital channels have a 
fixed value, the scaling option is disabled for these channels. The main function of digital channels is to track 
on/off devices such as push-button switches and/or to receive digital signals output by timing devices. 
Similarly, these channels are also used to log signals from devices that output auditory/visual stimulus for 
examination of stimulus response patterns. 

0 volts

+5 volts

Positive edge Negative edge 

(binary "1")

(binary "0") 

 
 
Calculation channels 
Compared to either analog or digital channels, Calculation channels do not collect external data, but transform 
incoming data in some way. These channels do not alter the original data, but create new channels (with 
channel numbers starting at CH40) that contain the modified data. 
You can use Calculation channels to compute a host of new variables by using transformations (including 
BPM, integration calculations, and math functions). The channels are set up in much the same way (using 
Acquire/Plot/Values boxes) as analog or digital channels, with the exception of the pull-down menu next to 
the Calc button and the Setup dialog. 
To acquire a Calculation channel, click on the Calc button and check the Acquire box for each Calculation 
channel you want to compute (the Plot and Value boxes are optional). By default, all Calculation channels 
have the label “Calculation” and entering more descriptive channel labels might prove useful, especially when 
multiple Calculation channels are being acquired. 

  
 Windows/PC Mac OS X 
Each of these functions requires some additional parameters to be specified, and these options can be set by 
clicking on the Preset (Setup on Mac) button in the Input Channels dialog box. For any Calculation channel, 
you will (minimally) need to specify the source channel to be transformed and the nature of the 
transformation.  
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Up to 16 Calculation channels can be acquired, and you may use the output of one Calculation channel as the 
input for another channel, as long as the output channel has a higher channel number than the input channel. 
In other words, it is possible for Calculation channel 3 to include the result of Calculation channel 1, but not 
the other way around. This allows for complex Calculations to be performed that involve two or more 
Calculation channels such as filtering ECG data then computing BPM. 
Although Calculation channels can be useful in many cases and indispensable in others, each Calculation 
channel acquired will somewhat reduce the maximum possible sampling rate, and add to the amount of 
memory required to store data both during and after an acquisition. Thus, you may want to consider 
performing some of these functions after the fact if high sampling rates are needed for your particular 
application. 

TIP: All of the operations that can be performed online can also be 
performed after an acquisition has been completed. These options are 
available under the Transform menu.  

 
Metachannel  
Mac AcqKnowledge 3.9.2 and later only—
Calculation metachannels provide a method for 
expanding the 16 available calculation channels to 
allow for more complex online analysis. The 
metachannel calculation channel type combines 
multiple steps into a single calculation channel so 
that a chained computation can be performed using 
a single calculation metachannel. 

• AcqKnowledge can display the results of up 
to 16 metachannels, allowing for a total of 
256 intermediate subchannel steps. 

 
One metachannel can contain up to 16 subchannels, each of which can be individually configured. 
Subchannels can perform any of the functions of top-level calculation channels. 
Each metachannel has one user-defined output channel. The output subchannel is the only waveform data that 
will be recorded in the graph for that metachannel. All other subchannels associated with that metachannel are 
temporary; they do not display in the graph and require no extra space in the graph file to compute. 
Metachannels alleviate the need to use top-level calculation channels for computing intermediate steps where 
only the final computation is desired. Metachannels also can be used as the basis of presets, allowing multi-
step analyses to be applied with a single preset.  
Computation takes place at the lowest waveform sampling rate of all of the referenced source channels, and 
all subchannels are computed at this rate. 
Metachannels labels display in the graph as C#.# 

Primary Source 
The primary source for a metachannel can be set to any analog, digital, calculation, or subchannel 
with a lower index (index 0-15, with 15 being lowest). 

Set Up Subchannel 
Click this button to display the calculation setup dialog 
for the selected subchannel and then set the calculation 
parameters and the source channel.  
Source channel: Each subchannel can be set to use the primary source channel as its data source or 
another channel (analog, digital, or lower-index calculation channel). When the primary source 
channel for the metachannel is changed, the source channel of each subchannel will implicitly be 
changed. 
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Integrate Calculation 
The online Integrate Calculation offers two basic operations: 

1. Perform a moving average (and associated processing) over a fixed number of sample points. This 
option is useful for: 
a)  Smoothing noisy data 
b)  Real-time “integration” of EMG 
c)  Real-time “root mean square” evaluation of EMG. 
d)  Real-time windowed standard deviation. 

2. Perform a real-time integration over a potentially variable number of sample points. This option is 
useful for: 
a)  Real-time conversion of flow signals into volume signals (i.e., Blood flow  Blood volume; Air 

flow  Air volume). 
b)  Any processing involving a need for a cyclic, continuous integral calculated in real time. For 

example: Acceleration  Velocity; Velocity  Distance; Frequency  Number of cycles; 
Power  Energy. 

  
Calculation channel set to integrate across 3 samples 

Destination 
Determined by the calculation channel selected when the Scaling button was pressed. 
Source 
The source channel is selected from a popup menu that includes any channels being acquired and any enabled 
Calculation channels. 
Sample rate 
Provides the sample rate for the selected channel (may be different than the acquisition sample rate). 
Option 
As mentioned previously, the Integrate setup dialog is divided into two sections: 
1. Average over samples will calculate the moving average (mean) of the specified number of samples. 

Additional parameters (Rectify; Root mean square) add further functionality. Used typically, these 
features allow you to process EMG signals and will display the integrated (rectified, then sample 
averaged) or Root mean square calculation on the original raw EMG data. 

2. Reset via channel permits real-time integration of input data over a data-defined time interval. This 
feature is extremely useful for converting flow signals into volumetric equivalents. The integral of flow is 
volume. For example, when recording airflow with a pneumotach, volume can be precisely calculated as 
the flow varies in a cyclic fashion. 

Average over samples option 
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Online sample averaging can be useful when there 
is a high degree of noise present in the data. At 
least some of this noise can be “averaged out” by 
pooling some number of adjacent data points 
together, taking the average of these points, and 
replacing the original values with the new averaged 
values. This process creates a “window” of moving 
averages that moves across the waveform 
smoothing the data.  
Since an average represents the sum of a series of 
data points divided by the number of data points 
present, you can use the Average over samples 
calculation to provide the information needed to 
create a moving average. 

 
Integration used to smooth noisy data 

Samples 
To specify the number of data points to average across, enter a value in the Samples box. The number you 
select will depend in large part on the sampling rate you select and the type of noise present. All things being 
equal, for slower sampling rates you will probably want to mean average across a smaller number of samples. 
As you increase the sampling rate, you will probably want to integrate across more and more samples. As the 
number of samples specified in the samples box increases, the amount of high frequency information 
contained in the data will decrease. 
Parameters 

Rectify —The Average over samples calculation 
can also be used for producing an envelope of 
modulated data. For instance, EMG waveforms 
frequently contain high frequency information, 
which is often of little interest compared to the low 
frequency information also contained in the data. 
When the Rectify option is checked, 
AcqKnowledge will take the absolute value of the 
input data prior to summing and a plot of the 
waveform’s mean envelope over a specified 
number of samples will be obtained. 

 
Online “Average over samples” feature used 

as an envelope detector 

Typically, this option is only used for processing raw EMG and similar types of applications. The signal for 
Rectify is normalized by a factor of (# samples averaged)/(Channel sampling rate). 
Root mean square—This feature provides the exact root mean square (RMS) of the input data (typically 
EMG) over the specified number of samples.  
Remove baseline—This feature provides the exact standard deviation of the input data (typically EMG) over 
the specified number of samples. When the mean of the input data equals 0-0, the standard deviation and the 
RMS will be equivalent.  
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Scaling… button—Since the integration values are 
going to be on a different scale than the original 
units, you need to change the scale of the 
integration channel to reflect the new units. When 
you click on the Scaling… button, a Change 
Scaling Parameters dialog will be generated. 

 
The rescaling involves multiplying the “Input units” values by a factor determined by the sampling rate and 
number of samples mean averaged across. 

Scale value = Input units x 
 averaged mean be  tosamples ofNumber 

 rate Sampling  

As an example, if data were being acquired at 75 samples per second, and you wanted to integrate across an 
interval of 10 samples, you would set the Integration Setup Scaling parameters so that +10 Volts 
corresponded to a Scale (MAP) value of 75 and a Scale (MAP) value entry of –75 reflected an Input value of 
–10 Volts. 

 It is important to note that this rescaling should be performed independent of any rescaling 
performed on analog channels themselves. Even if an analog channel is being rescaled to some other 
units, the input values in the integration scaling should be set to +10 Volts (next to Cal 1) and –10 
Volts (next to Cal 2). 

   
Integrate Calculation and Scaling dialog boxes for 10 point averaging 

When data is averaged in this way, a portion of the data at the beginning of the record (equivalent to the 
number of samples being integrated) should be ignored, as they will reflect a number of zero values being 
averaged in with the first few samples of data. 
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Reset via channel option 
This feature is used to integrate data over a data-dependent interval. Either the source channel or a different 
channel can control the integration process. 

  
Control channel 
Allows user to select any active channel as the integration control channel. 
Reset Thresholds 
The threshold is to be set at points surrounding the flow level. Typical values are: 

LOW: a negative value close to 0.00 HIGH: a positive value close to 0.00 
For airflow to volume conversion, the flow signal will vary positively and negatively around zero flow. 
Reset trigger  
The Reset trigger polarity determines on which slope (Positive ↑ or Negative ↓) the integration process will 
begin and end. 
Mean Subtraction 
This option will subtract the mean from the data evaluated during the integration period. If this option is 
selected, the integration will only proceed after all the data in the integration period has been collected. When 
collected, the mean value of all the data is subtracted from each data point in the integration period. In this 
fashion, the integral of the corrected data points will result in the integral returning to exactly zero at the end 
of the integration interval. Although this option will result in “well-behaved” integrations, the integrated data 
will be delayed by a fixed amount of time, as specified by the max cycle period. 

Online Enabling mean subtraction delays the signal by the mean cycle length. It waits for that period of 
time to pass so it can determine a mean value for the initial cycle, and it then tries to re-
compute this mean for each cycle. If the resets are too short or too long, the window expires 
and the processing halts again until a new mean can be recomputed. Online processing may 
reset from threshold crossing in the control channel or window expiration when it loses mean 
tracking. 

Offline Since all the data is available, the mean is computed from the data in the channel and the signal 
is not delayed. Also, since it isn’t doing windowed means, there are no window expiration 
events that are inserted. Offline processing may reset from threshold crossing in the control 
channel. 

Max cycle period 
The Max cycle period should be longer than the maximum time expected from trigger event to trigger event 
in the Control Channel. Typically, the default scale settings for cyclic integrated data will be fine. However, 
the units may need to be changed (i.e., liters/sec to liters) via the Scaling option.
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Output reset events—Mac only (not available for metachannels) 
Add Events markers to show where Reset occurred and distinguish why the channel reached zero. 

 Threshold crossing on the 
control channel 
For example: Calculation 
channel resetting on positive 
crossings of 0V on CH 1. 

 

 
 Window expiry when mean 
removal is enabled 
For example: No threshold 
crossing within “mean cycle 
width” as specified in calc 
channel setup. Settings of 
calc channel: threshold 
crossings positive, 3V, Mean 
cycle subtraction, 1 second 
period width. First reset is 
due to threshold crossing; 
second reset is due to 
window expiry.  

 Zero value due to “true” zero 
being achieved due to 
mathematical results 
For example: Mathematical 
Source is sine wave, integral 
is cosine. Input (10V) never 
crosses threshold levels. 
Signal reaches zero 
mathematically; no reset 
events appear on output. 

 
Windows/PC users can overlap the signals to identify reset occurrences but will not be able to identify the 
cause of the reset. 
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Smoothing Calculation 
The Smoothing Calculation functions online and permits. This function is very useful if you are trying to 
remove noise of varying types from a data set. (Off-line Smoothing is available as the Smoothing option of 
the “Transform” menu.) 

  
Source Source is a pull-down menu of the available channels. 
Sample rate provides the sample rate for the selected channel (may be different than the acquisition 

sample rate). 
Smoothing factor enter the number of samples to use as a smoothing factor. 
Smoothing method This calculation channel provides real-time Mean (default) or Median smoothing. 
 Mean value The default is mean value smoothing. Use Mean value smoothing when noise appears in 

a Gaussian distribution around the mean of the signal. 
Use Median value Click in the box to activate Median value smoothing if some data points appear 

completely aberrant and seem to be “wild flyers” in the data set. 
  Windows only—For a given sequence of wave data, x = {x1, x2,...,xn}, Median value 

smoothing will sort the sequence and extract the median equivalent to the recommended 
NIST (National Institute of Standards and Technology) formula: 
• n is odd: median is the center element of the sorted list of n items. 
• n is even: median is the mean of the center pair of elements of the sorted list of n items.  

 The smoothing calculation channel is the primary method of computing real-time median 
values using the definition of median as given above. The smoothing output at a sample 
position is the median of the window of source channel samples including the current 
sample and the previous samples in the window. 

    The size of the window is 1 at the start of acquisition and increases incrementally until 
the final window size is reached. The median extraction method shifts between even and 
odd definitions as the window size is incremented. 

Scaling Click on the Scaling button for access to options that allow you to modify the units or 
linearly scale the output. 
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Difference Calculation 
The Difference calculation returns the difference between two data samples over a specified number of 
intervals and divides the Difference by the time interval spanned by the data values. The Difference 
Calculation is useful for calculating an approximation of the derivative of a data set in real time. 
To have AcqKnowledge perform a Difference calculation in real time, click on the button next to Calc in the 
Input Channels dialog box. A popup menu will appear with Integrate at the top of the list. Scroll to choose 
Difference and then check an Acquire box for the Calculation channel you wish to contain the difference data. 
You may also check the Plot and Values boxes as appropriate for each channel. 
The Difference Calculation dialog allows you to specify the source channel and the number of intervals 
between samples over which the difference is to be taken, and also includes the option of rescaling the 
channel to reflect different units. 
Click on the Setup button in the Input Channels dialog box to generate the Difference dialog box:  

 
 
Source When the Source channel contains relatively high frequency data, the Difference Calculation 

may result in a very noisy response, so it’s best to use Difference on relatively smooth data. 
Sample rate This line provides the sample rate for the selected channel (may be different than the 

acquisition sample rate). 
Intervals Difference is calculated with respect to the number of intervals between points (rather than 

the number of sample points). For instance, two sample intervals span three sample points: 
POINT<interval>POINT<interval>POINT 

 A 1-interval difference transformation applied to a blood pressure (or similar) waveform will 
result in the widely used “dP/dT” waveform. 

 See page X386H245X for a complete description of the online Difference function. 
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Rate Calculation 

   
The Rate Calculation is used to extract information about the interval between a series of peaks in a 
waveform. This interval can be scaled in terms of BPM (the default), frequency (Hz), or time interval between 
peaks. 

 The BPM (or beats-per-minute) Rate function is used as a measure of peaks or events that occur in a 
sixty-second period. 

 The frequency rate function is commonly used to describe the periodicity of data, or the amount of 
time it takes for data to complete a full cycle (from one peak to the next peak). 

 The Interval Rate function returns the raw time interval between each adjacent pair of peaks, which 
is essentially the inter-beat interval (IBI), frequently used in cardiology research. 

These three functions essentially provide the same information in different formats, since a frequency of 2Hz 
is equal to an inter-peak interval of 0.5 seconds, both of which are equivalent to a BPM of 120. Other options 
allow you to record the maximum or minimum value of all peaks (the peak max/min option), or to count the 
aggregate number of peaks (the count peaks option).  
In order to calculate Rate information, you have the option of specifying the threshold manually or having 
AcqKnowledge automatically compute the threshold value (which is the default). This section describes the 
basic parameter settings for typical online Rate Calculations. 

NOTE: Parallel functions can be performed after data has been acquired. A 
detailed description of the Rate Calculation options can be found in the Find 
Rate section on page X387H286X. 

To perform a Rate Calculation in real time, click on the button next to Calc in the Input Channels dialog box. 
A popup menu will appear with Integrate at the top of the list. Scroll to select Rate and then check an 
“Acquire” checkbox for the Calculation channel you wish to contain the rate data. You may also check the 
“Plot” and “Values” checkboxes as appropriate for each channel. To further specify the calculation 
parameters, click on the Setup button in the Input Channels dialog box to produce the Rate setup dialog.  
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Destination—determined by the Calculation channel that was selected when the “Setup” button was pressed. 
Source—selected from the Source popup menu at the top of the dialog box. 
Sample rate—provides the sample rate for the selected channel (may be different than the acquisition sample 
rate). 
Function —The popup menu includes options to scale the rate in terms of Hz, BPM, Interval, Peak Time, 
Count Peaks, Peak Minimum/Maximum, Peak-to-Peak, Mean Value, or Area. 

 For more information on each of these functions, see the Calculation Channels section beginning on 
page X388H286X. 

 Calculate systolic using the peak maximum Function, diastolic using the peak minimum Function, 
and mean blood pressure using the mean value Function. 

 NOTE: All of these Function options are available in the post-acquisition mode through 
the Transform>Find rate function 

Remove baseline—provides the exact standard deviation of the input data (typically EMG) over the specified 
number of samples. When the mean of the input data equals 0-0, the standard deviation and the RMS will be 
equivalent. 
Auto Threshold detect—The most convenient way to calculate a Rate channel online is to have 
AcqKnowledge automatically compute the threshold value (the “cutoff” value used to discern peaks from the 
baseline). This is done by checking the Auto Threshold detect box. 
Output reset events (not available for metachannels)—When auto threshold detection is being used, the 
minimum and maximum rates of the signal are specified in the Windowing controls. If the input signal falls 
out of this range, the value of the rate function and automatic threshold level will be reset. By enabling 
“Output reset events” a reset event will be placed on the output at the location of these window expirations. 
Rate detector is set to “Peak function, default window of 40 BPM to 180 BPM, auto threshold detect for 
positive peaks. The reset event occurs after the window expiration, approximately a full 40 BPM interval after 
the “peak” transition from 0 to 5 volts in the source signal. 

  
Polarity—For Rate Calculations involving data with positive peaks (such as the R-wave in ECG data), click 
on the button next to “Positive” in the Polarity section of the dialog box. 
Noise rejection—AcqKnowledge constructs an interval around the threshold level when Noise rejection is 
checked. The size of the interval is equal to the value in the noise rejection text box, which by default is equal 
to 5% of the peak-to-peak range. Check this option to help prevent noise “spikes” from being counted as 
peaks. 
Peak Interval Window—When “automatic” Rate Calculations are set, specify a minimum rate and a 
maximum rate. These parameters define the range of expected values for the Rate Calculation. By default, 
these are set to 40 BPM on the low end and 180 BPM on the high end. The Windowing units option is only 
activated when the selected function can have variable units (i.e., count peaks, mean value, area). 
The Rate Calculation will use these values to find and track the signal of interest, assuming the input BPM 
range is reasonably well bracketed by these values. Depending on the shape of the input cycle waveform, the 
Rate window settings may be closer or further from the expected rates. 

 For ECG-type data (where the waveform peak is narrow with respect to the waveform period), the 
Rate window values will closely bracket the expected values. 
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 For more sinusoidal data, with the waveform energy distributed over the waveform period (as with 
blood pressure or respiration), the Rate window will closely bracket the expected rate on the high-
end, but can be up to twice the actual measured rate at the low-end. 

One of the most frequent applications of the Rate Calculation is to compute BPM online for 
ECG, pulse, or respiration data. For more information on optimizing ECG amplifiers for 
online calculation of heart rate, see the ECG100C section of the MP Hardware Guide. 

Show Threshold—Plots the threshold used by the Rate calculation function. This feature is useful to help the 
rate detector performance on any given data. 
Show Modified—Plots the modified data as processed by the Rate Detector. Typically, the modified data is a 
differential version of the original input data. The data will be modified if the “remove baseline” feature is 
checked in the Rate Detector Setup dialog.
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Math Calculation 
The Math Calculation performs standard arithmetic calculations using two waveforms or one waveform and a 
constant. It is also possible to use other Calculation channels (such as a Rate Calculation channel) as an input 
channel for a Math Calculation channel, as long as the Calculation channel used as a source channel has a 
lower channel number than the Math Calculation channel. 
Use the pull-down Source menus to select the source channels (Source 1 and Source 2). 
The Sample rate line provides the sample rate for the channel selected as Source; the channel sample rate may 
be different than the acquisition sample rate. 
Use the pull-down Operand menu to select a function. In the example below, analog channel 1 (Source: A1) is 
added to analog channel 2 (Source: A2). To use this summed waveform as an input for another Math 
Calculation channel. One useful application would be to divide this waveform (C0) by K, where K=2, thus 
producing an arithmetic average of source channels A1 and A2. 

    
The “Constant” entry is activated when “K” is selected as a Source. 
As an alternative to creating an additional Calculation channel for dividing the summed waveform, you can 
use the scaling function to perform the same task. To do this, click on Scaling… button and then set the Scale 
value (MAP value) for the summed waveform equal to +5 and –5 (to correspond to Input Volts values of +10 
and –10 respectively). This will effectively plot the sum of channels A1 and A2 as the arithmetic mean of the 
two waveforms. 

For additional libraries of online Calculation options, consult the sections on Function Calculation 
channels and the online Equation Generator (page X389H77X). These types of Calculation channels can be 
used to perform more complex operations on waveforms. Although Calculation channels can be 
“chained” together (so that the output from one serves as the input for another) to form more complex 
calculations, a separate channel must be used for each function. Since only sixteen Calculation 
channels are available, not all calculations can be performed. Additionally, chaining more than three 
or four channels together can require considerable system resources. 
For complex calculations (such as squaring a waveform then adding it to the average of two other 
waveforms) the Equation Generator is a more efficient solution. All of the features available online in 
the Math Calculation channels can also be computed after an acquisition using the Waveform Math 
option (see page X390H250X), which will eliminate the problem of system overload. 
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Function Calculation 

 

 

The Function calculation can be used to perform a variety of 
mathematical functions using two waveforms or a waveform and a 
constant. Function Calculation channels compute new waveforms 
in a manner similar to the math Calculation functions, but provide 
access to higher order functions. Like math Calculation channels, 
function Calculations can be chained together to produce complex 
functions (such as taking the absolute value of a waveform on one 
channel and Calculating the square root of the transformed 
waveform on another channel). These same functions are also 
available under the transform menu in AcqKnowledge for post-hoc 
operations. Many of these functions can also found in the online 
Equation Generator (see page X391H77X for details on this feature). 
To have AcqKnowledge perform a Function Calculation in real 
time, click on the button next to Calc in the Input Channels dialog 
box. A popup menu will appear with Integrate at the top of the list. 
Scroll to choose Function and then check an “Acquire” box for the 
Calculation channel you want to contain the function Calculation 
data. You may also check the “Plot” and “Values” boxes as 
appropriate for each channel. To further specify the Calculation 
parameters, click on the Setup button in the Input Channels dialog 
box to produce the dialog shown to the left. 
Other Functions are available in the online Equation Generator 
(see page X392H77 X). Function Calculations can be chained together to 
produce more complex Calculations, although it is more efficient 
to program complex functions using the Equation Generator. 
The Sample rate line provides the sample rate for the selected 
channel (may be different than the acquisition sample rate). 

Function 
Abs Returns the absolute value of each data point 
Atan Computes the arc tangent of each data point 
Exp Takes the ex power of each data point 
Limit Limits or “clips” data values that fall outside specified boundaries 
Ln Computes the base e logarithm for each data point 
Log Returns the base 10 logarithm of each value 
Noise Creates a channel of random noise with a range of ± 1 Volt 
Sin Calculates the sine (in radians) of each data point 
Sqrt Takes the square root of each data point. 

Threshold Converts above an upper threshold to +1 while converting data below a lower threshold to 0. 
Thresholding Algorithm Assume a domain variable  t ∈ tstart , tstart + 1, tstart + 2,K{ } 

with tstart being an integer, a real-valued signal y(t) defined for all t, and two real valued levels 
ylow and yhigh satisfying the relation ylow ≤ yhigh . 

Define the Threshold function thresh(t) function such that: 

thresh(tstart ) =
1 y(tstart ) ≥ ylow

0 y(tstart ) < ylow

⎧ 
⎨ 
⎩ 

    thresh(t) =
0 y(t) < ylow

1 y(t) > yhigh

thresh(t −1) ylow ≤ y(t) ≤ yhigh

⎧ 

⎨ 
⎪ 

⎩ 
⎪ 
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Filter Calculation 
The Filter Calculation channel allows you to perform real time digital filtering on analog, digital, or 
calculation channels. To have AcqKnowledge apply a digital Filter Calculation in real time, click on the 
button next to Calc in the Input Channels dialog box. A popup menu will appear with Integrate at the top of 
the list. Scroll to choose Filter and then check an “Acquire” box for the Calculation channel you want to 
contain the filtered data. You may also check the “Plot” and “Values” boxes as appropriate for each channel. 
To further specify the type of filter, click on the Setup button in the Input Channels dialog box to produce the 
following dialog box: 

                         
Filter Setup (Windows and Mac) & Type Options 

In the dialog box above, the signal on analog channel one (A1) is run through a low-pass filter that attenuates 
data above 50 Hz. The “Q” for this filter is 0.707, which is the default. 

One possible application of the online filtering option is in conjunction with the Show Input 
Values option (see page X393H118 X). Raw EEG data, for instance, can be filtered into distinct 
bandwidths (alpha, theta, and so forth) using one source channel and multiple filter 
Calculation channels. The filtered data can then be displayed in a bar chart format during the 
acquisition using the Show Input Values option. 

Source Set the source channel. 
Sample rate provides the sample rate for the selected channel (may be different than the acquisition 

sample rate). 
Type (Output) Lists the filter options: low pass, high pass, band pass, band pass (low + high), band stop, and 

comb band stop. See About Filters in this section for more details on filter types. 
Frequency Fixed value—Type a value in the entry box. 
 Sampling rate—Mac AcqKnowledge 3.9.2 and later Sets the frequency to a fraction of the 

sampling rate and automatically updates when the sample rate is modified. 

 Line frequency—Mac AcqKnowledge 3.9.2 and later Uses the line frequency at which the 
data was recorded. 

Q coefficient The online filters are implemented as IIR (Infinite Impulse Response) filters, which have a 
variable Q coefficient. The Q value entered in the filter setup box determines the frequency 
response patterns of the filter. This value ranges from zero to infinity, and the “optimal” 
(critically damped) value is 0.707 for the Low pass and High pass filters, and 5.000 for the 
Band pass and Band stop filters. If you wish, you may change the Q. A more detailed 
explanation of this parameter, and digital filters in general, can be found in Appendix D. 

About Filters 
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While the technical aspects of digital filtering can be quite complex, the principle behind these types of filters 
is relatively simple. Each of these filters allows you to set a cutoff point (for the low and high pass filters) or a 
range of frequencies (for the band pass and band stop filters). 

 A Low Pass filter allows you to specify a frequency cutoff that will “pass” or retain all frequencies 
below this point, while attenuating data with frequencies above the cutoff point. 

 High Pass filters perform the opposite function, by retaining only data with frequencies above the 
cutoff, and removing data that has a frequency below the specified cutoff. 

 Each type of Band Pass filter is optimized for a slightly different type of task. 
The Band Pass (low + high) filter is designed to allow a variable range of data to pass through the 
filter. For this filter, you need to specify a low frequency cutoff as well as a high frequency cutoff. 
This defines a range or “band” of data that will pass through the filter. Frequencies outside this range 
are attenuated. The Band pass (low + high) is actually a combination of a low pass and a high pass 
filter, which emulate the behavior of a band pass filter. This type of filter is best suited for 
applications where a fairly broad range of data is to be passed through the filter. For example, this 
filter can be applied to EEG data in order to retain only a particular band of data, such as alpha wave 
activity. 
The alternative Band Pass filter requires only a single frequency setting, which specifies the center 
frequency of the band to be passed through the filter. When this type of filter is selected, the “width” 
of the band is determined by the Q setting of the filter (discussed in detail below). Larger values for q 
result in narrower bandwidths, whereas smaller Q values are associated with a wider band of data that 
will be passed through the filter. This filter has a bandwidth equal to Fo/Q, so the bandwidth of this 
filter centered on 50Hz (with the default Q=5) would be 10Hz. This type of filter, although 
functionally equivalent to the band pass (low + high) filter, is most effective when passing a single 
frequency or narrow band of data, and to attenuate data around this center frequency. 

 The Band Stop performs the opposite function of a band pass. A Band stop filter defines a range (or 
band) of data and attenuates data within that band. In this case, the Band stop filter is implemented in 
much the same way as the standard Band pass, whereby a center frequency is defined and the Q value 
determines the width of the band of frequencies that will be attenuated. 

 The Comb Band Stop removes interfering harmonics; resonance, aliasing, and other effects may 
generate interference at multiples of a base frequency. It combines all the required filters instead of 
requiring a separate filter for each interfering overharmonic. For setup details, see page X394H227X. 

Off-line filtering 
Apart from these online filter options, similar filters can be applied after an acquisition is terminated. Many of 
the biopotential amplifiers available from BIOPAC have selectable filters, which allow you to filter certain 
frequencies (including 50Hz or 60Hz electrical noise) and possibly reduce the need for online filters. 
Digital filtering can also be performed after an acquisition using the same types of filters. You can choose 
from the different filter types by selecting Digital filters from the Transform menu. The filters available after 
the acquisition use a different algorithm but operate in essentially the same way. 

For more information on digital filters and filters that can be applied after an 
acquisition, turn to the Digital Filtering section on page X395H219X or Appendix B. 
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Equation Generator (Expression) 

  
The online Equation Generator is available for performing computations more complex than possible in the 
Math and Function Calculation options. The Equation Generator will symbolically evaluate complex 
equations involving multiple channels and multiple operations. 

 AcqKnowledge 3.9 for Mac can perform conditional evaluation, data extraction, logical operations, 
expressions requiring a range of samples or the results of the previous expression, and evaluation of 
generic formulas that can be expressed in a closed, recursive form. 

Unlike the Math and Function Calculations—which can only operate on one or two channels at a time—the 
Equation Generator can combine data from multiple analog channels, and allows you to specify other 
Calculation channels as input channels for Equation channels. Also, computations performed by the Equation 
Generator eliminate the need for “chaining” multiple channels together to produce a single output channel. 
While the Equation Generator is more powerful than other Calculation channels, each Equation Calculation 
requires more system resources than other Calculations. This essentially means that acquisitions that utilize 
Equation Calculations are limited to a lower maximum sampling rate than acquisitions without online 
Expression functions. When an expression is evaluated, it is actually evaluated multiple times. The expression 
is computed starting at the first sample in the selection (or first sample acquired, for calculation channels) and 
is then evaluated once for each subsequent sample in the selection (or each successive acquired sample). 

 AcqKnowledge 3.9 for Mac can accept the notations SC, MC, and CHn to reference the sample at the 
current evaluation position or SC(x), MC(x), and CHn(x) for values at locations prior to the 
present evaluation location using an offset expressed in sample intervals. 
For example, CH1(-1) will give the previous sample of Channel 1. 

The same features that are available in online Calculation channels are also available under the Transform 
menu for evaluation of complex equations after acquisition. Thus, simple Calculations such as summing two 
channels or dividing one channel by another (and so forth) are best performed in either the Math Calculation 
channels or the Function Calculation channels. 
On the other hand, for complex Calculation channels, such as squaring one channel, multiplying it by the sum 
of two other channels, and dividing the product by the absolute value of another waveform, a single Equation 
Calculation channel is more efficient than chaining five Math and Function Calculation channels together. 
Save to Calculation Channel 
To evaluate an expression and save the result to a Calculation channel in real time: 

1. Click on the MP menu and select Set up Channels. 
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2. Click on the preset pull-down menu in the Input Channels dialog box. A menu will be generated with 
“Integrate” at the top of the list. 

3. Choose New > Equation Generator (Windows) or Expression (Mac OS X). 
4. Check an Acquire box for the Calculation channel you want to contain the filtered data. You may also 

check the Plot and Values boxes as appropriate for each channel. 
5. Click on the Setup button in the Input Channels dialog box. This will produce a dialog box, where 

you can enter the expression to be evaluated: 
The different components of each expression can be entered either by double-clicking buttons from the button 
rows (sources, functions, and operators) in the setup expression dialog box, or by typing commands directly 
into the Equation box. The Equation Generator uses standard mathematical notation. 
For each expression, you need to specify at least one source, the function(s) to be performed, and any 
operators to be used. Sources are typically analog channels, although you may also select Time from the 
source button row and AcqKnowledge will return the value of the horizontal axis (usually time) for each 
sample point. When the horizontal axis is set to frequency (in the Display>Horizontal axis dialog), the “time” 
item in the source button row will switch to “frequency.” 
When using the online Equation Generator Calculation, it is important to keep in mind that while different 
channels, functions, and operators can be referenced, the Calculation cannot reference past or future sample 
points. That is, data from waveform one can be transformed or combined in some way with data from 
waveform two at the same point in time, although data from one point in time (on any channel) cannot be 
combined with data from another point in time (on any channel). See the section on post-acquisition 
expression commands (beginning on page X396H249X) for ways around this limitation. 
Functions The arguments to each function are represented in the Functions table in italics and 

may be replaced by any valid expression. Each argument is separated from its next 
argument by a comma. Expressions can only contain commas within balanced 
parenthesis pairs. An ellipsis (“...”) at the end of a function description indicates that 
any number of arguments may be present provided they are in a comma separated list. 
When a function is added to an Expression, the cursor is placed between the 
parentheses.  

Conditionals Mac OS X only Change output based upon a condition test. All of the conditionals treat 
the value zero as false and any non-zero value as true. Expressions can only contain 
commas within balanced parenthesis pairs. 

Offset Notation Mac OS X only Offset notations take integer offsets in terms of the number of samples 
using the formation CH#(P) where CH# is the channel number and P is the number of 
points. For example, an offset of -1 will return the data point immediately to the left of 
the selected point and an offset of +1 will return the data point immediately to the right 
of the selected point. 

 To refer to previously acquired data, offsets must be negative. For notational 
convenience, offsets that result in an invalid negative sample position (e.g. no data is 
defined prior to the first sample in the graph) evaluate to zero. Any attempt to access a 
sample beyond the end of the data will result in an error. Any attempt to use a positive 
offset for an online Equation Generator/Expression calculation channel will result in an 
error. 
CHn(x) Returns the value of channel with index n x samples away from the current 

evaluation position. 
SC(x) Returns the value of the selected channel x samples away from the current 

evaluation position. Only allowed for Transformations and Measurements; 
not allowed for Calculations. 

MC(x) When x is zero or positive, returns the value of the measurement channel x 
samples away from the current evaluation position. When x is negative, 
returns the result of the expression evaluation that occurred x steps previous 
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to the current evaluation position. Only allowed for Measurement 
Expressions (see below); not allowed for Calculations or Transformations. 

Recursive notation Mac OS X only Since transformations and calculation channels replace the source data 
of the channel with the result of the expression evaluation in sequence, negative offsets 
are equivalent to returning the final result of the expression that was evaluated a certain 
number of steps in the past. The channel where the expression results are stored can be 
thought of as a storage record of the previous evaluation steps. Negative sample offsets, 
therefore, can be used to compute any formula that can be expressed in closed recursive 
form. For example, the recursive definition of the Fibonacci sequence is: 

Fn = Fn-1 + Fn-2 
To evaluate this as an expression transformation, use the expression: 

SC(-1)+SC(-2) 
Note that to actually get the Fibonacci sequence the selected channel would need to 
have a constant value of one prior to the transformation. 

Expression Mac OS X only Measurements are powerful tools for quick manual analysis and  
Measurement also for advanced automated analysis when combined with the Cycle/Peak detector. 

Expression measurements extend measurements to evaluate simple formulas or 
complex data reduction. Each Expression measurement has an expression associated 
with it and the measurement result is derived from computing the Expression(s) on the 
selected data. 

Measurement expression dialog is 
generated the first time a measurement is 
set to Expression or when the 
measurement “info” button is clicked. 
OK invokes a syntax check. If there is an 
error, the user will be prompted to correct 
the error and the error will be selected 
(highlighted) in the Expression edit field. 

 Cancel discards any changes to the Expression measurement and reverts back to the 
previous Expression.  
Clear erases the current contents of the expression edit field. 
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Measurement Channel 
Expression measurements can reference the “measurement channel” (MC), which 
refers to either the selected channel or a specific channel as set in the measurement 
channel selection box within the graph window. 
Negative sample offsets to MC are interpreted as returning the result of the Expression 
from a prior step. Transformations and calculation channels achieve this as they replace 
the contents of their destination channels sequentially. Measurements, however, do not 
actually replace the data of their source channels. Expression measurements are 
actually executed on a temporary copy of the channel data in memory. This implies that 
negative indicies to the measurement channel are interpreted exactly the same for 
measurements as for transformations and calculation channels even though the 
“transformed” data of the measurement is not visible. Negative sample offsets to MC 
that refer to the sample position prior to the leftmost sample of the selected area will 
always return zero. 
Evaluation Rules 
When a new selection is made, the first step in evaluation searches through the 
Expression measurement for any MMT() invocations. Any measurement whose value 
is needed by MMT() is computed at this time prior to the Expression evaluation. This 
behavior is similar to calculation channels and successfully allows measurements to the 
right and bottom of the Expression measurement to be used in the expression. 
The expression is subsequently evaluated from the leftmost sample in the selection to 
the rightmost sample. It is evaluated at the waveform sampling rate of its source 
channel, with one expression evaluation per sample contained within the selected area. 
Interpolation is not used at the boundaries to maintain a consistent sample interval for 
the expression. After each expression evaluation, the result is cached in memory for 
potential negative MC result references. 
The value of the final expression, the rightmost sample, becomes the result of the 
measurement. 
Circularity Detection 
Expression measurements may reference other expression measurements or calculation 
measurements by using the MMT() function in the expression. This raises the 
possibility of circular dependencies being formed by the user if a measurement 
expression either directly or indirectly needs its own value to compute a MMT() 
invocation. Circular dependency checking will be in place at execution time and will 
result in an error. 
To refer an Expression measurement to its own value, use the MC notation. 
Error Reporting 
The Expression measurement result will display the text “Error” if there are syntax 
errors in the Expression measurement, errors computing measurements referenced by 
MMT(), or a circularity. 

Validation Tip Mac OS X only To function correctly, AcqKnowledge requires real-valued data. You 
are encouraged to ensure that your expression results are real-valued. To test if a 
floating point number x is a real-valued number, use the expression 
 NOT(OR(ISINF(x), ISNAN(x))) 
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Note for variable sample rate processing:  
The Equation Generator and Waveform Math functions will constrain operations between waves of different 
rates as follows: 
If an equation is operating on two or more waves of different sample rates, the result of the operation will 
always be output at the lowest sampling rate from the waves (F low). If the destination channel for the result 
has an assigned rate other than (F low), the operation will not be permitted. If the destination channel is set to 
a new channel, the operation will always be permitted. 
On Mac OS X, all sources for Expressions and Waveform Math operations must be sampled at the same 
waveform sampling rate. 
VSR data padding—If the channels are of unequal length (as a result of variable sampling rate or waveform 
editing), they will be padded for Append acquisition. Digital and Analog channels are stored as short integers 
by default; a waveform paste into a digital or analog channel, however, will result in its underlying data being 
converted to floating point. This will generate the “Abort/Replace” warning for pastes to Digital or Analog 
channels since the data format has changed since the last acquisition. 
Additionally, if an Analog or Digital channel is used as the source waveform for a Copy, it will also be 
converted to floating point and will result in the “Abort/Replace” warning being generated. 
Since Calculation channels are already floating point, pasting into them or copying from them will not change 
their data format. The channels will be padded with their last value and the append will commence. 
Waveform Cut operations do not change the underlying data format for Analog, Calculation, or Digital 
channels. If only Waveform Cut is used, no data format conversion will occur and channels will be padded 
with their last value and subsequent appends are allowed. 

 
Source Description 

ACQLENGTH 
Mac only 

Calculation only Acquisition length from 
Set up Acquisition; keeps Appended 
segments the same whereas “Sample” 
would increase with each segment. 

CH Value of the designated channel (CHn) at 
the current evaluation step. 

Primary Source 
Channel 
metachannels only 

Appears as PSC in the dialog. Refers to 
the data of the primary source channel of 
a metachannel.  

Time Time (in sec) of current evaluation step 

Sample  Sample index of evaluation step; the first 
sample in the graph will always be 
reported as a value of zero. 

MC Measurements only Value of the channel in 
the measurement menu—either the 
explicit channel or “SC”—at the current 
evaluation step. 

Pi  Value of pi (3.141592654…) to double-
precision accuracy. 

SC Mac only Transformation and measurement only Value 
of the selected channel at the current 
evaluation step; can still back-reference 
samples points. 

True  Evaluates to the value 1 (non-zero values 
are interpreted as True) 

False  Evaluates to the value 0  

Operator Operation 

+ Addition 

- Subtraction 

* Multiplication 

/ Division 

^ Power 

( Open parentheses 

) Close parentheses  
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FUNCTION  RESULT 
ABS Returns the absolute value of each data point. 
ACOS Computes the arc cosine of each data point in radians. 
AND(x, y, …)  Computes a logical “and” operation for its arguments. Accepts up to eight (8) 

arguments and evaluates to 
1 if all of its arguments are non-zero values. 

 0 if one of its arguments is zero. 
ASIN Calculates the arc sine of each value in radians. 
ATAN Computes the arc tangent of each sample point. 
CEIL(x) Computes the ceiling function (the closest integer larger than the value x). 
COND(T, A, B, C)  Three-way conditional takes four arguments: 

COND(test_expr, neg_test_value, zero_test_value, pos_test_value) 
Evaluates test_expr and if 

< 0, returns neg_test_value 
= 0, returns zero_test_value 

 > 0, returns pos_test_value 
COS Returns the cosine of each data point. 
COSH Computes the hyperbolic cosine of each selected value 
EQUAL(x, y, …)  Performs a Logical equal (numerical comparison) of its arguments. Accepts up to 

eight (8) arguments and evaluates to 
1 if all of its arguments are equal. 

 0 if one of its arguments is not equal to the others. 
EXP Takes the ex power of each data point.. 
FLOOR(x) 
 

Computes the floor function (the closest integer less than the value x). 

IF(T, A, B)  
 

Two-way conditional takes three arguments: 
IF(test_expr, true_value_expr, false_value_expr) 
The conditional evaluates test_expr and if 

non-zero, returns true_value_expr 
0, returns false_value_expr 

ISINF(x)  Filters out infinities and unrepresentable numbers from data; important because 
such values can cause erratic behavior in autoscaling and other operations. Use to 
test whether any expressions have resulted in floating point overflow and have 
generated numbers too large to be represented in the computer. Evaluates to 

1 if x is inf, the floating point representation of infinity. 
0 if x is NaN or a real-valued floating point number. 

ISNAN(x)  
 

“Is not a number” can be used to test whether any expressions have resulted in 
floating point errors such as division by zero. Use to ensure that the output of 
transformations and equations does not produce numbers that AcqKnowledge 
cannot display. Evalutes to 

1 if x is NaN, the invalid floating point number. 
 0 if x is inf or a real-valued floating point number. 

LESS(x, y)  
 

Performs a numerical comparison of its arguments and evaluates to 
1 if x is less than y. 
0 if x is greater than or equal to y. 
 

FUNCTION  RESULT 
LOG Computes the natural logarithm of each value 
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LOG10 Returns the base 10 logarithm of each value 
MMT(row,col)  Transformation and measurement only Evaluates to the result of a measurement 

being displayed in the graph, as specified by row and column. Use to scale by a 
result without having to manually enter the result. Row and Column for a 
measurement start as 0,0 for the top left measurement box; the fourth argument on 
the first row is accessed by MMT(0,3). For this function, the required measurement 
box must be displayed in the graph. Since the values of measurements may change 
during the course of an acquisition, calculation channel expressions cannot use this 
function. 
If a Model Expression (page X397H253X) uses MMT() syntax to reference a measurement 
and that referenced measurement is linearly interpolated, the results of the NLM 
measurement will also be displayed as being linearly interpolated. 

MOD(x,y) Computes the floating point modulus; returns integer portion of modulus. 
Example: MOD(5,2) evaluates to “1” 

NOT(x) Computes a logical negation of its argument. Evaluates to 
1 if x is zero. 
0 if x is non-zero. 

OR(x, y, …)  
 

Evaluates multiple variables; true if any are true. Computes a logical “or” operation 
for its arguments. Accepts up to eight (8) arguments and evaluates to 

1 if any one of its arguments is non-zero. 
 0 if all of its arguments are zero. 

ROUND(x) Returns an integer closest in value to the argument. For example: 
  round (2.4) = 2    round(2.5) = 3    round(-1.5) = -1    round(-1.6) = -2     

SIN Calculates the sine (in radians) of each data point. 
SINH Computes the hyperbolic sine for each sample point. 
SQR Squares each data point. 
SQRT Takes the square root of each data point. 
TAN Computes the tangent of each sample point. 
TANH Calculates the hyperbolic tangent of each sample point. 
TRUNC(x) Removes the fractional part of the number and returns an integer. For example: 

  TRUNC(2.4)= 2    TRUNC(2.5)= 2    TRUNC(-1.5)= -1    TRUNC(-1.6)= -1 

Note When used with scientific notation, TRUNC(x) applies only to the fractional 
portion after the exponential factor is taken into account: TRUNC(2.93E+4) = 
TRUNC(29300) = “29300”. Since 2.93e+4 (29,300) has no fractional portion, 
the number is returned unchanged. Similarly, TRUNC(2.931245E+4) = 
TRUNC(29312.45) = “29312”. 

XOR(x, y, …)  Logical exclusive OR; true if an odd number is true. Computes a logical “exclusive 
or” for its arguments (e.g. “one or the other, but not both”). Accepts up to eight (8) 
arguments and evaluates to 

1 if an odd number of its arguments are non-zero. 
0 if an even number of its arguments are non-zero or 

if none of its arguments are non-zero. 
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Delay Calculation 

  

 
Delay setup dialog and resulting graph showing 20 sample delay 

This option allows you to use a Calculation channel to plot another channel lagged (delayed) by an arbitrary 
interval. The delay interval can be specified either in terms of samples or seconds. These types of plots are 
useful for producing non-linear (“chaos”) plots in AcqKnowledge’s X/Y display mode (see page X398H305X for a 
description). 
When a delay channel is recorded, there is a segment at the beginning of the Calculation channel (equal to the 
value of the delay) that will read as 0 Volts. This is normal and occurs because the delay channel is waiting to 
“catch up” with the original signal. AcqKnowledge fills this buffer with zeros until the delay channel begins 
to plot actual data. In the example below, the delay channel contains a 0.25-second interval of zeros at the 
beginning of data file. 
Although there is not a parallel function in post-processing mode, the same effect can be obtained by selecting 
a section of one waveform equal to the desired delay interval and choosing the Edit>Cut function or the 
Edit>Clear command to remove a section of the waveform. 
The Sample rate line provides the sample rate for the selected channel (may be different than the acquisition 
sample rate). 
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Control Calculation 

  
The Control function is used to output a digital pulse when the value for a specified input channel exceeds a 
certain level, falls inside a given range, or falls outside a given range. This feature is unique in that the output 
is on a digital channel (which ranges from I/O 0 through I/O 15) rather than a Calculation channel. Also, 
unlike other Calculation channels, this Control Calculation can only be performed in real time (i.e., while data 
is being acquired) and cannot be performed in post acquisition mode. 
In addition to outputting a signal on a digital channel, the Control Calculation will also plot an analog version 
of the digital signal on the Calculation channel you specify. For instance, in the example below, Calculation 
channel C0 is used to perform a control function using analog channel 1 (A1) as an input and digital channel 0 
(D0) as an output. In addition to outputting a pulse on D0, the setup below will also produce a plot on channel 
40 (the first Calculation channel) that emulates the signal being output on digital channel 0. Since 
Calculations are analog channels, the Calculation channel does not contain a “true” digital signal, but is a 
reasonably good approximation. To retain the physical output generated by a Control channel, the output 
digital channel should be looped back to another digital input channel of the MP unit and acquired as well as 
being connected to any external devices. The calculation channel values are not guaranteed to precisely match 
the actual digital output. 
There are four parameters that need to be specified for each Control channel: 

a) Source channel c) Type of threshold function 
b) Output channel d) Threshold level values  

“Source” refers to the input channel to be used for the Control function. As with other Calculation channels, 
the Control function can use either an analog channel or another (lower) Calculation channel as an input. In 
the previous example, analog channel 1 (A1) is used as the input channel. It is not possible to use a digital 
channel as an input channel for a Control Calculation. 
The Sample rate line provides the sample rate for the selected channel (may be different than the acquisition 
sample rate). 
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The channel selected in the Output Channel section determines which digital channel the pulse will be sent to. 
The digital channels range from 0 to 15 (D0 through D15) and external devices can be connected as described 
in the section on UIM100C connections in the MP System Hardware Guide. In the sample dialog box shown, 
the digital pulse is sent over I/O line D0. 
Digital channels have two levels, 0 Volts and +5 Volts. When the signal transits from 0 Volts to 5 Volts, an 
“edge” is created and since the signal is going from low to high, this is referred to as a positive edge. 
Similarly, as the signal transits back from 5 Volts to 0, a negative edge is created. These transitions or edges 
can be used to trigger external devices when an analog signal level meets certain threshold criteria. 
The Threshold Function option sets the criteria for the Control channel. You can specify threshold conditions 
such that the digital I/O line goes to +5 Volts when the conditions are met, or you can program the digital line 
to go to 0 Volts when the threshold conditions are met. Threshold conditions can be set so that either (a) the 
digital line is switched when the value of an analog channel exceeds a specified value or (b) the digital line is 
switched when an analog channel falls within a given range. AcqKnowledge also allows you to create a single 
level threshold or a “wide” threshold. 
Tip Mac OS X only To use test conditions more complicated than simple thresholding, combine the 

conditional tests of Expression calculations with the Control channel to change digital 
output based on the Expression result. 

For example, suppose you want to set a Control channel to switch digital line 5 from low to high whenever 
the signal for Calculation channel one (C0) exceeds 85 BPM. Set the source channel to C0 and the output to 
D5. Select the upper left graph in the control dialog box and set L2 and L1 to 85, as shown: 

  
Control dialog and graph showing result of BPM control example 

As you can tell from the preceding graph, there are a number of instances where C0 (heart rate) exceeds 85, 
usually for a short period of time. When it does drop below 85, it appears to return to a value greater than 85 
within a second or two. In instances such as this, it might be useful to “widen” the threshold so that the digital 
line is triggered whenever the input value is greater than 85, but the signal must drop significantly below the 
threshold value before the threshold is reset. 
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As another example, the upper threshold value (L2) is set to 85 and the lower threshold (L1) is set to 83, 
which means that the threshold will not reset until the signal from the source channel drops below 83. In the 
following example, the digital line is switched from low to high (from zero to +5 Volts) when the heart rate 
channel exceeds 85, and stays at +5 Volts for several seconds even though the source channel drops below 85 
(but above 83). The digital line does not switch back to zero until the heart rate channel drops below 83 
(toward the end of the record). Once this occurs, the threshold is reset and the digital line will switch again the 
next time the source channel exceeds 85 BPM. 

  
Control dialog and graph showing control channel with “wide” threshold 

It is also possible to have the digital line switch when the source channel drops below a certain value. In the 
example below, a simple threshold is used to switch the digital line high each time the source channel drops 
below 50 BPM. Since L2 and L1 are set to the same value, this is not a “wide” threshold (as above) and the 
threshold resets each time the source channel goes above 50 BPM. 

  
Control dialog and graph showing control channel detecting source channel levels less than 50 BPM 

These examples are only a few of the possible applications of the control channel using the two threshold 
icons on the left-hand side of the Control Setup dialog. You can construct variations of these (i.e., switching 
the digital line from low to high using a wide threshold whenever the source channel drops below a given 
channel) that are not discussed above. Moreover, each of the options can be construed somewhat differently 
than they have been presented here. For example, the previous example switches the digital line from low to 
high each time the signal on the source channel drops below 50 BPM. Conversely, it also switches from high 
to low each time the source channel value is greater than 50 BPM. This allows you to vary the default setting 
for the digital channels (whether the default is zero or +5 Volts) depending on what types of devices are 
connected. 
(For a description of how to connect various digital devices, see the section on UIM100C connections in the 
MP System Hardware Guide.) 
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In addition to setting “above and below” type thresholds, you can program the Control channel such that the 
digital line is switched whenever the source channel falls within a given range or outside a specified range. In 
the example that follows, digital line 15 is set to switch from zero to +5 Volts whenever the source channel 
signal falls between the values entered in the L1 and L2 boxes. In this case, I/O is switched to +5 Volts 
whenever the heart rate is greater than 60 BPM but less than 80 BPM.  

  
Control dialog and graph showing control channel switching from 
low to high when source channel is between 60 BPM and 80 BPM 

You can also program the digital line to switch from high to low when the signal on the source channel falls 
within a given range. This is equivalent to setting the digital line to shift from low to high when the source 
channel values fall outside a given range (as shown below). 

  
Control dialog and graph showing control channel switching from 
high to low when source channel is between 60 BPM and 80 BPM 
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Fourier Linear Combiners: FLC, WFLC, CWFLC Calculations 
Fourier Linear Combiners are linear combinations of adaptable sinusoidal functions that are particularly well 
suited to processing cyclic data. Sine and cosine are harmonics that are multiples of a base frequency that are 
summed together, and the order is the fixed number of harmonics used in the model. Step size provides mu, 
the gain factor used to adjust the weights of the harmonics at each processing step. Step sizes must be much 
less than 1 for the system to converge. As step sizes decrease, relaxation time lengthens. The FLC model is 
adjusted based on the source data using least means square (LMS) feedback and the bias compensates for DC 
offset. 

 See FLC Transform options, including Scaled FLC, on page X399H228X. 

FLC WFLC CWFLC 

 

Basic FLC  
Simple summation of fixed 
numbers of sines and cosines; 
uses harmonics of a fixed 
frequency and adjusts weighting 
coeffiicients of the mixture. 

Weighted-Frequency FLC 
Base frequency of the harmonics 
is variable; adapts the frequency 
in response to the input signal 
using LMS feedback; the 
frequencies are similarly adjusted 
to the amplitudes. 

Coupled WFLC/FLC 
Runs a WFLC on the signal to 
determine the harmonic frequency 
and then runs the result through an 
FLC using the computed harmonic. 

Operates on a single channel at a 
time. 

Operates on a single channel at a 
time. 

The second FLC can be run on the 
same or a different channel. 

Well suited for extracting data of 
a known frequency band from a 
signal with a stable frequency. 

 Use as an adaptive noise filter 
to remove non-periodic and 
semi-periodic noise 
uncorrelated to the base 
harmonic frequency. 

Well suited for modeling periodic 
signals of an unknown and 
potentially varying frequency 
and/or amplitude. 

 No cycle boundaries or 
frequencies need to be pre-
determined. 

Well suited for real-time extraction of 
information from one signal based 
upon the frequencies contained in 
another signal. 

 Use to remove movement noise 
from ECG. 

 Unique configurations can be 
established with two input signals, 
one for frequency and one for 
amplitude. 
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Adaptive Filtering Calculation 

 
 See the Adaptive Filtering transform on 

page X400H224X. 

Adaptive filtering is a signal processing technique that 
processes two different signals in relation to one another 
and can be used for noise estimation, noise reduction, 
general-purpose filtering, and signal separation. Adaptive 
filtering creates efficient high-quality filters with a 
minimal number of terms, which can be very useful in 
blocking mains interferences or other known periodic 
disturbances. 

 Useful for noise filtering where it is possible to 
acquire a signal that is correlated to the noise (similar 
to the way noise-cancelling headphones detect and 
remove outside noise). Applications include removing 
EMG from ECG or EOG from EEG. 

The weights within an adaptive filter are modified on a step-by-step basis. AcqKnowledge uses the N-tap FIR 
adaptive filter, with coefficients updated using least means squares (gradient) feedback. 

Order Specify a positive integer for the number of terms to be used in the internal FIR filter. 
Step size Provides mu, the rate of adaptation of the coefficients within the FIR filter. 
Source channel The source channel will be replaced by the adaptive filter results. 
Noise channel The noise channel is the signal that is correlated with the noise to be eliminated from 

the Source; it is not modified by adaptive filtering. 
Source and Noise channels must have the same channel sampling rate (under Channel Set Up). 
 
Comb Band Stop Filter Calculation 
See page X401H75 X for details. 
 
Metachannel  
See Metchannel details on page X402H62X. 
 
Rescale Calculation 

 

Mac AcqKnowledge 3.9.2 and later only—Rescale applies two-point linear mapping and allows users to 
change the measurement units (for example, to change temperature from Celcius to Farenheit). The text 
corresponding to the new units can be manually entered. 
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• Use the Rescale transformation (after acquisition) to adjust forgotten calibration of analog channels or 
reverse incorrect calibrations.  

• A "Rescale" Automator action has been added to allow rescaling to be performed in workflows. 

The rescale formula is: 

 
 
Rescale Source Displays the label and number of the selected channel.  
Old Units Displays the values of the current vertical units of the channel 
New Units Allows for manual entry of the new units to be used. The new units will be displayed in 

the vertical units of the channel 
Note  When rescaling only a selected area of the waveform, the manual entry of new 

units is not available unless “Transform entire wave” is checked since it is not 
possible to display different units for different time ranges in the same channel. 
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Chapter 4  Set Up Acquisition 
Set Up Acquisition—The Basics 
Once you have selected the channels to 
be acquired, the next step is to set up the 
acquisition parameters. Among other 
things, these options control the data 
collection rate, where data will be stored 
during an acquisition, and the duration of 
each acquisition. The dialog box that 
allows these options to be set is found 
under the Set Up Acquisition menu item 
of the MP menu. 

 
Storage Mode 
At the top of the dialog are three popup menus that allow you to control a number of aspects for storing the 
data from each acquisition. 
The first option, Record/Record last allows you to control whether the software saves all the data or only the 
most recent segment of the data. 

 When Record is selected, the MP System will store data for the amount of time that is specified in the 
acquisition length box. This is the default and is appropriate for almost all types of acquisitions.  

 When Record last is selected, the MP System will acquire data continuously, but will only store the 
most recent segment of data equivalent to the duration in the acquisition length dialog box. That is, if 
the value in the acquisition length box is 30 seconds and record last is selected, the MP System will 
acquire data ad infinitum, but will only store the most recent 30 seconds of the data.  

The second option, Save once/Autosave file/Append allows you to vary how the data is saved to a file. By 
default, AcqKnowledge will save the data to a single continuous file. 

 When Save once is selected, AcqKnowledge will begin an acquisition when the mouse is clicked on the 
start button, and will stop either when the acquisition length has been reached or when the stop button is 
clicked with the mouse. 

 Autosave file mode allows you to perform several acquisitions one after another, and save the data from 
each acquisition in a separate file. When the Autosave option is selected, a File button will appear to the 
left of the sample rate dialog box. Clicking on the File button generates a modified Save dialog that 
allows you to choose the root file name for the data from each acquisition. 

  
 Append mode is similar to the Save Once mode, except that the Append mode allows you stop and 

restart acquisitions at arbitrary intervals. Append mode is unique in that clicking on the Stop button 
only pauses the acquisition, which can then be restarted by clicking on the Start button. 
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In Append mode, each time an 
acquisition is restarted, a marker is 
inserted into the record showing the 
time (hh:mm:ss) at which the MP 
System started acquiring data; see page 
X403H161X for marker details. Although you 
can pause for any period of time, the 
MP System will only acquire data for 
the amount of time indicated in the 
Acquisition Length box. Data can be 
acquired in Append mode while being 
saved to computer memory, disk, or 
the MP acquisition unit (but not in 
Averaging mode). 

  
Sample data Acquired in “Append” mode. 

Markers indicate where Acquisition was paused. 

Append plus external trigger: An acquisition that takes place over a long period of time with brief 
events which are few and far between can be set up in the following manner: the researcher watches for 
these event, triggers the acquisition to start, and then lets the pre-defined acquisition length run out. 
When another event of interest occurs, the researcher triggers the next acquisition. This acquisition will 
be “appended” onto the end of the first acquisition. Memory is the only limit as to how many 
“appendages” can be added. 
Append plus Variable Sampling Rates: If the mode is started and stopped manually, it is statistically 
possible that, prior to the next pass of the Append, extra data points may be inserted in various data 
channels to “line up” the data (see sample on page X404H57 X). These extra data points simply replicate the last 
sample in any affected channel. To minimize the impact of the extra data points, make sure the lowest 
sampling rate is on the order of 10Hz or higher, or don’t use VSR. 
Appended segments can be stored to disk, memory, MP1XX or averaging. 

 Append to Disk: In this mode, it is usually best to record all channels at the same rate. If the user 
stops the acquisition, the length will be the same for all channels—so the next segment of appended 
data will neatly link onto the end of the existing record. If channels are sampled at different rates, 
append to disk operation will cause the software to rewrite all data files in the graph and add 
“extra” data to the “uneven” waves. This extra data will be a continuation of the same data point at 
the end of each uneven wave. This operation may take some time to complete for very long data 
files.  
 You can append to existing files—just open them, change the storage mode to “Append to 

Disk” and Start the acquisition. 
 On the Macintosh, Append functions only work on AcqKnowledge 3.9 Macintosh format files. 

If you open any other file format, you will be prompted to translate the file. 
 Append to Memory: In this mode, data is appended to the “uneven” waves in the same manner as 

described for Append to Disk. When channels are sampled at different rates, this mode will respond 
faster than Append to Disk because the data files are already in memory so the software does not 
have to rewrite all the data files in the graph.  

 A Reset button is generated in the Set up Acquisition dialog when Append is selected. Click 
on the Reset button to erase the acquired data file and start a fresh acquisition file (this is 
essentially the same as saying yes to an “Overwrite existing data?” prompt). AcqKnowledge 
3.9 for Mac OS X generates the following prompt for Reset commands: 

 

  The Rewind button on the toolbar will delete the last recorded segment. Ctrl-Rewind 
(Windows) or Option-Rewind (Mac OS X) will delete all recorded segments (similar to the 
Reset button). 
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The third option in the popup menu tells AcqKnowledge where to store data during an acquisition. The 
options here are Disk/Memory/MP/Averaging. Once data has been acquired and is stored in a file, it is stored 
on a hard disk or other similar device. There are a number of options for storing data during an acquisition. 
The best choice as to where data should be stored during an acquisition depends in large part on the nature of 
the acquisition itself, and the type of computer being used. 
 Memory stores data in computer memory (RAM) during an acquisition. After the acquisition is finished 

you will have to select Save As... from the File menu to permanently save this to your computer’s hard 
disk. This usually allows for faster acquisition rates, although most computers have less available RAM 
than disk space. 

 Disk saves data directly to the computer’s hard disk during an acquisition. Disk mode is fast enough (in 
terms of maximum sampling rate) for many applications, especially when only a few channels are being 
acquired. Saving data to Disk also allows for longer acquisitions, since most computers have more hard 
disk space free than free RAM. A final advantage of saving data directly to Disk is that if there is a 
system failure (including power outage), all the data collected up to that point is saved on disk and can be 
recovered, whereas the data is deleted if it is being saved to computer memory.  

IMPORTANT 
If you are saving files in Disk mode, always be sure to save your files under a different name 
BEFORE you start each acquisition. Otherwise, any previous data in that file will be 
overwritten. In Memory mode, you simply go through the standard procedure of saving the file 
after the acquisition. 

 MP stores a small amount of data on the MP acquisition unit itself. 
o The MP150 is limited only by internal memory, with storage estimated at 4 MB and 400kHz 

aggregate sampling rate. 
o The MP100 can save up to 16, 000 samples at up to 70, 000 samples per second. 

Obviously, data cannot be sampled this fast for a very long period of time if it is to be stored in the MP 
acquisition unit. Also, as more and more channels are acquired, the duration of acquisition to the MP 
acquisition unit will shorten. Another drawback of storing data to the MP acquisition unit is that the data 
is not plotted on the screen as it is being acquired, but will automatically be plotted on the screen as soon 
as the acquisition is terminated. 

 Averaging is used exclusively for acquisitions involving repeated trials and is discussed in detail on page 
X405H99X. 
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Acquisition Sample Rate 
The value in the box labeled “Sample rate” indicates how many samples the MP System should take per 
channel during each second of data acquisition. The sample rate can be changed by clicking on the pull-down 
menu. To allow for variable sample rates, the rate options are constrained so that channel sample rates are 
equal to or a specific power of 2 less than the acquisition rate. New sample rates can be chosen at the selected 
increments for the MP150 and set between 1Hz and 2000Hz for the MP100, with a Custom option on Mac OS 
X. 

 
MP150 rate options (High-speed options) 

 

 
MP100 rate options 

Sample Rate pull-down menu 
Depending on the nature of the data being acquired, the “best” choice in terms of sampling rate will vary. 
Technically speaking, the minimum sampling rate should be at least twice the highest frequency component 
of interest. This means that if the phenomenon you are interested in observing has frequency components 
(which are of interest) of 100Hz, you should sample at least 200 times per second. Fourier analysis (FFT) can 
be used to determine what frequency components are present in the data (see page X406H257X for a more detailed 
description of the FFT function). 

TIP: A good rule of thumb is to set the sampling rate to at least three to four times the highest 
frequency component of interest. 

In less technical terms, lower sampling rates can be used for data with slowly changing values (e.g. 
respiration, EDA, GSR), whereas higher sampling rates should be set for data where values change markedly 
in magnitude or direction (e.g. ECG, EEG, evoked response). 
The maximum allowable sampling rate will automatically adjust itself according to the storage mode, how 
many channels are being acquired in the channel setup window and the type of computer being used. You can 
try this by entering a large value (say 99, 999) in the sample rate box. Now click the mouse button or press 
return and AcqKnowledge will automatically return the maximum allowable sample rate given the computer’s 
throughput and the acquisition parameters. 
If data is being stored to disk or computer memory (RAM) during an acquisition, To set a sample rate that is 
too high. The acquisition will begin normally, but AcqKnowledge will stop the acquisition and display a 
message indicating that the acquisition buffer has overflowed. The data up to this point has been saved, and 
the sample rate must be set to a smaller value if you wish to complete an entire acquisition. 
The sample ECG waveforms below illustrate the effect of different sampling rates on obtaining varying levels 
of fidelity when reproducing the data. 
 Top waveform: data is sampled relatively slowly; difficult to make out the shape of the waveform. 
 Middle waveform: sampled at the faster rate; more samples are taken in the same period of time, which 

results in higher resolution for some components of the waveform. 
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 Bottom waveform: sampled at a relatively high rate; increased resolution of the waveform. Waveform 
components that were obscured at slow sampling rates are now well defined, and measurements taken on 
this waveform would be able to better establish the maximum amplitude, time between different ECG 
complexes, etc. 

 

 
Representation of ECG waveform sampled 
with relatively few samples per second 
“True” ECG wave is superimposed over dots 
that indicate sample points. 
 

 Preceding waveform as it would look if 
plotted in AcqKnowledge (with data points 
superimposed). 
 

 

 
 
Representation of same ECG waveform 
sampled at a relatively higher sampling rate. 
 

As shown, under-sampling completely misses the QRS complex of this waveform, although it might detect 
components of the QRS in subsequent beats. Although this is an extreme example of how under-sampling can 
affect digitally processed data, it is important to note that the rate at which data is sampled has important 
implications for the interpretation and analysis of data. 
The disadvantage of acquiring data at high sampling rates is that each sample point takes up memory, whether 
it is RAM or disk space or MP memory. Moreover, once the file is saved, it will require more disk space than 
a file of similar duration sampled at a slower rate. 
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Note for variable sample rate processing: 
The Equation Generator and Waveform Math functions will constrain operations between waves of different 
rates as follows: 
If an equation is operating on two or more waves of different sample rates, the result of the operation will 
always be output at the lowest sampling rate from the waves (F low). If the destination channel for the result 
has an assigned rate other than (F low), the operation will not be permitted. If the destination channel is set to 
a new channel, the operation will always be permitted. 
VSR data padding—If the channels are of unequal length (as a result of variable sampling rate or waveform 
editing), they will be padded for Append acquisition. Digital and Analog channels are stored as short integers 
by default; a waveform paste into a digital or analog channel, however, will result in its underlying data being 
converted to floating point. This will generate the “Abort/Replace” warning for pastes to Digital or Analog 
channels since the data format has changed since the last acquisition.  
Additionally, if an Analog or Digital channel is used as the source waveform for a Copy, it will also be 
converted to floating point and will result in the “Abort/Replace” warning being generated. 
Since Calculation channels are already floating point, pasting into them or copying from them will not change 
their data format. The channels will be padded with their last value and the append will commence. 
Waveform Cut operations do not change the underlying data format for Analog, Calculation, or Digital 
channels. If only Waveform Cut is used, no data format conversion will occur and channels will be padded 
with their last value and subsequent appends are allowed. 

 
Acquisition length 
To set the duration of an acquisition, enter a number in the acquisition length box. By default, 30 seconds of 
data will be recorded. The popup menu right of the length box allows you to scale the duration of the 
acquisition in terms of milliseconds, seconds, minutes, hours, or samples. Changing this option will not 
change the length of the acquisition, only the units used to describe it. Thus you can describe the same 
acquisition as lasting 30 seconds, or 0.5 minutes, or 30, 000 milliseconds. Scaling the duration of an 
acquisition in terms of samples is essentially the same as the time scaling options, except the length of the 
acquisition will be expressed in the total number of samples to be collected on one channel. 
Regardless of what scale you use to determine the length of acquisition, AcqKnowledge will end an 
acquisition when the value in the total length box is reached. You may also stop the acquisition at any time by 
clicking on the stop button in the lower right hand corner of the graph window. 
The MP will automatically limit the maximum recording length to the amount of available memory on the 
target storage device (memory, disk, or MP). The default is to record one acquisition of the duration specified 
in the acquisition length box. The acquisition length parameter has a somewhat different interpretation in the 
Record Last and Averaging modes. See pages X407H92 X and X408H99 X (respectively) for more information on these features. 
Windows only AcqKnowledge will round Acquisition length so that the “Total Acquisition Length” multiplied 
by the “Minimum Channel Sample Rate” is a natural number (1, 2, 3…). 

 



98 AcqKnowledge Software Guide 

Visit the online support center at www.biopac.com 

Multiple Hardware 
AcqKnowledge can be used with multiple MP150 data acquisition units to 

 control multiple, independent experiments on one computer 
 increase the total number of channels used for a single experiment (e.g., 32-channel EEG) 

To synchronize the Start of multiple units, use the External Trigger function. 
To combine up to 60 channels of data into one file, use the Merge Graphs feature (see page X409H213X). 

Each graph window can 
support a different MP150 unit. 
To add an MP150 unit for 
acquisition, open a New Graph 
(not a Data View). 

 
 

To show/hide the “Connected 
to:” information, toggle the 
Show/Hide Hardware icon in 
the Toolbar. 

 

 
To switch the MP150 unit 
associated with a graph 
window, click on the 
“Connected to” box and drag to 
select an available unit or Add 
new hardware.   
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Averaging 
Overview 
In some instances, the signal of interest does not stand out against the background or ambient noise (the level 
of ambient noise exceeds the signal produced by the object of interest), and the only way to detect the signal 
of interest is to perform repeated trials as part of one acquisition, and average the trials together. Since the 
“noise” associated with the signal is assumed to be random, and the “signal” is assumed to be systematic, the 
noise should approach zero as the individual trials are averaged together.  

 
Signal (top) measured in the presence of noise 
(middle), which results in the bottom waveform 
when measured in standard Acquisition mode 

 
Same signal averaged in the presence of noise 

over 2,000 trials to produce the lower waveform. 
 

Any averaging acquisition consists of three general components: 
(a) the stimulus signal 
(b) the duration of the acquired data, and 
(c) a small amount of processing time (or overhead) that takes place between acquisitions. 

The duration of the stimulus signal and the duration of data to be acquired can be set by the user. The amount 
of overhead required is a function of the acquisition length, the sampling rate, and the number of channels 
being averaged. 

Acquisition length

Stimulus signal

Overhead

Latency
 

Stimulus signal usually some sort of pure tone or pulse; occurs at the beginning of each trial. 
Acquisition length refers to the amount of data to be acquired during each trial. 
Overhead refers to a period of time after data has been acquired that is needed to perform

the mathematical averaging. 
Latency refers to the total time elapsed between the start of one trial and the start of the 

subsequent trial. 
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Averaging Setup 
 For Advanced Averaging, see page X410H102 X. 

To set up Averaging: 
1. Use Set up Acquisition to select the 

Averaging option. 
2. Click the Setup button to generate the 

Averaging Options dialog. 
3. Set the Averaging Options as detailed below. 
4. Click OK to close out of the dialog. 
5. Set the Stimulus (see page X411H107X). 
6. Use the buttons in the graph window to Start, 

Stop, and save the averaging acquisition. 
 

Note In AcqKnowledge for Windows, 
averaging is not allowed when Variable 
Sampling Rates are used. 

Averaging Options 
Averages  
Select the number of averages to perform from the pull-down menu, to a maximum of 10,000. 
 This option is disabled for Advanced Averaging because you must use the Advanced Averaging Setup 

dialog (page X412H102X) to set the number of averages. 
Latency 
The individual components of stimulus signal, acquisition length, and overhead are, in sum, equal to the 
latency of the acquisition. As a rule, you should set the latency to at least three times the acquisition length. In 
some cases—such as when you want to allow a subject to return to a baseline state or condition—you may 
want to set the latency to a value much larger than this. By default, each trial is initiated when the latency 
value is reached (in the sample dialog box shown, a new trial is initiated every 100 msec). 
If the latency is set to a value too short to allow for averaging to take place, an Acquisition Warning will be 
generated:  

 

 Adj Latency: automatically adjust the latency 
to the shortest possible value that still allows 
for data to be acquired and processed. 

 Adj Length: reduce the amount of data 
acquired without changing the latency. 

 Abort: return to the graph window without any 
data being collected. 

External trigger 
To initiate a trial on a signal from an External Trigger, enable this option and select positive or negative edge. 
When this option is checked, a new trial will be acquired each time a trigger circuit is closed. For more 
information on triggers, see page X413H104X. 



Part B — Acquisition Functions: The MP Menu 101 

AcqKnowledge Software Guide 

Averaging Options continued 
Artifact rejection 
Occasionally during an acquisition, extreme levels of artifact will be present for one reason or another. 
Checking artifact rejection allows you to determine what signal levels constitute artifact, and have the MP 
System reject these trials. When artifact rejection is enabled, the MP System will ignore any trials that contain 
signals exceeding the artifact rejection thresholds, keep track of how many trials have been rejected, and add 
that number of trials to the total number of trials to be acquired. This allows you to “re-try” a trial that was 
rejected due to the presence of artifact. 
To set these parameters, you need to set a high threshold and a low threshold. Both thresholds refer to the 
scale limits (normally ± 10 Volts). If the high and low artifact rejection thresholds are set to 80% and 30% 
(respectively), the MP System will reject any trial where the signal exceeds +8 Volts or –3 Volts. 
When the channel scaling feature is used to change the range of scale (MAP) values to something other than ± 
10 Volts, the artifact rejection thresholds reference the scale (MAP) value associated with +10 Volts (for the 
high threshold) or with –10 Volts (for the low threshold). If the channel scaling for a particular channel is set 
so that +10 Volts scales to 400 mVolts, and the artifact rejection is set to 80%, then the MP System will reject 
any trial which contains a value greater than the equivalent of 320 mVolts or less than the equivalent of –320 
mVolts.  
Enable Channels 

To add analog channels to the average, check 
additional channels in the Enable list. 

 Channels must be set to “Acquire” under 
MP150 > Set Up Channels to be selectable 
here; otherwise the channel box will be 
grayed out. 

  
 

 
Stimulus Signal 
Although AcqKnowledge does not require a stimulus signal to be output for Averaging trials, most 
applications that use signal averaging make use of a stimulus signal. Digital stimuli (i.e., clicks) or analog 
stimuli (i.e., tones, pulses, and arbitrary waveforms) may be output.  
In almost all cases, the most convenient way to output a stimulus signal is to output a predefined wave on 
analog output channel A0 and/or A1. You can create pulse waveforms, tone waveforms, ramp waveforms, 
and arbitrarily shaped analog waveforms. Use MP menu > Stimulator Setup to set all of the stimulus output 
functions (see page X414H107X). 
 
Mac OS X: When you start Averaging, the Start button turns to Averaging status and the green dot turns to 

“A” to indicate that Averaging is in process. 
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Advanced Averaging—P300 
Advanced averaging can be used to set up P300 protocols. A sample P300 setup is included in the Samples 
folder. 
To set up Advanced Averaging: 

1. Open two or more graph files. 
2. Use Set up Acquisition to set each graph file for Averaging (see page X415H99 X). 
3. Click the Averaging Setup button and set Averaging Options as desired for each graph file. 

 Advanced Averaging will use the defaults if you choose not to set Averaging Options for 
Latency, Artifact Rejection, or Enabled channels.  

4. Use Setup Stimulator to establish the desired stimulus output for each graph file (see page X416H107X). 
 Set the Output channel to the same channel (A1 or A0) for all graph files. 
 Set the Stimulator Output to During Averaging Pass (recommended). 

5. Save each graph file with an appropriate name. 
6. Choose MP150 > Set Up Advanced Averaging. 

 

This menu option is only enabled if two or more open 
graphs are set to Averaging.  
 

7. Set the Advanced Averaging options: 

 

a. Averages: Select the number of averages from the pull-
down menu (max 10,000). 

b. Graph: Assign a Graph from the pull-down menu of open 
graph files. Up to eight graph files can be used in 
Advanced Averaging. 

c. Trial distribution: Use the slider to assign a percentage for 
each graph; the total will adjust to 100%  
Note The software counts 0 as 1, so the percentage of the 

active graph should be entered as one less than the 
desired output (for 50% enter 49%). 

8. Click the Start button in the Advanced Averaging setup dialog to begin acquisition. 
9. Review the status in the “Completed” bar that is activated when Start is pressed and/or in the status 

display at the bottom of the AcqKnowledge software window. 

  
 

10. Save each graph file. 
11. Make sure that the Graph names are correct in the Advanced Averaging setup dialog, and then use 

Save or Save As to save the setup as an AVG file. 
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Repeating 
The Repeat mode allows you to acquire data from repeated trials using the same parameters for each trial. 
Checking the Repeat every box at the bottom of the acquisition setup dialog enables a series of dialog boxes 
and popup menus at the bottom of the dialog box. These allow you to control how many times an acquisition 
will repeat as well as the interval between trials. When this is unchecked, the acquisitions will repeat as soon 
as possible (usually instantaneously, but slightly longer if data must be saved to a file between trials). 

  
Interval The entry to the right of the “Repeat every” checkbox tells AcqKnowledge how long to pause 

between the start of one acquisition and the beginning of the next acquisition. This can be scaled 
in terms of seconds, minutes, or hours using the second popup menu. 

 It is important to note that this value measures the interval between the start of two adjacent trials, 
rather than the interval between the end of one trial and the start of the subsequent trial. If the 
repeat interval is set for 15 minutes and the acquisition length is set to 60 seconds, then there will 
be a 14-minute pause between the end of the one trial and the beginning of the next. 

Trials Set how many trials to acquire: 
for perform a finite number of trials; enter the number of trials to acquire 
forever perform an infinite number of trials. Trials will be repeated at the specified interval 

until the acquisition is stopped either by clicking on the stop button in the graph 
window or if there is not enough free memory on the target storage device. 

Regardless of which options are checked, data for each trial is acquired according to the acquisition 
parameters specified in the dialog box. In the above example, each trial of data will be sampled at 50Hz and 
will last 1 minute; the trials will be repeated every 15 minutes for a total of 8 trials. 
By default, each acquisition will delete the data from the previous acquisition. You can change this by 
selecting the Autosave file option from the Save once/Autosave file/Append option at the top of the 
acquisition setup dialog box. When the repeating option is checked and Autosave is selected, AcqKnowledge 
will save the data from each trial using the file name and extension indicated by the autosave feature. See 
page X417H92X for a more detailed description of Autosave. 
Network Data Transfer 
Mac AcqKnowledge 3.9.2 and later— AcqKnowledge can be set to to allow applications running on other 
computers attached to the same network to gain access to data as it is being acquired. For more information, 
see page X418H313 X. 
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Chapter 5 Set up Triggering 
During a normal acquisition, the MP System will begin collecting data following a mouse click on the start 
button. It is also possible to begin acquisition using a trigger. Using a trigger allows you to start an acquisition 
“on cue” from a variety of different trigger sources. All trigger options are set in the Set up Triggering dialog 
box, which can be selected from the MP menu. By default, the trigger is Off, and acquisitions are started by 
clicking on the Start button in the graph window. Other options can be selected from the popup menu in the 
Triggering Setup dialog. To begin an acquisition with a trigger, first choose the trigger options most 
appropriate for your application and then click the Start button. After the Start button has been pressed, data 
will be acquired as soon as the trigger is activated. There are two general types of trigger sources: digital 
channels and analog channels. 
 
Digital Triggers 

Digital channels are channels that contain binary 
(either/or) data as typified by a switch being either open or 
closed. This type of data can be acquired from a push-
button switch or other device that produces an on/off 
pulse. For instance, it is sometimes useful to have an 
acquisition begin when a subject presses a button or when 
a signal generator sends out a pulse. These are typical 
digital signals and the trigger devices that emit these 
signals can be connected via the UIM100C. Most stimulus 
generators are equipped to output a digital pulse 
simultaneously with the stimulus signal. 
In a simple trigger design, an external switch is connected 
to the TRIG and GND D input as shown above. Since this 
switch will be either open or closed, the data will be 
digital and have two levels, +5 Volts and 0 Volts. A value 
of +5 Volts is interpreted as a binary 1, and a level of 0 
Volts is interpreted as a binary 0. In the setup above, when 
the switch is closed (i.e., the button is pressed) the signal 
changed from +5 Volts to 0 Volts, creating a transition or 
“edge.” 
If the trigger is set to external, and the edge is set to 
positive, the acquisition will begin as soon as the push-
button is pressed anytime after the start button in the graph 
window is pressed. Once the button is pressed, the 
acquisition will proceed according to the acquisition 
parameters you have set (acquisition length, sampling rate, 
and the like). 
 

BIOPAC
Systems

GND A
+12 V

-12 V

8
9

10
11
12
13
14
15

TRIG
+5 V

GND D

1
2
3
4
5
6
7

0

Pushbutton
switch

 

0 Volts 0 Volts

+5 Volts

Positive
edge edge

Negative

 



Part B — Acquisition Functions: The MP Menu 105 

AcqKnowledge Software Guide 

Analog Triggers 
Initiate an acquisition when an analog channel reaches a certain level. To enable the analog 
trigger feature, data must be acquired to either memory (RAM) or disk, and a value must be 
entered in the Mode Delay box (although the delay may be set to zero). The channel 
containing the data to be used as a trigger does not require the acquire/plot/values boxes to be 
checked in the Set up Channels dialog box. Leaving these boxes unchecked will allow the 
incoming data to trigger an acquisition but will not cause the trigger channel to be acquired or 
plotted. 
When you select Setup Trigger from the MP menu, the following dialog box will appear: 

  
 Digital Trigger Setup Analog Trigger Setup 
Source  Off: Disables Triggering while maintaining the established setup. 
 External: Select for Digital Trigger. 
 CH #: Select for Analog Trigger; must be acquiring to Memory or Disk. Specify the analog 

channel that contains the trigger data and then specify a voltage Level to initiate the trigger. 
Acquisition will begin when the data on the specified channel reaches the specified Level.  

 To trigger an acquisition when an ECG wave on analog channel 1 reaches a certain 
voltage or value, you would set “Source” to CH 1 and then set the Level when the entry 
box is enabled. 

Level  The Level option is activated when a Source CH is selected. Set a level to initiate the trigger 
(e.g., if the ECG wave peaks at 3 V, set the trigger level just under 3 V). 

Edge  Triggers can have a positive or negative edge, defined as follows: 

Edge Digital Analog 

Pos signal changes from 0 to 1 signal crosses from a baseline to a peak 

Neg signal changes from 1 to 0 signal crosses from a peak to a baseline 

 For ECG data (and other types of data with peaks of relatively short duration) there will 
be only minor differences between the two edges, although the positive and negative 
edges can be widely separated in time for data with slowly changing values (such as GSR 
or skin temperature data). 

Mode  Once the trigger channel and level have been specified, the final parameter is the delay. Delay 
can be measured in terms of samples, milliseconds, seconds, or minutes, and may be set to zero 
if desired. The delay option instructs the MP System to wait a specified period after the trigger 
level is reached before beginning the acquisition. 
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Delay When using a trigger, the default setting is for the acquisition to begin immediately after the 
trigger pulse or level occurs. You can change the default by using the Delay option in the 
Trigger Setup dialog box. This feature allows an acquisition to begin a specified period after the 
trigger level is reached. If you want to start an acquisition one second after a switch closes, set 
the trigger to external and enter 1.00 in the box next to Delay. The default scale for Delay is 
seconds, meaning that the acquisition will begin a specified number of seconds after the trigger 
has been initiated. The scale of the delay can be changed from seconds to samples, milliseconds, 
or minutes. 

Pretrigger During normal triggered acquisitions, data is collected only after the trigger has been activated 
(or after some delay). For some applications, it is useful to collect data on events that occur just 
prior to the trigger event. As an example, if an acquisition was set to begin when a device (such 
as a tone generator or flash) sends an output pulse, it might also be important to collect 
information on the subject’s state just before the stimulus. To do this, select the Pretrigger option 
from the Delay/Pretrigger popup menu in the Trigger Setup dialog (enabled when data is being 
stored to the MP acquisition unit; as opposed to disk, memory, or averaging). 

 When the Pretrigger function is enabled, you start an acquisition by clicking on the Start button. 
The MP System will begin collecting data once you click the Start button. When the internal 
memory in the MP acquisition unit is full, the MP System will start replacing the oldest data 
with the newest data (similar to the record last feature). This process continues until the trigger 
event occurs. Following the trigger, the MP System will collect data until the total length is 
reached. The acquisition now contains data from both before and after the trigger. 

 The amount of data collected before the trigger event is determined by the value in the box next 
to the Pretrigger popup menu. As with Delay, scaling can be set in terms of samples, 
milliseconds, seconds, or minutes. The duration of the Pretrigger may also be adjusted using the 
scroll box to the right of the Pretrigger dialog box. 

 When Pretrigger is selected, it is important to note… 
 The total length of the acquisition includes the duration of the Pretrigger. If the acquisition 

length is set to 120 seconds and the Pretrigger is set to 20 seconds, only 100 seconds of data 
will be collected after the trigger event occurs. 

 Since the total length of the acquisition includes the duration of the Pretrigger, the duration 
of the Pretrigger may not exceed the length of the acquisition. 
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Chapter 6  Set up Stimulator 

 

 

 

Although data acquisition is the primary function of the MP 
System, you may also output a signal through one or two 
analog channels while data is being acquired. This is 
handled through a window similar to the standard 
AcqKnowledge graph window. 
Four types of signals can be output: 

1. Square waveforms—page X419H113X 
2. Tone waveforms— X420H114 X 
3. Ramp waveforms— X421H115 X 
4. Arbitrary waveforms— X422H115 X 

Each of these waveform types can be set to repeat signal 
output either Once or Continuously, and parameters can be 
set to either Relative or Absolute time scales.  
To set the type of waveform to be output, select Setup 
stimulator from the MP menu. This generates a window that 
allows you to control the type of signal output by the MP 
System. Like the standard graph window, this plots time on 
the horizontal axis and amplitude on the vertical axis.  
You can use this window to create and shape waveforms to 
be output. Adjust the Stimulator Sample Rate (described 
below) to further control the parameters of the Stimulator 
Output design. 
For any waveform (or stimulus) to be output, you need to 
specify the type of stimulus, the “shape” of the signal, the 
output channel to be used, and how many times the stimulus 
should be output.  
All of these parameters can be set from within the Stimulator 
Setup dialog. Regardless of the type of waveform you select, 
stimulus signals will normally be output when an acquisition 
is initiated, either as a result of clicking on the start button or 
a trigger being activated. 
Stimulator Sample Rate—MP150 only 
A very powerful feature intrinsic to the MP150 unit is the 
ability to set a stimulation signal output rate that is different 
than the acquisition rate, thus permitting considerable 
flexibility for a variety of physiological applications.  
Use the pull-down menu to select a unique sample rate for 
the stimulator. 
 

  See also: Application Note H9HAH162 H - Using the 
Stimulation Features of the MP System 
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Parameters 

Reset  Reset button—Refresh the display; use after the time scale has been adjusted. 

Copy  Copy button—Copy a stimulus waveform from the Stimulator Setup window to the Graph 
window. Use in any situation where you might want a square wave or tone wave to be inserted into 
a Graph window. To use this feature, simply click on the icon when you have the desired waveform 
and it will automatically be copied to a clipboard where it can then be pasted into a graph window 
using the Edit>Paste command.  

Scaling  Scaling button—Rescale stimulus signals to units other 
than Volts according to the Change Scaling Parameters. 

 This type of rescaling does not change the amplification of the 
signal, it is useful for recalibrating the output signal to more 
meaningful units. 

 In the example shown here, an output signal of +10 Volts is 
rescaled to +128 dB, while an output signal of –10 Volts is 
rescaled to reflect 0 dB. 

Relative  Set the duration of each segment of the output waveform in Seg # Width. In the sample dialog 
shown below left, a 5000 msec output is created by entering individual segment widths: 500 + 400 
+ 250 +200 + 3650 = 5000 msec 

 Absolute   
As an alternative, you can enter an exact Seg # Time for each segment of the output waveform. 
This mode can make it easier to control the overall timeline of the stimulus output because you can 
review the setup as the total time. Enter the precise Time for each segment change. To create the 
same 5000 msec output as used in the Relative example, you would enter Seg # 2 Time as 900 (to 
mimic 500 + 400 in Relative mode) , and end the last segment at 5000 (the Seg # Time reflects the 
time associated with the last sample point of each segment, rather than the duration of the segment 
itself). 

  
 Relative mode Absolute mode 
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Output 
A# Analog Output You can output on one or two analog output channels. The output channels are 

listed as A0 and A1 and correspond to Analog Output 0 and Analog Output 1 the UIM100C. 
 For dual stimulation and independent control, connect an output device to A0 and A1.  
 MP150 Users: See Analog Output for MP150 Users notes on page X423H111X. 

The maximum resolution of a stimulus signal output through an analog channel is 22 µsec; this 
means that the shortest segment in the stimulus signal must be at least 22 long. 

PW Pulse Width AcqKnowledge allows you to output a single digital pulse through digital channel I/O 
15, with a resolution of 1 µsec. Since this is a true digital channel, pulse output has only two levels 
(0 Volts and +5 Volts), which cannot be edited. The segment that can be edited is the pulse width 
(duration), which can be set to any value greater than 1 µsec. 

Repeats 
Set independently for A0 and A1. 

 Turn Output OFF (no stimulus signal output). 

 Output the stimulus signal once. 

 Output the stimulus signal for the duration of the acquisition (forever). 
 When output continuously is selected, a vertical line 

is generated at the end of the first section of the 
waveform in the stimulator window to indicate where 
the first output signal ends and the second begins. 
The line can be dragged left or right like a vertical 
segment in a stimulus waveform to control the 
duration of the waveform as it is continuously output. 

Trigger 
When a trigger option is selected (in the Trigger Setup window), AcqKnowledge allows you to select 
from additional menu items with respect to when the signal is output. By default, the stimulus signal will 
be output when you click on the start button. When a trigger is enabled, however, you have the option of 
either outputting the signal when the start button is pressed or when the trigger is initiated. The trigger 
option is added to the stimulator window when a trigger is enabled in the Setup Trigger box (described 
on page X424H104X). 

Manual Stimulator Control MP150 only 

 Only available with MP150 units running firmware 1.1.14 or higher 

When an MP150 unit is being used, the manual stimulator controls at the bottom of the Stimulator Setup 
dialog can be used to start and stop stimulators independently of the acquisition. If changes are made to 
the stimulus wave while a stimulator is running, the stimulator will need to be turned off and then back 
on to apply the changes to the settings. 

The manual stimulator controls can not be used if the MP150 is set to acquire in averaging mode. 

Windows The “Start With” function controls stimulator output before, during or after acquisition. 
To enable the controls, set Duration to Once or Forever. 

   
• Acquisition will start the stimulator when the acquisition starts. 
• On/Off button will start the stimulator when the Start button in the Stimulator Setup 

window is pressed. The Start button toggles to a Stop button. 
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 If Dual Stimulator settings are active, “Start with” applies to both stimulators. 
Mac OS X A “lock” between the two sets of controls can be used to turn both stimulators on or off at 

the same time. This lock is useful for two-channel stimuli delivery, such as stereo sound. 
UNLOCKED 

  
LOCKED—Both channels Start/Stop together 

 
Stimulator Output 

You can set “Stimulator Output” to start before or during an averaging pass. For Advanced Averaging, 
we recommend presenting the stimulus within the Averaging window. 

 For Averaging details, see page X425H99X. 
 For Advanced Averaging details, see page X426H102X. 

   
Before Averaging Pass During Averaging Pass 
 Recommended for Advanced Averaging 
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Analog Output for MP150 Users 
The two MP150 Analog Output channels can independently output static or dynamic values: 

• Static output: Use “Manual Control” (page X427H125X) to set the output level for each channel in 
the range -10V to +10V. 

• Dynamic output: Use “Stimulator Setup” (page X428H107X) to define the output level and pattern. 
 
The MP150 will automatically use the “Manual Control” value if: 

• No acquisition is in progress OR 
• Acquisition is in progress but the Stimulator is disabled via the “Setup Stimulator” dialog. 

 
The MP150 will only use the “Stimulator Setup” value if: 

• Acquisition is in progress (or before Averaging pass) AND 
• Stimulator is enabled via the “Stimulator Setup” dialog. 

 
When the stimulator is in use: 

1. Any Stimulator Output starts (from before Time = 0) with the value established for “Manual 
Control”. 

2. If Segment # Width = 0 the stimulator ignores the associated Segment # Level. 
3. If the stimulator is in 1x mode, after the output waveform is sent, the value of the last 

segment is fixed until acquisition stops. 
4. When acquisition stops, the stimulator resets to the “Manual Control” value. 

 
The following dialogs and output illustrations demonstrate how the “Manual Control” value 
influences Analog Output for the Stimulator when an MP150 is used: 
 
Acquisition parameters: 

 
 
 
 
 

Stimulator parameters: 

 
Manual Control list box: Stimulator Output pattern (using MP150): 
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Dual Stimulation 
For independent control of two stimuli (such as sound and electrical output), set stimulator functions for 
Output to A0 and A1 for each MP150 unit.  

 For additional stimulus paradigms, add MP150 units (see Multiple Hardware, page X429H98X). 
 To output varying stimulus on one channel (i.e., short tones and long tones to headphones), use 

Advanced Averaging with each stimulus set to the same channel (see page X430H102X).  
Sample setup and result for dual stimulation: 

  
The above Stimulator Setup dialogs are for AcqKnowledge under Windows OS. To configure different output 
under Mac OS X, click on the desired output channel at the top of the Stimulator Setup dialog. 
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Square waves 

 Square waveforms are useful for generating pulse 
waveforms, which can be used as stimuli or to trigger a 
stimulus-generating device (such as a flash device or a tone 
generator). 

To output a square wave, choose the  icon in the 
“Repeats” section. You should see a rectangular wave appear in 
the window. You can control the shape of the wave by 
manipulating the various segments of the wave. A square 
wave has five segments, and AcqKnowledge allows you to set 
the level (amplitude) and width (duration) of each segment. 
In a square wave, each of the editable segments is oriented 
horizontally, with vertical segments connecting the adjacent 
sections of the wave. The first segment of a pulse waveform is 
the segment that appears at the far left of the waveform 
section. By positioning the cursor on this segment of the 
waveform, you can tell from the box at the bottom of the 
screen that the level (vertical offset) of the first segment is 0 
Volts, and the width of the first segment is 500 msec. 
To adjust the level of a segment, either: 

a) enter the desired level in the box that says Seg # Level; or 
b) position the cursor on the first segment of the waveform and drag it up or down using the mouse 

(segment 2 is selected in the preceding dialog, and appears in red). 
To change the duration of a segment, either: 

a) Enter a value in the Seg # Width box at the bottom of the Stimulator Setup dialog; or 
b) Position the cursor on the first vertical segment in the setup dialog, click the mouse button, and drag 

the vertical segment left or right. Moving the first vertical segment left shortens the duration of the 
first segment, whereas moving the first vertical segment right lengthens it. 

Each of the segments in the pulse wave can be “edited” in this way. 

Tone Stimuli 

 Tone waveforms allow you to create pure tone signals of 
any duration, magnitude, and frequency. This option outputs 
a pure sine wave, which is useful for audiological and 
stimulus response testing.  
A tone waveform is comprised of two segments, with only 
the second segment being the actual tone itself. This allows 
you to include a pre-signal delay (by setting the level for 
Segment #1 to 0 Volts and the duration to a desired value). 
To set the duration of the tone, adjust the length of segment 
#2 (by changing the Seg #2 Width value box or by clicking 
and dragging the segments within the window). As shown, 
there is an additional (uneditable) section of the waveform 
after the second section. This segment returns the last value 
from segment two, and continues to output that signal level 
until the acquisition is terminated (if the stimulator is set to 
output once) or until another signal is output (if the MP 
System is set to output continuously).  

There are three additional parameters for Tone waveforms: frequency; magnitude; and tone phase. 
 Tone frequency refers to the frequency of the second segment of the waveform. This can be set to 
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any value, although the most common settings are between 20Hz and 20,000Hz. 
 Magnitude refers to the peak-to-peak range of the signal, which can range from ± 0 to ± 10 Volts. 
 Phase of the stimulus signal can be any value equal to or greater than 0 degrees. Phase settings of 

more than 359 degrees will be rescaled to fit the 0°-359° range. In other words, setting the phase 
to 360° or 720° has the same effect as setting the phase to zero degrees. 

 

Ramp Waves 

 Ramp waveforms are useful when you need to construct 
a monotonically increasing or decreasing stimulus signal. 
Ramp waves are comprised of three segments and the 
amplitude and duration can be set for all three sections. 
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Arbitrary Waveform 

 The Arbitrary waveform option allows you to set a 
waveform’s shape and length using standard AcqKnowledge 
editing functions. 

 See Application Note #AH162 for performance 
specifications. 

 The length of an arbitrary waveform is only limited 
by the available memory (if recording in 
Memory/Disk mode; it will be limited to 4096 
samples if recording in MP150 mode). 

Unlike the other types of waveforms, Arbitrary waveforms 
have no segments, so the “shape” of the waveform is 
determined by selecting an existing waveform and the only 
parameters that can be set are Scaling, Repeats, and Trigger. 
There are two methods to create an arbitrary waveform: 
 A. Copy waveform segment 

1. Open a waveform in a standard graph window. 
2. Select the section of the waveform you wish to 

output.  

 
3. Return to the Stimulator Setup dialog—the selected 

area will automatically be pasted into the dialog.  

 

 B. Create waveform 
You can also construct an Arbitrary waveform by copying and pasting predefined stimulus waveforms 
(e.g., square waves or ramp waves) into a standard graph window. This is useful when a pure signal 
needs to be modified by adding noise or modifying waveform parameters such as rise time or decay. It 
also allows you to combine complex sequences of existing stimulus waveforms, such as a pulse followed 
by a tone. 
1. Create a waveform in the Stimulator setup (as described above) of the desired duration and shape. 
2. Choose Edit>Copy. 
3. Switch to an empty graph window. 
4. Choose either Insert waveform or Paste from the Edit menu. 
5. Modify the waveform characteristics as desired. 
6. Choose Edit>Copy. 
7. Switch to the original graph window and paste into the Stimulator Setup window. 
8. Output as an arbitrary waveform. 
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Stimulator Icons 
Waveforms: 

 
Square wave 

 
 

Tone (sine) wave 
 

 
Ramp wave 

 
 

Arbitrary wave 

Parameters: 
 

Reset the display (use after adjusting the time scale) 
 

 
Copy a stimulus waveform from the Stimulator Setup window to the Graph window 

 
 

Scaling (rescale Stimulus signals to different units) 
 

 
Set time base to relative 

 
 

Set time base to absolute 
Output: 

 
Output to Analog Output channel 0 (default) 

 
 

Output to Analog Output channel 1 
 

 
Pulse Width outputs a true digital signal: 0 Volts and +5 Volts 

Repeats: 
 

Toggle the selected Stimulator Output ON and OFF 
For dual stimulator setup, Output is independent for A0 and A1 

 
 

Output stimulus signal once 
 

 
Output stimulus signal for duration of acquisition 

Trigger: 
 

Toggles between “Off” and “Wait for” if MP > Set Up Triggering is active 
Off—Output stimulus signal when Start button is pressed 
Wait for—Output stimulus signal when trigger is initiated 

Stimulator 
output: 

 Toggles between “Before” and “During” Averaging Pass if Set Up Acquisition is 
set to Averaging. For Advanced Averaging, “During…” is recommended. 

 
 

Before  
 

 
During  
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Chapter 7  Other MP Menu Commands 
Show Input Values 

 
 EEG data filtered into four bands Spectra displayed using 

 using online filtering option Show Input Values 

 

SIV window on the Mac 

The Show Input Values option of the MP menu generates an Input Values window, which displays channel 
values in real time, whether an acquisition is in progress or not—which allows you to display values prior to 
or after an acquisition.  

 In the example above, a single channel of EEG data was passed through four different online band 
pass filters. This created four new Calculation channels, each designed to retain data only within a 
given range. The Input Values window displays a spectral plot in real time. 

The Input Values display can be set to numeric, horizontal or vertical bar graph format, and it can be resized 
and moved to any position on the screen. To set the display mode on a PC, use the icons under the Input 
Values title bar; on a Macintosh, use the “Mode” menu generated via the “Options” button. 

 

 

 
 

Note: The Input Values window only 
displays values for channels that were 
set up with the “Values” box checked 
(see page X431H56 X for more information on 
the “Values” checkbox). 
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Display options:  PC:    Macintosh:  

MODE ICON EXPLANATION 

Hold 
 

PC 

Regardless of the display options selected, the display can be “frozen” at any point 
in time by clicking on the hand icon (PC) or the Hold button (Mac). Clicking this 
icon will hold the values at their level(s) when the icon was pressed. The window 
will remain frozen until the icon is clicked again. Once the values are “unfrozen,” 
the values will return to the standard real time display mode. 

Numeric 
  

PC 

When data are displayed 
in numeric value mode, 
the voltages of the 
appropriate channels are 
displayed numerically. 

Bar chart 
 

 Data can be displayed in either Horizontal or Vertical bar chart formats. The range 
of values of the bar graphs corresponds to the range for that channel in the graph 
window. To see the bar “bounce” less for a particular channel, increase the units 
per division in the graph window for that channel. Conversely, to have a bar take 
up more of the window space, decrease the units per division in the graph window. 

 Horizontal 
 
 

 Vertical 

 
PC 

 

 
PC 

  
Options  
 
 

 

  
 PC Macintosh 

Mode (on the Macintosh) controls the format of the values display. 
Precision—On a PC, Precision controls how many significant digits of data are 
displayed after the decimal place (a setting of 5 digits might display data from one 
channel as 1206.70425 and data from another channel as -.97159). 
On a Macintosh, Precision controls the total number of digits displayed. 
Show controls the amount and type of information displayed regarding each 
channel. Click in the box next to each option to activate it. 
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MODE ICON EXPLANATION 
 Channel Numbers will display the channel numbers (A1 for the 

first analog channel, for example). 
 Labels will display the channel labels (ECG 1, Respiration, etc.) 

along with the input values. This feature is especially useful when 
values from multiple channels are being displayed simultaneously. 

 Units will display the units for each channel (as indicated in the 
main graph window). By default, each channel’s display units are 
scaled in terms of Volts, but this can be changed by clicking in the 
amplitude scale units area in the graph window. 

 Min/Max will display the range of values associated with the data. 
This range corresponds to the upper and lower display limits for 
each channel as it appears in the graph window. 

 Values will display number values along with the horizontal or 
vertical bar chart. 

The Font button will generate a standard font control dialog. 

Sound  
On the Mac, 
the Sound 
option is 
accessible 
under the MP 
menu. 
See page X432H121X 
for Sound 
Control 
details. 
 

 The Sound button generates a “Sound Setup” dialog, 
which allows you to turn sound on or off, select the 
sound source channel, control the volume, and assign 
the High Frequency and Low Frequency values to 
establish the desired sound output. 

 

 
 
You can 
also use calculation 
channels to control the 
sound patterns. 
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Sound Feedback 
Sound Feedback can be used to generate an audio signal based on a channel’s data values. Use the Sound 
dialog to turn sound on or off, select the sound source channel, control the volume, and assign the High 
Frequency and Low Frequency values to establish the desired sound output. On the Macintosh, you can also 
control the output sampling rate. 

PC:  

  
A sine wave is generated that ranges between user-specified frequencies. As the input value changes, the 
generated tone shifts in response to the input value.  
The amount of change in the tone is dependent on the channel scale and mirrors the percentage of change of 
the gauges in the Input Values dialog “bar” display mode. The sound frequency and sampling rate for 
generation can both be adjusted. Lower sampling rates require less processing time to generate, while higher 
sampling rates can generate higher frequency tones. 
There is an option to silence the tone if the input signal falls out of specified range (if the value would not be 
plotted, no sound is emitted). 

See also: Sound Patterns, page X433H124X.
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Sound Feedback Settings Mac OS X 

On the Macintosh, the audio signal is generated with 16 bits of resolution, providing a frequency resolution 
equivalent to CD. 

Because of processing overhead, the actual audio output may be delayed. Changes occurring on the actual 
input may not appear in the audio output until a few seconds later. This delay may be dependent on the 
speed of the host computer. 

Whenever any of the settings for the lowpass filter, data source channel, output sampling rate, or median 
removal are changed, the audio playthrough will be halted and re-started. Settings that are modifiable by 
edit fields will have changes applied only if the edit field loses focus (tab, shift window focus) or when 
return is pressed. 

  
 Tone feedback Play channel as audio 

Sound Output Type 
 Tone generates a sine wave between the specified frequencies. The frequency is varied with the 

amplitude of the source channel. The minimum value on the vertical axis for the channel 
corresponds to the low frequency, the maximum value to the high frequency. As the value of the 
channel changes, the frequency of the tone is adjusted accordingly. See also: Sound Patterns, page 
X434H124X. 

 Play channel as audio allows the signal to be listened to directly; this is useful in EMG analysis, 
speech analysis, etc. Audio can be generated only when there is an acquisition in progress. All 
audio output goes to the default audio device. The default output device is set in the Sound System 
Preferences. To change the output device, exit the application, change the sound ouptut device in 
the System Preferences, and restart the application. The playthrough audio will not be generated on 
the device until the start of the next acquisition. 

Output sampling rate 
The sampling rate the sound hardware uses to generate the signal. Options are determined by the audio 
parameters of the computer, up to 44Hz. The output sampling rate controls the rate at which the data is 
generated as well as the maximum frequency value that can be used for the low or high frequency (half 
the sampling rate). Choosing a lower sampling rate will reduce processor overhead but will limit the 
range of frequencies that can be reproduced. 

Source channel 
Provides the channel whose data is either played back directly or used to adjust the tone frequency. The 
menu will list all analog, digital, and calculation channels that have the Acquire box checked in the 
Channel Setup dialog. 

Amplitude 
Tone feedback only—The amplitude slider controls the overall volume. 

Reset adaptive gain control 
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Play channel data as audio only—Use after audio playthrough has started to re-adjust the level after 
accidental spikes or other large artifacts. Shift the scaling factor m back to a very large value. An 
adaptive gain control mechanism maximizes the volume of the signal being output to match the 
dynamic range of the input. To change the volume of the audio output, use the volume control in the 
System Preferences. During an acquisition, high amplitude artifacts (e.g. an accidentally unclipped 
lead) may result in the sound output becoming too quiet. If this happens, clicking the “Reset Adaptive 
Gain Control” button in the MP > Sound Feedback control window will reset the audio gain to 
maximum. 

Enable lowpass filter 
Play channel data as audio only—The source channel data is processed before it is sent to the audio 
device. The audio signal is output at a sampling rate that may not match the acquisition sampling rate. If 
the acquisition sampling rate is lower than the audio rate, upsampling of the audio data will be 
performed. A lowpass filter can be optionally applied to remove artifacts from this upsampling process. 
The artifacts sound like a “buzz” imposed on top of the real signal. Enabling the lowpass filter will 
remove this “buzz.” This filter can be disabled if data is being acquired at rates equal to or greater than 
the audio output sampling rate. 

Median Removal 
Audio signals are AC coupled. Physiological data may exhibit DC offset, however. Median removal is 
applied to all source channel data to AC couple it prior to generation of audio. The window width 
controls the amount of information used to compute the median and should be longer than a single 
cycle of information in the data. The recomputation interval controls how often the median should be 
recomputed and is useful for signals that have significant baseline drift over time. 
Units correspond to the axis setting; changing the axis type will change the units.  
 Axis  Units  
 Time  Seconds 
 Frequency  Hz 
 Arbitrary  Arbitrary 
The default window width is 0.2 seconds and the default recomputation interval is 20 seconds. 

Silence 
Tone feedback only—The frequency is usually adjusted based upon the position of the voltage of the 
source channel versus the visible range in the graph window, similar to the bars of the input values 
display. If the signal goes outside the visible range, it will either be fixed to the low or high frequency 
or, if “Silence when input goes out of range” is checked, the tone will go silent. 
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Sound Patterns 
You can use Calculation channels to control the sound patterns. Begin in the MP >Set up Channels dialog. 
Select a calculation channel Preset and make sure the “Values” option is checked for each channel you want 
to use sound on. 

 
After you’ve selected a Preset, click on Setup… and then establish the desired settings. One possible set up is 
demonstrated on the following page. 

 or  
When you click on the “Start” button, the Calculation channels will display the sound pattern. 
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Manual Control 

 

 
STIM 100 option (STM100 on Mac)  

The Manual Control dialog box allows you to monitor and/or output pulses through the digital input/output 
(I/O) channels, as well as manually set the magnitude of the signal on either of the analog output channels. 
The digital outputs in Manual Control cannot be used to trigger an online Averaging acquisition. 

Stimulator Usage Note 
Use Manual Control to specify the stimulation output level  

a. if the wide range of waveform output options available in the Stimulator Setup dialog 
cannot match your specifications.  

b. for pre-stimulation and post-stimulation. 
MP150 users: See page X435H111X for important Analog Output details 

The 16 digital channels are sectioned off into two blocks, with the first block consisting of I/O channels 0 
through 7, and the second block consists of I/O 8 through 15. 

• All the channels within a given block are programmed together and can be set as either inputs or 
outputs. 

• The two blocks can be set independently. 

o In other words, the lower block can be set to input data while the upper block outputs data. 
You can set channels in the lower block to either read in data or do nothing (as opposed to 
outputting data) while channels in the upper block either output data or do nothing (as 
opposed to reading data). 

To read incoming values for a given block of digital channels, click on the Input button below the row of 
channels for which you wish to have input values displayed. This enables a block of digital channels to 
receive incoming data. To read the values for the entire block simultaneously, click the Read button to the left 
of the channel boxes for that block. Since these are digital channels, the values on the individual channel 
boxes will toggle between 0 and 1. 
When the Read Continuously box is checked (below the Input button), the values will be read in real time. 
When unchecked, the displayed values correspond to the values for that block of channels as of the last time 
the Read button was depressed. This mode provides much the same information as the Show Input Values 
mode. 
To output values for a given channel, the block containing that channel must first be enabled to output data. 
To do this, click on the bar below the channel boxes so the button reads “Output.” You can then program the 
individual channels within that block. These channels will toggle between 0 and 1, with a 0 corresponding to 
zero Volts and a 1 corresponding to + 5 Volts. To output a digital 1 on I/O channel 3, the dialog box would be 
setup as shown above. 
 
The function buttons toggle as follows: 

Input toggles to Output When Input is selected, the checkbox is “Read continuously.” 
Set toggles to Read When Output is selected, the checkbox is “Set immediately.” 

To output a signal on Channel 3, click on the Set button to the left of the channel box. If the Set immediately 
box is checked, the signal will be output when the channel button is clicked. 

IMPORTANT 
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Potential use conflicts can arise between the parameters set in the Manual Control window 
and those set for digital channels in the Set up Channels window. 

 
STIM 100 option (STM100) 

 
STIM 100 option (STM100 on Mac) 

When the STM100C stimulator module is connected to an MP System, the output level can be controlled via 
the Stim 100 option of the Manual Control dialog (“STM100” under Mac OS X). 
Attenuation Attenuate the output signal by a given number of decibels (dB) for controlled stimulus 

applications. To output a signal with no attenuation, simply set the “Stim 100 Attenuation“ to 
0 dB.  

 Manually outputting a value on a digital channel can stop an acquisition if data is being 
collected at very high speeds (greater than 10,000 samples per second aggregate). 

Invert output  Check this box to invert the polarity of the signal output through the STM100C. 
 This function can also be achieved by flipping the polarity switch on the STM100C from 

positive (POS) to negative (NEG). 
 
For more information on the STM100C stimulator output module, see the BIOPAC MP Hardware Guide.pdf. 
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Autoplot and Scroll 
Both Autoplot and Scroll control how data appears on the screen. By default, AcqKnowledge displays the 
most recently collected data first, and if more than one screen of data is to be collected, then the time scale 
will “scroll” so that the newest data is always on the right edge of the screen. 
When Scroll is deselected and Autoplot  is checked, the screen will be cleared when the data reaches the right 
edge of the screen, and plotting continues from the left again. 
When both Scroll and Autoplot are unchecked, the incoming data will be plotted until the screen is full. Once 
the screen is full, data will continue to be collected, but only the first screen is displayed. By default, the MP 
will display the first eight seconds of the data record, but this can be reset manually by changing the 
horizontal scale. To turn Autoplot ON or OFF in the middle of an acquisition: 

 For the MPWSW (PC)—select Ctrl+T on the keyboard to toggle Autoplot. 
 For the MPWS (Mac)—pull down the MP menu and check “Autoplot” ON or OFF 

or use the keyboard shortcut Command+T 
 
Warn on Overwrite 
Selecting the “Warn on overwrite“ option from the MP menu will cause the following dialog box to appear 
each time you start a new acquisition: 

  
If you click on “Yes,” then AcqKnowledge will erase your current file and overwrite with a new acquisition. 
If you don’t want to erase the file you’re working in, click on “No” and then open up a new file to work in. 
This prompt will appear at the beginning of each acquisition when the MP System is in Repeating/Autosave 
mode, so you will probably want to uncheck the “Warn on Overwrite” under the MP menu. 
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Organize Channel Presets  
The Organize Channel Presets option controls the channel presets (established or new) in the MP > Set up 
Channels dialog; you can rename, rearrange or delete Presets. You might use this option to place the most 
frequently selected Presets at the top of the menu or group related Presets, such as established ECG Presets 
and new channel Presets you’ve created. 
Click on a Preset description to select it, and then use the buttons to organize the Presets. The up and down 
arrows will move your selection one space at a time, and the Top and Bottom buttons will jump to the start or 
end of the list. 
Mac OS X users can drag items to reorder them on the Presets list. 

  
Organize Channel Presets dialog and resulting Presets menu display 

  
Revised Organize Channel Presets dialog and resulting Presets menu display 
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To delete or rename a Preset, select the Preset 
name from the listing and click on the Delete or 
Rename button. Or, click the right mouse 
button to select the Preset from the listing and 
scroll to the desired option. 

 

 

Rename a Preset by typing in a new 
description and clicking OK. 

 You can’t use any name currently used 
by a Preset or any name that matches a 
Calculation type (Integrate, Rate, etc.). 

 

  
Delete a Preset by selecting that option. You cannot delete 
the Default Analog Input preset. When you delete a Preset, 
you will be asked to confirm the request because it is an 
irreversible action.  

  

 
Select Network Adapter 
Windows only, MP150 only 
The Select Network Adapter option generates the 
Ethernet card configure dialog, which prompts you 
to select an Ethernet adapter to use with the MP 
System.  
Mac OS X only Access to multiple network adapters 
is provided in the “Connected to MP” window when 
DLC is in use; see page X436H303 X for details. 
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Select MP150 
MP150 only 

 

 
The “Comment” option is available when you 
choose Select MP150 (not Connected to). You can 
enter a comment to help you identify each MP150 
unit, i.e. “Main Lab” or “Station 12.” 

 

 
Mac OS X only: To set No Hardware as the default, 
click “Do not ask me again.” 

The pull-down menu lists all MP150 units that are powered ON and sitting on the same local area network. 
The software can’t determine the lock status until a user attempts to communicate directly to a MP150 unit—
each MP150 unit needs to be tried to determine if it is locked or unlocked. 
The fact that MAC (Ethernet) addresses appear in the user’s “Select MP150” dialog does not imply that the 
MP150 unit is, in fact, unlocked and available. If a user attempts to connect to a locked MP150, an error 
message will be generated to advise that the MP150 unit is locked to a different computer. 
AcqKnowledge locks an MP150 as soon as it connects to it, which tells the MP150 to only respond to 
commands from that particular computer and the communication method (serial or Ethernet). The lock has a 
timeout which is reset every time the MP unit receives a command from the computer that locked it. To locate 
MP150s in the local network, AcqKnowledge sends a broadcast packet to the local area network that asks all 
the MP150s in the network to respond. All the MP150s—whether locked or unlocked—will respond to this 
prompt. This means that the “Select MP150” menu may allow a user to select an MP150 that is locked. In 
such cases, AcqKnowledge will fail to connect (to a locked MP unit, as expected). To resolve this issue, 
unlock or power cycle the MP unit. See Locking/Unlocking the MP150 (Appendix E—page X437H328X) for more 
details. 
When “No Hardware mode” is selected, the menu of available MP150 units is grayed out and becomes 
unselectable. 
 
Exit Playback Mode 
Mac OS X only—Enabled when Open File for Playback (see page X438H33X) has been selected. Select to resume 
acquisition functionality (Playback menu to MP menu, Replay button to Start button). 
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Update Firmware 

Generates a Firmware Update routine. 
• Windows users, see page X439H330X. 

 
• Mac users, see page X440H332X. 

 
 
About MP / MP150 Info 
Select About MP (Windows/PC) or MP1X0 Info (Mac OS X) from the MP1X0 menu to generate a dialog 
with information about the software and firmware versions being used by AcqKnowledge: 

  
The Factory-installed Firmware version (“Manufacturer ROM” on Mac OS X) is provided in case you have to 
“Reset” the MP150 unit for a Firmware Rollback (see page X441H332X). 

 Factory-installed Firmware version 1.1.2 or previous (purchased approximately November 2002 or 
before) may not reset to a level compatible with UDP communication. In such cases, you will need to 
install AcqKnowledge 3.7.2 or previous (non-UDP) and update to UDP in stages; contact BIOPAC for 
additional support. 

 To use an MP150 with UDP communication on a network with a non-Windows DHCP server, you 
must use firmware 1.1.12 or greater for the MP unit to properly be assigned an IP address. This is also 
true for any DHCP system with non-Windows operating systems, such as Unix, Linux, Mac OS X, and 
other DHCP-aware devices. 

Note: For information about AcqKnowledge software, click Help > About AcqKnowledge. 
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Chapter 8  Video 
AcqKnowledge can record and synchronize a video signal with an acquisition. 

AcqKnowledge control of video capture—Acquisition can be delayed or advanced (with 1 ms resolution) 
for tight synchronization to the start of a video. Users can view a video file in post-processing and link the 
video frame to the position of the AcqKnowledge data cursor. When the video file frame is advanced, the 
AcqKnowledge data cursor advances the corresponding period of time (and vice versa). 
AcqKnowledge synchronization to existing video—The Video Capture and Playback functions are 
independent. This permits the user to link otherwise recorded video files to an AcqKnowledge data graph. 
This flexibility permits the user to acquire video in a camcorder, transfer the camcorder video to the 
computer, and then time synch the digitized video to an AcqKnowledge data graph.  

Video Capture will create an *.avi file format; Video Playback supports only*.avi, *.mpeg, and *mpg file 
formats. 
 
Capture 

 
Setup 

Choose Capture > Set up from the Video menu: 

 
Select capture device 

 Use the pull-down menu to link AcqKnowledge to any video capture device connected to the 
computer (typically via a USB port). 

 Click Refresh to update the capture device menu after connecting a video capture device to the 
computer (typically via a USB port). 

During acquisition capture video to file 
 Click Browse and select an existing video file location to link the acquisition to or create a 
placeholder for a new video file to be created along with the new acquisition. 

 If a location has been selected, Unlink will disconnect the acquisition and allow the user to link to a 
different video file or create a new one. 
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Preview 
Choose Capture > Preview from the Video menu to generate an 
image of the video frame to be recorded. Use this image to 
determine proper camera alignment.  

 

Playback 

 
Setup 

Choose Playback > Set up from the Video menu: 

 
Link the active graph to file 

 Click Browse and select an existing video file to link to. 
 If a video file has been selected, Unlink will disconnect the video file and allow the user to link to a 
different video file. 

Delay 

Use the Delay option to adjust for any time offset (positive or negative) between the video recording and 
the AcqKnowledge data file. The settings can establish a tight correlation between the start of data 
acquisition and the start of the video device. This correlation is important because the delay in video 
device start (upon program command) often exceeds the delay in AcqKnowledge acquisition start. 

Use Delay of __ ms 
 Click in the box to toggle the Delay option ON/OFF. 
 Enter a value in milliseconds for the delay. 
o The default is positive, which starts the video AFTER the graph playback starts. 

 For example: with a positive delay of +1,000 ms, (1 second), entered as “1000”, events 
occurring in the video playback will not become visible until the cursor in the 
AcqKnowledge file is placed in advance of 1,000 ms. 

o Include “-” for negative, which starts the video BEFORE the graph playback starts 
 For example: with a negative delay of 1,000 ms (1 second), entered as “-1000”, the 
waveform in the video does not begin to appear until the cursor is placed at or beyond the 
1,000 ms mark of the associated data file. 

Synchronize 
To synchronize the video stream optimally to the AcqKnowledge data graph, use the stimulator function 
to drive an LED to illuminate the video field just after the start of the recording. Set the Delay value for 
exact alignment (subject to video time resolution) between the presentation of the video stream and the 
AcqKnowledge data. The point that the LED turns ON is paired to the transition, from low to high, of the 
stimulation signal driving the LED. 
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Show 

 
Choose Playback > Show from the Video menu to display the recorded video in your computers default 
media player. Since the video time base in the playback pane is linked to the AcqKnowledge data time 
base, shifting frames in the video pane will correspondingly shift the cursor in the AcqKnowledge data 
graph and vice versa. 
To shift the entire video recording forward or backwards with respect to the AcqKnowledge time base, 
use the Delay option. This option is used in post-processing only, to properly align the video and 
AcqKnowledge data to compensate for setups when the video device did not start at the exact same time 
as AcqKnowledge.  

 The video can be viewed independent of the associated acquisition. 
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Part C—Analysis Functions 
OVERVIEW 
This part describes how to analyze data; in most cases, analysis is performed after the data has been collected. 
This involves creating, managing, and saving files, as well as editing data, performing mathematical 
transformations, and displaying data in various ways. Many of the functions covered here are also discussed 
in Part A—Getting Started. Features that can be computed during an acquisition (primarily transformations 
and calculations) are discussed in Part B—Acquisition Functions. 
For general information about sections of the graph window, and to become familiar with the “look and feel” 
of AcqKnowledge, turn to the Editing and Analysis Features chapter that follows. Descriptions of functions 
can be found in the chapters describing each menu. All of the commands discussed here can be found under 
the File, Edit, Transform, or Display menu items. 
 

Menu See… Type of Commands 

File Page X442H187X 

General file management commands, including opening, saving, and 
closing files. Export data files. 

Edit Page X443H209X Cut, copy, and paste between and within files. Export data files. 

Transform Page X444H217X 

Mathematical transformations and functions, from simple arithmetic to 
digital filtering and spectral analysis. 

Specialized 
Analysis Page X445H333X 

A courtesy copy of the new Specialized Analysis package is included 
under the Transform menu for AcqKnowledge 3.9 for Mac OS X. 

Display Page X446H294X 

Control how data appears on the screen either during or after an 
acquisition. 

 
Toolbars 
Many of the most commonly used features in AcqKnowledge can easily be executed with a mouse click. The 
toolbar contains shortcuts for some of the most frequently used AcqKnowledge commands; icons are grayed 
out when they are not applicable. 
Click Display > Show > Tool Bar to view the icons. Click on an icon to activate it. 
See page X447H37 X for Toolbar icon definitions. 
 
Shortcuts 
Keyboard shortcuts are detailed on page X448H37X. 
Mouse shortcuts are detailed on page X449H39X, including right-click options for Windows and and contextual menus 
for Mac OS X. 
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Chapter 9  Editing and Analysis Features 
Overview 
This section provides a brief overview of some of the most frequently used AcqKnowledge features and 
functions. For more detailed information about specific features, turn to Chapters 9 through 13.  
If you are not currently running AcqKnowledge, double click on the AcqKnowledge icon to start it. Choose 
Open from the File menu and select the file called “4chData.acq” (or “4chData” for MPWS). Your screen 
should look like this: 

 

Edit menu functionality during acquisition 
Mac OS X only—The following Edit menu functions may move or alter memory and cannot be performed 
during acquisition: Undo, Cut, Clear, Clear All, Paste, Insert Waveform, Duplicate waveform, and Remove 
Waveform. 
 
Using the scroll bars 
As you can see, there are four channels of data in this file (BP, Resp, Lead 1, Lead 2). Although this record is 
30 seconds long, only a few seconds are displayed on the screen at one time. You can move to different 
locations in the record by moving the scroll box at the bottom of the screen. Dragging the box left moves you 
to earlier points in time, and moving right displays events closer to the end of the record. Clicking on the 
arrows at either end of the horizontal scroll bar allows you to move to different points in time at smaller 
increments. 
A vertical scroll bar is on the right side of the screen, and. If you click on the scroll arrow at the top of the 
box, you’ll see that one waveform appears to move down within its “track” on the screen. Moving this scroll 
box changes the amplitude offset of a selected channel. As with the horizontal scroll bar, you may either 
move the box or click on the arrows. 
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Changing the scale 
Horizontal scale 
As an alternative to the scroll bar, you can click the mouse button with the cursor in the area just above the 
horizontal scroll bar or just left of the vertical scroll bar. Clicking in the horizontal scale area (where it says 
“seconds”) generates a dialog box that allows you to enter a value for units per division and horizontal scale 
offset. This dialog varies based on the lock status of the grid, which is established in the Display > Show 
>Grid Options dialog. 

AcqKnowledge 3.8 Windows/PC AcqKnowledge 3.9 Mac OS X 

 
Unlocked 

 
Locked, with Grid… button 

 
Grid control from Grid… button 

 
Unlocked and Locked 
(when Locked, Time scale will be seconds/screen) 
 
 
 
 
 

 

 
Grid control from Grid Spacing button 
 

Unlocked 
Scale refers to the time interval (units per division) between the on-screen grid marks. There are four 
vertical divisions per screen, and the default is 2.00 seconds per division, so eight seconds of data will be 
displayed on the screen display. Entering a larger value will display more of the record, and entering a 
smaller value will display less. 

Initial offset refers to the time corresponding with the first data point displayed. For example, to display 
the middle 1/3 of the data file (assuming the record is 30 seconds long), set the offset to 10 seconds and 
the seconds per division to 2.5 seconds. 
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Hold relative position is an option available only in the Append acquisition mode. When checked, the 
display for appended acquisitions will show the same relative position with respect to the start of 
acquisition. This is convenient when doing short-duration, high-speed acquisitions where you want to be 
able to zoom in on the signal of interest and have the relative position (from the start of acquisition) stay 
the same. The relative position will not be preserved if the selected area falls within two or more 
appended segments. 

When Hold relative position is checked, if you zoom in on a section of data that has been selected 
(highlighted) and is completely within one appended segment, the scale of the selected area changes with 
each appended segment such that it remains relative to the start of acquisition for that segment and 
updates the measurements. If the selected data area falls within two or more appended segments, this 
feature is not implemented. 

Locked 
Scale Range determines the limits of the viewable scale. Horizontal scale parameters can be established 
with Start/End values or Range/Midpoint values. You cannot enter a value less than 0. 
Hold relative position is an option available only in the Append acquisition mode. When checked, the 
display for appended acquisitions will show the same relative position with respect to the start of 
acquisition (see unlocked grids section for more detail). 
The Grid… button generates a Grid line parameters dialog. Set the scale for the Major Division and the 
Grid reference, which is the point from which the first grid line will be drawn. To turn minor grids ON, 
check “Show minor division” under Display > Show >Grid Options. 
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Amplitude (vertical) scale 
Clicking the mouse in the vertical scale area (where the amplitude of each channel is displayed) generates a 
similar dialog box. This dialog varies based on the lock status of the grid, which is established in the 
Display > Show >Grid Options dialog. 

AcqKnowledge 3.8 Windows/PC AcqKnowledge 3.9 Mac OS X” 

 
Unlocked 

 
Locked, with Grid…button 

 
Grid control from Grid… button 

 
Unlocked and Locked 
(when Locked, scale will be units/screen) 
Scale determines the limits of the viewable 
scale on the horizontal axis. When grids are 
locked, the Scale changes from units/div to 
“units/screen” and establishes the total units 
per screen. The total units will be displayed on 
the screen, with grid divisions at the unit 
interval entered in Grid Spacing. 

 
Grid control from Grid Spacing button 

 
Adaptive Scaling Settings 
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Unlocked 
Scale determines how many units (usually Volts) are displayed for each division. As with the horizontal 
scale, AcqKnowledge divides each channel into four vertical divisions. When data is displayed in chart 
mode, each “track” is divided into four divisions. When data is displayed in scope mode (or if there is 
only one channel of data) the entire screen is divided into four intervals. To increase the apparent 
amplitude for a given channel, set this value to a smaller number; entering a larger number will cause 
the waveform to appear to have less variability. 
Midpoint refers to median displayed value for a particular channel. A checkbox to the left of each of 
these options allows you to apply these scaling options to all channels. By default, the scaling options 
you choose will only apply to the channel indicated in the dialog box. If you want to apply these to all 
channels, click all the checkboxes. 
Friendly Grid Scaling—Mac OS X only 
Too much precision can create numbers that are difficult to quickly interpret. For example, it’s easier to 
comprehend 4.1000000 than 4.1427385. Unlocked grids always restrict precision to the minimum 
needed for a given magnitude. This produces a “friendly” scale that makes it easier to determine the 
range between the gridlines when data is formatted for display or printing. 
With unlocked horizontal grids, the horizontal scale values printed on a graph may not match the 
horizontal scale values displayed on the application screen. For example, horizontal scale values 
 Displayed in the application: 0.00000   7.50000   15.00000   22.50000 

  Printed:    0.00000   7.50125   15.00250   22.50375 
The precision will only match when using the “Visible area” print option. With selected area or entire 
graph options, the precision will not match when grids are unlocked because friendly grid scaling is 
applied on screen, but is not used during printing where the range is fixed to fill the entire page. 
Note that the Zoom tool and vertical autoscale may produce different results. To accommodate the grid 
precision, the Zoom result may be slightly more than specified in the zoom box. For precise correlation 
from selected area to result, lock the grids (horizontal and vertical). Precision is not restricted for locked 
grids or display ranges manually entered in the axis setting dialogs. 

Locked 
Scale Range determines the limits of the viewable scale on the vertical axis. When grids are locked, the 
Scale changes from units/division to “units/screen” and establishes the total units per screen. The total 
units will be displayed on the screen, with grid divisions at the unit interval entered in Grid Spacing. 

Start/End is normally used for data not centered on 0.00 (i.e. data falls from 0-50 grams). 
Range/Midpoint is normally used for data that is centered on 0.00 (i.e. AC-coupled data). 

The Grid… button generates a Grid line parameters dialog. Use this to establish scale for the Major 
Division and the Grid reference, which is the point from which the first grid line will be drawn. Check 
the “All Channels” box to use these parameters on all channels. 
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Adaptive Scaling—Mac OS X only 
Adaptive scaling uses the data to automatically determine the appropriate visible range for the data. 
As the data changes or the baseline shifts, the visible area shifts along with the data to ensure that data 
will always be plotted on the screen. Rather than limiting data visibility to a fixed voltage range, the 
range adjusts for factors such as background noise, electrode movement, EMG interference, 
disconnection, etc. 
Adaptive scaling can be applied to channels individually. The vertical scale dialog includes a 
checkbox to “Use adaptive scaling” and a “settings” button is activated when it is enabled. The 
Unlimited option results in no minimum or maximum range setting, and is equivalent to min 0 and 
max infinity.  
Changes to the scale will be applied whenever the domain of the plot area is changed. This includes 
manual changes to the horizontal scale, horizontal scrollbar use, horizontal auto-scrolling when 
dragging out a selected area, auto-scrolling or auto-plotting during acquisition, initial enabling of 
adaptive scaling, and auto-scrolling when executing Find Cycle/Peak functions. 
Adaptive scaling can be unique for each Data View. 
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Selecting a waveform / channel 

Although multiple waveforms can be displayed, only 
one waveform at a time is considered “active.” Most 
software functions only apply to the active waveform, 
which is also referred to as the “selected” channel. 
Selecting a channel allows you to highlight all or part 
of that waveform, and enables you to perform 
transformations on a given channel. 
In the upper left corner of the graph window there is a 
series of numbered boxes that represent each channel of 
data. The numbers in the boxes correspond to the 
channel used to acquire the data (the specifics of setting 
up channels are discussed on page X450H28X). In the sample 
file, ECG channels are represented by channels 1 and 2, 
with respiration on channel 3 and blood pressure on 
channel 4. 

To select a channel, position the  cursor over the channel box that 
corresponds to the desired channel and click the mouse button or position the 

 cursor on the waveform of interest and click the mouse button. 
Note that the selected channel box appears depressed and the channel label to 
the right of the channel boxes changes to correspond to the selected channel. 
Additionally, the channel label in the display (on the left edge of the track) will 
be highlighted for the active channel. 

 

 
Channel Labels 
Each channel has a label on the left and right edge of the graph window.  
The left label is used to identify the contents of each channel (ECG, 
Respiration, etc.). 
The right label is used to denote the units for each channel’s amplitude scale 
(usually scaled in terms of Volts). 

 
 

 

When a channel is active, its label is highlighted and also 
appears by the channel boxes. 
To change the label for a given channel 

 during or before acquisition 
(including Append mode) 
revise the MP menu> Set up Channels label text 

 post-acquisition / analysis only 
click on the left label enter the desired text in the dialog box 

Mac OS X: Label and Units change prompts are separate. Click 
on the left to change the label and on the right (vertical scale) to 
change the units. The label can be up to 40 characters. 

 

 
AcqKnowledge 3.8 Change Label and Unit 

 

 
AcqKnowledge 3.9 Change Label and Unit 
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Hide a channel 
You can “hide”a waveform display without 
changing the data file. To hide a channel,  
Windows: Ctrl+click in channel box. 
Mac OS X: Option+click in channel box. 
When a channel is hidden, the channel box will 
have a slash through it. You may view a hidden 
channel by holding down the Ctrl or Option key 
and clicking in the channel box again. Channels 2 
and 4 are hidden in the following display: 

 
Cursor Tools 

  
 Windows/PC Mac 
The cursor tool icons are in the lower corner of the graph window. These cursor tools are used in many of the 
on-screen functions described below, including editing, measurements, and the amount of data displayed. 

 
This is a general-purpose cursor tool, used for selecting waveforms, scrolling through data, 
and resizing the chart boundaries between waveforms when in chart mode. All other cursors 
default to this mode when the cursors are moved outside the graph area. 

 
This is a standard “I-beam” editing tool. This tool is used to select an area of a waveform 

(or waveforms) to be edited or transformed. To select it, click on the middle button 
in the lower right hand corner of the screen. Now move the cursor toward the 
waveform. You’ll notice that the cursor changes from an arrow to an I-beam when 
it is placed over the graph area. Using this tool to edit data is analogous to editing 
text with a word processor.  

 When this cursor appears, you can select an area of data by holding down the 
mouse button and dragging the mouse to either the left or right. You can extend the selected 
area to include data that is not on the screen by positioning the cursor at the left edge of the 
area to be selected and clicking the mouse button. Next, use the scroll bars to scroll through 
the data until the desired data appears on the screen. Hold down the shift key while you 
position the cursor to select the right edge of the area to be selected. Click the mouse button 
to select the area. 

Lock Toggle the lock state of the grid for horizontal axis or the channel. 

 
This is a standard “zoom” tool. The zoom tool lets you select and magnify any portion of any 
wave. Click on the  icon (in the lower right portion of the screen) to use the zoom tool. As 
you move the mouse into the graph area, it will change from an arrow  to a crosshair (+). 
Start by positioning the cursor in one corner of the box, then hold down the (left) mouse 
button and drag the crosshair horizontally, vertically, or diagonally to form a “box” that 
encompasses the area you need to zoom in on. When you release the mouse button, 
AcqKnowledge will automatically adjust the horizontal and vertical scales. To “unzoom,” 
choose Zoom back from the Display menu. 

Grid Adjust the grid lines horizontal and vertical. 
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Control 

 
Event 
Definition 

 

Inserts an event at the mouse click location. See page X451H164X for Event details. 
 On a plot, the horizontal location matches the ‘x’ coordinate of the click 

 In Chart mode, the event will be placed on the channel track where the click took 
place. 

 In Scope mode, the event will be defined on the active channel. 
 Within the marker bar, clicks define global events. 

When Event Definition is active, the cursor changes to a flag and the cursor includes a 
downward pointing arrow to indicate where the event will be defined. 
The Event Definition tool is disabled in X/Y mode and if events are not visible. 

Event 
Removal 
“Zap” 

 

Deletes event(s) from a graph with the mouse. It allows for quick editing to eliminate 
misclassified events found through visual inspection. 
 If the user clicks on a single event, that event will be removed from the graph.  
 If the user clicks and drags to define a rectangular area (similar to the zoom tool ), all 

events between the left and right edges of the area will be removed; the event icon does 
not need to lie vertically within the bounded area in order to be removed. 

When Event Removal is active, the cursor changes to a lightening bolt. 

Jump-to 

 

Mac only—Data views and advanced analysis output display multiple representations of the 
same data at the same time. Sometimes this association may be abstract or difficult to 
visualize. The Jump-to tool is a green arrow, and is available in all display modes and during 
acquisitions. 

Use the “Jump-to” tool to correlate data. 

• Click the Jump tool on a data point to “jump”all of the open data views for that graph 
to the same time. 

• Click the Jump tool on a point in an X/Y plot to jump data views in chart or scope 
mode to the point in time corresponding to the point in the X/Y plot. This can be 
useful for correlating PV loops back to other acquired signals. 

• Rate analysis output graphs will jump back to the corresponding point of source data 
at the start of that cycle. 

• Clustering scatterplots will select the appropriate segment of the source graph 
corresponding to the chosen data point. 

Text 
Annotation 

 

Mac only—Use Text Annotation to add floating text notes on top of data in a graph; the text 
notes move and scale with the data. During report or figure preparation, it is nice to be able 
to add additional textual information on top of signals to help clarify signals for readers or 
draw their attention to particular areas of visual interest. AcqKnowledge provides a text 
annotation facility to assist in figure preparation. 
Click the A icon and then click in the graph window to generate the Text Annotation 
Contents dialog. Drag the red “handles” from the annotated text to add connector lines to 
connect the text to the data. 



Part C — Analysis Functions 145 

 

 
 

 

 

 

 
Connector handles 

 
Add a range 

 
Resize a range 

 
Move a connector 

  
Text annotations are short pieces of text that float above channel data and markers and can be 
used to draw visual attention to particular areas of interest in a graph. These text annotations 
can be simple outlined text, can have a connector from the outline boundary to a specific 
sample point on the waveform, or have a range indicator of a specific width. Each text 
annotation is tied to a sample of data in a channel; when the data is moved by coping, 
pasting, or other waveform editing operations, text annotations remain fixed to their 
corresponding sample positions, similar to channel events. 
Although text annotations are tied to specific markers, they are displayed in a relative 
fashion. The relative pixel distance between the text annotation outline boundary and the 
sample of data remains the same under zoom and autoscaling operations. 

• For example, an annotation that is 20 pixels above a T-Wave peak position will 
continue to be drawn 20 pixels above regardless of zoom. This allows for flexible 
data viewing while maintaining text annotation visibility. 

 
 
Text annotation controls 
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Create Insert using the text annotation cursor tool. With the tool active, click in 
the graph to define a new annotation. 

Select Click an annotation once to select it. 
Reposition Drag a selected annotation to reposition it. 
Add Connector Connectors or range indicators can be added to selected annotations by 

using the editing handles on the edges of the selected annotation. 
Edit Connector If the selected annotation has a connector to a data point of the graph, an 

editing handle will appear on the end of the connector. The connector can 
be moved to a different data sample of the graph by dragging the editing 
handle on the end of the connector to the new position in the channel. To 
remove the connector, grab the editing handle on the end of the connector 
and drag the mouse inside the text annotation. 

Range Indicator If the selected annotation has a range indicator, editing handles will 
appear at both ends of the range indicator. To resize the range indicator, 
grab an editing handle and move the mouse. To remove the range 
indicator, grab an editing handle and move the mouse back inside the text 
annotation. 

Autoposition Resizing windows or adding channels may reposition text annotations 
outside of the visible area. Click and hold down the text annotation tool to 
activate the text annotation popup menu. The “Autoposition Hidden 
Annotations” entry will automatically reposition all annotations so they 
are visible. 
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Measurements 
A convenient feature in AcqKnowledge is the popup measurement windows. A variety of different 
measurements can be taken, and you can display different measurements from the same channel and/or 
similar measurements from different waveforms. AcqKnowledge can display measurements for the selected 
channel or for any other channel. By default, AcqKnowledge displays measurements from the selected 
channel (as denoted by the “SC” in the measurement boxes). 
To select a channel for measurement, position the cursor over the part of the measurement window that reads 
“SC.” Click the mouse button and choose a channel number from the pull-down menu. The channel numbers 
in the pull-down menu correspond to the numbers in the channel boxes in the upper left corner of the graph 
window. 
To select a measurement, position the cursor on a measurement box and click the mouse button. Choose a 
measurement from the pull-down menu. The measurements in the upper half of the menu reflect amplitude 
measurements, or measurements which contain information about the vertical (amplitude) scale. Other 
measurements use information taken from the horizontal axis (usually) and are found on the section of the 
pull-down menu below the dividing line. Some of the measurement options change (or are disabled) if units 
are selected for the horizontal scale. 

 
 Mac only Windows & Mac 
Some of the values are single point measurements while others require at least two points to be selected. 
In some cases, the computations involved in the measurement can produce nonsensical results (such as 
dividing by zero, or calculating a BPM from a single point). In those cases, you may get a measurement value 
like INF (for infinite). This means that the result was undefined at this point.  
Mac OS X only: 
Measurement menus are tinted to match the color of the corresponding waveform. 

For a complete description of each of 
the measurement functions and the 
minimum samples for each, turn to 
page 131. 
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Measurement Display 
The number of measurement windows depends on (a) the width of the screen and (b) the number of rows 
selected in the Display > Preferences > General dialog box. 

 
As the screen gets wider, more measurement windows will be displayed in the area above the graph windows. 
By default, only one row of measurement windows is displayed. To display more than one row of 
measurements, select a number from the measurement rows popup menu in the Display > Preferences > 
General dialog box. 
 
Measurement Area 
It is important to remember that AcqKnowledge is always selecting either a single point or an area spanning 
multiple sample points. If an area is defined and a single point measurement (such as Time) is selected, the 
measurement will reflect the last selected point. 

 
 Single-point 

measurements 
When a single point is 
selected, the cursor will 
“blink.” The graph on the left 
shows how the I-beam is 
used to select a single point 
for measurements. 

 
 

 
 Selected range 

measurements 
Drag the cursor to select an 
area; the selected area will be 
highlighted. The graph on the 
right shows how the I-beam 
is used to select an area for 
measurement.  
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IMPORTANT! 
The first data point is “plotted” at zero (on the left edge of the graph); the first visible data point is sample 
point 2. The selected areas below demonstrate this concept. 

 

 

 

 
Measurement Validation 
You can validate measurements with the ValidateMeasurements.acq sample file that was included with the 
software. Pay attention to the “Sample data file” section of the measurement definitions that begin on page 
X452H151X, and where included, note which sample points to use for validation (i.e., the first four sample points are 
used to validate the Correlate measurement using the ValidateMeasurements.acq file). 
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Measurement Info / Parameters— Mac only 

 Measurements that have parameters have an “i” for 
info button next to the measurement type in the measurement bar. Click the button to generate a sheet to edit 
the parameters. To paste parameters, enable the Journal Preference via Display > Preferences > Journal > 
Measurement paste settings > Include measurement parameters. 

Measurement Interpolation—Mac only 
On a down-sampled channel, the cursor can fall on a point between physical samples. In such cases, in the 
Line Plot mode only, some measurements will display interpolated values; the value is obtained by linear 
interpolation with respect to the two adjoining samples. 

 To disable measurement interpolation, uncheck the “Use linear interpolation” option in the Display> 
Preferences dialog. 

 If interpolation is disabled for Line Plot, or any time Step Plot or Dot Plot is selected, measurements 
take on the value of the first physical sample immediately to the left of the cursor or edge of the 
selection. 

 When measurements are pasted to the Journal, there is no indication of interpolated measurements. 
 A Calculation measurement can be an interpolated value. When a measurement uses an interpolated 

value, the result box background changes from gray to light purple. 
 The “Delta S” and “Samples” measurements are never interpolated. 
 Measurements will not be interpolated if all measurements are set to “SC” (selected channel); the 

cursor will snap to the left for the measurements.  
 Measurement tooltips will reflect measurement interpolation. 

Exporting measurements 
One of the most important reasons to take measurements is to save them; AcqKnowledge allows you to store 
and export these measurements in different formats. 

 Copying measurements to the journal:  
To copy measurements (exactly as they appear in the measurement windows) and paste them to the 
Journal, select Edit > Journal > Paste measurement. Under the default settings, only the values 
themselves are copied to the journal; you can change the settings to include the measurement name and 
other options under Display > Preferences>Journal 

 Copying measurements to the clipboard:  
To copy measurements (exactly as they appear in the measurement windows) to the clipboard and paste 
them into a word processor or other application, select Edit > Clipboard > Copy measurements. Under 
the default settings, only the values themselves are copied to the clipboard; you can change the settings 
to include the measurement name and other options via Display > Preferences under Windows or 
Display >Preferences > Journal under Mac OS X. 
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Measurement Definitions 
The table below explains the measurement options available and the range required for each. The default 
option is for time to be displayed on the horizontal axis, although it can be set to display frequency or 
arbitrary units (see page X453H301X for details on how to change the horizontal scaling options). Unless otherwise 
noted, all of the measurements described here relate to those displayed when the horizontal scale reflects time. 
Measurement Area Explanation  
Area Minimum area: 

3 samples 
 
Uses: 
All points of 
selected area 

Area computes the total area among the waveform and the straight line that is 
drawn between the endpoints. 
Area is expressed in terms of (amplitude units multiplied by horizontal units) 
and calculated using the formula: 

( ) ( ) ( ) ( )( )
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Where: 
n—number of samples; 
i—index (i = 1.n-1); 

1, +ii xx  - values of two neighboring points at horizontal axis ( 1x – the first 

point, nx – the last point); 

( ) ( )1, +ii xfxf  - values of two neighboring points of a curve (vertical 
axis); 

( ) ( )1, +ii xyxy  - values of two neighboring points of a straight line (vertical 
axis). 

At the endpoints y( 1x )= f( 1x ) and y( nx )= f( nx ). 

1−
Δ

=Δ
n

Xxi - horizontal sample interval; 

The value of a straight line can be found by formula: 

( ) bxmxy ii +∗=  

( ) 11 xmxfb ∗−= - intercept; 

X
Ym

Δ
Δ

= - slope of the straight line; 

( ) ( )1xfxfY n −=Δ  - vertical distance of increase at vertical axis; 

1xxX n −=Δ - horizontal distance of increase at horizontal axis. 
Sample plot: 

 
The area of the shaded portion is the result. 

Note: The Area measurement is similar to the Integral measurement except 
that a straight line is used (instead of zero) as the baseline for integration. 
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Measurement Area Explanation  

 
Results: This calculation will always return a positive result. 
Units: Volts - sec. 
Sample data file: “ValidateMeasurements.ACQ” 
 Result: 0.4533 Volts - sec. 

BPM 
(Time domain 
only) 

Minimum area: 
2 samples 
 
Uses: 
Endpoints of 
selected area 

BPM (beats per minute) computes the time difference between the first and 
last points and extrapolates BPM by computing the reciprocal of this 
difference, getting the absolute value of it and multiplying by 60 (60 sec). 
The formula for calculation of BPM is: 
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Where:  

nxx ,1 - values of the horizontal axis at the endpoints of selected area. 
Note: As mentioned, this measurement provides essentially the same 
information as the Delta T and Freq measurement. 
Results: Only a positive value. 
Units: BPM. 

Calculate Minimum area: 
2 sources 
 
Uses: 
Results of 
measurements 
used in 
calculation 

Calculate can be used to perform a calculation using the other measurement 
results. For example, you can divide the mean pressure by the mean flow. 
When Calculate is selected, the channel selection box disappears. 

 
The result box will read “Off” until a calculation is performed, and then it will 
display the result of the calculation. As you change the selected area, the 
calculation will update automatically. 
To perform a calculation, generate the “Waveform Arithmetic” dialog via 
PC: Ctrl-Click or right mouse click on the Calculate measurement type box 
Mac OS X: click “info” button next to measuremnt type box. 

  

 
Use the pull-down menus to select Sources and Operand. 
Measurements are listed by their position in the measurement display grid (i.e., 
the top left measurement is Row A: Col 1). Only active, available channels 
appear in the Source menu. 
Mac users: Calculation measurement Source operands are updated before 
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Measurement Area Explanation  
a Calculation is performed, which means that Calculations can 
be based on measurements that are located after them in the 
measurement row/column ordering. 

  
 

Also, Calculation measurements can include other Calculation 
measurements as their operands. 
 If a cyclic dependency is introduced, the measurement result 
reads “Error.” 

 When interpolation is being used, a Calculation measurement 
can also be an interpolated value. 

 If either of the operands of a Calculation is interpolated, the 
result will be displayed as an interpolated value (with a light 
purple background). 

PC users: You cannot perform a calculation using the result of another 
calculation, so calculated measurement channels are not 
available in the Source menu. 

The Operand pull-down menu includes: Addition, Subtraction, Multiplication, 
Division, Exponential. 
The Constant entry box is activated when you select “Source: K, constant” and 
it allows you to define the constant value to be used in the calculation. 
To add units to the calculation result, select the Units entry box and define the 
unit’s abbreviation. 
Click OK to see the calculation result in the calculation measurement box. 

Cap_Dim  Capacity Dimension; fractal dimension estimate. 
(Fractals measure the amount of self-similarity in a data set. AcqKnowledge 
offers three alternate estimates for fractal dimension: Cap_Dim, Corr_Dim, and 
Inf_Dim. The estimates will not agree, based on the heuristic and the 
parameters.) 

Corr_Dim   Correlation Dimension; fractal dimension estimate. Always greater than 
capacity if parameters are the same. (See fractals note at Cap_Dim.) 

Correlate Minimum area: 
2 samples 
 
Uses: 
All points of 
selected area 

Correlate provides the Pearson product moment correlation coefficient, r, over 
the selected area and reflects the extent of a linear relationship between two 
data sets: ix  - values of horizontal axis and ( )ixf  - values of a curve 
(vertical axis). 
You can use Correlate to determine whether two ranges of data move 
together. 

Association  Correlation  
Large values with large values Positive correlation 
Small values with large values Negative correlation 
Unrelated Correlation near zero 

The formula for the correlation coefficient is: 

Correlate = 
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Where: 
n—number of samples;  
i—index (i = 1..n); 

ix — values of points at horizontal axis ( 1x – the first point, nx – the last 
point); 

( )ixf - values of points of a curve ( vertical axis). 
Results: 
Returns a dimensionless index that ranges from -1.0 to 1.0 inclusive. 
Units: None 
Sample data file: “ValidateMeasurements.ACQ” 
 Result: -0.74825(for whole wave) and 0.95917 (for first 

four sample points). 
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Measurement Area Explanation  
 
 
 
 
 
 

Delta Minimum area: 
2 samples 
 
Uses: 
Endpoints of 
selected area 

Delta returns the difference between the amplitude values at the endpoints of 
the selected area. 

Delta ( ) ( )1xfxf n −=  
Where: 

( )1xf , ( )nxf —values of a curve at the endpoints of selected area. 
 
 
Results: 
If the data value at the starting location is greater than the data value at the 
ending location of the cursor, then a negative delta will result. Otherwise, a 
positive delta will result. 
Units: Volts 
Sample data file: “ValidateMeasurements.ACQ” 
 Result: -2 Volts (for whole wave). This result shows the 

absolute value of change of amplitude (2) and the minus 
sign means a decrease of amplitude. 

Delta S  Minimum area: 
1 sample 
 
Uses: 
Endpoints of 
selected area 

Delta S returns the difference in sample points between the end and beginning 
of the selected area. 
Results: This calculation will always return a positive result. 
Units: Samples 
 

Delta T(time) 
Delta F 
(frequency) 
Delta X (arbitrary 
unit) 

Minimum area: 
2 samples 
 
Uses: 
Endpoints of 
selected area 

The Delta T/F/X measurement shows the relative distance in horizontal units 
between the endpoints of the selected area. Only one of these three units will 
be displayed in the pop-up menu at a given time, as determined by the 
horizontal scale settings. 

Measurement Horizontal Axis 
Delta T Time 
Delta F Frequency (FFT) 
Delta X Arbitrary units (Histogram Bins) 

The formula for Delta T/F/X is: 

Delta T 1xx n −=  
Where: 

nxx ,1 - values of horizontal axis at the endpoints of selected area. 
Results: 
If the data value at the starting location is greater than the data value at the 
ending location of the cursor, then a negative delta will result. Otherwise, a 
positive delta will result. 

For Delta T measurements with the horizontal axis format set to 
HH:MM:SS. 

 For values less than 60 seconds, you will get a value in 
decimal seconds. 

 For values greater than 60 seconds, you will see an 
HH:MM:SS format value 

(See page X454H137X for details on how to change the horizontal scaling). 
Units:  

Delta T: Seconds (sec.)  Delta X: “arbitrary unit” 
Delta F: Hz 

Sample data file: “ValidateMeasurements.ACQ” 
 Result: 0.12 sec. (for whole wave). 
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Measurement Area Explanation  
Evt_amp 
Mac only 

 Extracts the value of the measurement channel at the times where events are 
defined. The measurment result is unitless. Specify Type, Location, and 
Extract; see page X455H175X for details. 

 The amplitude is always taken from the measurement channel, which may 
be different from the channel on which events are defined. 

Evt_amp can be useful for extracting information such as the average T wave 
height within the selected interval.  

Evt_count  
Mac only 

 Evaluates the number of events within the selected area. The measurement 
result is unitless. Specify Type and Location; see page X456H176X for details. 
 

Evt_loc  
Mac only 

 Extracts information about the times of events. The measurement result uses 
the units of the horizontal axis. Specify Type, Location, and Extract; see page 
X457H176X for details. 

Expression 
Mac only 

 Generates the Expression transformation dialog (page X458H77X) and offers Source 
“MC” Measurement Channel instead of “SC” Selected Channel to build 
recursive formulas, i.e. result of the expression as it was evaluated x samples 
ago. Data within the selected area is not changed. 

Freq (time 
domain only) 
 

It is important 
to note… 

This does not 
compute the 
frequency 
spectra of the 
data. 
To perform a 
spectral 
analysis, use 
the FFT 
function (see 
page X459H257X). 

Minimum area: 
2 samples 
 
Uses: 
Endpoints of 
selected area 

Freq computes the frequency in Hz between the endpoints of the selected 
area by computing the reciprocal of the absolute value of time difference in 
that area. 
The formula for Freq is: 
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Where:  

nxx ,1 - values of horizontal axis at the endpoints of selected area. 
The information provided by this measurement is directly related to the Delta T 
and BPM measurements, and is related to a lesser extent to Delta S 
measurement. That is, if the Delta T interval between two adjacent peaks is 
calculated, the BPM and Freq measurement can be extrapolated.  
If the sampling rate is known, the Delta S can also be derived. 
In the following example, you can see Delta T, Freq and BPM measurements 
for the particular area. The Delta S can also be derived. 

 
Selected area with measurements that describe 

the same interval in different terms. 
Note: It is important to note that this does not compute the frequency spectra 
of the data. To perform a spectra analysis, use the FFT function (described on 
page X460H257X). 
Freq (or frequency) is only available in time domain windows. 
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Measurement Area Explanation  
Results: This calculation will always return a positive result. 
Units: Hz 
Sample data file: “ValidateMeasurements.ACQ” 
 Result: 8.33 Hz (for whole wave). 

Inf_Dim   Information Dimension; fractal dimension estimate. (See fractals note at 
Cap_Dim.) 

Integral Minimum area: 
2 samples 
 
Uses: 
All points of 
selected area 

Integral computes the integral value of the data samples between the 
endpoints of the selected area. This is essentially a running summation of the 
data. 
Integral is expressed in terms of (amplitude units multiplied by horizontal units) 
and calculated using the following formula. 

Integral = ( ) ( )[ ]
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Where: 
n—number of samples; 
i—index (i = 1.n-1); 

1, +ii xx  - values of two neighboring points at horizontal axis ( 1x – the first 

point, nx – the last point); 

( ) ( )1, +ii xfxf  - values of two neighboring points of a curve (vertical 
axis); 
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Xxi - horizontal sample interval; 

1xxX n −=Δ - horizontal distance of increase at horizontal axis. 
The following plot graphically represents the Integral calculation. 

 
The area of the shaded portion is the result. 

Results: The Integral calculation can return a negative value if the selected 
area of the waveform extends below zero. 
Units: Volts—sec. 
Sample data file: “ValidateMeasurements.ACQ” 

Result: 0.300 Volts -sec.(for first 6 sample points) and –
0.155 Volts -sec.(for last 6 sample points—the wave 
below zero). 

Kurtosis   Kurtosis indicates the degree of peakedness in a distribution, e.g. the size of 
the “tails” of the distribution. Distributions that have sharp peaks in their center 
have positive kurtosis; flatter distributions have negative kurtosis. A normal 
distribution has a kurtosis of 0. The following formula is used to extract kurtosis 
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Where from a signal (x) containing n points: 
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Measurement Area Explanation  
Lin_reg Minimum area: 

2 samples 
 
Uses: 
All points of 
selected area 

Linear regression is a better method to calculate the slope when you have 
noisy, erratic data. 

 For advanced modeling options, see Nonlinear modeling on page X461H253X. 
Lin_reg computes the non-standard regression coefficient, which describes the 
unit change in f (x) (vertical axis values) per unit change in x (horizontal axis). 
For the selected area, Lin_reg computes the linear regression of the line drawn 
as a best fit for all selected data points using the following formula: 

Lin_reg = 
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Where: 
n—number of samples;  
i—index (i = 1.n); 

ix — values of points at horizontal axis ( 1x – the first point, nx – the last 
point); 

( )ixf - values of points of a curve ( vertical axis). 
Note: For a single point, Lin_reg computes the linear regression of the line 
drawn between the two samples on either side of the cursor. 
Results: 
If the data value at the starting location is greater than the data value at the 
ending location of the cursor, then a negative delta will result. Otherwise, a 
positive delta will result. 
Units: Volts/sec. 
This value is normally expressed in unit change per second (time rather then 
samples points) since high sampling rates can artificially deflate the value of 
the slope. If the horizontal axis is set to display Frequency or Arbitrary units, 
the slope will be expressed as unit change in corresponding vertical axis 
values (frequency or arbitrary units, respectively). 
Sample data file: “ValidateMeasurements.ACQ” 

Result: 230.00 Volts/sec. (for 1-4 samples) and 
–170.00 Volts/sec. (for samples 4-7). 

Lyapunov   Lyapunov exponent describes the exponential rate of divergence of a system 
when perturbed from its initial conditions. For instance, if the system is started 
from two slightly different locations, this indicates how different their results will 
be with time. Stable experiments have exponents equal to zero. Specify an 
embedding dimension and a time delay; produces a single-valued measure. 
This measure is quite dependent on the amount of data used. 

Max Minimum area: 
1 sample 
 
Uses: 
All points of 
selected area 

Max (maximum) shows the maximum amplitude value of the data samples 
between the endpoints of the selected area. To compare peak heights, select 
each peak—you can easily see the maximum peak values or paste the results 
to the journal. Also, since you can simultaneously obtain measurements for 
different channels, you can easily compare maximum values for different 
channels. 
Note: For a single point, Max shows the amplitude value in this point. 
Units: Volts 

Max T Minimum area: 
1 sample 
 
Uses: 
All points of 
selected area 

Max T shows the time of the data point that represents the maximum value of 
the data samples between the endpoints of the selected area. 
Note: For a single point, Max T shows the time value in this point. 
Units: Seconds 

Mean Minimum area: 
2 samples 
 
Uses: 
All points of 
selected area 

Mean computes the mean amplitude value of the data samples between the 
endpoints of the selected area, according to the formula: 

Mean = ( )∑
=

∗
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i
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Where:  
n—number of samples; 
i—index (i = 1.n); 

ix — values of points at horizontal axis; ( 1x – the first point, nx – the last 
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Measurement Area Explanation  
point); 

( )ixf - values of points of a curve ( vertical axis). 

Units: Volts 
Sample data file: “ValidateMeasurements.ACQ” 

Result: 1.538462 Volts (for whole wave). 
Median Minimum area: 

2 samples 
 
Uses: 
All points of 
selected area 

Median shows the median value from the selected area. 
Note: The median and calculation is processor-intensive and can take a long 
time, so you should only select this measurement option when you are actually 
ready to calculate. Until then, set the measurement to “none.” 
Units: Volts 

Median T Minimum area: 
2 samples 
 
Uses: 
All points of 
selected area 

Median T shows the time of the data point that represents the median value of 
the selected area. 
Note: The median and calculation is processor-intensive and can take a long 
time, so you should only select this measurement option when you are actually 
ready to calculate. Until then, set the measurement to “none.” 
Units: Seconds. 
 
 
 
 

Min Minimum area: 
1 sample 
 
Uses: 
All points of 
selected area 

Min (minimum) shows the minimum amplitude value of the data samples 
between the endpoints of the selected area. 
Note: For a single point, Min shows the amplitude value in this point. 
Units: Volts. 

Min T Minimum area: 
1 sample 
 
Uses: 
All points of 
selected area 

Min T shows the time of the data point that represent the minimum value of the 
data samples between the endpoints of the selected area. 
Note: For a single point, Min T shows the time value in this point. 
Units: Seconds. 
 
 
 
 

Moment  
 

Uses: 
All points of 
selected area 

Central Moment is a general-purpose statistical computation that can be used 
to compute central variance and other higher-order moments of the data within 
the selected area. Specify the order as an integer (generally). The central 
moment is computed using the following formula: 
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Where: 
x—signal; 
n—points;  
m—order. 

Mut_inf   Mutual Information determines how much could probabilistically be known 
about an unknown signal given a known variable. Specify a time delay. 
Produces a single valued result. 

NLM  
Mac only 

 Nonlinear modeling (also called “arbitrary curve fitting“) determines the “best 
fit” model for the selected data of the selected channel. The measurement 
result corresponds to the value of one of the parameters of the best fit. NLM 
can be used to extract Tau (time delay LVP constant) for assessing cardiac 
condition. See page X462H253X for nonlinear modeling details. 
 If a Model Expression uses MMT() syntax to reference a measurement 

and that referenced measurement is linearly interpolated, the results of 
the NLM measurement will also be displayed as being linearly 
interpolated. 

 When combined with the Cycle/Peak Detector (on page X463H270X), the NLM 
measurement can be useful for extracting cycle-by-cycle best fit models 
for an entire waveform. 

None n/a None does not produce a measurement value. It’s useful if you are copying a 
measurement to the clipboard or journal with a window size such that several 
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Measurement Area Explanation  
measurements are shown and you don’t want them all copied. 

P-P Minimum area: 
2 samples 
 
Uses: 
All points of 
selected area 

P-P (peak-to-peak) shows the difference between the maximum amplitude 
value and the minimum amplitude in the selected area. 
Results: The result is always a positive value or zero. 
Units: Volts 
Sample data file: “ValidateMeasurements.ACQ” 

Result: 13 Volts (for whole wave). 
Samples Minimum area: 

1 sample 
 
Uses: 
All points of 
selected area 

Samples shows the exact sample number of the selected waveform at the 
cursor position—the first data point is not displayed, but is plotted at zero. 
See page X464H149X for examples of selected area Samples. 
Note: When an area is selected, the measurement will indicate the sample 

number at the last position of the cursor.  
Units: Samples. 

Skew  Skew is a statistical measure of the degree of asymmetry in a distribution 
(away from normal Gaussian distribution), e.g. if the distribution is weighted 
evenly or trends toward an edge. 

• A normal distribution has a skew of 0. 
• A distribution with a prominent left tail has a negative skew. 
• A distribution with a prominent right tail has a positive skew  

The following formula is used to extract skew: 
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Where a signal (x) contains n points: 
Slope Minimum area: 

2 samples 
 
Uses: 
All points of 
selected area 

Slope computes the non-standard regression coefficient, which describes the 
unit change in f (x) (vertical axis values) per unit change in x (horizontal axis). 
For the selected area, Slope computes the slope of the straight line that 
intersects the endpoints of the selected area, using the formula: 

Slope = 
( ) ( )

1

1

xx
xfxf

n

n

−
−

 

Where: 
( )1xf , ( )nxf —values of a curve at the endpoints of selected area. 

1x , nx - values of horizontal axis at the endpoints of selected area. 
This value is normally expressed in unit change per second (time rather then 
samples points) since high sampling rates can artificially deflate the value of 
the slope. 
Note: Lin_reg (linear regression) is a better method to calculate the slope 
when you have noisy, erratic data. 
For a single point, Slope computes the slope of the line drawn between the two 
samples: the selected sample point and the sample point to its left. 
Results: 
If the data value at the starting location is greater than the data value at the 
ending location of the cursor, a negative delta will result. Otherwise, a positive 
delta will result. 
Units: Volts/sec. (or corresponding to Freq or Arbitrary setting) 
Sample data file: “ValidateMeasurements.ACQ” 

Result: 233.33333 Volts/sec. (for samples 1-4) 
-166.66667 Volts/sec. (for samples 4-7) and 
-16. 66667 Volts/sec. (for whole wave). 
 
 
 

 
Stddev Minimum area: 

2 samples 
 

Stddev computes the standard deviation value of the data samples between 
the endpoints of the selected area. Variance estimates can be calculated by 
squaring the standard deviation value. 
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Measurement Area Explanation  
Uses: 
All points of 
selected area 

The formula used to compute standard deviation is: 

Stddev = ( )∑
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Where: 
n—number of samples;  
i—index (i = 1.n); 

ix — values of points at horizontal axis ( 1x – the first point, nx – the last 
point); 

( )ixf - values of points of a curve ( vertical axis); 
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 - the mean amplitude value of the data samples between 

the endpoints of the selected area. 
Results: The result is always a positive value or zero. 
Units: Volts 
Sample data file: “ValidateMeasurements.ACQ” 

Result: 3.09570 Volts (for samples 1-4), 
1.000 Volts (for samples 10-12). 

Time Minimum area: 
1 samples 
 
Uses: 
All points of 
selected area 

See the X-axis: T measurement for explanation. 

Value Minimum area: 
1 sample 
 
Uses: 
All points of 
selected area 

Value shows the exact amplitude value of the waveform at the cursor position. 
For the selected area, Value indicates the value at the last position of the 
cursor, corresponding to the direction the cursor was moved (the value will be 
the left-most sample point if the cursor was moved from right to left). 
Units: Volts 

X-axis:T/F/X 
(horizontal units) 

Minimum area: 
1 sample 
 
Uses: 
All points of 
selected area 

The X-axis measurement is the exact value of the selected waveform at the 
cursor position, based on the Horizontal Axis setting: 
 Measurement Horizontal Axis Setting Units  

X-axis: T Time Sec. 
X-axis: F Frequency Hz. 
X-axis: X Arbitrary units Arb. units 

For X-axis: T measurements, the time value is relative to the absolute time 
offset, which is the time of the first sample point. 
The X-axis: F measurement applies to frequency domain windows only (such 
as FFT of frequency response plots). The Freq function for time domain 
windows is described on page X465H155X. 
Note: If a range of values is selected; the measurement will indicate the 
horizontal value at the last position of the cursor. 
Results: This calculation will always return a positive result. 
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Markers on Windows/PC 
 This section describes Marker functionality for AcqKnowledge 3.8.1 for Windows/PC only. See 

Events on page X466H164X for Mac OS X functionality. 

 

In many instances it is useful to have the software “note” an 
occurrence or event during an acquisition so it can be referenced later. 
For instance, you may want to note when a treatment began or when 
an external event occurred so you can examine any possible reaction. 
The software places “markers” above the data to record events. 

AcqKnowledge distinguishes between Append Markers and Event Markers, and allows you to pre-program 
and automate each. Markers appear at the top of the graph window, and can be edited, displayed, or hidden 
from view. 
 “Append markers” are automatically inserted each time you record a segment in “Append” mode 
 “Event markers” can be inserted during an acquisition or after recording (off-line) 

You can automatically insert event markers during an acquisition by pressing the F9 key on a PC. This will 
insert a marker at the exact time the key is pressed and will activate the text line entry so you can 
immediately enter a comment to be associated with the marker. Use Marker Preferences to change or add 
function key assignment(s). 
To enter an event marker after recording, click the cursor in the area beneath the marker area. This will insert 
a marker. To add text describing the event, click the cursor in the marker box and key the desired text. 
To view the text associated with a marker, position the selection tool over the marker and click the mouse 
button. 
Marker Tools 

 
Find Activates a standard Find function and searches marker labels to locate matching text. 
Clear Active Event Marker or All Event Markers. 

o It is not possible to clear Append markers from the marker pull-down menu. 
Summary All Markers, Event Markers, or Append Markers. Will paste marker information to the Journal, 

with order, header and label as set on the Preferences > Journal Summary tab. 
Markers Summary: 
Event Markers: 
Marker Index: Time(sec.): Label: 
Event 1: 3.1470 Eyes open, 12:00:00 AM 
Event 2: 24.8080 Eyes closed, 12:00:00 AM 

Show Event Marker or Append Marker. The list of markers is shown in the sub-menu. The menu can 
support 239 markers. 

Preferences  Use to pre-establish marker labels and set function keys for different labels, or format marker 
information for pasting to the Journal. See page X467H162X for details.  

Printing markers 
The markers will be printed when the marker display is enabled. To keep the markers from being printed, hide 
the markers before printing. If the display is compressed, marker labels and/or indicators will be layered when 
printed to prevent overlapped text. 
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Marker Preferences 

 
Marker Preferences has three tabs of options to auto-label markers, and one to format marker data 
summarized to the Journal  
Selecting the Display > Preferences > Markers or “preferences form the Marker tools will generate the 
Marker Preferences dialog. There are four tab options in the Marker Preferences dialog: Append Markers, 
Events Markers (Fixed), Event Markers (Sequential), and Journal Summary. 
The software generates three types of markers: 

1. Append Markers appear as triangles located above the marker label region and will be automatically 
inserted at the start of each recording segment in the Append acquisition mode. Append markers are 
blue when active.  

2. Automatic Event Markers appear as green inverted triangles located below the marker label region 
and use labels that are generated automatically when the assigned function key is pressed. Event 
markers are yellow when active. 

o You can pre-establish Automatic Event marker labels as sequential or fixed. 
3. Manual Event Markers appear as inverted triangles with a line above them and are located below the 

marker label region (in the same region as the Automatic Event Markers). Event markers are yellow 
when active. 

System Time Stamp 
Tabs include the option to Automatically add a system time stamp to Append Marker labels and 
Event Marker labels generated during an acquisition. 
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Pre-establish Labels 
Append Markers - Automatically generate the Append Marker labels as Segment 1, Segment 2, 
etc., or generate labels from a pre-established list that will be applied sequentially each time the 
recording continues. 

 
Automatic Event Marker Labels - Generate Sequential or Fixed labels. 

• Sequential - generate labels from a pre-established that will be applied sequentially each time 
the F9 key is pressed during a recording. 

• Fixed - generate labels based on pre-established function key assignment that will be applied 
according to the function key pressed (different function keys have different labels). 

  
Journal Summary 

You control how the marker summary is presented in the Journal. Choose to separate or combine 
Append and Event marker summaries, show or hide the header information, and sort by time or label. 

 
For Journal details, see page X468H48 X; for Journal Preferences, see page X469H312X. 
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Events (Markers) on Mac OS X 

  

 

Event Toolbar Event Insertion Event Control 

Event (Marker) Overview 
 This section describes Event (Marker) functionality for AcqKnowledge 3.9 for Macintosh. See Markers 

on page X470H161X for Windows/PC functionality. 
For detailed analysis, it can be useful for waveforms to have extra information associated with them. This 
information might include waveform boundaries from ECG analyzers, spike classifications from a spike 
sorter, heartbeat classification from a PhysioBank file, or even detailed user notes. AcqKnowledge 3.9 for 
Macintosh uses “event” functionality to store and manage this information. 
An event is a piece of information associated with a specific time in a waveform. An event can capture points 
of interest within a file (i.e. subject moved, dose added) or on a particular channel (i.e. T-wave onset). Once 
events are marked in the file, AcqKnowledge can use the event information for analysis, including 
measurement (page X471H178X) and cycle detection (page X472H270X). 

 An event has the following pieces of information associated with it: 
o event type 
o sample location: the time position in hardware samples where the event is defined. 
o channel: the channel for which the event is relevant. 

o Some events, such as the time of the start of an appended segment, may be relevant to all of 
the channels of a graph—these are “Global” events. 

o label: a string of text that can be entered either automatically or by the user to provide more 
information about an event. 

 Different event types can be entered automatically or manually. These different event types allow 
events to be filtered and also support analysis routines that key off of these events. 

o Event insertion tool 
o Set Up Hotkeys (see page X473H166X) to manually insert events during acquisitions 
o Copy/paste measurements and Copy/paste wave data operations can insert events at the 

selection boundaries; choose “Mark with events” under Preferences (see page X474H166X) 
o Cycle Detector Output Events option (see page X475H270X) 
o Contextual menu in Event region 

 
o Specialized Analysis (see page X476H333X) to automatically insert markers according to complex 

analysis algorithms 
 
Event Toolbar  

 
The event toolbar displays global events and provides a quick editing area for event descriptions. The right 
button toggles visibility of the Event Palette for detailed control (see page X477H168X). The palette will “refresh” 



Part C — Analysis Functions 165 

 

when events change the event configuration, such as horizontal scrolling, scale changes, changes in the 
selected event via clicking in the graph window, editing of the event label by using the event bar, 
transformations that define new events for the graph, waveform editing operations, and additions of new 
events by clicking the event bar at the top of the graph window. 
 
 
Event Tooltips 
If events are being displayed within the plotting area and tooltips are enabled, a tooltip will be associated with 
every event in the plotting area. The tooltip includes the event type description, the user-defined label (if 
present), the time location of the event, and the amplitude of the waveform at the event location. While this 
information can be drawn directly on the graph, event tooltips assist in browsing event information when the 
screen becomes too crowded and there is not enough room to display all of the times, amplitudes, and labels. 
Event tooltips are displayed under the event icon. 

 If the event is being plotted directly on the waveform, this will be the point on the waveform 
associated with the event. 

 If there is an indicator and the event icon is at the top of the indicator, the tooltip will be anchored at 
the top of the indicator. 

 If the events are being plotted at the top of each track, the tooltip is anchored at the top of the plotting 
area directly underneath the event icon. 

Event tooltips will not be displayed if tooltips are disabled, if events are only being displayed in the marker 
bar at the top of the screen, if X/Y mode is in use, or if events are not currently visible. 
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Event Preferences 

  
Display > Preferences 

Use the “Event summary options” section of the Preferences dialog to set options for pasting summaries of 
events into the journal 
 List events 

Sequential listed in order of increasing time 
Sorted by type sorted by event type descriptions first 
Sorted by channel grouped based upon where they are defined (Global events appear first, 

followed by groups for each individual channel). 
 Include only events visible on the screen 

Determine if the summary is generated for all of the events that are in a graph, or only for those 
events that are currently visible on the screen. If there are thousands of events in a file, this feature 
allows the list to be pared down to those of interest. 

Event summary options will be saved with the graph if the graph has a graph journal, and can be pasted into 
the journal using “Summary in Journal” Event Palette Actions command (see page X478H171X). 
Mark…with events 
Selection events and time stamp events can be automatically inserted when Paste Measurements to Journal 
and/or Paste Wave Data to Journal are activated using the Journal Preference settings. 
Choose “Mark selection with events in graph” from the “Other options” box to create events at data selection 
bounds. This will include selection events (selection begin and selection end) for global events when 
measurements or waveform data are pasted. When selected, measurement pasting will result in an automatic 
execution of the “Mark Selection” feature manually accessible from the Event Palette. 

 “Include timestamp” will include time and date stamps for when the paste ocurred; this timestamp will 
match any timestamp pasted into the journal. When selected, any selection events added to the graph 
will have their labels set to match the timestamp. 

 “Include Time values” will include the time value (relative to start = 0) for the paste. 
Combine these options to retain enough information to reproduce measurement results and correlate 
measurement results with specific areas of the graph; this helps verify the accuracy of measurement results 
made through manually constructed graph selections. 
Both paste event setting options are off by default. Any change to these settings will be retained within a 
saved graph file and will become the default for newly constructed graphs. 
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Event Hotkey Setup 

 

Events of different types can be inserted during acquisition, 
whether or not events are visible in the graph. When a 
hotkey is pressed during acquisition, an event will be 
inserted into the graph at the end of the most recently 
acquired data. Each hotkey can have a different 
configuration, adjustable through a dialog accessible via 
the “MP1#0 > Set up Event Hotkeys...” menu item: 

Hotkey Assign Escape or F1 through F9. When a different hotkey is chosen, the other controls of the 
dialog change to reflect the configuration of the new hotkey. 

Event type Lists the standard hierarchical menu of available event types; Types are detailed on page X479H172X. 
Choosing a new type from the pull-down menu will change the type of event inserted when 
the hotkey is pressed during acquisitions. 

Channel Contains a “Global” entry and all of the channels (analog, digital, or calculation) set to 
“Acquire” in Set up Channels. 
 “Global” will define global events drawn in the event bar above the graph data 
 Choosing a new channel from this menu will cause events to be inserted on the 

appropriate channel of the graph when the hotkey is pressed. 
Label Edit field for label text and toggle optional inclusion of time stamp and/or date stamp. Stamps 

correspond to the time of the system clock when the key was pressed, that is, the time of the 
event insertion in “real clock time.” 
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Event Palette 

  

 
 

 

The event palette is a floating window that 
provides a quick summary of events for the 
top most graph and can used to examine, 
search, and modify events. Events can be 
extracted in a time range for a specific 
event type and specific channels. 
There is only one visible event palette for 
the entire application. The palette consists 
of four sections: event list, selected event, 
display, and event actions. Each section 
can be shown or hidden by toggling the 
disclosure button next to its title. 

 Event List, see page X480H168X. 
 Selected event, see page X481H168 X.X482HXX483HX 
 Display, see page X484H169X. 
 Actions, see page X485H171X. 

o See the Event Journal 
Summary enhancements. 

 

Event List 

 

The event list provides an expandable, scrollable, 
hierarchical view of the events in the topmost graph. 
Events are grouped by their channel on the top level. 
The event list has three columns of information: 
 Events: the readable type for each event 
 Location (Time): the time location for each event 
 Label: the user defined description for the event. 

Sort the contents in ascending or descending order on each column by clicking the column header. Events and 
Description will sort in standard alphabetical order, Location will sort based on the numerical sample location 
of each event. 
Select a single event from the event list by clicking on a single event. The event will be selected in the graph 
window and made visible if it is not currently displayed. 
List visible events only toggles the checkbox to switch between the two display modes. 
 When enabled, the event list will display only those events that are being displayed on the plotted 

portions of the graph. As the user navigates through the graph with the scrollbars, horizontal scale, or 
other means of changing the amount of visible data, the event list will continually refresh to contain the 
new set of visible events. 

 When disabled, the event list will display all of the events for the entire graph. This can allow for easier 
navigation through graphs with hundreds of events, such as PhysioBank files. 

Selected Event 
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Event type options are 
detailed on page X486H172X. 

When a single event is selected, the type, channel (or “General” for global events), user-defined label, and 
location of the event will be filled in and can be edited. The controls can display information about only one 
event at a time; if no event is selected, the controls will be grayed out. 
Event Location 
“Location defines the position where the selected event occurs, relative to the first sample in the file. To 
change the location of an event, change the position entered in the Location box. Precision matches the 
horizontal axis setting. 
Events may also be repositioned using the mouse. Option-click the event icon in the graph and hold down the 
mouse while dragging; the event will be repositioned at the horizontal position where the mouse button is 
released. 
 

Display 

  
 Event display location Event display detail 
Display controls determine the location and detail of events to be drawn in the frontmost graph. 

 Location—Choose one of the five display methods (described on page X487H170X). 
 Detail—the three checkboxes to establish how much information to include with events. 
 Indicator—Set the slider to shorten or lengthen the indicator line. This option is only active if the 

display mode is “On waveform, with indicator” or “At top, with indicator.” 
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Location & Display Description 

In event bar 

 

Event icons are displayed in the global marker bar located on top of the plot area in the 
graph window. This does not allow for distinguishing what channel a specific event 
belongs to. 

 To select the event, click the icon in the marker bar. 

On waveform 

 

Event icons are displayed above or below the actual sample in the source channel 
corresponding to the location of the event. 

 To select the event, click the event icon on top of the waveform. 

Top of plot 

 

Event icons are displayed at the top of the channel track, either on top of the grid or in 
a channel-specific marker bar. 

 To select the event, click the icon at the top of the channel track. 

On waveform, with 
indicators 

 

Event icons are displayed above the data with a vertical line of configurable length 
running through the data sample of the source channel at the event’s location. 

 To select the event, click the event icon or the indicator line. 

Top of plot, with 
indicators 

 
 

Event icons are displayed at the top of the channel track with a vertical line of 
configurable length running through the data sample of the source channel at the 
event’s location. 

 To select the event, click the event icon or the indicator line. 

Detail When an event is being plotted within a graph, either on the top of a channel or 
floating above the data, the event's location, description, and amplitude of the 
waveform at that location can optionally be displayed along with the event icon. 
Plotting of additional information can be used for graphical annotations on the data 
and for clarifying event location for hardcopy or presentation. 
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Actions 

  
Actions Button Description 

Find It is easy to create many more events then one can easily scroll through and locate 
in a list. Find controls the automatic location of events based on established search 
criteria. 
Click on the Find button to generate the Event search criteria dialog, and then 
combine or restrict information to define desired events: event type, specific 
channel location, or label search. 
Click “Find First” to search for the first event in the graph that matches the 
criteria. If found, the event will be selected and made visible in the graph window. 

Find Next Finds the next single event that matches the established search criteria until no 
remaining events match the search criteria. 

Cut Selected Event Active only when an event is selected, removes the selected event from the graph. 

Clear 
Clear all 

Generates a search criteria dialog (identical to the Find dialog) and removes all 
matching events from the graph. 

Summarize in 
Journal 

Displays a sheet with controls that affect which events are included in the 
summary. 
Events can be filtered by visibility on the screen. Creates a textual summary of all 
of the events in the journal. 
 See “Event Preferences” on page X488H166X for more information about 

modifications to the traditional marker summary. 

Event Journal Summary Enhancements 

 
Mac only—events to be included in the summary can be filtered using the 
same criteria as Find... in the Event Palette. By adding the ability to 
summarize only events matching specific criteria, textual reports of 
arrhythmias or other infrequently occuring events of interest can be generated 
with ease. 

When “Summarize in Journal” is clicked on the event palette, a sheet will be 
displayed with controls that affect which events are included in the summary. 
If there is no journal for the current graph, you will be prompted to create a 
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journal. 

 
Mark Selection Defines two new Global events in the graph at the precise time locations of the 

currently selected area (the highlighted wave data section). If there is no selection 
in the graph, this button has no effect. The events that are inserted will have the 
“Selection Begin” and “Selection End” event types. 
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Event Type Options 
Event Types are pre-defined options for assigning event information. The Event Type is for marking purposes 
only and does not imply any analysis has or will occur for the event (unless Specialized Analysis was 
performed, see page X489H333X). 
Once Event Types are defined, some analysis functions can be automated, including measurement (page X490H178X) 
and cycle detection (page X491H270X). 

Event classifications: 

 

Event classifications group similar event types together into a logical category. 
Event classifications present event types in a hierarchical fashion and allow other 
event classifications to be contained within them. 
For example, the “Hemodynamic”event classification includes a “Beats” sub-
class with pre-ventricular contraction and escape beat event types. 

Event type Classification 
Global This is the same as ‘untyped’ markers from AcqKnowledge 3.6 or earlier. Unrecognized event 

types will be classified as global events. 

Append Automatically inserted by the program on append operations. 

Notes Annotation event to add notes on the data. 

User-defined Hotkey insertion for user-specific events; 9 types can be inserted via the keyboard during 
acquisition. 

Pharmacology Basic pharmacological events: baseline, washing, and dosing. 

Waveform Edits Automatically inserted by the program on cut or paste operations in a graph file. The description 
consists of the edit operation performed and a timestamp. 
Insertion of waveform edit events is off by default, but can be turned on for GLP purposes. 

Selections Used to mark boundaries of selected areas. 
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Classification Pre-defined Event Type Options 

Default “Esc” key inserts global event. 

General Waveform onset or end Maximum and minimun 
Change in signal quality or rhythm Reset  
Recovery Append 

Hemodynamic 
> Beats 

Normal Nodal premature 
Paced Supraventricular premature 
Fusion of paced and normal Premature ventricular contraction 
Unclassifiable R-on-T premature ventricular contraction 
Left bundle branch block Fusion of ventricular and normal 
Right bundle branch block Atrial escape 
Bundle branch block Nodal escape 
Atrial premature Supraventricular escape 
Aberrated atrial premature Ventricular escape 

Hemodynamic 
> Blood Pressure 

Systole End diastolic pressure 
Diastole 

Hemodynamic 
> ECG Complexes 
 

QRS onset, peak, and end U-wave peak 
T-wave onset, peak, and end PQ junction  
P-wave onset, peak, and end J-point  
Q-wave peak ST segment change  
S-wave peak T-wave change  

Hemodynamic 
> Impedance 

A-point  O-point  
B-point  X-point  
C-point Y-point 

Hemodynamic 
> Monophasic AP 

Plateau  Upstroke 

Hemodynamic 
> Other 

Start of ventricular flutter Pacemaker artifact 
Ventricular flutter wave Isolated QRS-like artifact 
End of ventricular flutter Non-conducted P wave 

Notes Arrow—short, medium, or long Star 
Flag 

Pharmacology Baseline Wash 
Dose 

User-defined User Type 1-9 

Waveform Edits Cut Paste end 
Paste begin  

Selections Selection begin Selection end 

 
Event Measurements  
Measurements are a quick way to extract information from a graph. Three measurements extract information 
from events. When combined with the Cycle/Peak Detector (page X492H270X), they are also powerful data reduction 
tools. These event measurements can provide quick summaries of event information, compute mean intervals 
between event types, and detail other operations. 

 evt_ampl Event Amplitude Measurement (see below) 
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 evt_count Event Count Measurement (see page X493H176 X) 
 evt_loc Event Location Measurement (see page X494H176X) 

 
Event Amplitude Measurement 

 

evt_amp Extracts measurement results where events 
are defined. Note that the amplitude is always taken from 
the measurement channel, which may be different from the 
channel on which the events are defined. Useful for 
extracting information such as the average T wave height 
within the selected interval. The measurement result is 
displayed without units (matching Value and other 
amplitude events). 
Select Event Amplitude or click the measurement info 
button to generate the settings dialog. 

Event Type Determines the type of events that will be processed; Types are detailed on page X495H172X. 
Location Determines where the processed events need to be defined. The menu options are: 

 Measurement channel only—Only extracts amplitude values for events that are defined on 
the channel specified in the measurement channel pull-down menu. Global events and other 
channel events are not included. 

 Global events only—Only extracts amplitude values for events that are defined as global 
events appearing in the marker bar; changing the measurement channel will not affect the 
measurement result. Channel events are not included. 

 Anywhere—Extracts amplitude values for events defined on any channel and also global 
events; changing the measurement channel will not affect the result 

Extract Determines what processing will be performed on the amplitude values extracted from events 
that match the Type and Location settings. The processing options are: 
 Amplitude at first event only—The value of the measurement channel at the time of the 

first matching event in the selected area. 
 Amplitude at last event only—The value of the measurement channel at the time of the 

final matching event in the selected area. 
 Sum of amplitudes at all events—Computes the sum of the value of the measurement 

channel from each matching event within the selected area. 
 Mean amplitude from all events—Computes the average amplitude value of the 

measurement channel from all of the event locations within the selected area. 
 Mac AcqKnowledge 3.9.2 and later—Minimum amplitude from all events  
 Mac AcqKnowledge 3.9.2 and later—Maximum amplitude from all events  

If there are no matching events of the selected type in the selection, the measurement result will be zero. 
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Event Count Measurement 

 

evt_count Evaluates the number of events within the 
selected area. The measurement result is unitless. 
Select Event Count or click the measurement info button to 
generate the settings dialog. 

Event Type Determines the type of events that will be counted; Types are detailed on page X496H172X. 
Location Determines where the counted events need to be defined: the pull-down menu options are: 

 Measurement channel only—Only includes events that are defined on the channel 
specified in the measurement channel pull-down menu; global events and other channel 
events are not included. 

 Global events only—Only includes events that are defined as global events appearing in 
the marker bar; channel events are not included. Changing the measurement channel will 
not affect the measurement result. 

 Anywhere—Includes events defined on any channel and also global events. Changing the 
measurement channel will not affect the measurement result. 

If there are no matching events of the selected type in the selection, the measurement result will be zero. 
 
Event Location Measurement 

 

evt_loc Extracts information about the times of events. 
The measurement result will take on the units of the 
horizontal axis; if specific units were set for time or 
frequency via Preferences, those units will be used. 
Select Event Location or click the measurement info button 
to generate the settings dialog. 

Event Type Determines the type of events that will be processed; Types are detailed on page X497H172X. 
Location Determines where the processed events need to be defined. The menu options are: 

 Measurement channel only—Only extracts the time of events that are defined on the 
channel specified in the measurement channel pull-down menu; global events and other 
channel events are not included. 

 Global events only—Only extracts the time of events that are defined as global events 
appearing in the marker bar; channel events are not included. Changing the measurement 
channel will not affect the measurement result. 

 Anywhere—Extracts the time of events defined on any channel and also global events. 
Changing the measurement channel will not affect the measurement result 

Extract Determines what will be extracted from events that match the Type and Location settings: 
 First event location only—The measurement will equal the time at which the first matching 

event in the selected area is defined. 
 Last event location only—The measurement will equal the time at which the final event 

within the selected area is defined. 
 Sum of all event locations—The times at which all matching events are defined are added 

together to produce the measurement result. This sum of times can be combined with Event 
Count measurements to compute average intervals over the selected area. 

If there are no matching events of the selected type in the selection, the measurement result will be zero. 
 
Printing Events 
When a graph is printed and events are displayed onscreen for the graph, event icons will print as they are 
displayed. Event icons will be scaled, depending on the printer's DPI, to be proportional to the vertical scale 
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plotted on the screen. If events are located at linearly interpolated positions, event icons will be dimmed on 
the printout (see the Variable Sample Rate section). 

Event display setting Printed result 

Global events Global events are drawn above and outside of the data plotting rectangle in the 
printout, corresponding to the marker printing position of AcqKnowledge 3.7 
and earlier versions.  

In event bar All events are drawn above the data area of the printout. Only labels may be 
drawn with the events. 

Top of plot or 
Top of plot, with 
indicator 

Channel-specific events are drawn at the top edge of their channel’s track. No 
indicator lines are drawn. Depending on the display settings of the graph, the 
event label, amplitude of waveform at the event location, and Time of the event 
may be printed below the event icon  

On waveform or 
On waveform, with 
indicator 

Channel-specific events are drawn immediately above the position of the 
waveform sample at their location and will appear to be printed immediately 
above the data of the waveform. No indicator lines are drawn. The vertical 
printing position of an event icon will be identical for “On waveform” and “On 
waveform, with indicator” displays. Depending on the display settings of the 
graph, the event label, amplitude of the waveform at the event location, and time 
of the event may be printed above the event icon. 

“Draw vertical divider at event locations” option in the Print Setup dialog. 
 Enabled: draws a dashed vertical line at the precise time location of each event. Vertical divider lines for 

the event type will extend  
Global Through all channels of data 
In event bar Through all channels of data 
Top of plot From the top to the bottom of the relevant channel track 
On waveform From the top to the bottom of the relevant channel track 

 Disabled: prints only the event icon, label, amplitude, and time. No indicator lines will be printed for the 
event display. The vertical divider can be used in place of indicator line drawing. 

 
Event Selection 
Individual events can be selected according to click locations.  
When an event is selected, the event icon will be drawn based on the graphic type: 

 Specific “selected” graphic—the selected graphic is drawn or if none, an inverted global graphic. 
 No associated graphics—the global event graphic will be used. 

 
Events and Graph Selections 
When an event on a waveform plot occurs within a selected area of the graph, the event icon and indicator 
line (if present) will be inverted along with the grid, background, and wavedata. Event types that don't have a 
selected graphic will appear as global events if the events are selected events and they are contained in an I-
beam selection. 



178 AcqKnowledge Software Guide 

Visit the online support center at www.biopac.com 

Events and Waveform Editing 
Waveform editing will adjust event locations for channel-specific events. Waveform editing will never alter 
the time values for Global events (not associated with any specific channel, such as append events). 
Copy  When a portion of a waveform is copied the channel events will also be copied to the clipboard.  
Cut When a portion of a waveform is cut, any channel events within that selected area will be removed 

and channel events to the right of the removed area will be shifted to the left. 
 If waveform editing event insertion is active, a waveform edit event will be inserted at the 

location of the edit operation indicating a “Cut” operation in its description. 
Paste When the waveform is pasted from the clipboard, the channel events will appear at their same 

locations and any channel events to the right of the end of the pasted segment will be shifted by the 
length of the pasted segment. 
 If waveform event insertion is active, a waveform event marker will be inserted at the beginning 

and at the end of the pasted segment. 
Constructing Graph Selections from Events 
Graph selections can be defined from events (in addition to the I-beam tool). Holding down the 
Command/Open-Apple key while double-clicking an event icon in the graph window will place a cursor at 
the event location; this is a zero-width selection, equivalent to single-clicking with the I-beam tool without 
dragging. 
 To create a graph selection from events, hold down the Command key and select an event by clicking on 

the event icon in the graph window or its entry in the event list. 
 To align the boundaries of the graph selection with the time of the previously selected event location and 

the time of the newly selected event, hold the Command key when selecting the new event. 
 To make a graph selection match the time between two events, click once to select the first event, hold 

down the Command key, click again to select the second event. On this second click, the selected area of 
the graph will change to align with the two events. 

Event Plotting and Variable Sampling Rate 
Event positions are defined in terms of the hardware sampling rate. The Variable Sampling Rate feature can 
generate waveforms with a sampling rate lower than the hardware sampling rate. Through explicit event 
definition, waveform downsampling, or other operations, events on a downsampled channel may not align 
with an actual waveform sample, but rather occur at a hardware sample position in between waveform 
samples. These events will be drawn using linear interpolation when applicable, and only if the waveform is 
being drawn in line plot mode. In step plot and dot plot modes, regular event drawing routines will be used 
with the vertical position and amplitude of the nearest waveform sample to the event’s left. 
When an event is to be drawn on an intermediate position on a waveform, the linearly interpolated value will 
be calculated for the hardware sample location. The interpolated value will be derived from the closest 
waveform sample to the left and to the right. The vertical position on the waveform of the marker and 
indicator line will match the vertical position of the linearly interpolated sample amplitude. This will place it 
immediately above the line connecting the two waveform samples on screen. 
If an event is being drawn using linear interpolation 
 Event icons will be dimmed, regardless of their display position (on waveform or top of the plot). 
 Indicator lines will be drawn on the waveform at a linearly interpolated position and the indicator line will 

be a gray dashed line instead of a solid black line. (Indicator lines are never printed.) 
 Amplitude labels, if included with the event, will correspond to the linearly interpolated amplitude at the 

event location and the linearly interpolated amplitude will be drawn in italicized text. 
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Grids on the PC 
Grid functionality varies between PC and Macintosh. See page X498H183X for Grids on the Macintosh. 

Grid superimposes a set of horizontal and vertical lines on the 
graph window. The grid is designed to allow for easy 
measurements, since the grid lines correspond to horizontal and 
vertical scale divisions.  

To activate a grid display, click on the  icon in the toolbar or 
select Display > Show > Grids. 

To include minor grid lines in the display, use Ctrl-  or select 
Display> Show> Grid Options and check the “Show minor grid” 
box. 
The horizontal scale grid is always four vertical lines, whether 
the horizontal scale is set to represent time, frequency or an 
arbitrary amplitude value. 

 

Grid Display Off Grid Display On (unlocked) 

The grid can be locked (analysis, printing) or unlocked (visual aid), as checked in the Grid Options dialog 
(Display > Show > Grid Options). 

Unlocked Grid with Scale increased 2x Locked Grid with Scale increased 2x 

You are encouraged to experiment with grid settings to familiarize 
yourself with the effect each option has on the data display. 
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Unlocked Grids 
Unlocked grids are more of a visual aid than an analysis tool. 
Set the lock status in the “Grid Options” dialog (Display > Show > Grid Options). 
Unlocked grids help you view the data display on the monitor. The unlocked grid setting displays four grid 
divisions across the horizontal and vertical axes, and will generate interval numbers as needed to match the 
zoom factor.  

 Horizontal grid: The grid always cuts the horizontal scale into four segments (using four vertical grid 
lines), regardless of the lower scale (axis) setting, which can be set to represent time, frequency, or an 
arbitrary amplitude value. 

 Vertical grid: In Chart mode, the unlocked grid cuts the vertical scale of each track into four sections 
(using four horizontal grid lines per waveform channel). In Scope mode or X/Y mode, the unlocked 
grid cuts the vertical scale into four sections (four horizontal grid lines across the graph).  

Beware!  Although the unlocked grid will be retained if the waveform is printed, saved as a graphic 
image (WMF or PICT) or copied to the clipboard, the nature of the grid changes. When a graph 
is printed, saved, or pasted, AcqKnowledge will dynamically adjust the number of vertical 
divisions. In effect, this will “round” the vertical scale value so that anywhere from two to nine 
lines are displayed. Although the number of divisions changes, the process does not affect the 
nature of the data, only the scale used to plot it. 

Locked Grids 
Locked grids help more with analysis and printing. 

 Macintosh displays a lock state icon on horizontal and vertical scales. 
Set the lock status in the “Grid Options” dialog (Display > Show > Grid Options). 
The locked grid setting locks the grid to the data for all functions. It’s easy to set the grid interval using 
locked grids. Interval parameters (start/end or middle point/range) for the horizontal and vertical scales are 
determined in the Scale dialogs. 

 The Scale dialogs change when grid lines are locked. See page X499H137X for details on Horizontal Scale 
and page X500H139X for details on Vertical Scale. 
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Using the Scale and Print Options on a locked grid, you can very closely match chart recorder output: 

 

 
 
Note:  Standard clinical grids use major grid 

divisions of .5 mV vertically and .2 sec. 
horizontally. 
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Grid Options on the PC 

  
To control the style and functionality of the grid display, select Display > Show > Grid Options. The Grid 
Options control grid format (line type, style, width and color), grid lock, and grid adjustment. 

Major grid lines  Use the pull-down menus to set the major grid line style, width and color. A sample 
of the grid line settings is generated within the dialog. 

Minor grid lines  Check whether or not to “Show minor division” grid lines, and set the minor grid line 
style, width and color. A sample of the grid line settings is generated within the 
dialog. 

Lock grid lines  Check this option to lock the grid to the data for all functions. Locking grid lines can 
be useful for analysis and printing. 

•  See page X501H180X for details on locked grids. 
• The Scale dialogs change when grid lines are locked. See page X502H137X for 

details on Horizontal Scale and page X503H139X for details on Vertical Scale. 
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Grid functionality varies between PC and Macintosh. See page X504H179X for Grids on the PC. 
Grids on the Macintosh 
You can customize the grid behind the waveforms displayed in graph windows in a number of ways. 

 
Grid Lock/Unlock 
Each scale has a small padlock in the lower right hand corner that displays the current state of the grid lock 
for that axis and channel. Click the padlock to change the lock state. 

  Unlocked grid—the number of grid lines and their pixel spacing on screen is kept constant through 
zoom and scaling operations 

  Locked grid—the grid lines themselves are maintained at constant values through zoom operations, 
e.g. a grid line which is located at .753 volts when the grid is locked will continue to be located at 
.753 volts regardless of changes in scale. 

Grids can be locked and unlocked on 
individual channels.  

 The lock for the horizontal axis is shared 
by all channels. 

 The vertical scale can be locked and 
unlocked independently. 

The lock state of the grid can also be changed 
through the axis dialogs displayed when the 
mouse is clicked on the axis scale values in the 
graph window. 

  Click the “Lock units/div” checkboxes. 
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Grid Scaling 
When the grid is locked, the scaling factors controlling how much data is visible on the screen (the distance 
between consecutive major lines of the grid and a fixed location for one of the lines of the grid) are specified 
differently. When the grid is unlocked, these scaling factors do not affect the grid. 
The  button in the axis setup dialogs is activated when the grid is locked. Click it to generate 
a dialog that allows you to specify the scaling factors and whether or not to “Show minor divisions” on that 
grid display. Changing these values only affects the grid display, not how the waveform is scaled. 

   
 Horizontally: the scaling factors are specified in how many seconds of data should be visible on the 

screen (Major division) and the time offset of the left hand side of the display (First grid line).  
 Vertically: the total range of vertical units displayed per track is specified (Major division) along with 

the first value that should be displayed (First grid line). 
 
Adjust Grid Spacing 
To modify the horizontal and/or vertical grid spacing, choose “Display > Adjust grid spacing.” This will 
generate a dialog for you to modify the locked axes of the selected waveform. 

 This menu item functions identically to holding down the “Option” key and clicking the selected 
waveform when the grid tool is active. 
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Grid Tool 
The Grid Tool allows divisions of the grid to be specified with the mouse. This tool has four states: 

  Inactive The cursor changes to a circle with a line running through it. The grid 
cannot be adjusted since both the horizontal and vertical axes are unlocked. 

  Horizontal axis locked The cursor changes to a horizontal line. A mouse click and drag will change 
the location of the horizontal lines of the grid. 

   Vertical axis locked The cursor changes to a vertical line. The tool can be used to adjust the 
vertical spacing of the grid. 

  Both axes locked The cursor changes to a crosshair. The rectangle of a full grid division can 
be drawn over the data. Adjust the spacing of locked grid lines underneath 
the waveform. 

If the “Option” key is held down for the Grid Tool in any of the active modes, an ellipsis will 
appear under the cursor. After a mouse click or drag, a Grid Settings dialog will be generated. 
This dialog is functionally similar to the grid dialogs accessible via the axis settings dialogs. 

 Based on lock status, the dialog will allow you to adjust Horizontal, Vertical or combined settings. 
 The values displayed in the dialog correspond to the grid ranges that were just drawn out on the screen 

with the grid tool if a mouse drag occurred. 
 If the mouse was simply clicked, the current grid settings are displayed. 
 This dialog allows the grid drawn out with the grid tool to be made more precise. 

 
Grid Reset 
To return to the original grid, choose “Display > Reset grid.”  
This will reconstruct the default, unlocked grid of four divisions per screen with solid light gray grid lines. 
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Grid Options 
The major and minor grid lines can be further customized with different colors and dashing styles. These are 
modified under the dialog generated via Display > Show > Grid options… 

 
Line color Click the color well to generate a color chooser. 

 
Line width Adjust the corresponding slider. 
Dash style Select a style (solid or broken) from the pop-up menu. 
Dash length Adjust the corresponding slider (for any dash mode that is not a solid line). 
Spacing Adjust the corresponding slider (for any dash mode that is not a solid line). 
# of Divisions Enter a value in the text field to set the maximum number of minor grid lines 

to be displayed in a single major grid division. 
To undo your selections and return to the original grid, choose “Display > Reset grid.” This will reconstruct 
the default, unlocked grid of four divisions per screen with solid light gray grid lines. 
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Chapter 10 File menu commands 
Overview 

  
Most of the items in the File menu are standard menu items and follow the standard Windows conventions 
(for MPWSW) or Macintosh conventions (for MPWS). By default, all files are created and saved in the 
AcqKnowledge file format, a proprietary format used to store binary data. Data can be read in from either text 
files or AcqKnowledge files, and can be saved in text, graphic, or binary format. As a rule, storing data in the 
AcqKnowledge format saves information in the most compact format possible and takes up less disk space 
than other file formats. In most cases, you will probably be working with graph windows and saving data in 
the AcqKnowledge format. 
AcqKnowledge also supports an online journal that can be used to store waveform data (in numeric format) or 
to make notations and comments in a text file. 
New 

  
New Graph 

In almost all cases, you will need to create a new 
graph window before beginning an acquisition so 
that the data may be displayed on the screen. To 
create a new file, choose New from the File menu. 
When a new graph window is created you should 
see the following: 
You can modify any of the window parameters, 
including horizontal scale, vertical scale, window 
size and position. In addition, you can also set the 
acquisition parameters for sampling rate, number of 
channels, and acquisition length. These settings 
take effect once an acquisition begins. 

 
 
New > Data View 

Creates a new Data View for the active (frontmost) graph, and names the new window “Data View of 
‘Filename’”. . For Data View details, see page X505H35X. 



188 AcqKnowledge Software Guide 

Visit the online support center at www.biopac.com 

 
New > Graph-specific Journal 

Mac OS X only—Creates a graph-specific journal; see page X506H48X for details. 
 
New > Independent Journal 

Mac OS X only—Creates an independent journal; see page X507H48X for details. 
 
New > Batch Acquisition 

Mac OS X only—Use the Batch Acquisition feature to configure advanced experimental setups and 
acquire data from a sequence of templates. Each template in the Batch may have different acquisition 
settings, channel configurations, and stimulator setups. Use a Batch for long duration experiments with 
hardware setting changes across segments, to automate routines, or to run multiple experiments on the 
same experimental setup in succession. 
 For example, if an experiment has a preparatory period, a stimulus period, and a response period, 

three graph templates could be batched: 
 A template to acquire for the length of the preparatory period 
 A second template with a stimulator configured for the stimulus period 
 A third template to acquire the response period without stimulation 

All three templates could be added in sequence to a single Batch Acquisition, which would then acquire 
all of the data for all three templates with a single start. 
To create a new batch, choose File > New > Batch Acquisition to generate the Batch dialog. 

The Templates controls at the top allow you to add, 
remove, or re-order the templates. 
 Double click on a template in the list to open the 

output graph from the most recent acquisition. 
 Batch acquisition cannot combine acquisitions that 

do not end, so the acquisition storage mode for 
template files cannot be set to “Save last,” 
“Autosave”or “Repeat forever.” 

 Advanced Averaging cannot be used in a Batch. 

Status 
N/A No status is available for the template, no batch acquisition has been performed. 
In Progress Data is currently being acquired for the template. 
Waiting A batch acquisition is in progress but has not yet reached the step where the template is used. 
Complete Data acquisition for the template has been finished successfully and has been saved to disk at 

the batch output location. 
Error A batch acquisition was aborted manually or due to communication errors. The data for the 

template may not have been saved or may be unreliable. 
Batch Errors 
Misconfigured templates and misconfigured averaging templates may generate the Adjust 
Length/Adjust Latency/Abort Acq warning prior to the start of acquisition. Clicking “Abort” 
will halt the batch acquisition. Misconfigured templates may result in those rare cases where 
data was acquired into a graph template with a different hardware configuration prior to 
saving the template to disk. 
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Saving to: 
Use the “Change” button to specify the 
directory where the acquisition output should 
be saved. 

 
Use MP Unit: 
Specify the MP unit that should be used for the 
Batch Acquisition. 

This menu lists all of the available hardware units. 
Entire menu dimmed out while batch acquisitions are in 
progress. 

Start/Stop Acquisitions  
Toggles to starts and stop batch acquisitions; dimmed 
when the specified MP unit is being used to acquire 
data unless it is a batch acquisition that is in progress. 
Batch acquisitions may be terminated by using either a 
control in the batch user interface or by clicking the 
“Stop” button in the graph window actively acquiring 
data for the current template of the batch. During the 
execution of an individual template acquisition, errors 
may occur that abnormally terminate that acquisition 
(i.e., communications errors with the MP unit, errors in 
calculation channel, disk errors, etc.). When the 
acquisition in progress is terminated due to an error, the 
batch acquisition will be halted as well.  

 If a batch acquisition is aborted early, the 
batch output directory will contain the full 
result graphs for all of the templates that 
were previously completed successfully. It 
will also contain a partial graph file for the 
template that was being used at the time the 
acquisition was aborted. Templates that 
were not used will not have any associated 
graph files. 

Resume—Mac AcqKnowledge 3.9.2 and later  
When a batch acquisition is terminated prematurely, the 
acquisition may be restarted from the first template in 
the sequence or from where it was stopped (e.g. the 
template with the error status). 

Batch Acquisitions can be saved for use at a later time using File > Save Batch 
Acquisition As. Batch Acquisition files retain all of the settings for their 
individual templates and can be used even if the original templates used to 
configure the batch no longer exist or have been moved. Each template is 
acquired and saved into an output graph file that can be opened at a later point in 
time to examine the results.  
To open a Batch Acquisition, use File > Open and select type “Batch 
Acquisition.” 
When a batch acquisition is started, the templates will be executed in the order indicated in the batch to 
acquire data from the specified MP unit. Files are autosaved before the next acquisition is started. 

 If the batch acquisition completes successfully, the batch output directory will contain all of the 
graph files that were created during the acquisition. Each output graph is saved into a user-
specified directory and is titled “Batch n - template name” where n is the order in the acquisition 
sequence. 
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Open 
The File > Open command generates the standard file open menu, and allows you to open a variety of 
different file formats from the popup menu at the bottom of the dialog box.  

  
 Windows Mac 

Multiple files 
To open multiple files in a single dialog on a Mac, hold the Shift key down and select multiple files. The 
Command-A key combination will “Select All” files in the dialog. AcqKnowledge can only recognize one 
Journal file at a time, so multiple selection is disabled when the file type is set to Journal or Journal 
Template. 

ACQ 
Graph 
Graph 

(Windows) 

AcqKnowledge files 
The default file formats (Graph and .ACQ) are referred to as “AcqKnowledge” files. 
The AcqKnowledge file format is the standard way of displaying waveforms in 
AcqKnowledge. These files are stored in a compact format that retains information 
about how the data was collected (i.e., for how long and at what rate) and takes 
relatively little time to read in (compared to text files, for instance). AcqKnowledge files 
are editable and can be modified and saved, or exported to other formats using the Save 
as command. 
File Compatibility 

Windows AcqKnowledge cannot open Macintosh AcqKnowledge 3.9 files. 
Macintosh AcqKnowledge 3.9 can open Windows AcqKnowledge files. 

 Macintosh AcqKnowledge 3.9 can open and create PC-compatible Graph 
(*.acq) and Graph Template (*.gtl) files. Variable sampling rate information 
and hardware settings are retained, and Journals can be read from and written to 
PC files. 

Files must end on a multiple of the lowest channel sampling rate to be fully PC 
compatible. 

BSL 
Import 

This file format is from files created using the Biopac Student Lab software. 
 Windows “BSL Lesson Files (*.Ldd)” 
 Mac “Biopac Student Lab Graph” 

 BSL File Import Notes 

BIOPAC produces two different software lines, the AcqKnowledge software for 
research and the BSL software for higher education. These two applications use 
different file formats, making it difficult to analyze data recorded in one with the other.  

AcqKnowledge can directly import data files that were created in Biopac Student Lab 
Lessons or BSL PRO. This allows data acquired with an MP30 or MP35 with BSL to be 
analyzed using the advanced analysis routines of AcqKnowledge.  

Hardware and calculation channel settings are also imported. This allows for the 
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migration of some BSL PRO templates to AcqKnowledge. Only basic analog, digital, 
and calculation channels can be acquired; templates that use any of the BSLSTM or 
other output options are not supported. 

Importing is limited to graph files created with BSL 3.6.6 or higher. It is not possible to 
import files created with earlier versions of BSL. To import from earlier BSL versions, 
those files must first be opened with BSL 3.6.6 or higher and re-saved to disk to update 
the file format. The updated files can then be imported directly into AcqKnowledge. 

 
When saving files, AcqKnowledge must save using the AcqKnowledge graph file format 
or another available export format. It is not possible to open AcqKnowledge graph files 
with BSL Lessons or BSL PRO. 

 

Batch Mac only 

 
TXT Text or .TXT. Text files are a convenient way of transferring information between 

applications, and most spreadsheet and statistics programs are capable of importing or 
exporting data in a text file format. AcqKnowledge assumes that the text file contains 
numeric data laid out in columns and rows, and that there is some delimiter between 
each column. It also assumes that each column represents a distinct variable or channel 
of data. Normally, the values in each row represent the state of each variable at different 
points in time. When a text file is opened, the numeric values will be plotted as 
waveform data in a standard graph window and non-numeric values will be ignored. 
Each column of data is read in as a separate channel. 

 Options 
When the Files of type: Text option is select, an Options button is activated. Clicking on 
this button generates another dialog box that allows you to control the amount and type 
of data to be read in, as well as the time scale for data display. 

  
Read Line 
 To control how much data is read in, enter a value in the read line box at the top of 
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the dialog box. This tells AcqKnowledge which row contains the first data point in 
the series. By default, this is set to 1, although you may want to set it to another 
value since some applications (usually spreadsheets) generate a “header,” or text 
information at the top of a file. You can also read in a limited amount of data by 
entering a value in the box to the right of the line box. This value indicates the last 
line to be read in as data. By default, text files will be read in starting at line one 
and data will continue being read in until the end of the file is reached. 

Interval 
 To control the horizontal scale (usually time) for the text file after it is displayed in 

the graph window, change the Interval between sample points, which can be 
expressed either in terms of time or frequency. For example, if data were collected 
at 50 samples per second, there is an interval between sample points of 0.02 
seconds. AcqKnowledge would then assume that there is a 0.02 second “gap” 
between the data point in row two and the data point in row three (and all 
subsequent pairs of adjacent rows). Likewise, if you have a data file that spans 10 
seconds and has 100 rows of data, the interval between sample points will be 0.01 
seconds. 

 Most files contain time domain data, although some applications generate 
frequency domain data (the results of a spectral analysis, for example). The 
principle here is the same as with time data, that there is some interval between 
different frequencies. If a text file contains 20 sample points covering the range 
between 0 and 60Hz, then the interval would be set to 3Hz per sample. 

Column Delimiter 
 This setting tells AcqKnowledge what characters indicate a “gap” between two 

columns. This can be set to tab, comma, or space. All text files must have some 
sort of column delimiter, unless there is only one channel of data present. 

 Tab delimited text files —the most common type— have a tab between each 
column for every row of data. These files are most often generated by 
spreadsheets and similar packages. 

 Comma delimited files place a comma between each column of data for each 
row, much the same way as a tab delimited file. Statistics programs such as 
BMDP and SAS frequently create these types of files. 

  Space delimited files are also commonly created by statistics packages, and 
place some number of spaces (usually two) between each column of data for 
every row which contains information. 

 None. If you are not sure which delimiter to use, select auto and AcqKnowledge 
will automatically select a delimiter. 

When either tab or comma is selected, AcqKnowledge will read in a new column 
each time it sees a delimiter, even if there are no numeric values between 
delimiters. For example, the following text file will read in three channels of data, 
although the channels will be of different lengths. 

0.301424, 0.276737, 0.045015 
0.338723, 0.808811, 0.542627 
0.354271, 0.506313, 0.715995 
0.001325, 0.762115 
946207, 0.894992 
0.926409, 

 Sample text file 
The first channel will contain six data points, the first being 0.301424 and the last value 
being 0.926409. The next channel will contain three data points, starting with 0.276737 
and continuing through 0.506313. The software considers that there is no other data 
values for channel two. The third channel starts with the entry 0.045015 and the last 
data point for this channel is 0.894992. There are only five data points in the last 
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channel. 

GTL Graph Template files (*.GTL)  
This powerful feature allows you to open a template file with predefined experiment 
parameters and then simply click “Start” to run the experiment.  
The Graph Template option allows you to open a copy of a master file so you can 
maintain the master settings. Graph template files open to previously saved window 
positions and setup parameters (as established under the MP menu). See Appendix G for 
descriptions of a wide array of applications and features. 
This feature can be especially useful for recreating protocols in the laboratory. You can 
set up an experiment and save it as a Graph template, then simply open the Graph 
template file and click the Start button to acquire data under the same settings. 
When a Graph template file is opened: 

a) The graph window will not contain any data. (Since no data is saved in the 
template, arbitrary waveform output setups, which require a source date file, 
will not function in a template.) 

b) The journal window will contain text you entered and saved with the 
template—this is a handy way for you to place instructions or information 
about the experiment for yourself or others. 

AcqKnowledge “Quick Start” (*.gtl graph template) files are available for over 40 
applications. Just open the graph template file to establish appropriate settings for the 
selected application, and then click Start. Quick Start files were installed to the Sample 
folder and can be used to establish the settings required for a particular application or as 
a good starting point for customized applications. 
 

MAT MATLAB® format AcqKnowledge can open files created as a MATLAB work space. 
 Windows™ can open MATLAB v6 compatible MAT files, including MATLAB 7 

if the “v6” flag is specified in MATLAB before saving. 
 Mac™ can open MATLAB v7 compatible MAT files, including V7 format. Only 

ASCII text is supported; Unicode text within MATLAB v7 is not supported. 
 Interoperability with earlier versions of MATLAB is not guaranteed. 

Uses the “MAT-file” binary format to load numerical and textual information. If the 
MAT-file is properly formatted with the following arrays, AcqTKnowledgeT will 
reconstruct the graph with appropriate sampling rate, channel labels, units, and data: 

data units labels isi isi_units start_sample 

 MATLAB files open with no Start button. 
 If the MAT file is missing any of the 

expected variables or contains extra 
variables, only one two-dimensional array 
variable can be imported into a graph. A 
MATLAB Import Options dialog will be 
generated. Choose which variable data is 
stored in, what dimension maps to 
samples, channel indices, and sample rate, 
and then click OK to open the file. 

 If AcqKnowledge can’t recognize the file 
format, an error prompt will be generated 
and a blank graph window will be opened. 

 

  
AVG  Advanced Averaging Experiment 

N
O
T
E 
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Open AVG files saved from the Advanced 
Averaging setup dialog. See page X508H99X for 
Advanced Averaging details. 
Use the Start button in the Advanced Averaging 
setup dialog to start the acquisition. 
The Sample folder includes a sample P300 setup. 

  
Igor Pro Igor Pro Experiments (compatible with Igor Pro 3.1, 4.0, and 5.0). 

The waves contained in an Igor Pro packed experiment can be opened (imported) in 
AcqKnowledge provided that the packed experiment files comply with the following: 

 ≤ 59 waves 
 no text waves 
 no complex waves 

 all waves in Version 2 or Version 5 format (Igor defaults) 
 all waves one-dimensional (vectors) 
 all waves multiples of the same fundamental inter sample interval 

If the wave has an associated wave note, it will be used as the channel label. 
 

PhysioNet Mac OS X only—PhysioBank is a public service of PhysioNet and offers downloadable 
archives of gigabytes of “standard” data for cardiac arrhythmias, gait analysis, and other 
types of physiological signals. AcqKnowledge can use PhysioBank data directly and can 
be integrated with other software tools that understand this interchange format. 
A PhysioBank file is usually comprised of several files, including a header file (usually 
“*.hea”), and all of the files must be located in the same directory for the PhysioBank 
record to open successfully. Open using the header file. 
Opening a PhysioNet file will import data and annotations into a new graph window. If 
“atruth” annotations exist, they will be translated into appropriate events on the 
appropriate channel. All annotation types are retained except LEARN annotations, 
which are treated as UNKNOWN. 

Raw This low-level data exchange option interprets all data at a single sample rate; variable 
sample rates are not supported. All of the data will be unscaled when opening 
(importing) files. That is, a value of 0 will be imported as a zero voltage. Scaling will 
need to be manually applied to the data. Options to open (import) raw data: 

Data type: 32-bit or 64-bit IEEE floating point format or 8-, 16-, and 32-bit 
integer formatted data 

# of channels: Enter the number of channels stored in the data file as a positive 
integer less than or equal to 60. 

Layout: Packed sequential: All of the data for an individual file is located in 
a single block of the file and multiple channels follow one another. 

 Interleaved: Data is grouped into a single “frame” for each sample 
location with one data element for each channel, so data for a 
particular channel is spread throughout the file (similar to Linear 
PCM audio file format). 

Endian: Little and big endian byte ordering, matching the data formats of x86 
and PowerPC/Sparc, respectively. Set to big for Mac-generated raw 
files (default), or to little for Windows-generated raw files. 

Set to x/sample: Specify the inter sample interval of data in the file, which will be 
translated into an appropriate sampling rate. The edit field will 
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accept an arbitrary floating point number. The units menu contains 
μsec, msec, sec, MHz, kHz, Hz. The edit field will be dynamically 
converted to match the units selection; no conversion will be used 
when switching between frequency and time. 

Journal Mac OS X only—Opens an independent journal; see page X509H48 X for details. 
Jrnl Temp Mac OS X only—Opens a journal template; see page X510H48 X for details. 

WAV Mac OS X only—WAV files containing 60 channels or less can be imported. When this 
format is chosen, the list of available files will be filtered such that only files ending in 
the “.wav” extension or having the “WAVE” type are shown. When a WAV file is 
selected, it will be analyzed to determine if it is compatible with the AcqKnowledge 
application. 
If the file is compatible, a new graph window will be created displaying the data 
contents of the WAV file. 

• Each channel will be numbered “Channel n” where n is an increasing digit. 
These channels will be unitless in amplitude. 

• All of the data will be converted into the 64 bit floating point format for storage 
in memory and in the ACQ formatted files on disk. 

• The horizontal axis of this graph will be set to time and the sampling rate set to 
match the rate as specified in the WAV file headers. 

• This graph will be marked as an imported graph into which data cannot be 
acquired. 

• This will dim the start button and any appropriate hardware menu entries that 
would be used to access the invalid hardware settings. 

EDF Mac 3.9.2 and later only— Opens files with .eeg and .edf extensions saved in European 
Data Format (EDF). Data is imported entirely into memory in a newly created graph 
window titled after the filename, similar to other file import routines. All scaling factors 
will be applied to the data as it is imported, and it will be converted to double precision 
floating point format. 
Since EDF format includes data that is not used by AcqKnowledge, only the following 
items are imported: 

• channel data 
• channel labels 
• units 
• sampling rate (taken from maximum sample rate of all channels) 

All other information stored in the EDF file will be discarded when the file is imported. 
Only 60 channels of data can be imported from an EDF file. Channels will be imported 
starting with the graph file index 1. If there is a 60th channel, it will be placed into the 
channel with index 0. If an EDF file contains more than 60 channels, only the first 60 
channels will be imported and a prompt will advise that not all of the channels could be 
imported. 
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Close 
Close menu command 

This File menu command will close the active file window and prompt you to save if necessary.  

 
Close without saving 

 Windows—click on the  in the upper right corner of the file window 

 Mac OS X—click on the  in the upper left corner of the file window 
Click “No” when AcqKnowledge asks you if you want to save the changes. 

Close during acquisition 

 
Close multiple data views 

Set the level of close functionality under Display > Preferences > General. 
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Save 

  
This menu command will save any changes made to a file. If more than one file is open, this command only 
applies to the active window. For untitled files, you will be prompted to name the file you wish the data to be 
saved in. The file will remain open after you have saved it, allowing you to continue working.  
Mac OS X: The Save menu is dynamic and corresponds to the type of file you are trying to save, i.e. Save 
Graph, Save Journal, Save Advanced Averaging Setup. 
Files must be less than 2 GB, except AcqKnowledge 3.9 “Graph” files on the Mac, which can be larger if not 
compressed. 
To save data in another format (such as a text file), see the File>Save As section which follows 
Save As 
Choosing File>Save As produces a standard dialog box that allows you to save data in a variety of different 
formats and to any location. As with all save last dialog boxes, you can use this to save a file to a different file 
name or directory than the default settings. 

  
 Windows/PC Mac OS X 

ACQ 
Graph 
Graph 

(Windows 
AcqKnowl-

edge) 

AcqKnowledge format 
The default file format for the File>Save as command is to save files as an 
AcqKnowledge file. Selecting Graph (MPWS) or .ACQ (MPWSW) from the popup 
menu in the Save As dialog box will save a file as an AcqKnowledge file, which is 
designed to be as compact as possible. These files can only be opened by 
AcqKnowledge, but data can be exported to other formats once it has been read in. 
The Options button generates a dialog box 
that allows you to save only a portion of 
your file. When the “Selected Section only” 
option is enabled, only the data that has 
been selected with the I-beam tool will be 
saved. This option saves the selected area 
to another file and does not affect the current file that you are working in. 
 
File Compatibility  

Windows AcqKnowledge cannot save as Macintosh AcqKnowledge 3.9 files. 



198 AcqKnowledge Software Guide 

Visit the online support center at www.biopac.com 

Macintosh AcqKnowledge 3.9 can save as “Graph (Windows)” files, but it saves in 
Windows AcqKnowledge 3.7.1 format. In this earlier format, all data is retained, but 
new Windows AcqKnowledge features (like dual stimulation, data views, embedded 
archives, etc.) are lost along with any settings specific to Macintosh AcqKnowledge 
(like events, adaptive scaling settings, etc.). 

 Macintosh AcqKnowledge 3.9 can save PC-compatible Graph (*.acq) and Graph 
Template (*.gtl) files. Variable sampling rate information and hardware settings 
are retained, and Journals can be read from and written to PC files. Choose the 
format “Graph (Windows)” to create PC-compatible files. 

The Mac version does not save PC GLP files or compressed PC files.  
Files must end on a multiple of the lowest channel sampling rate to be fully PC 
compatible. 

Compressed Saves a compressed AcqKnowledge formatted file. The degree of compression varies 
based on data characteristics, but will generally achieve about 60% compression. 
Saving small files (less than 200K) may have little effect. Using a sample file as an 
example: 

 
Compressed files are only readable by AcqKnowledge 3.8.1 or later. Mac can read PC-
compressed files. Windows cannot read Mac-compressed files. 
Compressed graphs no longer allow data acquisition and will open with no Start 
button. 
Windows: Resave the compressed file in standard format to enable a Start button. 
Mac OS X: A warning prompt 
will be generated when you 
try to compress a graph in 
which data can be acquired 
(Start button active): 

TXT Text  
Saves graph data in text format. When Save As Text is selected, an Options button is 
generated. Clicking on this button generates a Save Options dialog that allows you to 
control how much data is saved and the format it is saved in.  
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Header 
When the first box is checked, a “header” is included at the top of the text file that 
contains information about the sampling rate, number of channels, date created, and other 
information relating to the data. This information is frequently useful, but some programs 
will attempt to read in the header information as data, which could result in nonsensical 
results. You may wish to include the header as it can always be edited out later using a 
text editor or the journal. 

Selected Section 
Windows only Checking the second box instructs AcqKnowledge to save only the 
selected section of the file. This is useful for saving a brief segment of a long file. When 
this option is checked, the highlighted area of data will be saved from all channels. When 
only one data point is selected, the entire file will be saved. If you want to save only a 
portion of the selected channel, you can either remove other channels or copy the data 
through the clipboard. See page X511H215X for more information on how to copy data through 
the clipboard. 
Mac OS X only This option is managed in the Save and Save As dialogs. 

Horizontal Scale 
The third checkbox allows you to include the horizontal scale (usually time) values in the 
text file, along with the data to be saved. This allows you to produce time series plots in 
other applications, as well as correlating events to time indexes in graphing and statistical 
packages. Since a separate row is generated for each sample point, To exceed the 
limitations of programs if data is collected at a fast sampling rate (many spreadsheet 
programs are limited to about 16,000 rows). You may wish to consult the section on 
resampling data after an acquisition is completed (page X512H247X). 

Column Delimiter 
When data is saved as a text file, each channel of data is saved as a separate column, with 
the number values for each data point saved in rows. Use the pop-up menu to select the 
delimiter to separate the columns of data in the text file. By default, a tab is placed 
between each column for every row of data; this format is called a tab-delimited text file 
and almost all applications will read in tab-delimited text files. However, you may also 
save data in a comma-delimited format or a space-delimited format. 

Line endings 
Mac OS X only Use to create text files that are compatible with Classic Mac OS 
applications (Mac), Unix-compatible applications (Unix), or PC-compatible applications 
(DOS). 
 

WMF or 
PICT 

 

Metafile (WMF) for the MPWSW or PICT for the MPWS. 
AcqKnowledge also supports formats for saving graphical information. Most drawing, 
page layout, and word processing programs can read .WMF or PICT files. This is 
particularly useful for writing reports. A WMF or PICT file can be opened in any 
standard drawing program and can then be embellished or used to highlight any 
particular phenomena of interest. The following image is an example of a .WMF file. 
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When data is saved as a graphic, only the data currently on the screen is saved. So, if 
you have a data file that spans eight hours but only two minutes is displayed on the 
screen, only two minutes of data will be converted to a graphic file. Since 
AcqKnowledge uses information about the computer screen in creating the graphic file, 
the default resolution of the file will be the same as the window. Most word processors 
and graphics packages allow for some way to resize and scale graphics. 

GTL Graph Template 
This feature can be especially useful for recreating protocols in the laboratory. You 
can set up an experiment and save it as a Graph template, then simply open the Graph 
template file and click the Start button to acquire data under the same settings.  

TIP: Check the existing Quick Start template files listed on page X513H193X before 
creating or saving a new template. With over 40 templates provided, you 
may find one to establish the settings required for your particular 
application or to use as a good starting point for customized applications. 

The Save As Graph template option saves the setup parameters established under the 
MP menu and window positions. Any window (including the Journal window, Input 
values, Stimulator, or Manual Control) that was active when the file was saved as a 
Graph Template will come up with the exact same position and settings when the 
Graph Template is reopened. 
When a file is saved as a Graph Template: 

a) No graph data will be saved. 
• Since no data is saved in the template, arbitrary waveform output 

setups, which require a source date file, will not function in a 
template. 

• You must select Save / Save as and select “File of type .ACQ” to 
save the graph data. 

b) Journal text will be preserved. Any text you entered will be saved to the 
Journal window and stored with the template—this is a handy way for 
you to place instructions or information about the experiment for yourself 
or others. 

When this feature is used with the menu.dsc customization feature it is easy to comply 
with GLP standards and save your protocol as an SOP. When you change the menu.dsc 
file for a graph template file, save the “menu.dsc” file with the exact same name but 
save it to the new lesson folder you have created. For full GLP features, contact 
BIOPAC about the Lab Assistant GLP System. 

  

*.MAT 
MATLAB 

MATLAB® format. Uses the “MAT-file” binary format to save numerical and textual 
information as Filename.mat. 
 Windows™ and Mac™ create MATLAB Version 6 files, which are compatible 

N
O
T
E 
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with both MATLAB Version 6 and MATLAB Version 7. 
 Interoperability with earlier versions of MATLAB is not guaranteed. 

The following variables will be in the workspace when the file is opened in MatLab. 
data Contains the data of the graph in floating point format, for all of the 

channels of the array. The first dimension of this array is the amount of data 
in each channel, the second dimension increments with each channel. 
Therefore, each row contains a full channel of data that can be accessed in 
MATLAB via data (1:length). 

units This string array contains the textual representation of the units of the 
samples stored in data, with one element per channel of data. 

labels This string array contains the labels of each of the channels, with one 
element per channel. 

isi This floating point array of one element gives the number of units of a 
single inter sample interval of the data. 

isi_units This single string array provides a units string for a single unit of isi. Time 
data will always be “ms,” frequency data will always be “kHz,” and other 
values will be represented by an Arbitrary horizontal axis type in an ACQ 
graph. 

start_sample Contains the time offset of the index 0 sample of data in isi units. This will 
be 0 for many graphs, but if only a selected area of a graph was exported 
into the MAT file, the start_sample will contain the offset from the original 
data corresponding to the start of the data array in the MAT file. 

 

AVG 
(Advanced 
Averaging) 

To save an Advanced Averaging Experiment: 
1. Use the File > Save or Save As function 

in each graph to save the graph data. 
 
IMPORTANT: You must save the graph 
files separately from the Averaging 
setup. The graph files and templates 
used in an Averaging setup should be 
saved in the same directory as the 
Averaging setup so they can be opened 
automatically when the Averaging Setup 
file is opened. 

2. Make sure the Graph names are correct 
and then use the Save and Save As 
buttons in the “Advanced Averaging 
setup” dialog to save the setup. 

For Advanced Averaging details, see page X514H99X.  
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Igor Pro Igor Pro Experiment format. 
An AcqKnowledge graph will be saved (exported) to a single packed experiment file, 
with each channel saved into a separate Igor wave that preserves the channel label, 
waveform sampling rate, and unit information. Vertical units will be stored as data units, 
and horizontal units will be stored dimension units; extended units are supported. The 
scaling of each wave will be adjusted to match the waveform sampling rate. All data 
will be stored in 64-bit floating point format in a one-dimensional wave. The waves will 
be named incrementally from “wave0” and the channel label will be stored in the wave 
note field. Files will have the type/creator pair “IgsU/IGRO” and a “.pxp” extension will 
be added to the file name for compatibility with Igor Pro for Windows™. 

PhysioNet Mac OS X only —This format requires that the WFDB library is on your computer. 
PhysioBank is a public service of PhysioNet and offers downloadable archives of 
gigabytes of “standard” data for cardiac arrhythmias, gait analysis, and other types of 
physiological signals. AcqKnowledge can use PhysioBank data directly and can be 
integrated with other software tools that understand this interchange format. 
Saving a file in PhysioNet (WFDB) format will export the entire contents of the graph 
to a PhysioBank record. The record will consist of multiple files, all in the location 
specified for export. There will be a header file (*.hea) and a single data file for each 
channel of the graph (starting with “d” and ending with the base name of the header 
file). The files must not be separated for a successful move or copy. 
Export Limitations 

Precision Some precision may be lost due to differences in binary representation 
between AcqKnowledge and PhysioBank formats. 

Events Events will not be exported to the PhysioNet format. 
Channels Only 32 channels of data can be exported from a graph (the max allowed 

in a PhysioBank file). 
Rate If you are exporting a graph that uses variable sampling rates, all of the 

channels in the exported file will be downsampled to the lowest waveform 
sampling rate of the source graph. 
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Raw Options to save (export) data for low-level data exchange are: 

Data type: 32-bit or 64-bit IEEE floating point 
Layout: Packed sequential: All of the data for an individual file is located in a 

single block of the file and multiple channels follow one another. 
 Interleaved: Data is grouped into a single “frame” for each sample 

location with one data element for each channel, so data for a particular 
channel is spread throughout the file (similar to Linear PCM audio file 
format). 

Endian: Little and big endian byte ordering match x86 and PowerPC/Sparc data 
formats, respectively. To exchange with Windows applications, set to 
little endian; to exchange with Mac applications, set to big endian. 

 
Raw Data Export Limitations 

Formats Raw export only allows data to be saved in 32-bit and 64-bit IEEE floating 
point format. 

Rates All files will be interpreted at a single sample rate; variable sample rates 
are not supported. If a graph with variable sampling rates is exported, 
channel data for downloaded channels will be padded to match the highest 
waveform sampling rate. 

Length If channels have unequal lengths, the overall file length will match the 
longest channel. Shorter channels will be padded at the end using their 
final sample value so that all channels contained in exported files will be 
equal in length. 

Scaling When integer-valued analog channels are exported from AcqKnowledge to 
raw files, all relevant scaling and offset will be applied—the data in the file 
will appear the same as if the channel had been internally converted to 
floating point format before export. 

 If the value of a channel is outside the maximum/minimum value that a 
chosen export data type can represent, the value will be clipped 
accordingly. (AcqKnowledge uses a 64-bit data type, so this should only be 
a problem if exporting to 32-bit floating point values.) 

 

Excel 
Spread-

sheet 

Excel Spreadsheet Export—Graph data can be saved directly to an Excel spreadsheet by 
using the Excel Spreadsheet format in File > Save As. Each channel will be placed into 
its own column of the spreadsheet. Only 65K sample points can be exported at a time, 
however, so long or high sample rate data acquisitions may not be able to be saved in a 
single spreadsheet. 

• Also available for File > Save Journal Text As, Find All Cycles journal, and 
Specialized Analysis tools. 



204 AcqKnowledge Software Guide 

Visit the online support center at www.biopac.com 

 
Journal 

 note that you have to select the journal save icon for the Excel option 

 
Excel Spreadsheet File (*.XLS)—Journal text can be exported directly into an Excel 
spreadsheet by using the File > Save Journal Text As with the Excel Spreadsheet 
format. Each line of text in the journal will be saved as a single row with tabs separating 
columns. A selected portion of a journal can also be written to a spreadsheet. This 
export allows for textual data reduction results to be easily exported into a spreadsheet 
to allow for further analysis. 

• Also available for File > Save As, Find All Cycles journal, and, for 
Mac OS X only, Specialized Analysis tools.  

Mac OS X only—Text (*.TXT) Saves an independent journal; see page X515H48X for details. 
Jrnl Temp Mac OS X only—Saves a journal template; see page X516H48 X for details. 

WAV Mac OS X only 
This option saves the graph data into a WAV audio file for exchange with other 
applications. The “.wav” extension extension will automatically be added if the save as 
filename does not end with it. 
The “Selected area only” checkbox will be active for WAV export. When checked, only 
the highlighted area will be exported to the WAV file. The final sample of this range is 
not included in the export, mirroring the other file export routines of AcqKnowledge. 
All exported WAV files use the 64 bit floating point format. This format preserves full 
operational precision. Most audio applications should be able to support floating point 
WAV files. Exported data will not be normalized when it is exported. Any 
normalization to audio ranges should be performed prior to exporting the data. 
WAV files are normally either one or two channels (e.g. mono or stereo). 
AcqKnowledge graph files, however, usually contain more than two channels. Although 
they can contain more than two channels, most audio applications may not be able to 
recognize these multiple channel files. 

• If a graph file contains only one or two channels of data, a WAV file will 
automatically be created without further interaction. 

o Graphs with a single channel will result in mono WAV files. 
o Graphs with two channels will result in stereo WAV files. 

• If a graph contains more than two channels, the user will be presented with the 
following choice: 

 
o all channels—create a multiple-channel WAV file with one channel per 

channel of data in the graph. While this WAV file may be easily opened 
by some applications, it may not be fully compatible with audio 
applications and other applications expecting two channels or less. 

o selected channel only—create a single channel mono WAV file using 
only the data of the selected channel. This will be the selected channel 



Part C — Analysis Functions 205 

 

in chart mode, the active channel in scope mode, or the vertical channel 
in X/Y mode. This single channel export may be useful for exporting 
audio channels that are recorded along with physiological data, such as 
heart sounds, audio stimuli, and the like. 

After a WAV file is exported, the WAV file will not be reopened; the open graph will 
be left unmodified. To view the exported file, import the WAV file. 

EDF Mac 3.9.2 and later only 
Saves file in European Data Format (EDF). The saved file will automatically have an 
.edf extension added onto it if the user did not include it. Users will be able to save 
either the entire graph or only a selected portion of data. 
AcqKnowledge does not retain sufficient information to accurately complete an EDF 
header. When exporting, the following default values will be used: 

EDF Header Element Default 
subject ID Empty* 
recording ID Empty* 
recording date Set to the modification date of the graph 

file on disk. If no graph file is on disk, 
the current date is used. 

recording time Set to the modification time of the graph 
file on disk. If no graph file is on disk, 
the current time is used. 

transducer description Empty* 
filter description Empty* 
 * Empty: indicates that the field will be left blank 

All other fields will be filled with corresponding information from the graph, including 
channel titles, sampling rates, channel units, and scaling factors. Variable sampling rate 
information will be preserved as it can be expressed in the EDF format. 
EDF is used by many applications and online recording databases to store information, 
particularly EEG recordings. EDF is an open file format originally developed for sleep 
studies. It stores continuous time recordings of data in a binary format. Since its original 
proposal, EDF has been adopted by a number of open source and commercial tools as a 
supported data file format. Usage has also expanded beyond sleep studies into other 
types of recording.  

 
Format change warnings 
Mac AcqKnowledge 3.9.1 and later only—When a file open or save function requires a format change for 
compatibility or alters file content, a prompt will be generated to require the user to confirm the option to 
update format or convert and save.  
 

  
Created with a previous version of AcqKnowledge  Windows PC AcqKnowledge format 
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Saving as a “Graph Template” will erase all data Imported from another file format 
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Print 
The File>Print menu that AcqKnowledge uses is similar to the standard computer print dialog box; however, 
there are two additional box options that add functionality. 
Mac OS X  The Print menu is dynamic and corresponds to the type of file you are trying to print, i.e. Print 

Graph, Print Journal. 
 The additional options are activated under Page Setup when the “MP1X0…” option is selected. 

  
 Plots per page—Control how many plots appear per page when the file is printed. Printing more than one 
plot per page has the effect of “snaking” graphs on a page much the same way text appears in a 
newspaper. For example, if this option was selected so that two plots were printed per page, 
AcqKnowledge would divide the amount of data to be printed on that page into two graphs—one graph 
printing at the top of the page, the second graph printing at the bottom of the page. This option allows you 
to print records on considerably fewer pages than standard printouts, and is most effective when only a 
few channels of data are being printed. 

 Total pages (Fit to pages on a Mac)—Print the contents of a window across multiple pages. When a 
record is printed over multiple pages, the amount of data on the screen (the amount of data to be printed) 
is divided by the number of pages entered in the dialog box. The graph on the screen is then printed 
across the number of pages specified in the Total pages box at the bottom of the File>Print dialog. These 
two options apply only to graph windows, and do not apply to Journals. 

Print selected text from Journals  

Mac AcqKnowledge 3.9.1 and later only—When working with Journals, it is easy to generate large 
amounts of text content in the window. Only a portion of this information may actually be of interest and 
this feature allows for only portions of the text to be printed. 

 
To print only a portion of a journal or GLP modification log: 

1. Use the I-Beam tool to select the range of text to be printed in the journal. 
2. Choose File > Print. 
3. Switch to the “AcqKnowledge” printing options panel. 

• On MacOS™ X 10.3.9, this may appear as “MP1X0.” 
4. Check the “Print selected text only” checkbox. 

If there is no selected text, the entire journal or modification log will be printed regardless of this setting. 
Printer setup (MPWSW) or Page Setup (MPWS) 

  

 



208 AcqKnowledge Software Guide 

Visit the online support center at www.biopac.com 

Choosing File>Printer Setup on the MPWSW (PC) or File: Page setup on the MPWS (Mac) produces a 
standard printer setup dialog box that allows you to setup any available printers. All the options in this dialog 
box function as described in your system manual. There is also an options button that allows you to make 
several printing adjustments with respect to fonts, image orientation, and graphics presentation. 
Range of Data options—Mac only 

 
Select “MP1X0…” for Print range options 

To determine the range of data that will be included in 
the printout, select one of the print range options.  

 Visible portion only synchronizes the range of data 
in the printout to match the range of data that is 
visible on the screen. 

 Selected portion only prints only the data that is 
selected in the graph. This option is disabled if 
there is no selection in the graph. 

 Entire graph prints all of the data contained in the 
graph from zero to the maximum length channel. 

Event Divider 
Toggle “Draw vertical divider at event locations” to enable/disable this option. See Printing Events on page 
for X517H165X details. 
Based on the range selection, the software will make appropriate adjustments before printing. For visible area, 
friendly grid scaling (page X518H140X) will be applied, and onscreen and printed precision will match, even if 
horizontal grids are unlocked. For selected area and entire area, onscreen and printed precision will not match 
when grids are unlocked because friendly grid scaling (page X519H140X) is applied on screen, but is not used during 
printing where the range is fixed to fill the entire page. 
The automatic software adjustments before printing will set the horizontal scale as if it had been used to 
display the relevant data on the screen. When printing is completed, the scale and offset parameters of the 
graph will be restored to the previous settings. 
 
Exit  

Selecting Exit from the File menu exits AcqKnowledge software and prompts you to save any open 
graph files that have been modified since they were last saved. 
Mac OS X only—Use Quit under the AcqKnowledge 3.9 menu (page X520H317X) to exit the software. 
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Chapter 11 Edit menu commands 
Overview 

  
One of the most useful features in AcqKnowledge is the ability to edit and work with data by cutting sections 
and copying sections from one window to another. In this sense, the MP System allows you to work with data 
much as a word processor lets you work with text. When working with data, you will usually want to select a 
section of data to work with. To select a section of data, use the editing tool to highlight an area. The selection 
tool is used for a variety of purposes including cutting and pasting waveform data, making measurements and 
determining which portion of a waveform to save as text values. To select the tool, click on its icon in the 
lower right hand corner. You will notice that the cursor changes into the familiar “I-beam” cursor when you 
move it within the graph area. Click the mouse and drag to select a portion of the waveform. 

IMPORTANT 
When multiple waveforms are present, the highlighted area appears to include all of the 
waveforms, but most modifications and transformations apply only to the selected channel. 

Once you have selected a section of a waveform, you can perform such as editing, transformations, saving 
data to the journal, saving as text, and using the measurement functions on the selected area. The cursor 
always selects at least one sample point; when there is no defined area, a single sample point will be selected, 
and the cursor will blink. You can highlight a larger area by positioning the cursor over the first point you are 
interested in, holding down the mouse button, and dragging the cursor either left or right to highlight an area. 
This is similar to highlighting a series of letters or words in a word processor. You can modify the selected 
area by placing the cursor anywhere on the graph, then holding down the shift key and clicking the mouse. 
This feature is useful for fine-tuning the selected area. To fine tune, first coarsely select an area. By zooming 
in (with the zoom tool) on either edge, you can then use the shift key to precisely align the edges of the 
selected area. 
AcqKnowledge also allows you to select an area that spans multiple screens. To do this, first select an area 
that contains the leading edge of the portion of the graph that you are interested in. Next, use the horizontal 
scroll bar to scroll to the end of the area that you are interested in. Then place the mouse near the area of 
interest and click on the button while holding down the shift key. While still depressing the mouse button, 
move the cursor to the exact position desired.  
By using the selection tool to select areas of the waveform, the Cut, Copy, Paste and Clear functions are 
designed to work in much the same manner as a word processor. These functions operate only on areas 
selected by the selection tool. 

Edit menu functionality during acquisition 
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Mac OS X only—The following Edit menu functions may move or alter memory and cannot be performed 
during acquisition: Undo, Cut, Clear, Clear All, Paste, Insert Waveform, Duplicate waveform, and Remove 
Waveform. 
 
Undo / Can’t undo 
The Undo command allows you to restore data that was unintentionally deleted or modified. Undo applies to 
editing commands and transformations (such as digital filtering and mathematical operations). 
There are some important exceptions to the Undo command. 
First, neither Edit>Clear all nor Edit>Remove waveform can be undone. It is a good idea to make backup files 
before performing any editing, especially when using these commands. 
Second, changes in the display options (i.e., changing the horizontal scale or changing the color of a 
waveform) cannot be undone, since they are easier to manipulate and less drastic than cutting data out of a 
waveform. If you modify the screen scale (or other display parameters) you will still be able to undo your 
latest data modification, which is much more difficult to recover than a screen parameter change. 

TIP: If you accidentally remove a waveform or choose Clear All, one way to 
recover the data is to close the file without saving the changes. The data file 
can now be reopened, as it was when it was last saved; any changes made since 
it was last saved will be lost. 

 Windows/PC: With some exceptions, the Edit>Undo command will undo the last command carried 
out by AcqKnowledge. 

 Mac OS X: Perform multiple levels of undo on a per graph basis; Journal undo remains unchanged at 
one step. Complex data analysis in AcqKnowledge is rarely performed with a single transformation; 
multiple transformations are frequently cascaded together to produce a result. AcqKnowledge will 
“stack” the transformations and the user will be able to undo one step at a time until this stack is 
exhausted. 
o Undo may move or alter memory and cannot be performed during acquisition.  
o Undo operations may occupy large amounts of memory, particularly for transformations that 

affect entire waveforms or multiple markers. Users without large amounts of RAM or working 
with large data sets may require the available computer memory for performing transformations. 
To accommodate these users, the maximum size of the undo stack can be limited using the Levels 
of undo Preference (Display>Preferences). 

 
o Specialized Analysis (page X521H333X) scripts are complex and undo may not function for all steps. 
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Cut 
When Cut is selected from the Edit menu, the highlighted portion of the active window (Graph, Journal, entry 
prompt or dialog) is removed and copied to a clipboard, where it is available for pasting into other windows. 
Mac OS X: Cut may move or alter memory and cannot be performed during acquisition. 

 When a selected area is removed from a waveform, the data will shift left to “fill in” the deleted area. 
So, if ten sample points are deleted, all data after the selected area will be shifted over ten sample 
points. Since this alters the relationship of events to the time base, you might want to consider 
alternatives to cutting sections of data—such as using smoothing, digital filtering, or the connect 
endpoints functions to transform the section of data. 

Area selected using the 
editing tool  

 
 
 
 
 
 

Same data with selected 
area Cut out  

 
Note that the data 
after the selected 
area has shifted 
forward in time. 

 

 
Copy 
Choosing Edit>Copy will copy the selected area of the active window (Graph, Journal, entry prompt or 
dialog) to the clipboard without modifying the text/waveform on the screen. 

 Once the area has been copied, it can be inserted in another window using the Edit>Paste command or, 
for waveforms, the Edit>Insert waveform command. 

 To copy a waveform to another channel in the same graph window, choose the Edit>Duplicate 
waveform command. 

Paste 
The Edit>Paste command will take the contents of the clipboard and paste it into the currently selected area of 
the active window (Graph, Journal, entry prompt or dialog). 

 If no area is selected, the data is pasted at the beginning of the waveform in a Graph window or the end 
of the text a Journal window 
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Clear 
The Edit>Clear command works much the same way as the Cut command, with the key difference being that 
data is not copied to the clipboard. This function deletes the selected area from the selected channel only. If 
the entire waveform is selected (as with the Edit>Select all command), the clear command will delete all the 
waveform data and leave an empty channel. 
Mac OS X: Clear may move or alter memory and cannot be performed during acquisition. 

 As with the cut command, the clear function operates on only one channel, and when a portion of the 
waveform is deleted, the remaining data will shift left. If multiple channels of data are present, one 
channel will be “shorter” than the others. 

 To remove a selected area of data from multiple channels, use the Edit>Clear all command. 
 
Clear all 
Choosing Edit>Clear all will delete the selected area from all channels. This is similar to the clear function in 
that data is removed and is not copied to the clipboard. The Clear all command, however, removes a section 
of data from all waveforms, whereas the clear command applies only to the selected channel. 
Mac OS X: Clear All may move or alter memory and cannot be performed during acquisition. 

 When Edit>Select all is chosen prior to performing the Clear all function, all waveform data for all 
channels will be deleted. 

 The Edit>Undo command does not work for Clear all. 
 
Select All 
When Select all is chosen from the Edit menu, the entire selected channel becomes highlighted. For almost all 
commands, when a waveform is selected using Select all, subsequent operations apply to the selected channel 
only. 

 The exception is when Edit>Clear all is chosen after Edit>Select all. When this occurs, all data from 
all waveforms will be deleted. 

 
Insert waveform 
The Edit>Insert waveform command is useful for copying a waveform (or a section of a waveform) from one 
window to another. To do this, first select the area to be copied using the cursor and the Edit>Copy command. 
Next open the graph window you wish to insert the waveform into. To insert the waveform into the same 
graph it was copied from, although the Edit>Duplicate waveform is a much more straightforward way to do 
this. 
Once you have selected the graph you wish to insert the waveform into, choose Insert waveform from the Edit 
menu. A new (empty) channel will then be created and the data will be copied into the empty channel. The 
new channel will always take on the lowest channel number available (including zero). 
Mac OS X: Insert waveform may move or alter memory and cannot be performed during acquisition. 

 This command cannot be undone directly, although selecting the inserted channel and choosing 
Remove waveform from the Edit menu effectively undoes this operation. 
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Duplicate waveform 
Choosing Edit>Duplicate waveform will create a new channel in a graph window and copy an entire 
waveform (or a selected area) to the new channel. When a portion of the waveform is selected, only the 
highlighted area will be duplicated. 
Mac OS X: Duplicate waveform may move or alter memory and cannot be performed during acquisition. 

 To duplicate the entire waveform, choose Edit>Select all and then select Duplicate from the Edit menu 
or click the right mouse button and select Duplicate from the pull-down menu.  

 
Remove waveform 
Deletes the entire selected waveform, regardless of what other options are selected. 
Mac OS X: Remove waveform may move or alter memory and cannot be performed during acquisition. 

 The Edit>Undo command does not work for Remove waveform. 
 
Remove last appended segment 

Mac OS X only—Removes the last appended segment. Equivalent to the  Rewind toolbar icon. 

 
 Edit>Undo does not work for Remove last appended segment. 

 
Create Original Data Snapshot 
The Snapshot options store “snapshots” of the original acquired data at specific stages along with the full 
graph file. Use snapshots for analysis or reporting to compare results to original waveforms or intermediate 
stages of analysis. This is essentially an embedded archive; it is not a backup tool. 

IMPORTANT: Archive functions do not create a new file—they are not backup functions. 
Original data is copied and pasted to the end of the original file.  
You cannot use this feature to recover lost or damaged graph files. 

See page X522H49 X for Snapshot details. 
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Merge Graphs 
Combine multiple graph files into a single file for performing cross-file analysis and storage. Use merge with 
the multiple-hardware capabilities to produce single graph files containing multiple streams of data from an 
individual subject.  
Use Merge Graphs to combine up to 60 channels from multiple graph files acquired with the same acquisition 
rate into one merged graph file. On Windows OS, the resulting file size of a merge must be less than 2GB. 

1. Select Edit > Merge Graphs to generate the Merge Graphs dialog. 
2. Click Add Graph to generate the Choose Graph dialog. 
3. Choose a file to add to the merge. 

 “Add” the “Matching graph” listed (this pull-down menu includes all open files with the same 
acquisition rate) 

 “Add File…” to browse and select a file that is not already open 
4. Adjust the selection for individual channels if desired. 

 Click on the “+” to list individual channels in the graph file. 
 Toggle the checkbox to add or remove the associated channel/graph file. 
 You cannot delete a file name from the list, but you can remove it from the merge. 

5. Repeat as desired for multiple files. 
6. Click Merge and wait (you can check the status in the Total Channels bar). 
7. Save the merged file. 
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Clipboard 

  
All of the clipboard commands involve copying data from AcqKnowledge to the standard Windows 
clipboard, where the contents of the clipboard are made available for other applications. Transferring data 
through the clipboard allows you to copy data from AcqKnowledge to other applications even after you have 
closed the graph window and/or quit AcqKnowledge. 
Data can be copied to the clipboard in two formats: 

Text/Alphanumeric Copy Measurement and Copy Wave Data save information to 
the clipboard in text/numeric format. 

Graphic format Copy Graph transfers the image on the screen to the clipboard 
in WMF (MPWSW) or PICT (MPWS) format. 

 Copy Measurement 
Copies the contents of all visible measurement popup menus, along with the values associated with 
these windows. By default, three windows are displayed (on most monitors); you can change this by 
increasing or decreasing the width of the window. Once the measurements have been copied, they can 
be pasted into any application that allows paste functions, including word processors, drawing 
packages, and page layout programs. A sample of measurements pasted from AcqKnowledge into a 
word processor follows: 

BPM = 85.714 BPM delta T = 0.700 sec p-p = 0.8170 Volts 
 Copy Wave Data 

Copies the data (in numeric form) for all channels from the AcqKnowledge graph into the clipboard. 
When an area is selected, only the data in the highlighted area will be copied to the clipboard. As with 
the copy measurement command, once the data is stored in the clipboard, it can be pasted into 
virtually any application. 
When multiple channels of data are copied to the clipboard, the data is stored in columns and rows, 
with data from each channel stored in a separate column. For a four-channel record, four columns of 
data will be copied to the clipboard. As with a text file, AcqKnowledge will insert a delimiter between 
each column of data. The default delimiter is a tab; you can change the delimiter to either a space or 
tab in the options dialog box in the File>Save as dialog box. See page X523H191X for more detailed 
instructions on how to set the column delimiter. Transferring data through the clipboard performs 
essentially the same function as saving data as a text file (using the File>Save As command), with the 
obvious exception that transferring data through the clipboard does not save data to disk. 

 Copy graph 
Copies the graph window as it appears on the screen to the clipboard, where it is stored in Windows 
Metafile (PC) or PICT (Mac) format. You can then place the graphic into a number of different types 
of documents, including word processors, drawing programs, and page layout programs. Windows 
Metafile and/or PICT are common to almost all applications, and images saved in these formats can 
be edited in most graphics packages and many word processors. 
Using the copy graph function is similar to saving a graph window as a Windows Metafile or PICT 
file  (using the File>Save As command), except that using the file save command writes a file to disk, 
whereas transferring data through the clipboard does not save a file. 
 

 Copy acquisition settings 
Creates a textual summary of the current acquisition settings and sends it to the clipboard, where it can 
be pasted into the journal via Edit > Journal > Paste Acquisition settings, or pasted to another program. 
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The summary includes sampling rates, channel configuration, calculation channel settings, triggering 
options, averaging options, and if any stimulator is active. This is useful for retaining records for 
acquisition parameters (and for technical support, if necessary). Use this feature to keep a textual 
record or printout of the configuration of your MP unit along with your data. 
 

Journal 

  
The Edit>Journal sub-menu options are similar to those found in the Edit>Clipboard menu. The key 
difference is that data (whether measurements or raw data) is pasted directly into the journal rather than 
copied to the clipboard. 

 Paste measurement 
Choosing Paste measurement from the Edit>Journal menu will cause all visible measurement 
windows to be pasted into the journal. Each time this is selected, the measurements and values are 
pasted into the journal using the precision specified in the Display>Preferences dialog box. You can 
also change the total number of measurements displayed by adding more rows of measurements. Use 
the Preferences menu (see page X524H310X) to change the number of measurement rows or the measurement 
precision displayed on the screen. 
Paste measurement shortcuts: 

 Keyboard: Ctrl + M 
 Mouse: Right-click in the Journal and choose “Paste Measurement” 

 Paste wave data 
Converts, the selected area of the waveform to numeric format and paste it into the journal in standard 
text file format. As with the copy wave data command (in the Edit>Clipboard submenu) this will 
paste the selected area from all channels, not just the selected channel, and will place a delimiter 
between the columns when two or more channels are being pasted to the journal. By default, tab 
characters are used to separate columns; you can change to comma or space delimiters in the 
File>Save As>Options dialog box. See the Save As section on page X525H197X for more information on how 
to change the column delimiter. 

 Paste acquisition settings 
Pastes the acquisition settings to the journal as they were copied via Edit > Clipboard > Copy 
Acquisition settings. 

 
Show Journal—Mac OS X only 
To display the Journal on a Macintosh, select Edit > Journal > Show Journal. 
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Chapter 12 Transform menu commands 
Overview 

  
AcqKnowledge provides a number of options for post-acquisition analysis and transformations. These 
transformations allow you to perform a range of operations on your data, from digital filtering and Fourier 
analysis to math functions and histograms. All of these options can be found under the Transform menu, and 
are disabled while an acquisition is in progress. Unless otherwise noted, all of the transformations described 
here apply to the selected channel only. Some options (such as the expression and math functions) allow you 
to specify a channel (or channels) to be transformed.  
The table below groups all of the transformation functions into four general families or clusters. The first set 
of functions performs “data cleaning,” in that they perform some sort of filtering or data reduction tasks. The 
second set of transformations performs calculations or other mathematical operations on the data. The third 
set of functions allows you to search though the data, either for peaks or patterns of data. The fourth set of 
functions provides graphical summaries of the data, either in terms of the frequency spectra of the data or the 
measures of central tendency and dispersion of waveform data. 

AcqKnowledge Transformation Functions 

Isolate data Calculation/Math Search Summary 
Smoothing 
Digital Filtering 
Resample 
Fourier Linear 
Combiners 
Principal 
Component 
Analysis 
Independent 
Component 
Analysis 

Equation/Expression 
Waveform Math 
Math Functions 
Difference 
Integrate 
Derivative 
Integral 
Autoregressive Modeling 
Nonlinear Modeling 

Peak Detection Functions 
•Find Peak/Cycle 
•Find Next Peak/Cycle 
•Find All Peaks/Cycles 

Template Functions 
 

Histogram 
FFT 
Power Spectral 
Density 
Find Rate 
AR Time-
Frequency 
Analysis 
DWT (Wavelet 
Decomposition) 
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It is important to remember that AcqKnowledge is always selecting at least one point, and the cursor will flash 
whenever only one point is selected. Some of the transformation functions (e.g., math function, waveform 
math) can operate on a single sample point, and will transform a single sample point when only one is 
selected.  

There are two ways to apply a transformation to an 
entire waveform. 
a) For transformations that generate a dialog, check 

the “transform entire waveform” box (usually 
located toward the bottom of each dialog). This 
will transform the entire waveform, regardless of 
whether a single point, area, or the entire 
waveform is selected. 

b) For transformations that do not generate a dialog, use the Edit>Select all command prior to selecting the 
transformation. This will transform the entire waveform for all of the transformation functions. 
Mac OS X Using Edit > Select All is not necessary when only a single point is selected prior to selecting 

the transformation because AcqKnowledge will automatically apply the transformation to the 
entire waveform since it is not possible to perform these transformations on a single point. 
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Recently Used Transformations 
Mac AcqKnowledge 3.9.2 and later—The Transform > Recently Used submenu allows quick access to a 
user’s most recently used transformations regardless of a transformation’s fixed position in the transformation 
menu. The Recently Used submenu also appears at the top of the Transform submenu available from the 
context menus of waveforms.  
The submenu lists a default of five of the most recently used transformations, with the most recently executed 
at the top of the menu. To adjust the number of recent transformations displayed, select Display > Preferences 
(see page X526H312 X for more information). 
The recently used transformation listing is saved and restored across subsequent launches of AcqKnowledge. 
It also is application wide: Executing a transformation in any graph will add that transformation onto the 
recently used list. The recently used list is independent for each user account.  
Digital filtering 
The Transform > Digital filters selection includes FIR finite impulse response and IIR infinite impulse 
response post-processing filters, with Adaptive filtering available only on the Mac. 

   
FIR filters are linear phase filters, which means that there is no phase distortion between the original signal 
and filtered waveforms. 
IIR filters are not phase linear filters, but are much more efficient than FIR filters in processing data. The IIR 
filters are useful for approximating the results of standard biquadric filters of the form: 

(as2 + bs + c) / (xs2 + ys + z) 
These types of filters are commonly implemented in electronic analog circuitry. IIR filters are also used for 
online filtering (discussed on page X527H75X). 

 See Appendix B for more information about the differences between these types of filters. 
Adaptive filtering is a signal processing technique that processes two different signals in relation to one 
another; see page X528H224X for details. 
To understand how digital filters work, it is important to understand the nature of analog signals and their 
frequency components. All analog signals are comprised of signals of various frequencies. A commonly used 
analogy is that of the color spectra. Just as white light is made up of a variety of colors that have different 
wavelengths (frequencies), physiological signals are comprised of specific signals with unique frequency 
signatures. 
For example, an electroencephalogram (EEG) recording is comprised of several different types of signals, 
each of which has a different frequency signature. Alpha waves (one of the most studied EEG signals) have a 
frequency range of about 8 Hz to 13 Hz. This means that alpha waves go through a complete cycle (from peak 
to peak or trough to trough) anywhere from eight to 13 times a second. 
There are, of course, signals that have other frequency signatures in EEG data. Most types of physiological 
data have a number of different frequency signatures present in the overall signal. In addition, frequency 
components besides the signal(s) of interest are often present. In the U.S., it is not uncommon for 60 Hz 
electrical noise to be acquired along with physiological signals (in other countries, AC interference is present 
at either 60 Hz or 50 Hz). 
Use digital filtering to retain only the frequency components of interest and remove other data (whether it is 
“noise” or merely physiological signals outside the range of interest). 
It is important to note that the way in which data is filtered depends in large part on the sampling rate at 
which the original data was acquired. For instance, if data was collected at 50 samples per second (50 Hz), it 
is not possible to filter out 60 Hz signals. 
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In fact, data must be sampled at a rate equal to at least twice the frequency of the signal to be removed. So, if 
data is to be collected and the information between 80 Hz and 120 Hz is to be removed, the data must be 
sampled at 120Hz*2, or 240 samples per second (or faster). Also, each channel of data is filtered separately, 
so removing one type of data from one channel will not affect any other channels. 
Digital filters can be divided into four general classes: 

low pass     band pass     high pass     band stop 
Descriptions of these four classes of filters follow, with visual examples of how these filters work. In each of 
the four examples, a single channel of data containing frequency components in three ranges (low frequency, 
mid-range, and high frequency) is acquired. 

 Low frequency data, by definition, has slowly changing values, much like respiration patterns or core 
temperature variations. 

 High frequency data, compared to low frequency data, is noticeably more “spiked,” much like an 
EMG signal. As you can tell, the high frequency wave repeats itself about five times in the time it 
takes the low frequency wave to repeat once. 

 Mid-range data falls somewhere in between these two extremes. 
In the examples that follow, one possible way that these data could have been collected is if respiration were 
measured, but the measurement was contaminated with high-frequency muscle movement and mid-frequency 
signal coming from AC interference. The data is then passed through a filter, where some of the frequency 
components are removed. 
Low pass filtering 
In the example below, a low pass filter attenuates the data above a given threshold, allowing only lower 
frequency data to “pass” through the filter. 

Low
Pass
Filter

Incoming data Filtered data

Low
frequency
data

Mid
frequency
data

High
frequency
data

Low
Cutoff

 
High pass filtering 
In the example below, a high pass filter removes the low and middle range data, but allows the high frequency 
data to pass through the filter. 

Filter

Incoming data Filtered data

Low
frequency
data

Mid
frequency
data

High
frequency
data

Hipass

High
Cutoff
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Whereas the low pass and high pass filters retain data either above or below a given threshold, the next two 
types of filters work with a range, or band, of data. 
Band pass filter 
The band pass filter, allows only the data within the specified range to pass through the filter. A band pass 
filter is useful when you want to retain only specific waves from an EEG record. For instance, to retain alpha 
waves, you can set the filter to only pass data between 8 Hz and 13 Hz. 

Band
Pass
Filter

Incoming data Filtered data

Low
frequency
data

Mid
frequency
data

High
frequency
data

Low
Cutoff

High
Cutoff

 
Band stop filter 
The band stop filter allows data to pass above and below the specified range. This type of filter is typically 
applied to remove extraneous 60 Hz or 50 Hz noise from a data record.  

Band
Stop
Filter

Incoming data Filtered data

Low
frequency
data

Mid
frequency
data

High
frequency
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High
Cutoff
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FIR Filters 

 
Digital filter dialog box  
When you select an FIR filter type, the corresponding Digital Filter dialog box will pop up, allowing you to 
specify a number of different filtering options. 

   
1. Window. The Window popup menu allows you to choose from a variety of filtering algorithms. The filter 

default is set to a “Blackman” type. These different Windows (described in detail in Appendix D) allow 
you to “fine tune” the filter response. 

2. Cutoff Frequency (Hz) (or threshold). Enter fixed value(s) or set the cutoff to line frequency or sampling 
rate fraction. 
Sampling rate—Mac AcqKnowledge 3.9.2 and later Sets the frequency to a fraction of the sampling rate 
and automatically updates when the sample rate is modified. 
Line frequency—Mac AcqKnowledge 3.9.2 and later Uses the line frequency at which the data was 
recorded. 
Fixed—Fixed value guidelines are as follows: 
 Low Pass Filter—data with frequency components below the cutoff will pass through the filter, 

whereas frequency components above the threshold will be removed. For low pass filters, the default 
cutoff frequency is the waveform sampling rate divided by eight and can be set to any value between 
0.000001Hz and 0.5 times the sampling rate. 

 High Pass Filter—data with frequency components above the cutoff will pass through the filter, 
whereas frequency components below the threshold will be removed. For high pass filters, the default 
threshold is the waveform sampling rate divided by four and can be set to any value between 
0.000001Hz and 0.5 times the sampling rate. 

 Band-type Filters—a low threshold and a high threshold must be specified to define the band of data 
(the frequency range) that is either passed or stopped, depending on whether it is a Band Pass or Band 
Stop filter. In either case, the default for the low threshold is the waveform sampling rate divided by 
eight and the default for the high threshold is the waveform sampling rate divided by four. The 
threshold settings can take on any value from 0.000001Hz and 0.5 times the sampling rate, but the 
two thresholds cannot be set to the same value and the high threshold must be greater than the low 
threshold. 

3. Number of Coefficients. Enter a fixed value or enable the optimize option. 
Fixed—This determines how well the filter will match the desired cutoff frequency (or range). The 
minimum number of coefficients is 3 and the maximum must be less than the total number of sample 
points in the selected area. The software will truncate the maximum number of coefficients to the highest 
odd number less than the total. 
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Optimize for sample rate and cutoff—Mac AcqKnowledge 3.9.2 and later Estimate the number of 
coefficients as four times the sampling rate divided by the cutoff frequency of the filter. Optimize does 
not necessarily produce the best quality filter, but takes less time. 
 
The default number of coefficients is (4 x waveform sampling rate)/lowest frequency cutoff for the filter. 
For every filter except the band pass, the lowest frequency cutoff is equal to the specified cutoff 
frequency for the filter; for the band pass filter, the lowest frequency cutoff is the low frequency cutoff 
setting. Filters that use a small number of coefficients tend to be less accurate than filters that use a large 
number of coefficients. Larger coefficients increase filter accuracy, but also increase the processing time 
required to filter the data.  
To see how changing the coefficient value affects the way data is filtered, it can be useful to examine the 
filter response patterns. In the example below, data was collected at 500Hz and the band stop filter was 
designed to remove 60Hz noise using a low cutoff of 55Hz and a high cutoff of 65Hz. The same data was 
band stop filtered using a coefficient of 39 (upper waveform) and then 250 (lower waveform). 

 
Along the horizontal axis, the units are scaled in terms of frequency, with lower frequencies at the left of 
the screen. The values along the vertical axis are scaled in terms of dB/V and indicate the extent to which 
various frequencies have been attenuated. 
In both filter response waveforms, there is a downward-pointing spike that is centered on 60Hz. The 
baseline of the filter response corresponds to a value of approximately 0 on the vertical axis, indicating 
that the signals significantly above or below 60Hz were not attenuated to any measurable extent. As you 
can tell, however, the filter does not “chop” the data at either 55Hz or 65Hz, but gradually attenuates the 
data as it approaches 60 Hz. 
For example, the upper waveform in the filter response plot represents data that was filtered using a value 
of 39 coefficients. The slope is relatively shallow when compared to the lower waveform, which 
represents a filter response performed with 250 coefficients. Although the filter that used 250 coefficients 
took slightly longer to transform the data, the filter response pattern indicates that the data around 60 Hz 
is attenuated to a greater degree. Also, the 250-coefficient filter started to attenuate data considerably 
closer to the 55 Hz and 65 Hz cutoffs, whereas the default filter began to attenuate data below 55 Hz and 
above 65 Hz. 

TIP: A good rule of thumb is to use a number of coefficients greater than or equal 
to two times the sampling rate divided by the lowest cutoff frequency 
specified. For example, if running a low pass filter at 1 Hz on data sampled 
at 100 Hz, choose at least (2 x 100/1) or 200 coefficients in the filter. 
Additional coefficients will improve the response. 

4. Show Filter Response. When checked, this option generates a plot of the filter response in a new window, 
labeled “Frequency Response” (see example above). 
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 Mac only: Units: Select linear units or dbV. 

 
5. Don’t modify waveform. This option is useful in conjunction with the “Show Filter Response” option. 

When both boxes are checked, AcqKnowledge will produce a plot showing the filter response, but will 
not modify the waveform. This allows you to repeatedly specify different filter options (without 
modifying the waveform) until the desired frequency response is achieved. 

6. Filter entire wave. If this option is checked, AcqKnowledge will filter the entire wave and replace the 
original. If you want to keep the original, duplicate it prior to filtering. 

Adaptive Filtering 

  

 
 See the Adaptive Filtering Calculation 

Channel on page X529H89 X. 

Adaptive filtering is a signal processing technique that 
processes two different signals in relation to one another 
and can be used for noise estimation, noise reduction, 
general-purpose filtering, and signal separation. Adaptive 
filtering creates efficient high-quality filters with a minimal 
number of terms, which can be very useful in blocking 
mains interferences or other known periodic disturbances. 

 Useful for noise filtering where it is possible to acquire 
a signal that is correlated to the noise (similar to the 
way noise-cancelling headphones detect and remove 
outside noise). Applications include removing EMG 
from ECG or EOG from EEG. 

The weights within an adaptive filter are modified on a step-by-step basis. AcqKnowledge uses the N-tap FIR 
adaptive filter, with coefficients updated using least means squares (gradient) feedback. 
Source signal 

The source channel will be replaced by the adaptive filter results. 
Noise signal 

The noise channel is the signal that is correlated with the noise to be eliminated from the Source; it is 
not modified by adaptive filtering. 
Source and Noise channels must have the same sampling rate. 

Order 
Specify a positive integer for the number of terms to be used in the internal FIR filter. 

Step size 
Provides mu, the rate of adaptation of the coefficients within the FIR filter. 
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IIR Filters 
To access the IIR filter dialog box, click on the Transform menu, scroll to select Digital Filters, drag right to 
IIR and drag right again for the filter options. For all filter types, the software will limit the frequency setting 
so it cannot exceed one-half the channel sampling rate. For real-time filter options, see page X530H75 X. 

   
Low Pass and High pass Pass data that falls below or above the specified standard. The Low Pass default 

is 0.125 times the waveform sample rate; the High pass default is 0.25 times the 
waveform sample rate. 

Band Pass (low + high) Pass a variable range of data. Specify a low frequency cutoff and a high 
frequency cutoff to define the range or “band” of data that will pass through the 
filter; frequencies outside this range are attenuated. For the Band Pass (low + 
high) filter, the low default is 0.125 times the waveform sample rate and the high 
default is 0.25 times the waveform sample rate. 
 This filter is best suited for applications where a fairly broad range of data is 

to be passed through the filter. For example, apply to EEG data to retain only 
alpha wave activity. 

Band Pass (single freq) Requires only a single frequency setting, which specifies the center frequency of 
the band to be passed through the filter. The “width” of the band is determined by 
the Q setting of the filter (discussed in detail below). Larger Q values result in 
narrower bandwidths, whereas smaller Q values are associated with a wider band 
of data that will be passed through the filter. This filter has a bandwidth equal to 
Fo/Q, so the bandwidth of this filter centered on 50Hz (with the default Q=5) 
would be 10Hz. Although functionally equivalent to the Band Pass (low + high) 
filter, this filter is most effective when passing a single frequency or narrow band 
of data, and to attenuate data around this center frequency. The Band Pass (single 
frequency) default is 0.125 times the waveform sample rate. 

Band Stop (single freq) Defines a range (or band) of data and attenuates data within that band (the 
opposite function of a band pass). This filter is implemented in much the same 
way as the standard Band Pass, whereby a center frequency is defined and the Q 
value determines the width of the band of frequencies that will be attenuated. The 
Band Stop (single frequency) default = waveform sample rate x 0.125. 

Comb Band Stop Filters out a fundamental frequency and its overharmonics (integer multiples of 
the base). Resonance, aliasing, and other effects may generate interference at 
multiples of a base frequency. The Comb Band Stop filter combines all the 
required filters instead of requiring a separate filter for each interfering 
overharmonic. See dialog details on page X531H227X.  

Q coefficient The online filters are implemented as IIR (Infinite Impulse Response) filters, 
which have a variable Q coefficient. The Q value entered in the filter setup box 
determines, in part, the frequency response of the filter. This value ranges from 
zero to infinity, and the “optimal” (critically damped) value is 0.707 for the Low 
Pass, High pass and Band Pass filters. A Q of .707 for any of these filters will 
result in a second order Butterworth response. The Q is set to a default of 5.000 
for the single frequency Band Pass and Band stop filters. For more details about 
the Q setting, see the Appendix. 
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Sampling rate Mac AcqKnowledge 3.9.2 and later Sets the frequency to a fraction of the sampling rate 
and automatically updates when the sample rate is modified. 

Line frequency Mac AcqKnowledge 3.9.2 and later Uses the line frequency at which the data was 
recorded. 
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Comb Band Stop Filter Dialog 

    
 Transformation Dialog Calculation Channel Dialog 

Resonance, aliasing, and other effects may generate interference at multiples of a base frequency. The Comb 
Band Stop filter combines all the required filters instead of requiring a separate filter for each interfering 
overharmonic. Comb Band Stop filters remove a fundamental frequency and its overharmonics (e.g., integer 
multiples of the base frequency) from a signal, and are useful for removing noise. AcqKnowledge 
approximates a Comb Band Stop filter by cascading a series of IIR Band Stop filters, and is limited to 
removing frequencies and overharmonics. The number of filters used can be fixed at a particular number (e.g., 
limiting the number of harmonics to filter out) or configured to automatically remove all possible harmonics 
for any given sampling rate. 

• Mac AcqKnowledge 3.9.2 and later — Use the "Comb Band Stop Filter" Automator action to 
integrate Comb Band Stop filters into Workflows. 

For a given base frequency  and quality factor Q, the comb filter approximation will be given by the set of 
following formulas: 

( )( )xFFFFy kωωωω ooo ⋅⋅⋅= 32  

where F  represents a standard two-tap IIR band stop filter for the frequency  with coefficients 
computed using the quality factor Q. 
The number of overharmonics of the base frequency to be removed is given by the integer value k. 
The maximum allowable number of overharmonics may be automatically determined given the 
sampling frequency f s: 

⎥
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This limits the maximum overharmonic frequency to be less than the Nyquist of the sampling 
frequency. 

After the first comb filter is performed, the most recently used settings for the comb filter will be displayed, 
(except for “Transform entire wave,” which will be reset each time the dialog is opened). 
Textual export will include the source channel, base frequency, quality factor, and number of harmonics. 
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Comb Band Stop Filter Dialog 

number of samples Width of the selection. 

@ samples/sec Waveform sampling rate of the source channel. 
• The channel sampling rate of the calculation channel can not exceed the channel sampling 

rate of the source channel. Downsampling will be applied to the source channel prior to 
comb filter processing, if required, and all Nyquist frequency restrictions will be determined 
from the calculation channel sampling rate. 

Frequency Fixed—The comb filter will remove this base frequency and integer multiples of this frequency. 
• Must be positive and less than the Nyquist frequency (half the sampling rate). 

Sampling rate—Mac AcqKnowledge 3.9.2 and later Sets the frequency to a fraction of the 
sampling rate and automatically updates when the sample rate is modified. 
Line frequency— Mac AcqKnowledge 3.9.2 and later Uses the line frequency at which the 
data was recorded. 

Q Quality factor used when computing the coefficients of the IIR notch filters. 
• Must be positive. 

all up to Nyquist Removes all integer multiples of the base frequency. This will include all multiples of the base 
frequency that are less than the Nyquist frequency. 

Harmonics Removes the base frequency and integer multiples of the base frequency up to and including the 
multiple contained in the edit field 

• Must be an integer greater than 0 and must not exceed k max  
• The final multiple must be less than theNyquist frequency. If it is not, the input will need to 

be corrected before the comb filter can be applied. 

OK If the settings are valid, executes the comb filter transformation. Verification of certain calculation 
channel parameters does not occur until the start of acquisition as sampling rates may be changed 
after calculation channels are configured. 
Prior to the start of acquisition, the following will be checked: 

• source channel to ensure it is still being acquired. 
• base frequency of the comb filter to ensure it is less than the Nyquist frequency of the 

channel sampling rate. 
• if the user has manually specified that a fixed number of overharmonics should be used, the 

number of overharmonics to ensure the highest used overharmonic does not exceed the 
Nyquist frequency of the channel sampling rate. 

If any of the parameters are invalid, a prompt will be displayed indicating which settings are 
incorrect and must be fixed for the acquisition to be started. 

Cancel Exits without modifying any data. 

Source All enabled analog, digital, and lower-index calculation channels. 

Label When the calculation type of a channel is changed to comb filter, the title of the channel will be 
replaced with the default label “Cn –Filter” where n is the index of the calculation channel. 

• Must be 40 characters or less. 

Preset Displays the title of any Calculation Preset currently applied to the calculation channel. 
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Fourier Linear Combiners 
Transform > Fourier Linear Combiners: 

  
 

 See FLC Calculation Channel 
options on page X532H88X. 

 See FLC references on page X533H230X. 

Fourier Linear Combiners are linear combinations of 
adaptable sinusoidal functions that are particularly well 
suited to processing cyclic data. Sine and cosine harmonics 
of a base frequency are summed together and the order is 
the fixed number of harmonics used in the model. Step size 
provides mu, the gain factor used to adjust the weights of 
the harmonics at each processing step. Step sizes must be 
much less than 1 for the system to converge. As step sizes 
decrease, relaxation time lengthens. The FLC model is 
adjusted based on the source data using least means square 
(LMS) feedback and the bias compensates for DC offset. 

 

Basic FLC  
Simple summation of fixed numbers of sines and cosines; uses 
harmonics of a fixed frequency and adjusts weighting coefficients 
of the mixture. 
Operates on a single channel at a time.  
Well suited for extracting data of a known frequency band from a 
signal with a stable frequency. 
 Use as an adaptive noise filter to remove non-periodic and 

semi-periodic noise uncorrelated to the base harmonic 
frequency. 

 

Scaled FLC – Mac OS X only 
Fundamental harmonic frequency can vary on a cycle-to-cycle 
basis. The frequency remains fixed within a single cycle and must 
be known before processing.  
Scales the harmonics used in each cycle based on cycle boundary 
events (defined through the Cycle Detector, ECG Analysis, or 
manually). Events from one signal can be used to drive analysis of 
another signal.  
Well suited for signals with detectable boundaries, such as ECG. 
 Use to extract information that is tightly coupled to other cyclic 

signals, such as extracting ICG based upon Knowledge of the 
RR cycles of the ECG. 

 

Weighted-Frequency FLC 
Base frequency of the harmonics is variable; adapts the frequency 
in response to the input signal using LMS feedback; the 
frequencies are similarly adjusted to the amplitudes. 
Operates on a single channel at a time.  
Well suited for modeling periodic signals of an unknown and 
potentially varying frequency and/or amplitude.  
 No cycle boundaries or frequencies need to be pre-

determined.  
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Coupled WFLC/FLC 
Runs a WFLC on the signal to determine the harmonic frequency 
and then runs the result through an FLC using the computed 
harmonic. The second FLC can be run on the same or a different 
channel. 
The transformation will always occur in the source channel for the 
FLC, not in the active channel; the user cannot specify the 
destination channel for CWFLC. 
Well suited for real-time extraction of information from one signal 
based upon the frequencies contained in another signal. 
 Use to remove movement noise from ECG. 
 Unique configurations can be established with two input 

signals, one for frequency and one for amplitude. 
 

FLC References 
The basic Fourier linear combiner (FLC) is described by Vaz and Thakor. 

 Christopher A. Vaz, and Nitish V. Thakor, “Adaptive Fourier Estimation of Time-Varying Evoked Potentials,” 
IEEE Trans. Biomed. Eng., VolBME-36, pp. 448-455. 

The weighted-frequency Fourier linear combiner (WFLC) and the coupled weighted-frequency Fourier linear combiner 
(CWFLC) are described by Riviere, Rader, and Thakor.  

 Cameron N. Riviere, R. Scott Rader, and Nitish V. Thakor, “Adaptive Canceling of Physiological Tremor for 
Improved Precision in Microsurgery,” IEEE Trans. Biomed. Eng., Vol BME-45, pp. 839-846. 

The scaled Fourier Linear Combiner (SFLC) is described by Barros, Yoshizawa, and Yasuda. 
 Allan Kardec Barros, Makoto Yoshizawa, and Yoshifumi Yasuda, “Filtering Noncorrelated Noise in 

Impedance Cardiography,” IEEE Trans. Biomed. Eng., Vol BME-42, pp. 324-327. 
 

 



Part C — Analysis Functions 231 

 

Math Functions 
AcqKnowledge allows you to perform a wide range of mathematical and 
computational transformations after an acquisition has been completed. 
Unless otherwise noted, each of these functions applies only to the selected 
area of the selected channel. If no area is selected (i.e., a single data point is 
selected), the cursor will blink and Windows will apply the transformation 
only to the selected point, but Mac OS X will transform the entire wave. To 
perform a math function on the entire waveform under Windows, select a 
channel and choose Edit>Select all. If a math function attempts to divide by 
zero, a zero will be returned. 
For complex transformations involving multiple functions, you may want to 
use the Equation Generator/Expression (see page X534H249 X for more information on 
this feature). Many of the same functions found in the Math functions menu 
can also be found in the Equation Generator. 
The following table describes the commands available in the Transform>Math functions menu: 

Transform >Math Explanation of Command 

Abs (Absolute Value)  Computes the absolute value of the data. All negative data values are made 
positive, with no change in magnitude. This function can be used to rectify data. 

Atan (Arc Tangent) Returns the arc tangent of each data point in radians. This rescales the data such 
that the range is from -π/2 to π/2. 

Connect endpoints 
(Connect the endpoints) 

Draws a line from the first selected sample point to the last selected sample point 
and interpolates the values on this line to replace the original data. The connect 
endpoints function is very useful for removing artifacts in the data or in generating 
waveforms. 
In the example below, the “noise spike” in the data is an undesired measurement 
artifact that should be removed. You could cut the section of data, but then all 
subsequent data points would shift left. In order to preserve the time series of the 
data, you could use the connect endpoints command to draw a straight line 
(although not necessarily flat) that connects the two extreme sample points of the 
selected area. 

 

 
Area selected before (top) and after (bottom) connect endpoints function 

 

Exp Exponential Computes the function ex, where x is the waveform data and e is 2.718281828. 
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Transform >Math Explanation of Command 
This is the base of the natural logarithms. 

Limit (Limit data values) “Clips” data outside the range specified by the set of thresholds in the limit dialog 
box. This function will prompt you for an upper and lower limit. Any data values 
outside these limits will be clipped at the closer limit. Although both a high and low 
threshold must be entered, To limit only one extreme (high or low) while leaving 
the other extreme unaffected. For instance, if you wanted to limit data so that all 
negative values were set to zero but the positive values were left unchanged, you 
would set the low threshold to zero and the high threshold to 99 (or some other 
large positive value that exceeds the maximum value for that channel). 

Ln (Natural Logarithm) Computes the natural logarithm of the selected section. The inverse of this function 
is the exponential function, Exp. 

Log (Base 10 Logarithm) Computes the base 10 logarithm of the selected section. 

In order to perform the inverse of this function, which would be 10x, use the 
Waveform Math power operator with the constant k=10 as the first operand and 
the waveform data as the second operand. 

Noise Converts the selected section into random data values between –1.0 and +1.0. 
This is mainly useful for creating stimulus signals and other waveforms. 

Sin (Sine) Calculates the sine of the selected section. The data is assumed to be in radians. 

Sqrt (Square Root) Takes the square root (√) of each data point in the selected section. 

Threshold (Threshold 
data values). 

Transforms all data points above the threshold to +1 units, and converts all values 
below the lower threshold to 0 units. Once the data crosses a threshold it will 
continue to be set to +1 for the upper cutoff and 0 for the lower cutoff, until it 
crosses the opposite threshold. The most common application of this function is to 
serve as a simple peak detector, the results of which can be used in rate or phase 
calculations. 
Threshold Algorithm 
Assume a domain variable  t ∈ tstart , tstart + 1, tstart + 2,K{ } with tstart being an 
integer, a real-valued signal y(t) defined for all t, and two real valued levels ylow and 
ymax satisfying the relation ylow ≤ yhigh . 

Define the threshold function thresh(t) function such that: 

 thresh(tstart ) =
1 y(tstart ) ≥ ylow

0 y(tstart ) < ylow

⎧ 
⎨ 
⎩ 

 

 thresh(t) =
0 y(t) < ylow

1 y(t) > yhigh

thresh(t −1) ylow ≤ y(t) ≤ yhigh

⎧ 

⎨ 
⎪ 

⎩ 
⎪ 
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Template Functions 

  
 Windows Mac 

The Template Functions are useful for comparing waveforms. Technically, the template functions provide 
correlation, convolution and mean square error transformations of a template waveform against another 
waveform. 

NOTE: To determine a level of comparison between two waveforms, use the 
Correlation function. 

All the template functions perform a mathematical operation of the template waveform on the waveform to be 
compared, move one sample forward, and repeat the multiplication until the end of the longer waveform is 
reached. 
Set Template 
Use the following ECG waveform as an example. An abnormality exists in the record. After detecting an 
abnormality, you should find out if there are other (similar) abnormalities in the record. To do that, you need 
to select the pattern you’d like to search for, and then compare that pattern to other data sets in the file. 
Selecting a section of a wave to be used as a template: 

1) Highlight the section to be used as a pattern. 

  
2) Click on the Transform menu and choose Set template from the Template functions submenu. This 

copies the selected portion into a buffer for subsequent template functions 
3) Select the waveform and position the cursor at the beginning of the data. 
4) Choose Correlation from the Template functions submenu. The center waveform in the graph below 

shows the result of the correlation. 
Note the higher amplitude peaks where the template data more closely matches the waveform. The lower 
waveform illustrates the mean square error function, which is similar to the correlation function. 
This indicates that there are two abnormal beats in the record. The first one appears at about 3 seconds 
and is the one used as a template; the second one appears at about 11 seconds. 
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Result of correlation and mean square error functions 

5) Use the zoom tool to inspect the abnormalities more closely. 
 

Remove mean 
A drifting baseline can be a problem in comparing waveforms. If you perform a Template function and the 
template or the waveform has a slowly moving baseline, you can increase the effectiveness of the comparison 
by choosing Remove mean from the submenu of the Template function. The remove mean option causes the 
mean amplitude value of the template and the compared section of the waveform to be subtracted from each 
other before the sections are compared. This way, a large baseline offset will have very little effect on the 
comparison. This option is toggled every time it is selected and is enabled when a check mark is present. 
For example, the following graph shows the original waveform at the top, the correlated waveform with mean 
removal in the middle, and the same correlation without mean removal at the bottom. Note how the mean 
removal effectively compensates for the drifting baseline in the original waveform. 

 
Correlation with and without mean removal 
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Template algorithms 
The template functions are: correlation, convolution, mean square error, inverse mean square error, and for 
Mac OS X only, normalize cross correlation and adaptive template matching. 
a) Correlation is a simple multiplication and sum operation (as shown in the preceding example). The 

template is first positioned at the cursor position in the waveform to be correlated. Each point in the 
template waveform is multiplied by the corresponding point in the data waveform (the waveform to be 
correlated) and summed to produce the resulting data point. The template is then moved one data sample 
forward and the operation is repeated to produce the next resulting data point. The resulting data points 
replace the waveform to be correlated. 
The correlation function algorithm can be expressed by the following formula, where foutput(n) is the 
resulting data point, ftemplate(k) is the template waveform data points, and K is the number of data points 
in the template: 

∑
K

1 =k 
waveformtemplateoutput (n)f * (k)f = (n)f  

b) Convolution is identical to the correlation function except that the template waveform is reversed during 
the operation. This function is not generally useful by itself, but can be used as a building block for more 
sophisticated transformations. The convolution function algorithm can be expressed by the following 
formula, where foutput(n) is the resulting data point, ftemplate(k) is the template waveform data points, 
and N is the number of data points in the template: 

f (n) =  f (-k) *  f (n + k)output template waveform

k = -N/2

N/2 - 1

∑  

c) Mean square error positions the template at the cursor position in the waveform to be compared. Each 
point in the template waveform is subtracted from the corresponding point in the waveform to be 
compared. The result is squared and summed to produce the resulting data point. The template is then 
moved one data sample forward and the operation is repeated to produce the next resulting data point. The 
resulting data points replace the waveform. 
The mean square error function tends to amplify the error (or difference) between the template and the 
waveform, which makes it useful when you are looking for an extremely close match rather than a general 
comparison. When a match is found, the mean square error algorithm returns a value close to zero. 
The mean square error function algorithm can be expressed by the following formula, where foutput(n) is 
the resulting data point, ftemplate(k) is the template waveform data points, and K is the number of data 
points in the template: 

f (n) =  [f (k) -  f (n)]output template waveform

k = 1

K

∑
2

 

d) Inverse Mean square error simply inverts the result of the mean square error algorithm. Accordingly, 
when this algorithm finds a match between the template and the data, the algorithm returns the inverse of 
a value close to zero and, typically, a large positive spike will occur at the point of the match. 

e) Mac AcqKnowledge 3.9.1 and later only Remove Projection Template removes the projection of a 
reference signal from another part of a signal (whereas the other template functions revolve around the 
comparison of a portion of a signal against a reference signal). 

Remove Projection treats the template in memory as a vector. The projection of the selected area onto the 
template is computed as a vector dot product. This projection is then removed from the source data. After 
a remove projection transformation, the remaining data consists of the part of the signal that is the most 
unrelated to the template. 
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Remove Projection can be useful for emphasizing signal differences. For example, it may be useful for 
exploring differences in an arrhythmia in comparison to a normal reference beat. It may also be useful as 
a denoising building block by removing the projection of a signal against idealized noise in the template. 

The number of samples in the template should match the number of samples in the selected area of source 
data. 

• Dot product is undefined for vectors of mismatched dimensions. 

• If the template is longer than the selected source data, the template will be shortened (for that 
single transformation; it will be restored afterward) so its length matches the selection width. 

• If the selection is longer than the template, any data occurring after the end of the template will 
not be transformed. 

To create a Remove Projection template: 
1. Highlight the portion of data to be used as the reference signal. 
2. Transform > Template > Set Template. 
3. Highlight the portion of the data to be analyzed. 
4. Transform > Template > Remove Projection. 
 

f) Mac AcqKnowledge 3.9.1and later only Normalized cross-correlation is useful when searching for 
variations in the signal. Regular cross-correlation (Transform > Template > Correlation) can exhibit large 
amplitude spikes when the energy of a signal varies greatly or amplitudes change suddenly, causing 
jumps that are not necessarily indicative of a match with the template. Normalized cross-correlation is a 
statistical method that can help resolve these issues by applying normalization to both the template and 
signal being searched. This reduces the effect of amplitude variation in the result, making normalized 
cross-correlation useful for template matching purposes. 
This transformation computes the windowed normalized cross-correlation, and results in a value between 
-1 to 1, which indicates the linear fit of the data set. Normalized cross correlation is defined as: 
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where x = template 
y = signal 
L = length 

= mean value of the signal f 
At the end of the transformation, the source data will be replaced with the sliding NCC values. Data 
outside the selected area will be left unmodified. If the selected area is zero width when the 
transformation is to be executed, the entire waveform will be transformed. 
If selection is shorter than the template, the missing data at the right end of the selected area will be filled 
with zero padding until it matches the length of the template. This padding occurs in memory and will not 
affect the source data in the graph. This same zero padding is used when computing NCC at the end of 
every selected area when the template is running off the end of the data. This zero padding should trend 
the NCC to zero at the right edge of the transformed area, in most cases. 

g) Mac AcqKnowledge 3.9.1 and later only Adaptive Template Matching 
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Many different types of physiological analysis involve locating repetitive features within a signal. These 
may occur at regular intervals or may occur sporadically. Sometimes the features of interest may be 
intermingled with other results, such as occassional heartbeat arrhythmias occurring in a long-term ECG 
recording. Template matching is one frequently used approach for locating areas of waveforms that 
exhibit certain characteristics. An example feature is specified as the input template and then, using cross 
correlation or related methods, the areas of an arbitrary wave that most strongly match the example can be 
located. 
Adaptive Template Matching allows the template to vary during execution to incorporate changes to the 
morphology of signal features. The adaptation consists of a moving average of a number of the most 
recent matching features. A template match will be defined as a peak in the windowed normalized cross 
correlation of the adapting template with the signal. Normalized cross correlation  helps to eliminate 
artifact due to baseline shift and  changes in overall power and amplitude. This heuristic is sensitive to  
waveform morphology instead of amplitude. 
Template width 

The number of samples in the template that will be used as the initial template for the transformation, 
as set using Transform > Template Functions > Set Template. 

Note One template is shared globally by all graphs and data views in AcqKnowledge. 
Average template window size 

Input positive integers only. Provides the number of previous matches to be used for constructing the 
average template estimate. 

Correlation threshold 
Floating point input in the range -1 to 1. Provides the threshold used for peak detection on the 
normalized cross correlation signal. Corresponds to r in the algorithm description. 

Normalize matching data before updating average template 
Toggle check box. When enabled, the reference set normalization algorithm option is used. This 
performs mean subtraction and unit magnitude normalization to every member of the reference set 
prior to constructing the average template. This option can help to compensate for unintentional 
weighting of the windowed average template towards larger amplitude data. 
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Reject matches closer than 
When checked, the minimum match interval algorithm option is used. This rejects matches that are 
too close together and can compensate for degeneration of the algorithm into continual matching due 
to signal self similarity. The edit field contains the minimum width that must separate valid matches. 
The width must always be a positive number. The popup menu specifies the units of the separation 
interval. Its contents are dependent on the horizontal axis type: 

Time (seconds & HH:MM:SS) Frequency Arbitrary 
samples samples samples 
milliseconds Hz arbitrary units 
seconds 
minutes 
hours 

Output 
Show normalized cross correlation values provides access to the sequence of correlation values that is 
examined by the heuristic for potential matches. Viewing the normalized cross correlation signal can 
provide feedback that is useful for proper threshold selection and for detecting whether the heuristic 
has fallen into one of its degenerate cases (e.g. NCC signal hovering around the threshold for 
extended periods of time). When checked, a new channel will be added into the graph containing the 
normalized cross-correlation values computed by the algorithm.The channel will be labeled “NCC 
Values.” 
Generate synchronization waveform allows for the generation of spike trains. The value of the wave 
in the graph will be zero by default. At each sample position where a match with the average template 
is triggered, the wave value will be set to one. A single sample position set to 1 indicates a single 
valid match. This synchronization wave can be used in conjunction with the cycle detector to perform 
further data reduction, input to the rate detector for computing match frequencies, and other analysis. 
Define events at match locations output allows placement of an event on the waveform being 
analyzed at the location of each valid match. The event output can allow adaptive template matching 
to be used to construct classifiers that provide event locations for further data reduction with the cycle 
detector.  

 Type—Used to choose the type of event that will be defined at match locations. Displays the 
standard hierarchical menu list of event types. 

 Label—Label to be given to events defined at match locations. 
Transform entire wave 

When checked, the entire waveform will be analyzed. When unchecked, only the selected area will be 
transformed. 
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Integral 

Integral is essentially a running summation of the 
data. Each point of the integral is equal to the sum 
of all the points up to that point in time, exclusive 
of the endpoints, which are weighted by half. The 
exact formula is below, where f( ) is the data values 
and ΔTs is the horizontal sampling interval: 

f (n) =  f (k) f (n -1) +  f (n)] / 2]* Tsoutput input

k = 1

n -1

input input∑ + [[ Δ  

The units will be (amplitude units • horizontal units). The integral function can be used to compute the area 
under the curve in a continuous fashion. For instance, if you had data acquired by an accelerometer, the 
integral of the data would be the velocity, and the integral of the velocity would be the distance. As with all 
transformations, this function can be applied to either a selected area or to the entire waveform. 
Derivative 

   
Derivative calculates the derivative of the selected area of a waveform. Since high frequency components 
return nonsensical results in a derivative, a low pass filtering function is included in the Derivative function 
(see page X535H220 X for more information on low pass filters). Derivative is based on an FIR filter implementation. 
The Filter Response for a Derivative transformation will be displayed as a linear graph, not in (log). The 
Derivative FIR filter frequency response will appear as a linearly increasing magnitude up to the point of the 
specified cutoff frequency, at which point, the filter magnitude will drop off sharply. 

 
Derivative can provide a more meaningful result than Difference (which often has a higher than required 
frequency response, thus processing potentially undesirable data). However, if your data is already “well 
behaved” (i.e., low pass filtered or contains little or no high frequency information), you can use Difference 
with a 2-sample interval to quickly generate results very similar to Derivative. 
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Cutoff Frequency The value entered in the cutoff frequency box should be roughly equivalent to the 
highest frequency component of interest present in the time series data. The default 
cutoff frequency is 0.125 times the waveform sampling rate. 

 Sampling rate—Mac AcqKnowledge 3.9.2 and later Sets the frequency to a fraction of 
the sampling rate and automatically updates when the sample rate is modified. 

 Line frequency—Mac AcqKnowledge 3.9.2 and later Uses the line frequency at which 
the data was recorded.  

 # of Coefficients Fixed—The default number of coefficients is (4 x waveform sampling rate)/Cutoff 
Frequency. As the number of coefficients (Q) increases, the Derivative becomes more 
accurate. Fixed can produce better filters but may take longer to execute. 

 Optimize for sample rate and cutoff— Mac AcqKnowledge 3.9.2 and later Estimate the 
number of coefficients as four times the sampling rate divided by the cutoff frequency 
of the filter. Optimize does not necessarily produce the best quality filter, but takes less 
time. 

 
Units Mac only Select linear units or dbV. 

 
 

TIP: A good rule of thumb is to use a number of coefficients greater than or equal to 
two times the sampling rate divided by the lowest cutoff frequency specified. 
For example, if running a low pass filter at 1Hz on data sampled at 100 Hz, 
choose at least (2 x 100/1) or 200 coefficients in the filter. Additional 
coefficients will improve the response. 
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Integrate 

The Integrate transformation operates the same as 
the Integrate calculation—see page X536H63 X, except it 
does not have a Max Cycle option, which is not 
relevant post-acquisition, and Reset via channel 
with mean subtraction enabled functions differently 
online and offline. 
 
Root mean square is implemented as:  

Sqrt(sum(x^2)/(n)) 

Reset 
Online Mean subtraction causes the online version to be delayed by the mean cycle length. It waits 

for that period of time to pass so it can determine a mean value for the initial cycle, and it 
then tries to re-compute this mean for each cycle. If the resets are too short or too long, the 
window expires and the processing halts again until a new mean can be recomputed. Online 
processing may reset from threshold crossing in the control channel or window expiration 
when it loses mean tracking. 

Offline  Since all the data is available, the mean is computed from the data in the channel and doesn't 
delay the signal. Also, since it isn’t doing windowed means, there are no window expiration 
events that are inserted. Offline processing may reset from threshold crossing in the control 
channel. 

Output Reset 

Mac OS X 
Enable the 
checkbox 
option to 
create an 
Event at each 
signal reset. 

  
Windows/PC 
Manually 
overlap the 
source and 
response 
waveforms to 
identify 
signal reset. 
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The Integrate formula is the same in the calculation (online, real-time) mode and the transformation (off-line, 
post-processing) mode; it varies only based on the parameters selected. 

Notes 

• For the first points, value of index “i” will be less than or equal to zero; it means that for 
summation you have only values beginning with ( )1xf . 

o For the first point for summation you have: ( )1−xf , ( )0xf , ( )1xf . 

( )1−xf and ( )0xf  - don’t  exist, so you have only ( )1xf . 
o For the second point for summation you have: ( )0xf , ( )1xf , ( )2xf . 

( )0xf  - doesn’t exist, so you have only ( )1xf + ( )2xf . 
• The Integrate formula is implemented as a Standard Deviation formula (see 

mathworld.wolffram.com > Wolfram Research > equation 5 at 
H10Hhttp://mathworld.wolfram.com/StandardDeviation.html H). 

• The Root Mean Square formula is identical to the Standard Deviation formula, but without mean 
removal; this is the n-1 definition. 

o For an explanation of n-1 verus n in the formula, see notes as a H11HpdfH or 
H12Hhttp://www.uic.edu/classes/mba/mba503/971/503nts3.htmH. 

o For a window size n, to convert from the n-1 definition to the n definition, use
n

n )1( −  

• The formulas to calculate RMS are optimal for data with a 
zero mean (typical for biopotential data). For data with a non-
zero mean, scaling can be applied. Click  the “Scaling” button 
in the Integrate dialog (or click the channel’s vertical scale to 
generate the Vertical Scale dialog and then click the “Scaling” 
button), and then enter the following parameters: 

Input value    Scale value 
 10 7.07107 
 -10 -7.07107 

 

 
  

 
1. Via samples, no extra parameters selected 

( ) ( ) xxfxF
j

sji
ij Δ= ∑

+−=

*
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Where: 
i - index for source values (***the real range is 1..j); 
j - index for destination values (1..n); 
n - number of samples; 

ix , jx - values of points at horizontal axis; 

( )ixf - values of points of a curve; 
( )jxF - integrated values of points of a curve; 

s – number of samples to average across; 

1
1

−
−

=Δ
n

xx
x n  - horizontal sample interval; 

1, xxn  - values at horizontal axis at the endpoints of selected area. 
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Integrate formulas, continued…  See Notes on page X537H242X 

  2. Via samples, rectify 

 ( ) ( )( ) xxfABSxF
j

sji
ij Δ= ∑

+−=

*
1

 
Where:           
i - index for source values (***the real range is 1..j); 
j - index for destination values (1..n); 
n - number of samples; 

ix , jx - values of points at horizontal axis; 

( )ixf - values of points of a curve; 
( )jxF - integrated values of points of a curve; 

s - number of samples to average across; 

1
1

−
−

=Δ
n

xx
x n  - horizontal sample interval; 

1, xxn  - values at horizontal axis at the endpoints of selected 
area.  

3. Via Samples, root mean square (RMS) 
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Where: 
i - index for source values (***the real range is 1..j); 
j - index for destination values (1..n); 
n - number of samples; 

ix , jx - values of points at horizontal axis; 

( )ixf - values of points of a curve; 
( )jxF - integrated values of points of a curve; 

s - number of samples to average across.  
4. Via samples, root mean square, remove baseline 
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Where: 
i and m- indexes for source values (***the real range is 1..j); 
j - index for destination values (1..n); 
n - number of samples; 

ix , jx - values of points at horizontal axis; 

( )ixf - values of points of a curve; 
( )jxF - integrate values of points of a curve; 

s - number of samples to average across. 
k - coefficient: for the first few points that have index j < s  k=j, 

for the other points with j > =s    k=s 
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Smoothing 

 
The smoothing function is a transformation that computes the moving average of a series of data points and 
replaces each value with the mean value of the moving average “window.” This has the same effect as a crude 
low pass filter, with the advantage being that smoothing is typically faster than digital filtering. 
Samples AcqKnowledge allows you to set the width of the moving average window (the number of 

sample points used to compute the mean) to any value larger than three. By default, this is 
set to three samples, meaning that AcqKnowledge will compute the average of three 
adjacent samples and replace the value of each sample with the mean before moving on to 
the next sample. For data acquired at relatively high sampling rates, you will probably want 
to set the smoothing factor to a higher value, since smoothing three sample points when 
data is collected at 1000Hz will only average across three milliseconds of data, and will 
typically do little to filter out noise. To set the size of the window, enter a value in the 
Transform>Smoothing dialog box. 

 This function is most effective on data with slowly changing values (e.g., respiration, heart 
rate, GSR) when there is noise apparent in the data record. 

Mean value Mean value smoothing is the default and should be uses when noise appears in a Gaussian 
distribution around the mean of the signal. The Mean value smoothing formula is shown 
below, where “m” is the number of points in the window and “n” is the sample number: 

m/(k)f   = (n) f
1)/2]-[m+nk

(m/2)-n=k

inputoutput ∑
=

 

Median value Use Median value smoothing if some data points appear completely aberrant and seem to 
be “wild flyers” in the data set.  

  The Median value smoothing formula is shown below, where “m” is the number of points 
in the window and “n” is the sample number: 

[m/2]) n [m/2];-(n median   = (n) f output +  

Scaling  Generates the Scaling Parameters dialog. 
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Difference  

 
The Difference function measures the difference (in amplitude) of two sample points separated by an arbitrary 
number of intervals. The difference is then divided by the total interval between the first selected sample and 
the last selected sample. 
When you select the difference transformation, a difference interval dialog box will be generated and you can 
enter the number of intervals between samples (default of 1). 
For data with no high frequency components, a 1-interval difference transformation approximates a 
differentiator. 
Since it is not implemented as a convolution, Difference is much faster than the derivative function. 
The formula for the difference transformation is shown below, where “m” is the number of intervals 
difference, [ ] rounds the integer down, “n” is the sample number, and ΔTs is the horizontal sampling interval: 

foutput(n) = finput(n + [m/2])—finput(n—[(m+1)/2]) 
 (ΔTs * m) 

Example for boundary values when 
m = 3:

foutput(0) = (finput(1)—finput(0)) / (ΔTs * m) 
foutput(1) = (finput(2)—finput(0)) / (ΔTs * m) 
foutput(2) = (finput(3)—finput(0)) / (ΔTs * m) 
 

If you enter an odd number
(K = odd):

foutput(K) = (finput(K+1)—finput(K –2)) / (ΔTs * m) 
 

If you enter an even number
(K = even):

foutput(K) = (finput(K+2)—finput(K –2)) / (ΔTs * m) 

 
 
Note:  The online (real-time) Difference calculation is calculated differently because projected values are not 

available. The online Difference formula is: 

foutput(n) = finput(n –m)—finput(n) / (ΔTs * m) 
 Using the default difference setting of 1 interval will produce a “ΔP/ΔT” waveform when the 

transformation is applied to a blood pressure or similar waveform.  
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Histogram 

  
The Histogram function produces a histogram plot of the selected area. When a histogram is created, the 
sample points are sorted into “bins” along the horizontal axis that contain ranges of amplitude values. These 
bins divide the range of amplitude values into equal intervals (by default, ten bins) and the individual sample 
points are sorted into the appropriate bin based on their amplitude value. 
For instance, if a waveform had a range from 65 BPM to 85 BPM, the lowest bin would contain all data 
points with a value from 65 BPM to 67 BPM. The second lowest bin would hold all data points between 67 
BPM and 69 BPM, and so on, until the tenth bin was created. AcqKnowledge then counts the number of 
“hits” (the number of data points) in each bin and plots this number on the vertical axis. 
The Transform>Histogram Options dialog box has these options: 
bins Determines how many bins the data will be divided into; the default is ten bins.  
Autorange  Fits all the data selected into a bin; the bin sizes are determined by the extent of the data and the 

desired number of lines. Automatically sets the center of the lowest bin equal to the minimum 
value of the waveform (or the selected area, if a section is highlighted), and centers the highest 
bin on the maximum value of the waveform (or selected area, if any).  

Manual  Use to fix the bin sizes. Enter values for the Highest Bin and Lowest Bin. 
Mac OS X only—Manual and Autorange are toggled instead of radio buttons. 
When you click OK, a histogram plot will be generated in a new window. By default, AcqKnowledge displays 
the frequency of occurrence for each bin on the vertical axis. To calculate the cumulative frequency, select the 
entire histogram waveform and choose Integrate from the Transform menu. 
Since the histogram function sorts sample points into a relatively small number of categories, the histogram 
window is likely to display a large number of “hits” in each bin, especially if data was collected at a relatively 
fast sampling rate. If this is the case, you may want to resample the data at a lower rate (using the 
Transform>Resample function). The caveat to this is that resampling the data may cause a bias, unless the 
data was filtered to remove all frequency components that are more than 0.5 the resampling rate. 
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Resample 
Resample Graph 
Resample Waveform 

Resample – AcqKnowledge Windows 

 
Resample Graph – AcqKnowledge Mac 

 
Resample Waveform - AcqKnowledge Mac 

Resample is equivalent to Mac OS X Resample Waveform. 
This function resamples the active channel to another rate. Resampling data maintains the same time scale but 
changes the number of samples per second. You can also use Resample to increase the number of sample 
points per interval (usually samples per second). When this is done, AcqKnowledge will interpolate between 
sample points to adjust to the new rate. This will add data points, although not necessarily more information. 

 Resampling to a a lower sampling rate will “compress” a data file. 
 For instance, a 4-channel data file sampled at 250 samples per second for 15 minutes takes up 

about 1.8 MB of disk space. If these channels are resampled to 100 samples per second, the size 
of the file on disk is about 720 KB, a considerable reduction 

 Whenever data is resampled to a lower rate, information is lost. 
 The highest sampling rate that a channel can be resampled to is the file acquisition rate (MP menu > 

Set up Acquisition). 
 If data is resampled to a lower rate and then resampled again at a higher rate, the waveform will 

maintain the resolution of the lower sampling rate, only with more data points. 

TIP:  A good rule of thumb is that data should be sampled anywhere from two to ten times 
the highest frequency component of interest. 

The alpha component of an EEG signal has a frequency signature of 8-13Hz, so (assuming you have isolated 
the alpha component using a band pass filter) you would probably want to sample the data (in this case, 
isolated alpha waves) at a rate of at least 26Hz and probably no more than 130Hz. 
Arbitrary Sample Rate 
Arbitrary Sample Rate options are equivalent to Mac OS X Resample Graph. 
To apply an arbitrary, user-defined sample rate to ALL CHANNELS, enable this option, enter the arbitrary 
rate into the text box, and then click OK. 

 The highest rate you can enter is the Acquisition Sample Rate. 
 This option applies the specified rate to ALL CHANNELS, but will adjust as necessary to maintain 

the established channel rate/acquisition rate proportion. 
 You can create channel-specific rates by changing the channel sample rate after Resampling. 
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Resampling Interpolation Options 

 
AcqKnowledge 3.91 Mac only—Variable sampling rate and the flexible acquisition speeds of MP units can 
create data sets that are at different sampling rates. For some types of data analysis, the data must be 
resampled to a common sampling rate. AcqKnowledge has resampling facilities with 

• Transform > Resample Graph 
• Transform > Resample Waveform 
• Pasting between graph windows of different sample rates when the “Interpolate pastings 

between windows” Preference is enabled (via Display > Preferences, page X538H311X). 
AcqKnowledge provides three interpolation options for resampling data: padding, linear, or cubic spline. The 
interpolation method can be chosen through popup menus in the graph and waveform resampling sheets for 
the transformations and through a popup menu in the Preferences dialog for interpolated pasting between 
windows. 
Any changes made to the interpolated pastings between windows Preference and the interpolation method 
used in the Preferences dialog will be retained across launches of the software. 

Padding 
Padding will use the closest original value of the waveform to the left of the new sample position for 
the value, constructing a padded square save as the data is resampled. Padding is desirable when it is 
imperative no new data or data approximations get introduced into an analysis. 

Linear interpolation 
Linear interpolation is the default; previous software versions generated any missing data via linear 
interpolation. This method uses the sample points of the old waveform as the endpoints of a line. 
Missing data points are approximated from points lying on this linear segment. 

Cubic spline interpolation. 
Cubic spline interpolation will construct a spline for the entire data set and use the values of this 
spline as the new waveform values. A natural fit spline is used that keeps zero second derivative at 
the endpoints of the fit. Cubic splines are useful when the analysis requires data with a smooth 
derivative. 
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Equation Generator (Expression) 

   
Equation dialog boxes (PC on left, Mac on right) 

The post-acquisition Equation Generator (Expression) is available for performing computations more 
complex than available with the Math and Function calculations. The post-acquisition version of the Equation 
Generator includes all the same features as the online version described on page X539H77 X. The Equation Generator 
will symbolically evaluate complex equations involving multiple channels and multiple operations. Unlike the 
Math and Function calculations, which can only operate on one or two channels at a time, the Equation 
Generator can combine data from multiple analog channels, or specify other calculation channels as input 
channels. Also, computations performed by the Equation Generator eliminate the need for “chaining” multiple 
channels together to produce a single output channel.  
To have AcqKnowledge solve an equation/expression and save the result to a new channel, choose Equation 
Generator from the Transform menu. A dialog box will be generated. For each equation/expression, specify a 
source channel (or channels), the function(s) to be performed, any operators to be used, and a destination for 
the result. The different components of each equation/expression can be entered either by double-clicking 
items from the pop-up menus (sources, functions, and operators) in the setup dialog box, or by typing 
commands directly into the box using standard mathematical notation. 
You can divide a complex equation into several steps and perform each part of the equation with a separate 
channel. With up to 60 channels, almost any calculation can be performed. 
When using the Equation Generator, both the Mac and PC versions of AcqKnowledge can reference past and 
future points. 

See the tables starting on page 75 
for descriptions of sources, 
operators and functions for the 
Equation Generator/Expression 
dialog. 
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Delay 

 
Mac AcqKnowledge 3.9.2 and later only—AcqKnowledge has a calculation channel that can be used to add 
time delays to signals. The equivalent delay transformation allows the addition of time delays in 
postprocessing. Similar to the calculation channel, the time delay can be added by introducing zero-valued 
samples at the start of the area to be delayed. The length of the waveform will remain the same; an amount of 
data at the end of the wave prior to the delay will be lost, with the length equal to the delay. The delay can be 
applied by using the Transform > Delay menu item.  
When inputting the delay amount, the units can be changed between seconds and samples. 

• The samples units are relative to the graph sampling rate, the highest possible sampling rate for 
information in the graph. If using delays on waveforms that have been downsampled, the actual 
number of samples introduced will be the value in the dialog divided by the waveform’s sampling 
rate divider.  

The Automator action allows Delay to be used in Automator workflows. See page X540H19 X. 
 

Rescale 

 

The Rescale transformation operates the same as the Rescale calculation—see page X541H90 X. 

Waveform math 

 
The Waveform math transformation allows arithmetic manipulation of waveforms. Waveforms can be added 
together, subtracted, multiplied, divided or raised to a power. These operations can be performed using either 
two waveforms or one waveform and an arbitrarily defined constant. You can operate on the entire waveform 
by choosing Edit>Select all, or operate on portions of the waveform that have been selected using the cursor 
tool. If there is no selected area, only one sample point (the one selected by the cursor) will be transformed. 
When you select Transform>Waveform Math, the Waveform Arithmetic dialog will be generated. 
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All of the main components of a waveform math calculation can be selected from pop-up menus in the 
Waveform Arithmetic dialog box. 
Source  The channels to be used in the transformation are referred to as source channels (Source 1 

and Source 2), and can be combined using any of the operators in the pop-up menu. Source 
channels allow you to select any of the existing channels in the current window, or a 
constant (defined by K). 

Constant The “Constant =” entry box is activated when a Source is set to “K, Constant.” 
Operand  The pop-up menu allows selection of addition, subtraction, multiplication, division or power 

functions.  
Destination  You can save the results to an active channel, or create a new channel to store the results. 

Choose an existing channel from the pop-up menu or select the “New” option, which will 
create a new channel (using the next available channel). 

Result sample  When using variable sample rate processing, the Equation Generator and Waveform 
rate Math functions will constrain operations between waves of different rates as follows: 

 If an equation is operating on two or more waves of different sample rates, the result 
of the operation will always be output at the lowest sampling rate from the waves (F 
low). 

 If the destination channel for the result has an assigned rate other than (F low), the 
operation will not be permitted. 

 If the destination channel is set to a new channel, the operation will always be 
permitted. 

Scaling… Generates the scaling parameters dialog. 
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Waveform math can be used many ways. As one example, two waveforms can be added together. The 
following screen shows a sine wave in channel 14 and a triangle wave in channel 16. 

 
To add these two waves, select Transform>Waveform Math and set source 1 to channel 14, the operator to 
addition “+”, source 2 to channel 16, and destination to New as shown here: 

 
Click OK to perform the transformation. The following screen shows the sum of CH14 and CH16 on a new 
channel. 

 
 

NOTE:  If you select two waveforms of unequal length as sources, the length of the resulting 
waveform will be equal to that of the shortest one. Likewise, if one of the source 
waveforms extends only into a portion of the selected area, the resultant waveform 
will only be as long as the shortest source portion. If waveform math is performed 
on a selected area and output to an existing waveform that does not extend into the 
selected area, the resultant waveform is appended to the destination waveform. 
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Nonlinear Modeling 

About nonlinear modeling 
Modeling is used in physiological data to assess how well data conforms to a theoretical model. This is 
used to express a sampled signal in a continuous form and to perform data reduction. The nonlinear 
modeling features in AcqKnowledge support more advanced physiological analysis than is possible with 
the linear regression measurement, which is a rudimentary single order linear model. 
Nonlinear modeling is the process of finding the best fit of a mathematical function to an arbitrary data 
set. Fitting the function—or model—to the data consists of choosing a set of function parameters that 
minimize error between the actual data points and the values generated from the model function. 
Nonlinear modeling functions can be arbitrarily complex. When the model is close to the shape of the 
data, the fits between different data sets may be good indicators of subtle variations in the data. 
Most general-purpose methods of performing modeling are iterative and require an estimator for the 
function. A commonly used estimator is the least means squares (LMS) estimator. Nonlinear models can 
be estimated from data by combining LMS estimators with multidimensional function minimization 
algorithms. 
Applications in hemodynamics 

Many pressure and ECG signals exhibit regular morphologies. Fitting data to models that share these 
characteristics helps emphasize subtle differences in waveforms though variations in their model 
parameters. Nonlinear modeling is one of the most accepted methods for computing indexes for the 
relaxation period of left ventricular pressure. Cardiac researchers have used the time constant “tau” in 
various studies on cardiac function and abnormalities. Tau is determined by one of the parameters to 
an exponential model of the trailing end of the pressure signal. Studies have indicated that tau can be 
a good indicator of cardiac dysfunction, but reliable methods for its calculation have proven difficult 
and the effort is ongoing. The generic modeling abilities in AcqKnowledge allow researchers to 
analyze data using the tau constant and potentially develop robust algorithms for its calculation. 

See the NLM measurement on page X542H158X 

Mac OS X only—Nonlinear modeling (also called 
“arbitrary curve fitting“) determines the “best fit” of an 
arbitray function to source data; the function is called a 
model. 
AcqKnowledge uses a Nelder-Mead simplex search with 
a Euclidean distance function. A model must match 
underlying trends in the data to produce meaningful 
results. Also, to properly interpret the value of the best fit 
coefficients and any further derived results, users must 
consider the limitations of the simplex search method, 
which include: estimation only; not guaranteed to 
terminate; not guaranteed to find the exact solution; may 
get stuck in local minima. 

Nonlinear modeling generates a new display and replaces source data with a model of equal (unless specified) 
length and also pastes model parameters as text to a journal. The sampling rate and axis units match the 
source graph. 
Max iterations 

Indicates the number of iterations after which the simplex search will be terminated if no convergence has 
been achieved. 

Tolerance 
Provides the tolerance used for termination of the algorithm. If the estimator decreases in two consecutive 
steps by less than this tolerance, the simplex search will halt. 
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Model origin placement 
Controls where the zero point of the model is placed. Selection-relative placement is useful when 
comparing different sections of the same channel of data by looking for variations in their best fit model 
parameters. If channel data is used as part of the Model Expression the location from where the channel 
data is extracted will not be translated; regardless of the model origin setting, the channel data will be used 
from the selected area only. 

Model Expressions 
Models are defined through basic expressions, called Model Expressions. See the function tables starting on 
page X543H81X for details on Sources, Functions, and Operators. 

Preset 
The following presets for the most common types of models are included. Users can extend presets or 
create custom models if these presets are too general to achieve exact fits with simplex search. 

Preset Description Equation 

Cubic 3rd order polynomial. param(3)*(TIME^3)+param(2)*(TIME^2)+param(1)*TIME+param(0) 

Gaussian Standard Gaussian model; useful 
for peak fitting. 

param(0)*EXP(-((TIME-param(1))/param(2))^2 

Linear Basic linear fit of the data. param(1)*TIME+param(0) 

Logarithmic Logarithmic growth and decay; 
useful for initial rapid growth/decay 
followed by gradual 
decline/increase. 

param(0)*LOG(TIME-param(1))+param(2) 

Logistic Logistic LVP relaxation model; 
TL given by a(1). 

param(0)/(1+EXP(-TIME/param(1)))+param(2) 

Monoexponential Exponential LVP relaxation model;
Te given by a(1). 

param(0)*EXP(-TIME/param(1))+param(2) 

Power Series Useful for a wide variety of data, 
e.g. reactant analysis. 

param(0)+param(1)*(TIME^param(2)) 

Quadratic 2nd order polynomial. param(2)*(TIME^2)+param(1)*TIME+param(0) 

Weibull 
Distribution 

Commonly used in reliability 
analysis. 

param(0)*param(1)*TIME^(param(1)-1)*EXP(-param(0) 
*TIME^param(1)) 

Sources 
All channels except the channel being modeled can be used as Sources; if the channel of data being 
modeled is inadvertently set as a Source, a syntax error prompt will be generated. 

Parameters 
Parameters are represented by param(n) where n is an integer index starting from zero. For example, in the 
linear model param(0)*x+param(1), param(0) can be interpreted as the “a” in “ax+b and param(1) can be 
interpreted as the “b” in “ax+b”. 

Output to Journal displays the result of the modeling as text in the journal. 
Show model in separate graph generates a separate graph to display the best fit model. 
Length specifies the length of the separate model graph in samples. 
Don’t modify waveform suppresses replacement of the selected source data. 

 If the model fitting does not complete successfully, the original data will be preserved regardless 
of the state of this selection. 

Transform entire wave 
Fits the entire data of the selected waveform to the model, with model origin at start of graph. 
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Autoregressive Modeling 

About autoregressive modeling 
Autoregressive Modeling is a linear mathematical modeling algorithm that represents a signal as a 
weighted sum of its previous values combined with a noise factor. Autoregressive models are adept at 
capturing frequency behavior of an input signal and may be useful in generating high-resolution FFTs 
from undersampled data. 
AR models are well suited to operation on discrete series of data and are particularly useful for 
expressing frequency information of a signal. Consecutive models can be used to perform advanced 
time series analysis, compression, denoising, arrhythmia detection, and waveform classification. AR 
models are commonly used on physiological data in advanced spectral analysis, and increasingly for 
classification of heart rhythms and gastric waves or visual detection of arrhythmias. 
AR models can be used to extrapolate spectral features from waveforms at low sample rates. 

 Generate high-resolution FFTs without fast acquisition sample rates (quite useful for 
electrogastrogram analysis). 

 An FFT from a 3,000-point AR Model provides the same result as a 42,000-point FFT. 
 Examine spaces of AR parameters for feature extraction. 

Since the underlying model is linear, AR modeling is not appropriate for representing signals that are 
inherently chaotic. 

 
AR Time-Frequency Analysis is on page X544H256X. 

Mac OS X only—Autoregressive modeling estimates 
the parameters of a fixed-order autoregressive model, 
representing a model output value as a linear sum of 
previous input values. AR modeling may replace the 
source data with the model of equivalent length. The 
output length is equal to the source data, unless 
specified. 

Output can also paste model parameters as tabular text to a journal. If “Don’t modify waveform” and “Show 
model in separate graph” are both enabled, a new graph window will be generated to display the specified 
number of samples resulting from the best-fit autoregressive model. 
 
Power Spectral Density 
The PSD extracts the power present at different frequencies within a signal and is useful for EMG analysis. 
AcqKnowledge uses the Welsh approximation algorithm to average signal time-sliced portions of the signal 
and reduce noise effect, and generates a two dimensional graph displaying the wattage of a particular 
frequency component in a signal. The graph is plotted as horizontal frequency vs. vertical (units)^2/Hz, where 
units are the vertical axis units of the source data. The PSD transformation approximates the same result as 
squaring the linear FFT magnitude, but does not allow for user-defined settings (windowing, dB/linear, etc.). 
Not available when the horizontal units of the source graph are set to Frequency. 
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AR Time-Frequency Analysis 
Mac OS X only—The AR Time-Frequency transformation 
can be used to examine changes in the spectral density of a 
signal using enhanced frequency resolution from derived 
AR models. Examining frequency changes over time can be 
a useful tool for arrhythmia detection and rough 
classification of waveforms. 
Autoregressive spectrum time-frequency analysis divides a 
waveform into equal-length time segments, calculates an 
AR model (see page X545H254X) for each individual time segment, 
and then computes a power spectrum from the model. (To 
perform raw data time-frequency analysis, use the 
Cycle/Peak detector with the FFT 3D output option.)  
 

Time interval 
Enter a positive floating point value to specify the segment width; the source signal is split into fixed length 
segments of this width and a frequency spectrum is generated for each segment from a model of its data. 

Model order 
Enter a positive integer to specify the order of the AR model that is constructed on an interval by interval 
basis. 

Frequency resolution 
Enter a positive integer to indicate the number of points contained in the FFT of an individual time 
segment; it will be rounded to the closest power of 2 when analysis is performed. 

Amplitude scaling 
“Normalize amplitudes” scales amplitudes such that the maximum peak-peak distance is equal across time 
intervals. 

Show 3D Output 
Constructs a 3D surface plot of the time-frequency analysis with amplitude vs. frequency vs. time. 

Paste results to journal 
Inserts a series of tab-delimited tables representing the frequency distributions on a cycle-by-cycle basis 
into the Journal. 
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FFT Fast Fourier Transformation 

 
The FFT algorithm requires that the length of your data be an exact power of 
two (i.e., 256 points, 512 points, 1024 points, and so on). 

The Fast Fourier Transformation (FFT) is an algorithm that produces a description of time series data in terms 
of its frequency components. This is related to the frequency spectrum. The FFT displays the magnitude and 
phase of the time series data selected and displays only the DC and positive frequency components; the FFT 
does not display negative frequency components. To reconstruct a signal from additive sines or cosines, you 
need to include both the positive and negative frequency components. Since it’s not physically possible to 
generate a negative frequency signal, you need to double the amplitude of the corresponding positive 
frequency component. 
The output from an FFT appears in a graph window with magnitude (vertical axis) plotted against various 
frequencies (horizontal axis). A large component for a given frequency appears as a positive (upward-
pointing) peak. The range of frequencies plotted is from 0 Hz to 1/2 the sampling frequency. Thus, if data was 
collected at 200 samples per seconds, AcqKnowledge will plot the frequency components from 0 Hz to 100 
Hz. 
Fourier analysis can yield important information about the frequency components in a data set, and can be 
useful in making determinations regarding appropriate data cleaning techniques (e.g., digital filtering). The 
FFT algorithm assumes that data is an infinitely repeating periodic signal with the end points wrapping 
around. Thus, to the extent that the amplitude of the first point differs from the last point, the resulting 
frequency spectrum is likely to be distorted as result of this start point to end point discontinuity. This can be 
overcome by “windowing” the data during the transformation. For more information on the windowing 
feature, see the window section that follows. 
The FFT transformation cannot be performed in real time (i.e., during an acquisition). To emulate an online 
spectral analysis, use online filters and the Input Values window. See page X546H118X for more information about 
real-time frequency information. 
 
Pad If a section of data is selected that is not a power of two, AcqKnowledge will always “pad” 

data up to the next power of two, filling in the remaining data point with either 
Pad with zeros: a zero 
Pad with endpoint: the last data point in the selected area 
In other words, if 511 data points are selected, AcqKnowledge will use a modified version of 
the waveform as input. The modified waveform will have 512 points, and the last point in the 
modified wave will be either a zero or equal to the 511th point of the original data. 
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Show Mod. To view the modified waveform being used as input for the FFT, check the Show modified 
input box. Whenever possible, it is best to use an input waveform (select an area) that is an 
exact power of two. The waveform is modified by applying the windowing and padding 
options. Window functions diminish the discontinuities that occur at either end of the wave. 

 
Window The FFT algorithm treats the data as an infinitely repeating signal with a period equal to the 

length of the waveform. Therefore, if the endpoint values are unequal, you will get a 
frequency spectrum with larger than expected high frequency components due to the 
discontinuity. Windowing these data minimizes this phenomenon. For example, to apply a 
window transformation to a sine wave whose endpoints do not match up, check the box next 
to Window and choose a type of window from the pop-up menu. Each of the windows has 
slightly different characteristics, although in practice each provides similar results within 
measurement error.  

 As shown below, the frequency spectra of the windowed and non-windowed data differ 
significantly when the endpoints are unequal. When data are not windowed, the very low and 
very high frequencies are not attenuated to the same extent as when windowed. 
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Remove  Sometimes, data contains a positive or negative trend that can cause extraneous  
Trend  frequency components to “leak” into the frequency spectrum. In this case, you could select 

remove trend when you perform the FFT, which will draw a line through the endpoints, and 
then subtract the trend from the waveform.  

For example, the 
following sine wave 
has an upward trend 
through the data 
(positive trend 
component). The lower 
graph shows FFTs of 
the skewed sine wave 
data with and without 
the trend removed. 
Note that the spectrum 
of the data without the 
trend removal has 
gradually decreasing 
frequency components, 
while the data with the 
trend removed has far 
fewer frequency 
components except for 
the single spike due to 
the sine wave. 

 

without trend removal

trend removed

 
Remove Mean  Remove mean calculates the mean of all the points in the selected area and then subtracts it 

from the waveform. This is generally useful for windowing a waveform that has a large DC 
offset. 

 As an example, you might start with a sine wave with a 10-volt DC offset (with a little noise 
added to broaden the spectrum), and perform spectral analysis with and without mean 
removal: 

 
 Note the large spectral components at the beginning of the top plot, without mean removal. 

This is due to the offset of the original data. The bottom plot is with mean removal. 
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 Since the offset of the waveform is often an artifact of the way it was generated, the remove 
mean option provides a more accurate indication of the true spectral components. This is 
especially true for applications where low frequency components are of interest. If your data 
has a large DC offset and you plan on windowing the data, you will generally get a more 
meaningful spectrum if you remove the mean prior to windowing (which is the same order 
the FFT uses). 

Linear By default, the FFT output is described in terms of frequency along the horizontal axis and 
dBV on the vertical axis. The Bell scale (from which dB are derived) is logarithmic, and in 
some cases it may be useful to have the output scaled in linear units. To do this, click on the 
button next to linear and check OK. The other options in the dialog box work as they 
normally do when the dB scaling option is selected. The relationship between log and linear 
units is: dBVout = 20 log VIN. 

Phase The standard FFT produces a plot with frequency on the horizontal axis and either dB/V or 
linear units (usually Volts) on the vertical axis. In some cases, it may be useful to obtain 
phase plots of the waveform (as opposed to the default magnitude plots). Phase plots display 
frequency along the horizontal axis, and the phase of the waveform (scaled in degrees) on the 
vertical axis. This option functions exclusive of the magnitude option—you can check either 
independently, or if you check both, two plots will be produced (a magnitude plot and a phase 
plot). 

 
Inverse FFT 

 

The Transform>IFFT menu option is generated after an FFT is 
performed. An Inverse FFT (Transform>IFFT) converts spectral 
values back to a time series waveform to reverse the FFT 
transformation. Any modifications to the original data (such as 
windowing or padding) will be shown in the resulting time series 
data. 
To obtain a meaningful IFFT result you must have a graph window 
open with at least one magnitude channel and at least one phase 
channel. With the window open, choose IFFT from the Transform 
menu to generate the Inverse FFT dialog box. 

To accurately recreate the time series waveform  
1. Select the source channels for the inverse FFT in the Magnitude and Phase pull-down menus. 
2. Select whether to express Magnitude in linear units or dB logarithmic units (decibels). To determine 

this setting, check the vertical axis units of the magnitude channel; this should correspond to the 
Magnitude scaling choice that was used when performing the forward FFT. 
 The Phase waveform must be in degrees. 

3. Click OK to perform the IFFT. 
 The result is generated in a new time domain window, labeled “IFFT of Spectral…”
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To perform an FFT, you might start with an electroencephalogram (EEG) signal acquired when the 
subject alternated between eyes open and eyes closed. Typical results suggest that higher levels of alpha 
activity (activity with frequency components between 8Hz and 13Hz) are to be expected when a subject’s 
eyes are closed. 

1. The raw data, prior to FFT, is shown here: 
 Eyes

open
Eyes

Eyes
open

closed

 
2. Select Transform>FFT from the menu. 

The FFT Parameters dialog will be 
generated; in this example, the Window 
function chosen is Kaiser Bessel: 

 

13107

3. Click OK. 
A frequency domain window (a graph 
window which places frequency along the 
horizontal axis rather than time) will be 
created and displayed, showing the spectrum 
of the input data. 
The window is named “Spectral of (the 
original window name)” and ends with the 
channel number, as shown here: 
The resulting magnitude value for each 
component is equal to the peak value of the 
sine wave contributing to that component. 
The entire pattern of frequency components 
is known as the frequency spectrum of the 
data. The somewhat erratic appearance of the 
spectrum is usually due to small-scale 
variations in the original waveform. 

4. Optional—This “noise” can be removed by 
applying a smoothing transformation to the 
FFT output. In the graph shown, there is a 
pronounced frequency component centered 
on 8Hz, which corresponds to the alpha wave 
frequency band (8Hz—13Hz). The frequency 
spectrum (0-20Hz shown) used 20-point 
smoothing. 
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DWT Wavelet Transformation  

 

About Wavelet Transformation 
Wavelet transforms are similar to Fourier transforms. Instead of 
projecting a signal in a space of sines and cosines, wavelet transforms 
project a signal into a space comprised of orthogonal functions called 
wavelets. Discontinuities are more obvious in wavelet transforms than in 
sines and cosine analysis, making wavelet transforms a better choice 
for decomposing a signal to its fundamental form. Wavelet transforms 
can be used for noise reduction and filtering, extracting features from 
signals that are not apparent in time or frequency domains, and 
predicting signal qualities from a small number of data points. 

Discrete wavelet transforms break a source signal into high-frequency and low-frequency components. Use 
for ECG and EEG analysis. DWT creates a new graph with wavelet coefficients on the horizontal axis and the 
amplitude for each coefficient on the vertical axis, pastes acquisition settings to the graph-specific journal, 
and places an event at each boundary between the high- and low-frequency components produced at each 
iteration. 
 Wavelet type Specify Biorthogonal 4.4, Symlet 4, Coiflet 6, or Daubechies 8. 
 Number of iterations Specify the number of transforms to execute iteratively. 

Inverse DWT 
Operational on the result of a DWT. Projects data from 
wavelet space to time space. For correct recomposition of the 
source data, the wavelet type specified for the IDWT must 
match the wavelet type used for the DWT. Amplitudes of the 
wavelet coefficients may be changed, but an IDWT will fail if 
the horizontal units, events at DWT iteration level 
boundaries, or file length have been modified. 

Principal Component Analysis 

 

About Principal Component Analysis 
Principal Component Analysis decomposes source signals into a 
new signal space (constructs an orthogonal set of vectors). PCA is 
useful as a feature extraction and data reduction tool.  
Changes in the values of the mixing matrix may be indicative of 
changes in underlying signal morphologies that other methods 
cannot easily detect.  
For example, PCA is useful for EEG analysis; where it can reduce 
32 channels to the fundamental elements of signals.  

Mac OS X only—AcqKnowledge uses a mean-adjusted covariance matrix method to generate a new PCA 
graph with each component in a separate channel. The coordinates of the new space are the eigenvalues 
extracted from the matrix defined by the source data and are called “Principal components.” The extracted 
eigenvectors are the “mixing matrix.” Sine and cosine are orthogonal signals. The principal components are 
numbered in order of decreasing eigenvalues, which implies that the first principal component contains the 
majority of the variation of the source signals. Results are also pasted in to the journal, including the 
eigenvalue magnitudes and the eigenvector matrix. To determine the percentage contribution of each 
component, review the eigenvalue magnitudes. Select two or more channels—all of the selected channels 
must have the same sampling rate. 

Inverse PCA 
Available only for graphs produced by PCA. Reconstructs the source signals based on the components 
and mixing matrix of the PCA graph. The graph is reconstructed in a new window, with a list of the 
components used pasted to the journal. 

 For noise reduction, use only the strongest principal components to reconstruct the source signals. 
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Independent Component Analysis 

 

About Independent Component Analysis  
Independent Component Analysis is useful for signal separation, 
denoising, and advanced EEG analysis to remove noise signals or 
locate approximate regions of active processing centers in the brain. 
ICA is a form of statistical blind separation that attempts to separate 
mixed (overlapped) signals based on the assumption that they are 
statistically independent. 

 For example, if two microphones in a room record one person 
reciting Shakespeare and another person playing the banjo, the 
recordings will capture both the speaker and the banjo. After 
performing ICA on the two recordings, one result will have only 
the speaker and the other will have only the banjo. 

Mac OS X only—AcqKnowledge uses the FastICA algorithm to generate a new ICA graph with each 
component in a separate channel. 
Select two or more channels—all of the selected channels must have the same sampling rate. 
Specify tolerance and number of iterations. 
ICA limitations to consider for application and interpretation: 

1. The number of mixed sources must be equal to the number of independent components (as in the 
example where two microphones captured two sound types). 

2. Sources must be statistically independent; highly-correlated signals cannot be effectively separated. 
3. Sources must have non-Gaussian probability distribution. It is not possible to separate out 

components like white noise through ICA. 
4. Signal mixing must be a constant, linear process. Any type of non-linear signal propagation cannot be 

expressed in linear combinations of sources, the underlying assumption of ICA. 
5. The component sources must be stationary (that is, point sources). 

 
Inverse ICA 
Available only for graphs produced by ICA. Reconstructs mixed signals based on the components and 
mixing matrix of the ICA graph. The statistical nature of the algorithm implies that it cannot perfectly 
reconstruct original source data—it estimates the most probable set of source signals. The graph is 
reconstructed in a new window, with a list of the components used pasted to the journal. 
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Find Peak (Peak Detector)—Windows/PC 

 
Overview 

 This section describes peak detection functionality for AcqKnowledge for Windows/PC only; see 
page X547H270X for functionality under Mac OS X. 

The Find Peak (Peak Detector) function is a software analysis tool that automates measurement tasks. The 
Peak Detector provides a variety of mechanisms to automatically control the I-beam selection tool to 
automatically perform specific measurements on data in an AcqKnowledge data file which otherwise would 
have to be performed manually using the I-beam selection tool and the respective pop-up measurements. It is 
the primary tool used for waveform data extraction or reduction. The Peak Detector can perform automatic 
measurements on multiple channels simultaneously. The resultant measurements can be printed directly to the 
Journal or plotted, in graphical form, to a new channel in the AcqKnowledge data file. 
Peak Detector Measurement Modes 
In both of the operational modes, the Peak Detector advances (step-by-step) a single master cursor forward in 
time. The time jumps made by this master cursor are determined by the operational mode:  

1) Data driven—The cursor (or selected area) is placed at a specified time offset to locate Positive peaks 
or thresholds or Negative peaks (valleys) in the data file. The master cursor jumps forward to the next 
point as defined by the data stream and the kind of feature (Positive peak or Negative peak) 
identified. 

 A good example of a data driven measurement is the determination of 
R-R interval in an ECG recording. 

2) User-defined interval—The master cursor jumps forward by the pre-specified, user-defined interval. 
 A good example of a user-defined interval measurement is the determination 

of mean blood pressure values over ongoing, consecutive, 1-minute intervals. 
The Peak Detector also employs sub-cursors. Sub-cursors can be set to fixed positions, in time, related to the 
master cursor. For example, the master cursor could be set up to move through the data at 30-second intervals, 
while the sub-cursors could be configured so that a data measurement would be performed several seconds 
before and several seconds after the location of each 30-second jump point. 
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Data Driven Measurements 
Use this mode when you want the waveform data itself to drive the waveform data reduction process. In 
this mode, the algorithm will find positive or negative peaks or thresholds and move the I-beam to that 
found peak or threshold, offset in time by some fixed time delta. If the pop-up measurements are set to 
certain functions, the value returned by those functions will be present in the respective pop-up 
measurement result box. 
In this mode, data is extracted from the waveform as mediated by the form of the data itself. In typical 
physiological recordings, data is often quite cyclic in nature. Data driven measurements are those that 
employ characteristics of the data cycles themselves to determine the interval over which the 
measurement is performed. The Peak Detector will simply “hop” from the peak of one R-wave to the next 
and, in the process of doing so, will automatically extract all the cyclic R-R intervals present in the ECG 
recording. When performing data driven measurements, the user can specify whether the software should 
look for positive peaks or negative peaks in the record. If “Positive peak” is selected, the Peak Detector 
will advance a master cursor, step-by-step, through all the positive peaks in the data file or selected area. 

User-defined Measurements 
Use this mode when the waveform data reduction requirements necessitate examining the data around 
many equally sized data segments. The algorithm will reference the I-beam to pre-selected time intervals 
that can be set to “chop” the waveform data into equal chunks. 
In this mode, data is extracted from the waveform as mediated by a pre-defined time interval. The Peak 
Detector will simply “hop” to the next fixed point in time as indicated by the user-defined time interval. 
In all user defined interval measurements, the Peak Detector will advance a master cursor, step-by-step, 
through specific (fixed) time intervals, until the end of the file or selected area is reached. 

 
Averaging 

 A good example of this feature is assembling a representative or average blood pressure cycle 
from a larger collection of cycles. 

A special feature of the Peak Detector is the ability to perform averages of data when performing data driven 
or user-defined measurements. As one example, the Peak detector might automatically identify the high 
(positive) or low (negative) points of a selected series of blood pressure cycles. The Peak Detector would be 
set up to look “before” and “after” each positive or negative blood pressure peak. After all the peaks were 
found, the AcqKnowledge software would automatically assemble the identified data to create the averaged 
beat. 
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Peak Detector Controls 
Data-driven Mode 

Find Peak In data driven mode, the Peak Detector can look 
for Positive peaks or Negative peaks.  
• Positive peak—the highest valued point in the 

data between crossings when data crosses a Fixed threshold, first positively and 
then negatively. 

• Negative peak—the least valued point in the data between the crossings when data 
crosses a Fixed threshold, first negatively and then positively.  

Fixed mode In the simplest mode of data driven operation, the user can identify a Fixed value as the 
threshold point. 

Threshold  The next simplest mode of data driven operation employs a Tracking threshold, which 
adjusts the threshold level each time another peak (Positive or Negative) is found.  

 
Level If an area is selected before the dialog is opened, the software will determine the 

optimum Level based on that area (the units are those of the waveform to be peak 
detected). 
You can manually enter a threshold parameter in the threshold Level box to overwrite 
the software. If an area is selected when you reopen the dialog, the software will 
overwrite your manual Level entry. To refer back to manual Level entries, you need to 
note each manual entry before closing the dialog, or make sure only one data point is 
selected before reopening the dialog.  

Tracking mode The Tracking threshold mode modifies the threshold after it finds a peak, depending 
upon the value of the new peak, and will compensate for a slowly drifting baseline. 
• % of previous peak—The value entered here determines the amount that the 

Tracking mode changes the threshold. 
• The Options button generates a dialog with two tracking threshold options: 

— “Peaks reference” 
— “Means reference” 

Options Hints regarding the use of Tracking Threshold Options 

• If data has a very consistent cyclical nature, either Tracking Option will work. 

• If data has spurious positive or negative peak values present, the Means Reference 
Tracking Option is probably a better choice. 

• If data has an erratic baseline, but consistently sized, positive and negative peaks, 
the Peaks Reference Tracking Option is probably a better choice. 
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Means Reference 

The default option for Tracking threshold operation employs a Means reference. This 
option will cause the software to determine the Mean Value of all the data, from peak 
to peak. This Mean Value establishes a variable reference upon which the tracking 
threshold operates. The software will determine the new threshold (NT) as follows: 

For Positive Peaks 
NT = Mean Value + (Positive Peak Value - Mean Value) x (% factor) 

For Negative Peaks 
NT = Mean Value - (Mean Value - Negative Peak Value) x (% factor) 

Peaks Reference 
An alternate option for Tracking threshold operation employs a Peaks reference. This 
option will cause the software to determine the Positive Peak Value and Negative 
Peak Value of all the data, from peak to peak. The Positive and Negative Peak Values 
establish a variable reference upon which the tracking threshold operates. The 
software will determine the new threshold (NT) as follows: 

For Positive Peaks 
NT = Neg. Peak Value + (Pos. Peak Value—Neg. Peak Value) x (% factor) 

For Negative Peaks 
NT = Pos. Peak Value - (Pos. Peak Value—Neg. Peak Value) x (% factor) 

Set first cursor to 

 
The selection area can be modified by the user for a fixed-distance and offset from the 
reference point. In data-driven mode, the first cursor can be set to any one of the 
following four options, plus a positive or negative fixed-interval of time: 

a)  Previous peak c) Previous Threshold 
b)  Peak d) Threshold 

Set Second cursor 
to 

The second cursor can be set to a threshold plus a positive fixed-interval of time only, as 
long as the first cursor is also referenced to a threshold. 

User-defined Interval Mode 
Find Peak 

 
Start Point The Start Point can be specified at either the existing cursor (I-beam) location or at a 

specified time. 
Interval The Interval is the reference point of the cursor (I-beam). The cursor will move by the 

specified time Interval as the Peak Detector algorithm automatically moves the cursor. 
Set first cursor 

 
The selection area can be modified by the user for a fixed-distance and offset from the 
reference point. In user-defined mode, the first cursor can be set to either of the 
following options, plus a positive or negative fixed-interval of time: 

a)  Previous peak b) Peak 
Set second cursor The second cursor can be set to peak plus a positive fixed-interval of time only. In user-

defined mode, “peak” refers to the location of the next user-defined interval. 
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Paste Measurements into Journal 
To automatically write values to the Journal, click in the box next to “Paste Measurements 
into Journal.” 

Display Measurements as Graph 
This option will plot the measurements as a graph in a new channel. Each measurement is 
assigned its own channel. As each measurement is calculated, the results can be pasted to the 
Journal or displayed as a new channel. This function provides a powerful way to summarize 
large data files for further analysis. For instance, starting with a 24-hour recording, you could 
use the data reduction tools to take the Mean every 20 minutes and then display the Mean as a 
graph. 
 Measurements are inserted for all Find Peak operations, including Find All Peaks and 

Find Next Peak. 
 A new channel is created for the measurement when: 

 a) a measurement changes between successive Find Peak operations 
 b) the Source channel for a measurement changes between successive Find Peak 

operations 
 c) a measurement channel is removed from the graph (Edit> Remove waveform)\ 

 Display Measurements as Graph is not available with Off-line Averaging. 

Excel Spreadsheet Export 

  
The cycle detector has also been enhanced to allow for the direct creation of spreadsheets. 
The cycle-to-cycle values of the measurements can be inserted directly into an Excel 
spreadsheet file. Each measurement is placed into an individual column and each cycle 
corresponds to a single row. To generate the spreadsheet a “Find All Cycles” operation is 
required. 

Don’t Find Lets you exit the Peak Detection dialog box and still retain the peak parameters (peak value, 
valence, and so forth). This is useful for setting parameters using an area of a waveform and 
then repositioning the cursor at another point in the record. 

Cancel  Does not make or save any settings changes. 
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Off-line Averaging 

 
The Off-line Averaging option works with both Find Peak modes. This option lets the user average waveform 
data together from different reference points in the complete data record. For instance, when evaluating an 
ECG record, Off-line Averaging can be used with Find peak: Positive peak to generate a composite ECG 
cycle—the “average looking” cycle of a specified number of separate ECG cycles. 
Control Channel 

The Control Channel option lets you detect events in one channel while averaging the response from 
another channel. Using the Control Channel function, you can perform averaging on one data channel even 
though the master cursor is synchronized (controlled) by another channel. This means that the average value 
of one signal can be computed around events in another signal, which is useful for ERP and P300 studies.  
When Averaging is selected, a pop-up menu is activated for Control Channel selection. The default Control 
channel is the Source channel.  

 A good example of this feature revolves around P300 measurements, where two or more Control 
Channels are used to sequentially average data. Using the SuperLab® presentation system, the average 
response can be determined based on when stimuli were presented to the subject. One Control 
Channel can correlate to stimulus A, and other Control Channels can correlate to stimuli B, C, D, etc. 
In this fashion, averaged responses to different types of sequentially presented stimuli can be 
compared and analyzed.  

Setup Averaging 
Averaging Range 
• Entire Waveform—The average is generated with 

relevant data from the entire waveform. 
• Selected Area—The average is generated with 

relevant data from only the selected area. 
• From start point for Number of averages—The 

averaging algorithm collects relevant data from the 
start point and continues until the specified number 
of averages is reached. 

• From start point until end—The averaging 
algorithm collects relevant data from the start point 
and continues until the end of the data file is 
reached. 

Artifact rejection 
Artifact rejection eliminates suspect data from the averaging process. Suspect data is identified as any sample 
value in a relevant data block that is higher or lower than the respective Reject high and Reject Low levels. 
Ave Start Starts the average procedure per the established settings. 
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Find Cycle/Peak (Peak Detector) —Mac OS X 

 
Overview 

 This section describes peak detection functionality for AcqKnowledge 3.9 for Mac OS X only; see 
page X548H264X for functionality under Windows. 

The Find Cycle/Peak Detector uses three tabbed settings panels to define and automate cycle/peak detection. 
 Cycles/Peaks 
 Selection 
 Output 

Cycle detector settings are graph-independent, which means that find cycle/peak operations can be 
performed in multiple graphs without needing to re-enter graph-specific settings for each run. By using 
multiple data views, different find cycle/peak operation can be performed on the same set of data without 
losing settings between “Find Next Cycle/Peak” operations. 
When the Cycle/Peak Detector is first opened for a graph, the sheet will be filled with the values from the 
last successfully executed find Cycle/Peak operation. Subsequently, changes to the settings will be applied 
only to that graph. 
 

TIP (Mac only):  If you're running the peak detector multiple times and need to put the cursor back at the 
beginning of the waveform for the next pass, use the keyboard shortcuts Home, End, 
Page Up, and Page Down to quickly change cursor location. 
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Cycles/Peaks tab 

  
Peaks Events 

 
Fixed Interval 

A cycle is defined as the interval between two events of user-specified types. The Cycles/Peaks tab offers 
three general methods for establishing cycle parameters: 

 Peaks: Data driven maximum and minimum 
 Events 
 User-defined fixed time intervals 

When the cycle location mode is switched on the 
“Cycles/Peaks” tab, the edge selection offsets will be 
checked. If they are non-zero, a prompt will 
generated to warn that that the edge adjustment 
offsets may not apply for the new cycle location 
mode. The user can reset the offsets to zero 
(default) or retain the (non-zero) settings used in the 
previous cycle location mode. 
 

Peaks 
Peak direction See the Peak definitions on page X549H266X.  
Level Important usage note—Level is not set automatically when the Cycle/Peak detector is 

generated. (Automatic Level is used in previous versions of AcqKnowledge for Mac and 
current version for Windows.) 

Use selected... To optimize the threshold detection level for the selected area of data in the graph, click on 
the “Use selected maximum/minimum” button underneath the level. If you change the 
source channel or peak direction, you can also use this button to re-compute the 
recommended level based upon your new settings” 
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Events 
Event-based cycle location can extract information from events or define events based upon the output of the 
peak detector. A cycle is defined as the interval between two events of user-specified types. 

Start / End Define the event; any of the predefined event types can be explicitly matched. 
Match pairs “Match pairs of events only” is active when the Start event criteria are identical to 

the End event criteria. Toggle the checkbox to set this option. For a cycle to be 
located, a pair of two distinct events that match the criteria must be present. The 
event occurring earlier in time matches the left edge, later in time matches the 
right edge. This is the default search mode; this is the only search mode when the 
criteria are different. 
When unchecked, a single event can be used as the Start event and the End event 
of a cycle, which will produce a zero width cycle. This is useful for adjusting a 
selection relative to an event, such as locating the first second prior to each event 
of a specific type. This single-event matching option makes it possible to hit time 
periods for each event since each cycle consumes two events. 

Located on Specify the channel when the event must be defined, either its actual channel or 
“Global” for markers not associated with any channel. Select “Anywhere” to 
search for events of specific types across channels. 

With Labels 
optional 

Toggle the “With labels containing text” checkbox to set this option. 
When checked, the matching event’s label must contain the text in the edit box to 
the right of the checkbox. 
 The text search is not case sensitive. The search must be non-empty for cycles 

to be located properly. 
When unchecked, the matching event can have any label, including none. 

The Cycle detector uses the following algorithm to search for cycles in the graph: 
1. From the starting point, find the first event matching the criteria of the Start event. This will be 

defined as the left event. If no event matches the Start criteria, no more cycles are in the file. 
2. If the Start event criteria match the Ending event criteria and zero width cycles are allowed (e.g. 

“Match pairs of events only” is unchecked), define the right event as identical to the left event and go 
to step 5. 

3. From the location of the left event, find the closest event matching the criteria of the End event. This 
will be defined as the right event. If no event matches the End criteria, no more cycles are present in 
the graph. 

4. Within the time region between the left and right events, search for any events that match the Start 
criteria. If such an event occurs, redefine the left event to be this matching event and repeat the step. 
If no event is located, then the closest pair of events has been located. 
 This step is useful for working with data that has missing portions of the sequence, as can come 

out of some classifiers. For example, if two event types A and B are used as the endpoints, a 
sequence of three events AAB will match the last two events as the cycle. This is logical in the 
case of physiological data where, if B should occur periodically in the signal, AA is an indicator 
of an abnormality or missed classification. 

5. Set the selected area to the time interval whose endpoints are the left and right events. 
6. Perform selection adjustment and output as indicated by the settings on the “Selection” and “Output” 

tabs. 
7. If “Find All Cycles” is being performed, return to step 1 and use the ending event location as the new 

starting point to find any remaining cycles in the graph. 

Fixed Interval 
See the interval definitions on page X550H267X (same as for AcqKnowledge for Windows). 
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Selection tab 
Use the Selection tab to adjust the range of data that will be analyzed to generate any output. By default, the 
data range is set to be the entire cycle as located by the settings on the Cycle/Peak tab, but it can be adjusted 
to analyze only specific portions of the cycle. 
The controls on the Selection tab vary based on the settings on the Cycle/Peak tab 

Peak When the Cycles/Peaks location method is “Peaks,” you can adjust the Selection based on the 
times of the peaks in the data or the times of the threshold crossings prior to the peaks. 

  
To perform analysis on the entire data within each cycle, the selection should be from the 
“previous peak” to the “current peak.” To examine fixed-width time windows located at each 
peak, use the “current peak” to “current peak” settings and adjust the two time offsets 
accordingly. Note that your settings must place the left edge earlier in time than the right edge 
for the peak detection to succeed properly. 

Event When the Cycles/Peaks location method is 
“Events,” you can adjust the Selection based 
on the locations of the events that define the 
boundaries of a cycle. 
For a specific cycle, the starting event will be 
the event at the left boundary of the cycle and 
the ending event will be the event at the right 
boundary of the cycle. The starting event will 
never be located after the ending event in time. 
To analyze data over each entire cycle, use the “starting event” to “ending event” setting. To 
examine fixed-width time windows occurring within each cycle, set the left edge and the right 
edge to the same event (e.g. “starting event” to “starting event” for time windows at the 
beginning of each cycle) and adjust the offsets accordingly. Note that your settings must place 
the left edge earlier in time than the right edge for the peak detection to succeed properly. 

Fixed When the Cycles/Peaks location method is “Fixed 
time intervals,” you can adjust the Selection based 
on the endpoints of the time interval. 
To analyze the data over each entire interval, use 
the “previous interval” to “current interval” 
setting. 
To examine fixed-width time windows within 
each interval or only a sub-portion of each 
interval, use the “current interval” to “current 
interval” setting and adjust the time offsets 
accordingly. Note that your settings must place the left edge earlier in time than the right edge 
for the peak detection to succeed properly. 
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Output tab 

 

The Cycle/Peak Detector includes four Output 
options, which can be independently enabled: 
Measurements, Averaging, 3D Surface, and Events. 
The selected output, if any, is listed at the top of the 
Output tab as Enabled output. 

 
Output Measurements 

Toggle each checkbox to enable/disable the option: 
 Paste measurements for each cycle to the 

Journal 
 Plot measurement results; display measurement 

values as channels in graph. 

 
Output: Averaging—Offline 

Use Averaging Output” to perform offline ensemble 
averaging of source data or ensemble averaging of 
event locations. Specify the channel where the 
cycles/peaks are to be located in the “Cycles/Peaks” 
tab and specify the channel whose data should be 
ensemble averaged in the “Average” controls on the 
“Output” tab. 
Toggle the “Average channel events checkbox near 
the bottom of the tab to turn event averaging on and 
off. 
Offline averaging can produce average locations of 
events within the defined cycle along with the 
average data. When a cycle is found, any events in 
that cycle will be noted. Events that are on the 
channel of data being averaged will be examined for 
inclusion in the average. (See page X551H269X for offline 
averaging details) 

Index For each individual cycle, each event will be given an index starting at 0 and increasing to one 
less than the number of occurrences of that event type within the cycle. The time offset for each 
event from the start of its cycle will be averaged along with the offset for events with the same 
index from all other cycles. When the graph of the averaged data is produced, these average time 
offsets from the start of the cycle will be used to define new events for the averaged data. If the 
events and averaging interval were correlated with the data, the average event offset will produce 
a reasonable representation of the appropriate event locations for the averaged cycle. 
 Average events reflect the accuracy of classifiers and the consistency of data used to locate 
each cycle. 

Label Each event is labeled with the number of cycles contained in the event. Differences in the event 
sequence can cause spurious events to be inserted. The label helps in manual inspection for events 
that were only in one or two cycles. 

Rejection Toggle the “Events must be in…” checkbox to turn rejection on and off, and specify a percentage 
for the relative number of cycles an event must appear in to be considered valid. 
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Remove… When mean removal is enabled, the mean value of the data within each cycle is subtracted prior 
to including it in the overall signal average. This mean removal option is useful for: 

o Extracting signals that are “riding” on top of other signals with high DC offset (e.g., MRI 
artifact on top of skin temperature) 

o Compensating for baseline drift where there are not enough cycles present in the data for 
the baseline variation to completely cancel itself out. 

Output 3D Surface 

    

3D Engine menus and prompts 

  
Save as TIFF Choose File > Save as TIFF 
when 3D output is enabled. 

 

 

Toggle the “Generate a surface” checkbox at the top of the 3D tab to turn Surface Output on and off. 
1) Choose a channel to generate a 3D surface from. 
2) Confirm or establish the cycle period of interest on the channel. 

 Use the Cycles/Peaks tab and the Selection tab to adjust the threshold and cursor positions for the 
cycle period for 3D output. 

3) Choose a cross-section output format for the cycle data: cycle data, histogram, FFT, or DWT. 
 For histogram, FFT, or DWT, click on “Configure Transformation” to change the settings. 

4) Select surface and background colors. 
5) Set axis options. 
6) Click OK. 

Use the cursor to rotate the 3D image; the magnitude of display response increases as you leave the center of 
the screen (keep cursor close to center for slow response/display control). 
  
3D Output Example Compare ECG cycles in 3D Output. The following example shows how to 

AcqKnowledge will generate a 3D image using each cross section of ECG. 
a)  Cycles/Peaks tab: set the threshold level to identify each R-wave. 
b)  Selection tab: set the cursors to 

Current Peak 
Left edge -.5 seconds 
Right edge .5 seconds 

c)  On the Output tab 
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Enable 3D Output 
Specify the channel to generate a surface from. 
Choose “cycle data” for the cross-section format. 

d)  Click Find All Cycles. 
Output Events 

  

Toggle the “Output events” checkbox at the top of the 
Events tab to turn Event Output on and off. 
The Cycle/Peak Detector Output mode can define events at 
specific locations; a maximum of two events per cycle can 
be inserted with Event Output. After the Peak Detector has 
located a cycle and adjusted the selection, the data within 
that cycle can be analyzed and used to create new events in 
the graph (data-driven or time specific). 

Event definition 

   
Insertion method & 
channel selection 

Brief definitions follow, see the Event Location table on page X552H277X for details: 
At edge place the event directly at the specified edge (left or right). See Edge 
Adjustment on page X553H277X. 
Percent change looks for a crossing based on a percentage of the value of the 
signal at the corresponding edge and places the event when a signal increases or 
decreases in value from the edge. 
% peak to peak looks for a point where the signal's value has changed by a 
percentage of the maximum peak-to-peak amplitude distance over the selected 
area and places the event when a signal increases or decreases in value from the 
edge 
Minimum place events at the minimum of a specific channel's data within the 
selection. 
Maximum place events at the minimum of a specific channel's data within the 
selection 
The channel whose data should be examined is specified in the pull-down menu 
directly to the right of the insertion method pull-down menu: 

Output type For each insertion method, the “Output type” pull-down menu adjusts the event 
type of the inserted event. 

Output channel Sets the channel where the event is inserted, either “Global” for defining global 
events or specific channels. 

 None—disables any insertion for that event and all of the other controls 
will be hidden except the insertion method pull-down menu. 

 Left edge / Right edge—a pull-down menu is displayed to be used to 
change between the different offset methods 

 Minimum / Maximum  
Output label Use this edit field to type in specific label text. Each event that is inserted will 

have its label set to this text. By default, it is empty (inserted events will not be 
labeled). 



Part C — Analysis Functions 277 

 

 
  
Edge Adjustment When an “at edge” location method is used, options will be generated to fine-

tune event placement relative to that (right or left) edge of the selection. 

Offset Underneath the insertion method pull-down menu, a set of controls will be 
added that allow the user to specify the percentage, choose whether they want 
to search for an increase or decrease, and choose the channel whose signal 
should be examined. 

 
When the offset method is “Threshold crossing,” the event will be placed when 
the signal on a channel crosses a threshold.  
There are a number of possible ways to configure the threshold crossing: 
 Fixed—The edit field may contain a specific voltage level for the threshold. 

In this configuration, an event will be placed if the value of the channel 
specified in the next pull-down menu crosses this fixed voltage value. 

 + value—The edit field may specify an offset from the value of the channel 
at an edge. The threshold voltage level is the value of the chosen source 
channel plus the offset from the edit field. To specify a threshold lower then 
the value of the channel at the edge, a negative sign can be placed before 
the offset. 

Direction of 
 crossing 

The direction of the crossing can be specified. 
 + (positive crossing)—the signal must approach the threshold from below 

and cross to above the threshold before an event is inserted. 
 - (negative crossing)—the signal must approach the threshold from above 

and cross to below the threshold before an event is inserted. 
 ± (mixed threshold)—an event will be inserted at the first positive or 

negative crossing that is encountered. 



278 AcqKnowledge Software Guide 

Visit the online support center at www.biopac.com 

Event Location Table 
Insertion Method Location Process 

Edge, at edge Place an event at the left or right boundary of the selected area, as specified. 
Edge +/- percent offset Given a particular channel, place an event at the specified time within the 

selection when the signal increases or decreases by a specific percentage. 
Left edge + Place at the time closest to the left boundary of the 

selection. The percentage is calculated from the value of 
the signal at the left boundary of the selected area. 

Right edge - Place at the time closest to the right boundary of the 
selection. The distance between the event and the right 
edge of the selection will have an amplitude difference 
equal to the indicated percentage of the right edge’s 
value. 

If the signal does not increase or decrease by that percentage within the 
selection, no event will be inserted. 

Edge +/- percent peak to 
peak offset 

Given a particular channel, place an event at the specified time within the 
selection when the signal increases or decreases by a specific percentage of 
the peak to peak delta of the selected area. 

Left edge + Place at the time closest to the left boundary of the 
selection. The percentage is calculated from the result of 
subtracting the minimum value of the signal over the 
selected interval from its maximum. 

Right edge - Place at the time closest to the right boundary. The 
distance between the event and the right edge of the 
selection will have an amplitude difference equal to the 
indicated percentage of the minimum value of the signal 
over the selected interval subtracted from its maximum. 

If the signal does not increase or decrease by that percentage within the 
selection, no event will be inserted. 

Edge +/- threshold 
crossing 

Starting at the specified boundary of the selection, determine a threshold 
value. This threshold voltage may be: 

 fixed voltage level 
 value of signal at the specified edge + offset 
 mean value in selected area + offset 

Left edge + Search for the first location where the signal on a 
particular channel crosses the threshold. 

Right edge - Examining data from right to left, search for the rightmost 
location where the signal on a particular channel crosses 
the threshold. 

If the direction of the threshold crossing matches the user specified direction, 
then an event is inserted. If it does not, then the next threshold crossing is 
located and the process repeats. If the threshold is never crossed within the 
selected area in the user-specified direction, no event is inserted. 

Minimum The event will be placed at the time location corresponding to a specific 
channel’s minimum value within the selected area. 

Maximum The event will be placed at the time location corresponding to a specific 
channel’s maximum value within the selected area. 
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Output: Clustering 

Mac AcqKnowledge 3.9.1 and later only—Clustering is the process of taking a set of data points and 
partitioning them into a fixed number of groups called clusters. Each cluster represents data points that may 
share some type of commonality. This can be used to assign each data point to a class of similar points. 
Clustering can be used for hemodynamic analysis and is one of the basic analysis tools used for spike analysis 
in neurophysiology. 

Algorithm Overview 
K-means clustering is an iterative algorithm that begins with a data set of real-valued points in an n-
dimensional space. Given this data set, one then specifies how many clusters are present. The k-means 
clustering algorithm attempts to find the location at the center of each of these clusters. Essentially, this 
algorithm partitions the data set into k groups such that the sum of the differences between the centers of 
each group and its members is minimized. 
A basic algorithm description is: 

A. Given a total of k clusters, choose k potential cluster centers. 
B. Assign each member of the data set to a cluster according to the closest potential cluster center 

using a Euclidean distance function (sum-of-squares). 
C. Adjust the location of the potential center for each cluster to a more optimal value. The most 

basic method is to assign the new center as to match the mean value of all of the members of the 
set (referred to as expectation maximization). 

D. Determine if the set of clusters and centers is satisfactory. If not, go to step 2 and repeat the 
clustering process. 

There are many different variations on what constitutes satisfactory ending conditions. The most ideal 
stopping criteria is when the cluster assignments do not change any longer with successive iterations. If 
there is no change in the centers, the solution perfectly minimizes the Euclidean distance sum for each 
cluster, unique up to variations in ordering of the dimensions. In practice, determining the perfect 
clustering of a data set is computationally intensive and may require an indefinite amount of time. 
Approximations of perfect clustering are quicker to compute and usually produce sufficiently accurate 
results. 
A useful termination condition for constructing approximate solutions is to place a tolerance on how 
much the centers are moved in successive steps. If the total distance between the centers at subsequent 
steps of the algorithm is less then a specific tolerance, the centers can be assumed to approximate the 
ideal solution. Another potential termination condition is to limit the maximum number of steps that are 
executed. This condition does not necessarily produce a usable approximation, but it does provide a way 
to halt execution. This is required because there is no way to determine if the algorithm can terminate 
successfully for a given data set. 

Feature clustering is a very common data reduction method in use by clustering based spike sorting 
software. A waveform segment is reduced to a single data point by extracting numerical quantities known 
as features. Each feature is a single real-valued number extracted from the data. Examples of features are: 
maximum amplitude in waveform segment, minimum, time to maximum, time to minimum, peak to peak 
distance, sum of all values, maximum slope of peak, and so on. 

A commonly used feature clustering analysis starts with two features. The features are then calculated for 
each waveform segment and presented on a scatter plot, allowing the user to visually determine how 
many clusters may be present. A k-means clustering analysis is then run on these two dimensional data 
points to determine the center of the clusters in feature space. With the center known, each waveform 
segment is then assigned to a cluster depending on the values of its features. 
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Clustering Settings 

  
Number of clusters 

After features have been extracted from the data, the data points constructed from the feature will be split 
up into a number of groups. The number of clustering groups must be provided. Clustering will always 
partition the data into this number of clusters. The output of a clustering analysis should be verified 
visually and numerically to determine if the number of clusters matches the data. 

Locate Centers 
Clustering has a good potential to form the basis for classifiers to score physiological data. The clustering 
implementation will allow for automatic learning of cluster center positions through expectation 
maximization or for manually specified cluster center positions. 
Manually 
The manual method allows the centers of each cluster to be manually typed in and edited. Instead of 
running a full k-means algorithm to locate centers, the k-means algorithm will simply run through the 
data set and assign each element to the closest cluster center and apply any outlier detection. 
This simplistic clustering will allow centers as computed from a previous run to be used in subsequent 
clustering. Using manually specified centers is necessary to provide consistency when clustering data that 
may occur in different experiments or different graph files. The use of manual centers allows for the 
clustering implementation to be used as a classifier to compare new data sets to clusters as determined 
from either ideal or previously scored data sets. 
By Learning 
The learning method will use the full k-means clustering algorithm as described above. This consists of 
choosing candidate centers, computing mean distances, adjusting the candidate center positions, and 
repeating until termination conditions are met. 
The data set used to compute the center positions can either be the full data set or a subset of the data. 
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Training Set Definition 
The training set is the set of data that is used during the iterative portion of the clustering algorithm that 
learns the potential center of each cluster. Training sets are only used for learned centers. There are three 
ways to specify a training set for use in clustering: 

• Use all of the source data when searching for the centers.Allow the training set to be a specific 
percentage of the total source data set with members of the training set chosen at random. 

• Manually identify the training set with events located in the data. 

Partial clustering refers to running the k-means clustering algorithm on only a subset of the source data, 
referred to as a training set. The clustering algorithm outputs the centers of the clusters as determined 
from the training set, and other data points that are not members of the training set are subsequently added 
to the cluster whose center is closest to them. This approach assumes that the training set is a good 
approximation of the characteristics of each cluster in the entire data set. 

There are a number of reasons to perform partial clustering. One is computational efficiency. K-means 
clustering can be a time intensive procedure, as each iteration of the algorithm must recompute all of the 
distances to reclassify the entire data set. By performing partial clustering, it is possible to reduce the 
complexity of the k-means clustering step by limiting the amount of source data that needs to be 
processed in each step. This may be acceptable in situations where perfect partitions are not required. 

Another use of partial clustering is to construct a classifier. A classifier is some method for assigning a 
particular data point to a specific class. To construct a classifier using k-means clustering a k-means 
algorithm is run on a training set that has known desirable data properties for splitting data into a number 
of classes. Once the centers of this training set are known, they can be used to perform another clustering 
analysis on a set of unknown data and determine how well that data exhibits the properties of the training 
set. 

Remove Outliers 

One of the deficiencies of k-means clustering is that it is a total partition of the data set. Basic clustering 
assumes the original data set is ideal and that each cycle belongs to one of the clusters. Rejection of 
spurious data points is useful in real-world applications, particularly with physiological signals where 
noise and artifacts are to be expected. 

The clustering analysis allows for optional removal of outliers, or spurious data points. When enabled, 
each cluster is assigned a boundary. After each data point has been assigned to the cluster, the standard 
deviation of the distance of each point from the center of the cluster is computed. When outlier rejection 
is enabled, any data point that is farther away from the center than a specific number of standard 
deviations will be removed from the cluster. Enabling outlier removal retains only the points in a cluster 
that have the strongest association with each other. 
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Clustering Criteria 

 

AcqKnowledge can perform feature clustering. For a particular 
segment of a waveform, features are extracted based upon 
user-specified criteria. 

Segment Width Peak to Peak 
Value (left edge) Time peak to Peak Delta 
Max Sum 
Min Median 
Time to Max Mean 
Time to Min Measurement Result 

Multiple segments are located using the Find Cycle/Peak 
functionality. After the criteria have been computed for each 
segment, clustering is then performed on these criteria. This 
allows segments to be partitioned based upon their features. 
For example, “Segment Width” criteria can be used to 
partition ECG cycles into two clusters of shorter segments and 
longer segments. 

The criteria Segment Widths are reported in milliseconds for time-domain graphs, as are the other time-based 
criteria (Time to Max; Time to Min; and Time Peak-to-Peak Delta). If the measurements are fixed to units of 
milliseconds (Display >Preference), then K-Mean Criteria results will match measurement magnitude results. 
Clustering is defined with a hard left to right directionality for all measurements. Therefore, Delta T will have 
opposite signs than the same measurement pasted with Find Peak. 

Clustering Output 

The output of a clustering analysis can be presented in multiple 
ways, including events, waveforms in the graph, textual tables, 
and visual scatterplots. These outputs allow for visual 
examination of the clustering results for anomalies and also 
provide a foundation for further data reduction using other 
AcqKnowledge tools. By examining waveform data in a reduced 
feature space, it may be possible to construct clustering 
configurations that allow for separation of neuron action 
potentials into different classes, detection of heart arrhythmias, 
and other classification tasks. To generate 3D criteria 
scatterplots, select at least three criteria. Mac AcqKnowledge 
3.9.2 and later includes the option to change the 3D scatterplot 
background color and export results to an Excel spreadsheet. 
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Find Next Peak/Cycle 

 When you select Find next peak from the Transform menu (or select the toolbar icon), both cursors will 
move one peak to the right while staying above the threshold.  
 
Find All Peaks/Cycles 
When you select Find all peaks from the Transform menu, the software will find all peaks through the end of 
the file. If your data file is very large, it may take some time to find all the peaks, since AcqKnowledge loads 
data from disk while it scans for the peaks. 

 
If the “Paste measurement to Journal” option is selected, measurement values will be pasted into the Journal 
each time a peak is found, as shown above. Each column corresponds to a measurement value (in this case, 
Value and BPM). 
 
Cursor functions 
The process uses the default cursor settings to select the area between two adjacent peaks. In this mode, one 
cursor tracks the current peak location while the other cursor marks the location of the previous peak (these 
“cursors” are internal to the software and do not appear in the graph window). 
A cursor can be based on: 

(a) a currently selected peak 
(b) a peak found immediately prior to the currently selected peak 
(c) the current peak threshold 
(d) the threshold used for the previously selected peak. 

To select areas other than the inter-peak interval, enter an offset for these cursors. 

Excel Spreadsheet Export—The cycle detector has also been enhanced to allow for the direct creation of 
spreadsheets. The cycle-to-cycle values of the measurements can be inserted directly into an Excel 
spreadsheet file. Each measurement is placed into an individual column and each cycle corresponds to a 
single row. To generate the spreadsheet a “Find All Cycles” operation is required. 

 

• Also available for File > Save As, File > Save Journal Text As, and Specialized Analysis tools. 



284 AcqKnowledge Software Guide 

Visit the online support center at www.biopac.com 

 

The following example details how to detect the positive spike in the QRS complex—a typical use of 
the Find Peak (peak detection) function. 

Transform > Find Peak, Find next peak, Find all peaks Icons:  Find Peak    Find Next Peak 

1. Select the area around a peak. 
2. Select Find Peak. 

Windows: The Peak Detection dialog will be generated 
and will automatically compute a threshold value. 
 If you don’t want the Peak Detector to automatically 

set the threshold, then make sure that no portion of 
the waveform is selected prior to choosing Find Peak.  

Mac OS X: Enable “Use selected maximum” on the 
Cycles/Peaks tab to compute an appropriate threshold 
value. 

3. Select Find all peaks or Find next peak. 
You will see one cursor move to the next peak value above the threshold and the other cursor remain at 
the current location, as shown here: 

 
4. Select Find next peak. Both cursors will move one peak to the right while staying above the threshold. 

Note that the measurement values reflect the peak time and the BPM value. You can use any of the other 
measurements and they will automatically update when each new peak is found. 

5. Select the first peak and choose Find peak. 
6. Check the Paste measurements into journal option and click OK. The journal will be updated with the 

measurement values from the new peak. 
Mac OS X: Measurement output can be configured with the Measurement controls on the Output tab. 

7. Choose Find all peaks. This will find all peaks through the end of the file, and paste the measurement 
values into the journal each time a peak is found. 

8. Choose Find peak. 
9. Enter a value in the text box next to Set first cursor to to change the time offset of the first cursor. 

The preceding examples used the Find peak function with the first cursor set to the “Previous peak” and 
the second cursor set to the current “Peak.” One measurement option is to change the time offset of the 
first cursor.  
Entering a value of –0.5 will result in the first cursor being set to a point 0.5 seconds prior to the previous 
peak, and when the Find next peak command is selected, the graph should resemble the one shown below 
left:  
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Likewise, setting the offset of the first cursor to a positive value will result in a selected area similar to the 
one shown above right. 

10. Define an interval around the peak by locating both cursors at the found peak. 
To do this, go to the Set first cursor to: portion of the Find Peak dialog, and select Peak from the Previous 
peak/Peak popup menu. This causes the options for the second cursor to change by adding a time offset 
option. When both cursors are set to the found peak and the offsets are each set to zero seconds, the Find 
peak command will select a single point at the peak maxima of the next found peak. 
Mac OS X: Use “Current Peak” on the Selection tab and use “left edge” and “right edge” instead of first 
and second cursor. 

11. Include a time offset for the first cursor. 
This offset may be either positive or negative, and can be set to an arbitrary time value, such as zero. In 
the following example, the second cursor was set at the found peak, while the first cursor was set 0.5 
seconds prior to the peak. 
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12. Add a time offset to the second cursor, which allows for areas around a peak to be selected. 
The time offset associated with the second cursor must be either zero or positive. 

  
13. Highlight an area based on the location of a peak found on one channel and take measurements from other 

channels (this is possible since a selected area covers all channels). 
For example, suppose ECG data was acquired and the Derivative of the data was calculated on channel 0. 
The Find peak command could be used to locate peaks on the ECG channel, and measurement windows 
could display a value for the corresponding area on the Derivative channel, as shown in the following 
graph: 

 
14. Paste data from other channels using only data within the selected area. 

In the example shown, an area of +/- 0.5 seconds was selected based on the location of the peak found on 
the ECG channel. Measurements were displayed for the slope and max of the Derivative channel. Data 
from both channels was then pasted to the Journal along with the horizontal scale values. 

 



Part C — Analysis Functions 287 

 

Find Rate 
The AcqKnowledge Rate Detector is critical to AcqKnowledge’s 
ability to extract information from physiological data that has a 
degree of periodicity. Physiological data that can be investigated 
using the AcqKnowledge Rate Detector includes: 

• ECG (e.g. Heart Rate or Inter-Beat-Interval recording) 

• Blood Pressure (e.g. Systolic, Diastolic, Mean, dP/dt 
Max, dP/dt Min) 

• Respiration (Respiration Rate measurement) 

• EMG (Zero Crossing or Mean Frequency analysis) 

 
 
The Find Rate function allows you to compute rate calculations 
(including BPM) for data that has already been collected. 
Although this function uses the same algorithm as the online rate 
detector (which uses a Calculation channel), it can be 

advantageous to perform rate calculations after the data has been acquired. One benefit is that off-line rate 
computations do not require that a separate channel (i.e., a Calculation channel) be acquired. Since the 
number of acquired channels is reduced, other data can be collected and/or data can be sampled at a higher 
rate. 
AcqKnowledge 3.9 only 

Rate detector settings are graph-independent, which means that find rate operations can be performed 
in multiple graphs without needing to re-enter graph-specific settings for each run. By using multiple 
data views, different find rate operations can be performed on the same set of data without losing 
settings between “Find Rate” operations. When the Rate Detector is first opened for a graph, the sheet 
will be filled with the values from the last successfully executed Find Rate operation. Subsequently, 
changes to the settings will be applied only to that graph. 

Modes of Operation 
The AcqKnowledge Rate Detector incorporates a significant amount of flexibility to optimize performance 
when extracting data from periodic physiological waveforms. There are three basic modes of operation for the 
Rate Detector: 

1) Fixed threshold detect mode 
2) Auto threshold detect mode (enables Noise rejection) 
3) Remove baseline and Auto threshold detect mode 

The Rate Detector will eliminate certain options when selecting different modes of operation. 
• The Remove baseline function always uses the Auto threshold detect mode. 
• Any cyclic measurement relating to amplitude (e.g. Peak-Peak, Maximum, Minimum, Area, 

Mean) automatically turns off the Remove baseline function. 
• If the measurement pertains directly to time (e.g. Hz, BPM, Interval, Peak Time, Count Peaks) 

the Remove baseline and Auto threshold detect modes are both operational. 
Generally, it’s best to use the simplest Rate Detector mode that is suitable for your application. If the simplest 
mode doesn’t work, add layers of sophistication, one at a time. For example: 

• If the Fixed threshold mode can’t or will not work, use the Auto threshold detect mode. 
• If the Auto threshold detect mode is similarly unavailable, adjust the Noise rejection or add the 

Remove baseline option (if possible). 
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1) Fixed threshold detect mode: 

Fixed threshold detect mode is the simplest mode of operation for the Rate 
Detector. As shown here, the Threshold Level has been set to 0.00 Volts. If 
the waveform crosses 0 Volts, the Detector will begin to look for Positive or 
Negative peaks (based on the Peak detect setting). 

Not available in Fixed mode: 

• Noise rejection 

• Windowing options 

• Output reset events (Mac OS X only) 

 

2) Auto threshold detect mode:  

Auto threshold detect mode is a more advanced and flexible mode of 
operation for the Rate Detector. In this case, the Rate Detector will create a 
variable threshold defined as: 

 Positive peak search 
  0.75 • (Old Peak Maximum - Old Peak Minimum) 

 Negative peak search 
  0.25 • (Old Peak Maximum - Old Peak Minimum) 

Furthermore, the Rate Detector will construct a moving file of data points 
defined by 1.5 times the number of samples that can be placed in the largest 
rate window size (defined by the Window settings). If the Rate Detector loses 

sync (no trigger event inside the window), the threshold is changed to the mean value of the moving file of 
data points. This operation permits successful recovery in the event 
of spurious waveform data values. 

The Noise rejection setting creates Hysteresis around the variable threshold. The Hysteresis level is defined 
as: 

Hysteresis = Noise rejection (%) • (Old Peak Maximum - Old Peak Minimum) 

3) Remove baseline and Auto threshold detect mode: 
Remove baseline and Auto threshold detect mode is an advanced and 
flexible mode of operation for the Rate Detector. Primarily, the Rate 
Detector performs an automatic (and hidden) moving difference function 
on the waveform data. The difference function is performed over a variable 
number of samples defined by: 

# of points over which difference is performed = 
  0.025 • Sampling Rate 

This difference waveform is then passed through the variable threshold: 
 

Positive peak search = Negative 
peak search = 

  0.75 • (Old Peak Maximum - Old Peak Minimum)   0.25 • (Old Peak Max - Old Peak Min) 

Furthermore, the Rate Detector will construct a moving file of data points defined by 1.5 times the number of 
samples that can be placed in the largest rate window size (defined by the Window settings). If the Rate 
Detector loses sync (no trigger event inside the window), the threshold is changed to the mean value of the 
moving file of data points. This operation permits successful recovery in the event of spurious waveform data 
values. 
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FIND RATE OPERATIONAL SUGGESTIONS 

Option Waveform Characteristics 

Fixed threshold option • waveform data has clearly defined positive or negative 
peaks (like respiratory or air flow data), which are 
consistently higher (in magnitude) than the rest of the 
waveform. 

• waveform data has clearly defined zero-crossings (like 
EMG), and you wish to determine the rate of these 
crossings 

Auto threshold detect option • waveform data has a moving baseline, but the peaks are 
otherwise larger in magnitude than other parts of the 
waveform (blood pressure). 
You may need to adjust the Noise rejection (Hysteresis) to 
optimize performance. 

Remove baseline and 
Auto threshold detect options 

• waveform data has high narrow peaks (like most ECG 
leads), which may or may not be larger in magnitude than 
other (slow moving) parts of the waveform. 
You may need to adjust the Noise rejection (Hysteresis) to 
optimize performance. 

 



290 AcqKnowledge Software Guide 

Visit the online support center at www.biopac.com 

Find Rate Dialog Settings 

  
Function 

The Rate Detector Function menu lists a variety of calculations, which are discussed below. 
Rate (Hz), Rate (BPM), Interval (sec) 

The most commonly used function is the Rate (BPM) option, which calculates a rate in terms of beats 
per minute or BPM. Rate calculations can also be performed that return a rate value scaled in terms of 
frequency (Hz) or time interval (sec). When rate is reflected in terms of a time interval, the time 
difference (delta T) between the two peaks is returned. This is sometimes referred to as the inter-beat 
interval (IBI). The frequency calculation returns the rate in Hertz (Hz), which is computed by 
dividing 1 by delta T. These measurements are perfectly correlated with the BPM calculation, since 
BPM is equal to 60 times the frequency calculation, or 60 divided by delta T. 

Peak time 
Returns the time (in seconds) at which the peak occurred. Like the other Rate functions (e.g., BPM 
and Hz), the value of the last peak time will be plotted until a subsequent peak is detected. The 
resulting plot will resemble a monotonically increasing “staircase” plot. 

Count peaks 
Produces a plot of the number of peaks (on the vertical axis) vs. time on the horizontal axis. When 
used with the delta measurements (in the measurement windows), this is a convenient way to 
calculate how many peaks occur within a selected area. 

Peak maximum/minimum 
Tracks the maximum value of the peak (the ECG R-wave). This correlates to the systolic pressure in 
blood pressure readings. To search for minimum peak values, select negative from the Peak detect 
section of the dialog box.  

Peak-to-peak 
Looks at the vertical difference between the maximum and minimum values of the waveform on a 
cyclical basis—useful when you want to determine the amplitude of your pulsatile signal. 

Mean value 
Computes the mean of a pulsatile signal on a cycle-by-cycle basis between two peaks; produces a 
staircase plot. 

Area 
Computes the area of the signal between two peaks, on a cycle-by-cycle basis.  
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Peak Detect 
By default, the Peak Detector searches for Positive peaks (upward pointing, such as the R-wave of an ECG 
signal) to calculate the rate of a waveform. In some instances, however, you may have to base the rate 
calculation on negative peaks (downward pointing). To do this, select Negative peak. 

Remove baseline 
The Remove baseline option applies the optimal high pass filter based on the other settings. This option is 
useful when signals have a slowly fluctuating baseline. 

Auto Threshold Detect 
When the Auto threshold detect box is selected in the Find Rate dialog, AcqKnowledge automatically 
computes the threshold value using an algorithm that accentuates peaks and uses information about the 
previous peak to estimate when and where the next peak is likely to occur. This threshold detector is 
typically more accurate than a simple absolute value rate calculation function, and is able to compute a rate 
from data with a drifting baseline and when noise is present in the signal. (For a detailed description of how 
the calculation is performed, contact BIOPAC Systems, Inc. for the complete Application Note.) 

 When Auto threshold detect is enabled, the Noise rejection and Window options are enabled. 
Threshold level 

This option (activated when “Auto threshold detect” is not selected) 
lets you enter a threshold level to be used for a simple absolute value 
rate calculation function. 

 The Auto threshold detect option is typically more accurate. 

Noise Rejection 

Noise rejection (activated when “Auto threshold detect” is enabled) 
constructs an interval around the threshold level. The size of the 
interval is equal to the value in the “Noise rejection” text box. 
Checking this option helps prevent noise “spikes” from being 
counted as peaks. 

 The default is equal to 5% of the peak-to-peak range. 

Output reset events 
Mac OS X only This option is activated when “Auto threshold detect” is enabled 
and controls the definition of reset event insertion into the graph. 

If no thresholds are found within the user-
specified window width, the automatically 
detected threshold level will “reset” and tracking 
will start anew; the output of the rate detector 
function may also drop to zero. When “Output 
reset events” is enabled, a reset event will be 
added to the channel whenever the threshold is 
reset due to window expiration 

 This helps distinguish zero-valued output due to window resetting and true zero-value output. 
In the sample shown, the signal drops to zero during a period of analysis (e.g., due to lead clip falling off). 
Reset events indicate automatic threshold tracking was lost in this interval and the points where the search 
for a new level begins. 
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Window (Peak Interval) 

Window (activated when “Auto threshold detect” is 
enabled) is used to specify an upper and lower limit for 
the Rate calculation. Windowing Units (activated only 
when the selected Function can have variable units) is a 
pull-down menu of applicable units to choose from. 
Setting the upper and lower bounds for the “window” 
tells AcqKnowledge when to start looking for a peak. 

 

AcqKnowledge will try to locate a peak that matches the automatic threshold criteria within the specified 
window. If no peak is found, the area outside the envelope will be searched and the criteria (in terms of 
peak value) will be relaxed until the next peak is found. 
For instance, once the first peak is found, AcqKnowledge will look for the next peak in an interval that 
corresponds to the range set by the upper and lower bounds of the window. The interval associated with the 
upper band of 180 BPM is 0.33 seconds (60 seconds ÷ 180 BPM), and the interval for the lower band is 1.5 
seconds (1 minute ÷ 40 BPM). If a second peak is not found between .33 seconds and 1.5 seconds after the 
first peak, then AcqKnowledge will look in the area after 1.5 seconds for a “smaller” peak (i.e., one of lesser 
amplitude). 
For those rate functions that require a window interval in seconds, you will probably want to enter numbers 
like .33 seconds and 1.5 seconds (which correspond to the BPM defaults of 40 and 180). These numbers 
will be suitable for detecting the heart rate of an average subject. 

A simple peak detector uses what is called a 
threshold-crossing algorithm, whereby each time the 
amplitude (vertical scale) value exceeds a given value, the 
peak detector “remembers” that point and begins 
searching for the next event where the channel crosses the 
threshold. The interval between the two occurrences is then 
computed and usually rescaled in terms of BPM or Hz. 
This is how the AcqKnowledge rate Calculation 
functions when all options are unchecked. 

In the sample waveform shown here, the threshold was 
set to 390 mV to detect the peaks of the waveform and 
provide an accurate rate calculation. Since it only 
recognizes signals greater than 390 mV as a peak, this 
390-mV threshold is referred to as an “absolute 
threshold.” 

  
Most waveforms are not so well behaved, however, and artifact can be introduced as a result of movement, 
electrical interference, and so forth. Combined with actual variability in the signal of interest, this can result 
in “noise” being included with the signal, as well as baseline “drift“ which can render absolute threshold 
algorithms useless. 

Defaults:  Min 40 BPM 
Max 180 BPM 
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Put Result in New Graph 
When this option is checked, the results from the find rate calculation are plotted in a new graph window 
with data displayed in X/Y format, with time on the horizontal axis. By default, this option is unchecked 
and the resulting transformation is placed in the lowest available channel of the current graph. 

Find Rate of Entire Wave 
When this option is checked, the rate (or other function from the Find rate command) will be calculated for 
the entire wave (other than the selected area, if any). 

Don’t Find 
The Don’t Find button is useful when you realize you have not selected an area to perform the Find Rate 
function on, or when you want to change the selected area. When you click on Don’t Find, the dialog 
settings will be saved so that you can close out of the dialog and select an area. When you reopen the 
dialog, the settings will be established as before you closed out, and you can click on the OK button to 
perform the Find Rate function. This is useful for setting parameters using an area of a waveform and then 
repositioning the cursor at another point in the record. 

 
Specialized Analysis 

 
Windows 

 

 
Mac 

 
The Specialized Analysis package includes tools to automate analysis to save hours (or days!) of processing 
time and standardize interpretation of results. See Appendix G on page X554H333X for full details. 
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Chapter 13 Display menu commands 
Overview 
The Display menu includes a number of features that control how the waveforms appear on the screen and 
how much data is displayed at a time. 

  
 Windows/PC Mac 

Although these options change the appearance of the data, they do not change the data itself. In other words, 
changing the color of a waveform or showing only a portion of the data on the screen will not alter the data 
stored in the file. 
See the following shortcut options for Display menu commands: 
 Toolbar shortcuts, page X555H37X 
 Right-click shortcuts—Windows, page X556H39X 
 Context-sensitive shortcuts—Mac OS X, page X557H40X 
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Tile waveforms 
Tiling is an operation performed on all waveforms to visually separate them on the screen. Tile waveforms 
adjusts the vertical offset to center waveforms in the display; if there are multiple waveforms displayed in 
chart mode, the waveforms will be centered in their “tracks.” Tiling does not adjust the scale of the 
waveforms; it only affects the midpoints of the visible portion of the waveform. Tiling does not affect the 
vertical scale factor previously set for each channel (whereas Autoscale may affect the vertical scale factor as 
well as the offset). 
In Scope mode, tiling staggers the midpoint of the channels to visually separate them on the screen while 
maintaining their scales. In Scope mode, waveforms are spaced evenly along the vertical axis of the screen, 
and each waveform is centered vertically in its division. 
Choosing tile waveforms will center the waveform in the display by adjusting the vertical offset of the 
selected waveform. If there are multiple waveforms displayed in chart mode, the waveforms will be centered 
in their “tracks.” To apply tiling only to the selected waveform, hold down the CTRL key on Windows or the 
Option key on Mac OS X before selecting Tile waveforms. In scope mode, waveforms are spaced evenly 
along the vertical axis of the screen, and each waveform is centered vertically in its division. Tiling does not 
affect the vertical scale factor previously set for each channel (whereas Autoscale may affect the vertical scale 
factor). 
When grids are locked, Tiling will retain the appropriate heights and percentages. 
When grids are unlocked 
 Windows: Tiling will retain the appropriate heights and percentages 
 Mac OS X: The scale may be slightly larger in order to optimize the tick marks displayed on the vertical 

axis. 

  
Before Chart mode tiling After Chart mode Tiling 

  
Before Scope mode tiling After scope mode Tiling (red lines for illustration only)  

Note that the waveforms are centered relative to the horizontal divisions of the plotting area; the range and 
midpoint of the second waveform (blue square wave) are indicated in the figure above. 
 

Autoscale waveforms 
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The primary use of Autoscale is to make all of the data of 
the channel within the current time range visible on the 
screen. 
When Autoscale waveforms is selected, AcqKnowledge 
determines what the “best fit” is for each displayed 
waveform. The percentages and midpoints are identical 
whether grids are locked or unlocked. 

 

The software adjusts the vertical offset so that each channel is centered in the window (or within the channel 
track in chart mode) and adjusts the units per division on the vertical axis so that the waveform fills 
approximately two-thirds of the available area. In chart mode, the waveforms are autoscaled to fit their 
sections. In scope mode, the screen is evenly divided into horizontal “bands” and each waveform is scaled to 
fit the division without overlapping. 

 The autoscaling algorithm for Chart mode and X/Y mode is: 
1. Find maximum value of the channel in the time area, max. 
2. Find minimum value of the channel in the time area, min. 
3. Adjust scale such that max-min occupies 75% of the channel's track in Chart mode, or 75% of the 

entire plotting area X/Y mode. 
4. Adjust the midpoint so (max-min)/2 is at the vertical center of the channel's track in Chart mode, or 

vertical center of the entire plotting area in Scope and X/Y modes. 

  
Before autoscaling LVP channel After autoscaling LVP (red lines for illustration only) 

 The autoscaling algorithm for Scope mode is: 
1. Divide the plot height into m equal sections of height h each. 
2. Assign each visible channel to one of these plot sections. 
3. Scale the waveform such that the range between the max and min values will occupy 75% of h. 
4. Place the midpoint between the max and min at the center of the waveform's section. 

In scope mode, the screen is evenly divided into horizontal “bands” and each waveform is scaled to fit 
the division without overlapping. 
Note: Autoscaling a single channel in Scope mode results in that channel occupying 1 / 
(num_visible_channels) of the overall waveform plotting area. It will be autoscaled into the topmost 
division of the screen. 

  
Before autoscaling in Scope mode After autoscaling in Scope (red lines for illustration only) 
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Overlap waveforms 
Overlapping waveforms places all of the waveforms at the same scale and midpoint so that the plotting 
location of a specific voltage on screen is at the same spot for every channel. Overlapping is useful for 
examining closely associated waveforms, such as the calculated diastolic, systolic and mean calculation 
channels “overlapped” with the raw blood pressure waveform from a continuous blood pressure signal. 
In scope mode, when Overlap waveforms is selected, the waveforms are “overlapped” into one screen. All of 
the currently displayed waveforms are arranged in the graph window with the same vertical scale and offset 
so all the displayed waveforms will fit on the graph; their magnitude reflects their size relative to the other 
waveforms. The overall chosen scale for all the displayed waveforms will be a function of the pk-pk value of 
the combined waves 

  
Before Overlapping in Scope mode After Overlapping in Scope (red lines for illustration only) 
 

Compare waveforms 
Compare waveforms displays all of the channels with the same amplitude scale. Compare waveforms 
automatically sets the vertical scale to be the same for all channels and adjusts each channel offset so that all 
displayed waves are centered in the display. The scale for all the displayed channels is determined by the 
channel with the largest pk-pk range in the display interval. Compare waveforms is useful for gauging the 
relative amplitudes of a number of channels by placing them all on the same amplitude scale and discounting 
the effect of waveform offset (or baseline). 

 In Chart mode, compare waveforms functions on each channel in its track. 

  
 In Scope mode, the channel scaling is similar but disperses the channels through the plot area similar 

to tiling. For a graph with m channels being plotted: 
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Autoscale horizontal 
The autoscale horizontal command is a convenient way to display the entire data file (in terms of duration) on 
the screen. When this is selected, the display will be adjusted so that the duration of the entire waveform fits 
in the graph window. For long waveforms, this can take some time to redraw. You can cancel plotting at any 
time by pressing: 

 For the MPWSW (PC)—the escape key (Esc) 
 For the MPWS (Mac)— + “.” 

You cannot undo the autoscale horizontal function with Edit>Undo, but you can use the Display>Zoom back 
command to revert to the previous display settings. 
 
Zoom Forward / Back 
Zoom functions can affect the horizontal scale, the vertical scale, or both. Zoom restoration is functional for 
the Zoom tool, Autoscaling, and the Tile, Overlap, and Compare Waveform options. Zoom scales are stored 
until another zoom function is performed. For instance, you cannot Zoom back and then use the Zoom tool 
and expect Zoom back to take you back two scale levels. 

 Zoom Forward will redo a zoom function after it has been undone; you can repeat this selection 
to restore the latest zoom scales. 

 Zoom Back will restore settings one level at a time; you can repeat this selection to restore the 
original zoom scales. Essentially, Zoom back acts as an “undo” command for the zoom forward 
command and any other function that changes the amount of data displayed (either in terms of 
time or amplitude). 

Zoom functions will work for five iterations on a PC and without limitation on a Mac, until another Zoom is 
performed. 
 
Reset chart display 
The Reset chart display option will redistribute the chart displays evenly after you have changed the 
boundaries so that each channel’s vertical size is the same. This function, which only works in Chart Mode, 
can be useful if you need to expand a display region for analysis and then return to the original display. 

  
Before Reset Chart Display …and after 
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Reset Grid—Mac OS X only 
To return to the original grid, choose “Display > Reset grid.” This will reconstruct the default, unlocked grid 
of four divisions per screen with solid light gray grid lines. 
 
Adjust Grid Spacing—Mac OS X only 
To modify the horizontal and/or vertical grid spacing, choose “Display > Adjust grid spacing.” This will 
generate a dialog for you to modify the locked axes of the selected waveform. See page X558H184X for details. 
 
Set wave positions...  
By default, channels are arranged on the screen based on their channel numbers, with the lower number 
channels being displayed at the top of the screen. You can change the ordering so that waveforms are placed 
in an arbitrary order. 

 In chart mode this will result in vertical ordering of the individual waveforms. 
 In scope mode this will result in vertical ordering of the individual waveforms after a tiling or 

autoscaling operation. 
In addition, in the waveform positioning function, you can set any waveform to ignore the autoscaling and 
tiling functions. This can be important if you have some waveforms which you don’t want autoscaled with 
others. 
The waveform positioning function is selected through the Set Wave Position in the Display menu. The 
following dialog box will then appear, with a scrolling list of all stored channels:  

 
If you have more channels than displayed, you can scroll through the list by clicking on the vertical scroll bar 
at the right. The list will scroll if you move past the top or bottom when clicking and dragging the waveform 
positions. 
The “Tile” checkbox to the left of each channel enables tiling and autoscaling for each channel when checked. 
Click on the checkbox to toggle the enable.  
The on-screen position of the waveforms is the same as the ordering shown in the above dialog (from top to 
bottom). You can reposition the waveforms by reordering the channel labels as they appear in this dialog box. 
To change the order of any waveform, click on the channel label (e.g., Ch. 4 Respiration), hold down the 
mouse button, and drag the highlighted label to the desired position. Repeat this operation until the 
waveforms are ordered the way you want. 

 Click OK to apply your selected order to the display screen. 
 Cancel will revert all waveform positions to those set before the dialog was opened. 
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Wave color 
Select Wave color and then set the desired color to discriminate between waveforms. In scope mode, the 
vertical scale, channel text, channel units and measurement popup menus take on the same color as the 
selected waveform. When adding new waveforms, AcqKnowledge assigns waveform colors in the following 
order: black, red, blue, green, cyan, and magenta. 
You can assign new colors to waveforms by choosing the menu selection Display>Wave Color 

  
Or, you can click the right mouse button to bring up a menu, select Color, and then select the desired 
waveform color from the color palette menu. Depending on the type of graphics adapter on your computer, 
you may or may not be able to choose “Other” to display a palette of color options. 
Active Segment Color 

  
Selecting Active Segment Color generates a menu of color options for the active segment in Overlap 
Appended Segment mode (see page X559H33 X). 

1. Display>Show>Show Segment and Graph Contextual Menu>Show Segment: This allows the user to 
select an active segment in Overlap Segment Mode. 

2. Display>Active Segment Color 
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Horizontal axis… 
Change the sample offset and horizontal sample interval (the amount of time between two sample points) by 
selecting Horizontal axis from the Display menu, which will generate the following dialog box: 

  
The horizontal scale can be set in terms of time, frequency, or arbitrary units. Time domain scaling has two 
options, which allow you to store and display data either in terms of absolute seconds (ss.sss) or 
hours:minutes:seconds (HH:MM:SS). By default, AcqKnowledge displays data in the ss.sss mode; however, 
you can change this by checking the HH:MM:SS button in the horizontal scaling dialog box. When data is 
displayed in the ss.sss mode, the time scale corresponding with an event occurring 30 seconds into the record 
would be 30.00 seconds. The time scale for the same event in HH:MM:SS mode would be 00:00:30. 
This feature is generally useful for changing the time base (or other horizontal scale) of data that has been 
imported into AcqKnowledge as a text file. For instance, if you want to analyze data imported from a text file 
that contains 30 seconds of data that was collected at 100 samples per second (100 Hz), the first step would be 
to open the file (following the directions on page X560H191X). 
By default, AcqKnowledge assumes that the data was collected at 50 Hz, and would therefore plot the data so 
that a 60 second record was displayed that appeared to be collected at 50 samples per second. To change this 
to reflect the rate at which data was actually collected, you would change the sample interval box in the 
horizontal scaling dialog. When data are displayed on a 50 Hz time base, the sample interval will read 
0.0200000 seconds per sample. This means that there is a 0.02-second “gap” between sample points in the 
record. To display data at 100 samples per second, change the interval to 0.01 seconds per sample. 
To determine the sample interval for other sampling intervals, divide 1 by the rate at which data was sampled 
(in terms of samples per second). Thus, a sampling rate of 0.5 Hz would translate into a sample interval of 
2.00 seconds between samples, and data collected at 100,000 Hz (100 kHz) would have an interval between 
sample points of 0.00001000 seconds. 

TIP:  To confirm that AcqKnowledge is storing data in the same time base it was 
collected in, choose Statistics from the Display menu. This will generate a dialog 
box that describes (among other things) the sampling rate AcqKnowledge uses in 
analyzing the data. Once data has been saved as an AcqKnowledge file, time base 
information is automatically saved along with the data. 

Setting the horizontal scale in terms of frequency allows output from a spectrum analyzer or plots data from a 
Fourier analysis or other data with a frequency base (rather than a time base). As with the time options, this 
feature is typically used for importing text files from other applications. For instance, if you were importing a 
text file with 1,000 sample points that covered a frequency range from 0 Hz to 100 Hz, you would want to set 
the interval to 1000 Hz/100 samples, or 0.1 Hz per sample in the box to the left of the interval text box. 
Similarly, if the frequency range was 20 Hz to 100 Hz, you could set the offset to 20 Hz. 
You can attach arbitrary base units to the data (rather than a time or frequency base). This might be useful for 
data collected from a gas chromatograph. When the horizontal axis corresponds to wavelength, and the data 
consists of 100 samples covering a range from 1 to 10 Angstroms, the interval should be 0.1 units per sample. 
When arbitrary units are selected, two additional text boxes appear at the bottom of the dialog box. The upper 
Units text box is used to provide a name for the horizontal scale units (in this case, Angstroms), and the lower 
Units text box is used to provide an abbreviated label for the horizontal units (i.e., Ang). 



302 AcqKnowledge Software Guide 

Visit the online support center at www.biopac.com 

  
Show 
Selecting Show from the Display menu generates a submenu that allows you to control a number of data 
display options and what additional information is displayed in the graph window. To enable an option, select 
it from the submenu; a bullet (•) or checkmark appears next to the menu item when it is enabled. The three 
display modes and the two plotting modes are mutually exclusive, but the remaining items can be enabled 
independently.  

  
 Windows Mac 

Show Option Shortcut Explanation 
Channel 
numbers  PC or  Mac 

When the Channel numbers option is selected, the channel 
boxes appear just above and below the graph area. 

 Channel boxes with Channel 1 selected 
These boxes are useful for selecting channels and “hiding” 
channels by positioning the cursor over the channel box, 
holding the CTRL key on the MPWSW or the Option key 
on the MPWS, and clicking the mouse button. 

Chart 
  

Activates the Chart display mode (see page X561H31X). 

Dot plot  Dot Plot allows you to view data in a “dot” format. The 
software will create user-defined, discrete points that map 
out the selected waveform. This is often useful for 
demonstrating the concept of discrete digital sampling by 
dividing the waveform up into data points or “dots.” 
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Show Option Shortcut Explanation 
Dot size  Dot size lets you specify 

how large each dot will be. 
Each dot is measured by 
the number of monitor 
pixels it occupies. 

Events 
 

Enables Event display. See page X562H164X for Event (Mac OS X) 
details; see page X563H161X for Marker (Windows/PC) details. 

Grid 
  

Superimposes a Grid on the graph window (see page X564H47X). 
Windows/PC To increase grid precision, click Ctrl- . 
Mac OS X To change grid precision, use the axis scaling 
dialog of the horizontal or vertical axis.  

Grid Options  Activates the Grid Options dialog (see page X565H47X) 
Hardware 

 
Show/Hide Hardware “Connected to:” dialog in the graph 
display; includes network access under Mac OS X. 

Journal    Activates the Journal (see page X566H48 X). 

Last dot only  Plots only the most recently acquired data point. This is 
most useful when viewing data as it is being collected and 
when this data is displayed in X/Y mode. 

Line plot Right-click menu Connects each sample point with a line to create the 
waveform. Waveforms that are displayed in line plot mode 
match a true analog plot (as closely as possible). This is the 
default display mode for most waveforms, except histogram 
plots, which are displayed in Step Plot mode (see X567H246X). You 
can change line options by clicking the right mouse button, 
which will generate a menu displaying several commonly 
used features. 

Markers 
 

Displays the marker/event region at the top of the graph 
window, along with any markers/events associated with the 
data being displayed and the marker/event tools. See page 
X568H161X for Marker (Windows) details and page X569H164X for Event 
(Mac OS X) details. 

Measurements 
 

Displays the measurement popup menus and windows above 
the graph window (see pages X570H46 X and X571H147X).  

Scope  Activates the scope display mode (see page X572H31X). 

Selection 
Palette 

Mac AcqKnowledge 3.9.1 
and later 

 
Many of the tools within the AcqKnowledge environment 
are based around the selection. The selected range of data in 
the graph is used as the source for measurements, waveform 
editing, transformations, and other operations. The Selection 
Palette is a floating dialog that can be used to precisely enter 
the selection. 

• The Selection Palette can be used to adjust the 
selection at times when it is not possible to use the 
selection tool in the graph window, such as when 
transformation sheets are being displayed for the 
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Show Option Shortcut Explanation 
graph. 

• The selection palette offers a way to change the 
selected area without having to cancel the 
transformation setup and lose any parameters typed 
in the dialog. 

To display the Selection Palette, choose Display > Show > 
Selection Palette. This small floating dialog contains two 
edit fields that display the location of the left and right edges 
of the selection using the measurement units currently 
displayed in the horizontal axis. As the selection is changed, 
the new selection boundaries are shown. 

The Selection Palette also can be used to manually type in 
the edges of the selection. Double-click on one of the edges 
and type in the new horizontal position of the edge of the 
selection. Press “Return” to adjust the selection to that time 
location and update measurements and the visible display on 
the screen. 

When a graph is displayed in X/Y mode, the Selection 
Palette can be used to adjust the range of data that is plotted 
on the screen. Limiting the time range can be useful for 
generating X/Y plots for different intervals of the graph that 
can then be compared with each other, such as examining 
PV loops from different time periods of a recorded signal. 

Mac 3.9.2 Only—Click the small arrow in the top right of 
the selection palette for the following additional options: 

 
• Paste edges in Journal—This option pastes a line 

of text into the Journal that includes the left and 
right edge measurements of the selection. 

• Time units—Use this submenu to change the time 
units used in the selection palette. The following 
time units are available: Match units on axis; Hours; 
Minutes; Seconds, Milliseconds, and Microseconds. 
The Time units submenu will be dimmed unless the 
graph displays time/arbitrary measures). 

• Frequency units— Use this submenu to change the 
frequency units used in the selection palette. The 
following frequency units are available: Match 
horizontal axis, Kilohertz, Hertz, and Millihertz. 
The frequency submenu will be dimmed unless the 
graph displays frequency-based measures.  

Note Changing time/frequency units in the selection 
palette can be helpful during zoom operations when 
the units displayed in the horizontal axis may not be 
the most convenient for inputting new selection 
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Show Option Shortcut Explanation 
boundaries.  

Show Segments Windows only 

 

For Overlap mode 
(see page X573H33 X), 
generates a list of 
segments so you can 
select a specific 
segment. 

 
Spectrum 
Analyzer 
Palette 

Mac AcqKnowledge 3.9.2 
and later 

Provides a dynamic display of the frequency decomposition 
of data, in real time or post-acquisition. See page X574H306X for 
details. 

Stacked Plot 
Options 

Mac AcqKnowledge 3.9.1 
and later 

 For Windows 
equivalent, see 
Overlap Segment 
mode on page X575H33 X. 

Displays options that can help visually distinguish the active 
slice from other slices being drawn in Stacked Plot mode. 
See page X576H34 X for details. 

 
 

 
Step plot  Displays waveforms in a “step” plot, meaning that the lines 

connecting sample points are drawn either vertically or 
horizontally. Step plot is most useful for displaying 
histograms and similar plots, but since it displays data much 
as it appears to a digital processor (like the MP), it can also 
be useful for examining the effects of various sampling 
rates.  

NOTE: Step plot is mutually exclusive of line plot. 
Toolbar  Displays the toolbar (shortcut) icons across the top of the 

display (see page X577H37 X). 
X/Y  Activates the X/Y display mode (see page X578H31X). 
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Spectrum Analyzer Palette 

 
Mac 3.9.2 and later Spectrum Analyzer breaks time domain signals into their respective frequency 
components to provide a dynamic display of the frequency decomposition of data, in real time or post-
acquisition. Spectra can be generated in real time based on the most recently acquired data or post-acquistion 
based on the selected area of a saved data file. 

• Spectrum analyzers can be useful for locating and correcting noise sources in a system as well as 
other frequency domain analysis. 

• The spectrum analyzer displays the FFT of a portion of data of a single channel; FFT is preferable 
over Power Spectral Density as the averaged periodogram approach used by PSD is effective only 
over larger portions of data. 

• Other off-line spectral analysis tools include the FFT and Power Spectral Density transformations. 
The spectrum analyzer applies to all graph windows displaying data in the time domain. Viewing the 
underlying time domain data at the same time as the spectral information also provides useful visual feedback 
with regards to signal quality. The palette allows for continuous availability of the spectrum analyzer across 
multiple graphs and for positioning alongside original data. The channel is always indicated by the popup 
menu within the spectrum analyzer itself. The graph whose data is analyzed will always be the topmost graph; 
this is the graph whose window is highest in the Z ordering. 
Mode: 
 Real-time Analyzes the most recently acquired data in a graph.The analyzer generates full FFT output 

so, in linear units, it is the regular FFT multiplied by two. The analyzer extracts the spectrum 
based on a sliding window of samples at the tail end of the signal and periodically refreshes 
the spectrum plot during acquisition. The analyzer uses a fixed width window size. The first 
spectrum will be generated after the number of samples needed to fill the initial window has 
been acquired. If no data is being acquired, the analyzer will not display any frequency 
information and will appear to be off. 

 Selection Analyzes the highlighted section of the active channel of a saved graph (post-acquisition). 
Measurements derived from data on the selected area are useful tools for quickly comparing 
different portions of data. Choose a specific channel to analyze or “SC” to use the current 
active channel. Window size does not need to be specified for this mode; the closest power of 
two above the number of samples in the selected area will be used and padding will be 
applied in the method specified. 

Palette popup  (upper right) Displays the spectrum analyzer palette popup 
menu for performing other operations on the spectrum including 
extracting the spectrum to a new graph window and copying 
spectrum data to the clipboard or journal. Options are dimmed if 
there is no spectrum available. 
New … New Graph with Spectrum constructs a new graph 
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window with the contents of the spectrum. This allows for more detailed 
examination of the spectrum than is possible with the tools in the spectrum 
analyzer palette. 

Paste… Paste Spectrum to Journal makes a textual representation using the current 
Journal preferences and copies the text into the graph journal of the graph whose 
data is being analyzed. This will prompt to create a journal if none exists.  

Copy… Copy Spectrum to Clipboard makes a textual representation using the current 
Journal preferences and copies the text to the Clipboard. 

Settings… Displays the spectrum analyzer settings dialog. Equivalent to using the Settings 
button at the bottom of the palette; see Settings below for details. 

Channel Indicates which channel of the hardware setup or graph is being analyzed. The “Channel” 
popup menu contents vary with the analyzer mode: 

 Real-time Channel popup menu lists active channels whose “Acquire” checkboxes are checked in MP > 
Set Up Channels. The channels will be listed in the same format as the Sound window, 
“{A,D,C}{0-16}, chan_title” where chan_title is replaced with the manually entered title in 
the channel setup window. 

 Selected he channel popup menu matches the channel menu of measurements in the topmost graph 
window. The menu starts with “SC, Selected Channel” which, when chosen, uses the data of 
the active channel of the graph. The remainder of the menu lists the channel numbers and 
labels of the channels within the topmost graph. 

Plot display Plot of the spectrum of the corresponding data. 
 Vertical axis units match the source channel (displays either “dbV” or linear) 
 Horizontal axis displays frequency and is always displayed in “Hz.”  

 If there is a valid data selection that can be used to compute a spectrum, the spectrum will be 
displayed in this area. If there is no valid data selection, no axes will be displayed and the plot 
will be replaced with the text “Not Available”. The following conditions cause spectra to be 
unavailable: 

 graphs that contain no data (either no channels or only empty channels) 
 graph is being displayed in XY mode 
 graph uses either frequency or arbitrary units for its horizontal axis 

When operating in selected area mode, the following additional conditions also cause spectra 
to be unavailable: 

 selection contains no data on the active waveform 
 selection is a single-point selection (not enough data to compute FFT) 

When operating in realtime mode, the following additional conditions also cause spectra to be 
unavailable: 

 no data acquisition is in progress 
Auto Vert Click to autoscale the spectrum to fit all amplitudes within the visible spectrum plotting area. 
Auto Horiz Click to autoscale the spectrum to fit all frequencies within the visible spectrum plotting area. 
Settings 
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 Plot color Colorwell that changes the color used to draw the spectrum in the palette. Click to display a 

standard color picker. 
Window Width specifies the window size used when performing analyses in real-time mode. The 

spectrum will always reflect the frequency characteristics of the most recently acquired data 
of the graph, using this window size as the number of sample points to use. This popup will 
list various powers of two as well as a “Custom...” entry. If a custom width is entered that is 
not a power of two, padding will be applied during real-time operation according to the FFT 
Options. 

  
 FFT Options 
 Padding—used whenever the number of input points is not an exact power of two. Data can 

be padded either with zero or with the amplitude of the last data point. 
 Remove mean—Subtracts the mean value of the data is prior to frequency analysis. This 

helps remove the zero frequency component caused by DC offset. 
 Remove trend—Connects the endpoints of the data with a line and removes this linear trend 

from the data prior to frequency analysis. This can help compensate for drifting baselines. 
 Units—control whether the data is displayed using a logarithmic scale or a linear scale. 
 Window—enables the standard AcqKnowledge windowing options, to adjust the data to 

remove effects resulting from the discontinuities of data at the two edges. 

Value Click the crosshair icon  to display the frequency and amplitude values of the spectrum 
when moved within the spectrum display. The mouse cursor will change to a crosshair when 
inside the spectrum plot. The frequency and amplitude values corresponding to the mouse 
position are displayed above the spectral plot. Hold the mouse button down to display the 
amplitude of the spectrum at the horizontal mouse position, along with a crosshair cursor 
highlighting the exact location shown on the spectrum. If the active spectrum is compressed 
(that is, if multiple samples exist for a particular horizontal position), the value extracted will 
be the maximum value displayed at that pixel position. 

Zoom Click the magnifying glass  to perform zoom operations. Click and drag the mouse cursor 
(which will change to a magnifying glass) in the plot display to select the area to zoom in on. 
Alternately, click on either of the axes of the spectrum palette to display a dialog used to 
enter display ranges manually. Enter the start and end points of the desired range for each 
axis. There are no grids in the spectrum analyzer palette, so the axis scaling dialogs of graphs 
are not applicable. Note: adaptive scaling will be disabled for the spectrum display when 
either the zoom tool or the axis endpoint entry dialogs are used. 



Part C — Analysis Functions 309 

 

Statistics... 
The Display>Statistics  command generates an information dialog for the selected channel. 

 
Channel This box displays the channel number, channel label (if any). 
Interval Indicates the acquisition sampling rate. The sampling rate specified reflects the sampling interval 

AcqKnowledge uses to store the data, which is not necessarily the same rate at which it was 
collected. The sampling rate can be modified by using the resample function (described on page 
X579H247X), by changing the interval horizontal scale (see page X580H301X), or by pasting data collected at one 
sample rate into a graph containing data sampled at a different rate. 

 Mac OS X: Details interval of the finished waveform, i.e. waveform sample rate. 
Length Indicates the overall length of the channel in samples per second and time. Generally, the 

waveform length information is the same for all channels, although this is not always the case. To 
shorten waveforms by editing out sections of the waveform (using Edit>Cut and/or Edit>Clear 
functions). 

Divider The divider indicates the ratio between the acquisition rate and the channel sample rate. 
Divider = Acquisition Rate / Channel sample rate 

 Mac OS X: Divider is not included, but can be determined via the waveform Tooltip. 
 Included with the divider ratio (after the comma) is the sample rate for the selected channel. 
Min Provides the minimum value for the waveform data. 
Max Provides the maximum value for the waveform data. 
Mean Provides the mean value for the waveform data. 
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Preferences... 
Choosing Display>Preferences generates the general preferences dialog box, which allows you to control 
measurement options, how waveforms are displayed, and other AcqKnowledge features. Clicking the 
Journal… button will generate a separate Journal preferences dialog box, and the options in each dialog can 
be set independent of other options. In the MPWS System, the Journal option is located under the File menu. 

     
Measurement Options 

 measurement rows determines how many measurement rows should be displayed at the top of the graph 
window. Use the pull-down menu to set to a value (limited to 8 on Windows). 

o You can use the options in the Display>Show>Measurements menu to hide the measurements 
altogether. See page X581H302X for more information on this option.) 

 precision controls the accuracy of digits displayed right of the decimal (1-8) for all visible measurement 
results. For instance, with precision set to 3, one measurement window might show 125.187 while 
another reads 0.475. 

 Use linear interpolation—Mac OS X only Toggle the checkbox to enable/disable measurement 
interpolation. 

 Time/Frequency units sets the measurement unit to use for time and frequency pop-up measurements. 
This locks the units for the measurement result display (i.e., if seconds is selected, a result of 70 
seconds will display as “70 seconds” rather than “1.16667 minutes”). 

o Best match—Mac OS X only Scales units to best match the interval for time and frequency 
based on the total file. For example, won’t set a 3 hour file to display in msec. 

 Parameters—Mac OS X only Use Preferences >Journal > Measurement Options and enable “Include 
measurement parameters” to capture location and operation detail. 
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Waveform Display Options 
In the center of the dialog box are two options that control how waveforms are displayed on the screen. 

 Gray non-selected waves Mac OS X only When enabled, the active wave will be drawn in a solid color 
and any non-selected waveforms will be drawn using lighter, dotted lines (or with lighter colored dots if 
dot plot is in use). This can help emphasize the selected waveform when viewing data in Scope mode. 

 Draft mode for compressed waves allows for some (“compressed”) waveforms to be plotted in “draft” 
mode, which results in faster plotting time, although the display is not exact. A waveform is considered 
compressed when more than three sample points are plotted per pixel on the screen. Standard VGA 
displays are 640 pixels wide, so a compressed waveform on this type monitor would be any type of 
waveform displaying more than 2000 samples (approximately) on the screen at any one time. Using the 
default horizontal scale (which plots eight seconds of data on the screen), any data sampled at more 
than 250 samples per second would be considered “compressed.” 

 Enable tools during acquisition Windows/PC only Toggles waveform tool functionality during data 
acquisition; disable for memory-intensive acquisitions to optimize plotting performance and try to 
minimize buffer overloads. 

 
Other Options 

 …after transformations The first two options handle the way data appears on the screen after it has been 
transformed (e.g., filtered or mathematically operated on). Neither option affects how data appears on 
the horizontal axis, although both options change how data is presented along the amplitude (vertical) 
axis. 

o Autoscale after transformations will automatically rescale all waveforms after a 
transformation to provide the “best fit” along the amplitude axis. 

o Tile after transformations tiles all visible waveforms after any transformation, and is mutually 
exclusive of the autoscale command. When waveforms are “tiled” they appear to be stacked 
on top of each other. 

 Use all available memory instructs AcqKnowledge to attempt to use all the available memory for 
loading data. Otherwise, a variable sized buffer is used to load portions of large data files. This option 
works best if there is enough free memory to load the entire data file. 

 Interpolate pastings instructs AcqKnowledge to interpolate/extrapolate time base information when 
working with data sampled at two different rates. AcqKnowledge will interpolate data to fit the sample 
rate of the destination window. When doing this, you should copy data to a higher resolution window. 
Although To copy data in the other direction (from high resolution to low resolution), it is not 
recommended since some resolution will be lost in the process. 

o For example, if you have one 30-second waveform sampled at 50 samples per second, and 
another 30-second waveform sampled at 2,000 samples per second, you can copy the contents 
of one window into another using the insert waveform command, and AcqKnowledge will 
interpolate one waveform so that both appear to be 30 seconds long. In this example, data 
would be copied from the 50Hz (low resolution) window to the 2,000Hz (high resolution) 
window.  

 Show ToolTips—Windows/PC only Generates a flag with help text associated with an item when you 
leave the cursor over the item on the screen. Mac OS X users can toggle this function using Help 
>Show Tooltips. 

 Mark waveform edits with events—Mac OS X only Insert an event at points where waveform edit 
commands have been applied. 

 Snapshot data after acquisitions toggles the Embedded Archive feature (see page X582H49X), which stores 
snapshots of original acquired data along with the graph file for easy comparison of results to original 
waveforms or to intermediate stages of analysis. 
IMPORTANT: Archive functions do not create a new file—they are not backup functions.  

Original data is copied and pasted to the end of the original file.  
You cannot use this feature to recover lost or damaged original data. 
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When this Preference is enabled, a date-stamped archive of the data in the graph will be created each 
time the acquisition is stopped. In Append mode, the entire graph is backed up with each Append, old 
data as well as the newly acquired data. 
This is a memory intensive function; each snapshot that is added to a graph file will increase its size on 
disk by approximately 40%. You will be prompted about memory; click OK to proceed.  

 
 When closing… determines the degree of closing and what prompts, if any , for multiple data views. 

  
 List ___ recently used transformations—Mac AcqKnowledge 3.9.2 and later Change the number of 

recently used transformations that displays in the Transform > Recently Used submenu. 
 
Maximum Undo 
Mac OS X only Set the maximum number of undo operations. Unlimited may be memory-intensive, 
depending on the detail of each operation. 
 
Update screen interval 

The Update screen interval option lets you adjust 
the rate that the screen is updated, which can be 
useful when you have a large data file (as in sleep 
studies) and you want to quickly jump through 
the data. You can set the interval to update in full 
page, half page, or quarter page increments. Click 
in the circle next to the desired interval in the 
“Update screen interval” section and the screen 
will update in the selected interval when you 
click on the horizontal scroll bar. 

 
Shortcuts 
Windows  Right-click in the horizontal scale region
Mac OS X Control-click in the horizontal scale 

region to activate the contextual menu 
Hold the mouse button down and scroll to the desired 
interval, then release the mouse button to activate the 
new interval. 
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Hardware options 
Mac OS X only—Use the Hardware options to set the MP unit communication preferences: 

 No Hardware sets the default communication for no connection so you don’t get the connection error each 
time you launch the software. 

 Ethernet protocol is UDP by default, but can be switched to DLC to test communication. If you cannot 
establish MP unit communication with AcqKnowledge under either protocol, check the MP unit firmware 
(see page X583H332 X) and then contact BIOPAC for technical support. 

 Mac AcqKnowledge 3.9.2 and later—Adjust the line frequency specified during software installation. 
Every time data is recorded, the line frequency setting is saved along with the data. If no line frequency 
data was saved, the line frequency setting for the installed/active version of AcqKnowledge will be used. 

Windows—use the setup utility to change communication modes. 
Network Settings 

 

Mac AcqKnowledge 3.9.2 and later—Check “Enable networking” to allow applications running on other 
computers attached to the same network to gain access to data from AcqKnowledge as it is being acquired. 
Data is sent to other applications over a network using TCP (recommended) or UDP connection during 
acquisitions. All types of channels may be exported, including analog, digital, and calculation channels. 
AcqKnowledge will continue to function normally while data transfer is in progress, displaying the new data 
in the graph window and performing any autoscrolling.  

The network data transfer feature is not intended for strict real-time delivery. It also does not provide direct 
control over the MP unit. Perform all hardware configurations manually using the AcqKnowledge interface.  

• For applications that require low latencies, high-data throughput, or direct hardware configuration 
and control, use BIOPAC Hardware API.  

Create default menu configuration file 
Create default menu configuration file to customize menu display. See page X584H325X for customization details. 
 
Journal Preferences 
The Journal Preferences dialog box has five checkboxes that control the format of data when it is pasted into 
the journal or clipboard. To generate the Journal Preferences dialog 
 Windows Select Display > Preferences > Journal. 
 Mac OS X Select Display > Preferences and then Click the Journal… 

For Marker Journal Summary preferences, see page X585H163X. 
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 Include measurement name (i.e., BPM, delta T, Freq, etc.) with the values. 
 Include measurement units (i.e., volts, mmHg, and so forth) after the numeric values. 

o Note The first two options cause additional text to be pasted into the journal, which can 
drastically reduce the amount of numeric data that can be pasted into the journal due 
to limitations on the maximum journal size. See page X586H48X for more information on 
working with Journal files. 

 Include measurement parameters Mac OS X only Include any additional parameters used to compute the 
measurement function result, such as the operator used for Calculate measurements. 

 Include channel numbers at the top of each column of data. 
 Use a separate line for each measurement in the journal/clipboard. 
 Include timestamp Mac OS X only Automatically insert the time of day and the date when pasting 

measurements or wave data. This timestamp can be correlated with selection events to reconstruct the 
selected area.—useful for GLP auditing. 

 Mark selection with events in graph—Mac OS X only. Automatically insert a pair of Global Selection 
Begin and Selection End events at the selection boundaries when pasting measurements or wave data. 
These events will be timestamped with the time of day and the date when the paste occurred. This 
timestamp can be matched to the result of “Include timestamp” to recreate selected areas for 
reconstructing measurement results or re-executing wave data exporting—useful for GLP auditing. 

 Include time values copies the horizontal scale values along with the waveform data when data is 
copied to the clipboard. This means that when you paste data from the AcqKnowledge screen into a 
spreadsheet or similar application, horizontal scale information is retained. 

 Tabs: Specify the tab interval to make columns more readable when you have a high precision setting. 
 Change font to any font installed on your computer; the default font is 8 point Arial type.  
 Wrap Journal text—Mac OS X only. Wraps text to window size. 
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Marker Preferences 

 

Windows only Display > Preferences > Markers 
generates the Marker Preferences 
dialog; see page X587H162X for details. 

Mac OS X Access Event (Marker) preferences 
under MP menu> Set Up Events; 
see page X588H166 X for details. 

 
Performance  

 
Mac OS X only Set the priority for system resource 

allocation. For a data focus, move 
right, for a function focus, move left. If 
you are experiencing Buffer Overloads, 
move toward High speed. To allow 
autoscale during acquisitions or 
jumping between MPs, resizing 
displays, or working in other programs, 
move toward More responsive. 
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Size window... 

 

The Size Window function lets you specify exact 
dimensions for the size of the graph window. You can use 
this to create consistently sized windows for pasting into 
documents. The two text boxes allow you to enter screen 
width and height, both of which are scaled in terms of 
pixels. Standard computer displays have 72 pixels per inch 
(28.3 pixels/cm), so a graph window that is 360 pixels wide 
by 216 pixels high would be 12.7cm tall and 7.6cm wide. 

When the Reset chart boundaries box is checked, the boundaries between the waveforms will be reset so that 
each channel “track” is the same size. This function only works in chart mode. 
Set Font 

 

Windows only Allows you to change the font used in 
AcqKnowledge. Select any font 
installed on your computer. The 
default is 8 point Arial type. This 
dialog is also accessible via Display > 
Preferences > Journal… 

 

Create Data View 

 
Creates a new Data View for the active (frontmost) graph and names the new window “Data View of 
‘Filename’” For Data View details, see page X589H35X. 
Show All Data Snaphots 

Manual Archive: description and time 
Original file 
Auto-Archive: time only 

To view the embedded snapshot(s)/archive(s) associated with a graph file, choose Display > Show Original 
Data/All Data Snapshots. This will open a new graph window for each archive/snapshot associated with the 
graph. The time portion of the Filename for each graph is from the computer clock (saved with semi-colons 
because you cannot save a file with colons in the filename). The “Snapshot from…” graph will open with no 
Start button. 
Each embedded archive is essentially a “snapshot” of the original acquired data that is stored with the graph 
file so you can view the archive at a later time to compare results to original waveforms or intermediate stages 
of analysis. Append markers are not preserved in the snapshot/embedded archive file. For details on creating 
snapshots/embedded archives, see page X590H49X. 
Load All Data Into Memory 
Mac OS X only—Use with large files to improve plotting performance, measurement response, etc. Memory 
can hold up to two gigabytes of data. 
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Chapter 14 Other Menus 
AcqKnowledge menu 

 

Mac OS X only—System generated menu. Use for About and Quit. 
 

Window menu 

The Window menu is a standard OS function. See your Windows 
or Macintosh OS Guide for details. 

 

Help menu 

 

 

 

Use the User Support System pdf files for online help wth the 
software. 
When About AcqKnowledge is selected frorm the Help menu, a 
screen is generated that provides information about the 
AcqKnowledge software being used and your system parameters, 
which can be useful if you need to call BIOPAC for any reason. On 
the Macintosh this item is available under the Apple menu. 

 Mac OS X only—About AcqKnowledge is under the 
AcqKnowledge 3.9 menu. 

Note: For information about the MP acquisition unit and firmware, 
click MP menu > About MP on Windows/PC or MP menu> 
MP1#X Info on Mac OS X.  

Tooltips Mac OS X only—Tooltips is an online assistance feature to 
help novice users learn how to use AcqKnowledge. Text is 
generated to describe the software functionality of the item under 
the mouse. Unavailable items/controls will indicate why they are 
unavailable. 

 To show Tooltips when you pass the cursor over an item, 
select Help > Show Tooltips. 

Tooltips are not available for context sensitive (Ctrl-click) menus 
due to operating system limitations. 
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Part D—APPENDICES 
  

Appendix A - Frequently Asked Questions 
Q: I have a large data file and it seems to take a long time to redraw the screen. Is there anything I can do to 

speed it up? 
A:    Yes. You can choose from several remedies for this. 

(1) The simplest solution is to check the Draft mode for compressed waves and Use all available 
memory boxes in the Preferences dialog box (shown below). Checking these two boxes will 
cause AcqKnowledge to plot data faster (at the expense of some precision) and use as much 
available memory as possible. You can cancel the plotting at any time by holding down the ESC 
key on the MP//WSW (PC) or + “.” on the MPWS (Mac). 

  
(2) You can reduce the time interval per division, which causes less data to be displayed on the 

screen at one time, and should reduce plot time. 
(3) If the data still takes too much time to redraw and you have a color monitor, try reducing the 

number of colors displayed. 
(4) If you have a high-resolution video card (one capable of displaying many thousands of colors), 

you may want to reduce the resolution to speed up plotting time. 
(5) Load all data into memory; see page X591H316X for details. 

Q: Can I use other software with the MP System? Can I use AcqKnowledge to control other data Acquisition 
hardware? 
A: No. The MP System was designed to work with the AcqKnowledge software. However, the software 

can read in previously acquired text files generated by AcqKnowledge or any other software. 
Q: I have a device that outputs an RS-232/RS-422 signal. Can I connect this to the digital I/O lines? 

A: No. These types of digital output devices have their own communication protocols and are more 
complex than the digital pulses that the MP System can accept as inputs. 
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Q: I imported a text file and the time scale is wrong. What happened? 
A: When a text file is imported, AcqKnowledge assumes (by default) that the data was sampled at 100Hz 

or 100 samples per second. This is arbitrary, and there are two ways to adjust this. Both methods 
involve Calculating the interval between sample points. To calculate the sampling interval, you need 
to know the rate at which the data was originally sampled. The sampling interval is calculated by 
dividing one by the sampling rate. You can adjust the sampling interval to the appropriate value via 
the File>Open dialog box before the data is read in, or if the data is already present, change the time 
scale in the Display>Horizontal scale dialog box. 
For instance, if 20 minutes of data was originally collected at 2Hz and is read into AcqKnowledge as 
a text file, the software will interpret this as data collected at 100 samples per second. To set the time 
scale to accurately reflect the data, change the sampling interval from 0.01 to 0.5 seconds per sample. 
To change this setting before data is read in, click on the Options button in the File>Open dialog box 
and change the value in the Sampling Interval dialog box. To change the time scale after data has 
been read in, adjust the units per division in the Display>Horizontal axis dialog box. If the data are 
time-domain data, you can adjust the seconds/sample interval at the bottom of the dialog box. This 
value defines the interval between sample points, and can be changed to fit the rate at which the data 
was originally acquired. 

Q:  I have the fastest computer available. Why can’t I acquire data to the computer any faster than 11,000Hz 
on one channel, using an MP100 System? 
A: The bottleneck occurs in two places: 

1. The first occurs when data is transferred between the MP acquisition unit and the computer. 
While the MP System can acquire data as fast as 70,000Hz when data are stored directly to the 
MP acquisition unit memory, the maximum rate drops considerably when data is acquired to the 
computer memory, and even more so when data is acquired directly to disk. 

2. The second bottleneck occurs within the computer itself, and has to do with the time it takes to 
transfer and process incoming data. Faster computers can perform these tasks more quickly, 
which is why the maximum possible sampling rate for a Pentium (storing to memory) is faster 
than a 386SX. With a large number of channels, the aggregate sampling rate can climb to a 
theoretical maximum of 16,000 samples per second. 

To resolve the sampling limitation, use an MP150 System. 
Q: I just filtered a waveform and now my data file is huge. Why is that? 

A: When AcqKnowledge performs any type of transformation on a waveform (e.g. digital filtering, 
waveform math), it converts the entire waveform from integer format (two bytes per sample) to 
floating-point format (eight bytes per sample). Since each sample point in the waveform now takes up 
four times as much space, the file should be approximately four times as large. AcqKnowledge still 
saves the file as compactly as possible, and since some of the information stored describes the time 
base, the file size will not increase by exactly a factor of four. 
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Q: My MP acquisition unit seems to be connected, but I can’t acquire data. What should I do? 
A: This can be caused by one of several conditions: 

(a) Check to make sure that the MP acquisition unit is ON and, if so, that all the connections to the 
MP acquisition unit were made properly. When the MP acquisition unit is powered up, a light on 
the front panel of the MP acquisition unit will illuminate. If the power light will not illuminate, 
check to make sure the proper power supply is connected. The power supply that comes with the 
MP acquisition unit is rated at 12 VDC @ 1 Amp, and using other power supplies may result in 
damage to the MP acquisition unit. 

(b) If the proper power supply is connected but the power light still does not illuminate, disconnect 
the power supply and check the fuse in the back of the MP acquisition unit. The fuse is a standard 
2.0 Amp fast blow fuse, and can be changed by unscrewing the fuse cap and replacing the fuse. 

(c) If the power light does illuminate, the next step is to see if the busy light (next to the power light 
on the front panel of the MP acquisition unit) illuminates when the MP acquisition unit is 
powered up. When the MP acquisition unit is powered up, the busy light should illuminate for 
three or four seconds and then extinguish. 

NOTE: The busy light is normally off (except at startup), but it will remain on while 
data is being acquired and will illuminate for the duration of each trial when data is 
being acquired in averaging mode. If the busy light does not illuminate when the 
system is powered up or does not turn off after a few seconds, contact BIOPAC at 
one of the locations listed in Appendix A. 

Q: I set up the channels but I only seem to be acquiring noise. What’s wrong? 
A: A number of phenomena can cause this. Check to make sure that the settings in the Set up Channels 

dialog box correspond to the channel switch settings on the amplifier modules and/or direct analog 
connections to the UIM100C. When a direct analog input is set to the same channel as an amplifier, 
the resulting data will appear quite noisy or erratic. You should also check to see that no two 
amplifiers are set to the same channel. 
Another possible cause is that the gain settings on the amplifiers are too low and should be increased. 
You may also want to select Autoscale waveforms from the Display menu. This will automatically 
adjust the waveforms to provide the “best fit” in terms of scaling the data to fit in the available 
window space. 
It is also possible that the electrodes/transducers themselves are the source of the noise. Proper 
electrode adhesion techniques involve abrading the skin and securing the electrode in place to reduce 
movement artifact. 

Q: What is the storage and operation accuracy of AcqKnowledge? 

AcqKnowledge performs all internal calculations to the accuracy defined by the IEEE format for 
double precision flointing point numbers and stores the results of those calculations in double 
precision floating point format. This format assigns 8 bytes to all numbers involved in calculations or 
resulting from calculations. The 8 bytes (64 bits) are assigned as 52 bits to mantissa, 1 bit to sign, and 
11 bits to exponent. The effective decimal accuracy for calculation operation or storage will be 
defined as [2 to the 52] power or approximately 4.5 E15. Accordingly, the effective decimal accuracy 
will be between 15 and 16 digits. 
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Appendix B - Filter characteristics 
Filter types 
AcqKnowledge employs two types of digital filters:  

(a) Finite Impulse Response (FIR) perform post-acquisition filtering 
(b) Infinite Impulse Response (IIR) perform filtering calculations online (during an acquisition) or post-

processing (after an acquisition)  
Although the similarities between the two types of filters outweigh the differences, some important 
distinctions remain. 

1. First, IIR filters are typically more efficient than FIR filters, which means that IIR filters can filter 
data faster than FIR filters, which is why IIR filters are used for online Calculations. 

2. Second, IIR filters tend to be less accurate than FIR filters. Specifically, IIR filters tend to cause 
phase distortion or “ringing.” When the phase of a waveform is distorted, some data points on a 
waveform are shifted (either forward or backward in time) more than others. This can result in the 
intervals between events (such as the Q-R interval or the inter-beat interval in an ECG waveform) 
being slightly lengthened or shortened compared to the original signal. In practice, however, the 
effect of this distortion is usually minimal since the frequencies which are most distorted are also 
attenuated the most. By contrast, FIR filters are phase linear, which means that the interval between 
any two sample points in the filtered waveform will be exactly equal to the distance between the 
corresponding sample points in the original waveform. 

3. Third, IIR filters have a variable Q setting that defines the filter response pattern, but FIR filters do 
not have a Q component. The optimal Q of an IIR filter is 0.707, with lower values resulting in a 
flatter response and higher values resulting in a more peaked response. The default Q for all IIR 
filters is 0.707 (except for Band pass filters where Q defaults to 5), which is appropriate for nearly all 
filter applications. 

In the examples on the following page, the filter responses of several different types of filters are compared. 
All of the filters are 50Hz low pass filters operating on the same data. 
The first graph shows how the number of filter coefficients in FIR filters (Q) affects the filter’s frequency 
response. Note that as the number of coefficients (Q) increases, the filter becomes more accurate. A good rule 
of thumb is to set Q ≥ 2(fs/ fc), where fs = sampling rate and fc = cutoff frequency. 

 
 FIR filter performance as a function of number of coefficients (Q) 
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The next graph shows how the pole or zero locations of the filter, as related to filter “peaking” (specified by 
Q), affect the frequency response of the filter. The “Q” in this case is not to be confused with the Q from the 
FIR filter. Note how increasing “Q” in the IIR filter case affects filter “peaking.” 

 
FIR filter performance as a function of changes in pole or zero locations 

Coincidentally, the FIR (Q = 10) and IIR (Q = 0.707) filters have very similar responses in this case. 
Technically, the coefficient setting for FIR filters determines the number of multiplies performed by the 
filtering algorithm. In practical terms, it determines how “steep” the frequency response of the filter is. Filters 
with a large number of coefficients have a steep roll-off, whereas the frequency response of filters with a 
smaller number of coefficients is not as steep. 
 
Window Functions 
Window functions are used for two purposes in AcqKnowledge. Windows are applied to the impulse response 
in the (FIR) digital filtering functions, and can optionally be applied as part of the FFT function. In either 
case, a window refers to a computation that spans a fixed number of adjacent data points.  
Typically, window functions are used to eliminate discontinuities that may result at the edges of the fixed 
span of points of the digital filter function (FIR filters) or the data points of the FFT. 
Digital filtering. When a window is used in digital filtering, the impulse response of the filter (rather than the 
data itself) is modified. When the impulse response smoothly approaches zero at both the beginning and end 
of the data, this works relatively well. When the impulse response is not so well behaved, edge effect occurs. 
Edge effects can be minimized by windowing, or forcing the edges of the impulse response to smoothly 
approach zero. The exact process depends on the window selected (see below). 
Another way to minimize edge effect with an FIR filter is to increase the number of coefficients used to 
transform the data. 
FFT. The FFT function also windows data, although the nature of the windowing function is somewhat 
different in the sense that the window operates on the data. One of the assumptions of the FFT is that the input 
data is an infinitely repeating signal with the endpoint wrapping around. In practice, the endpoints are almost 
never exactly equal. You can check this by choosing the Delta measurement item from the measurement 
popup menus, which returns the amplitude difference between the first selected point and the last. To the 
extent that the endpoints differ, the FFT output will produce high frequency components as an artifact of the 
transformation. 

 AcqKnowledge displays only the positive coefficients of an FFT. In this FFT presentation, there is an 
implicit negative frequency component for each positive frequency component, so if you are looking 
at amplitude levels in a linear FFT you need to multiply by two (negative frequency can only be 
created with positive frequencies in the real world). 

By windowing the data, the effects of this phenomenon are greatly diminished. When data are windowed, a 
window is moved across the data, much as the smoothing function moves across the data. Whereas the 
smoothing function simply takes the average of a specified number of points, each type of window weights 
the data somewhat differently. 
The Window pull down menu offers the following options: 
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Bartlett implements triangular windowing and Rectangle does not window the data. The “shape” of the other 
windows is defined by the following formula, where n = 

0

N 1n−  and A, B, C and D are constants: 

A Bcos 2 n
N

Ccos 2 n
N

Dcos 2 n
N

− + +
π π π2 3

 

The table below details the different parameter values for each type of window. 

 Parameter Values 

Type of Window A B C D 

Bartlett n/a n/a n/a n/a 

Blackman 0.42000 0.50000 0.08000 0.00000 

Blackman -61 0.44959 0.49364 0.05677 0.00000 

Blackman -67 0.42323 0.49755 0.07922 0.00000 

Blackman -74 0.40217 0.49703 0.09392 0.00183 

Blackman -92 0.35875 0.48809 0.14128 0.01168 

Hanning 0.50000 0.50000 0.00000 0.00000 

Hamming 0.54000 0.46000 0.00000 0.00000 

Kaiser-Bessel 0.40243 0.49804 0.09831 0.00183 

Rectangle 
Windows/PC only 

n/a n/a n/a n/a 
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Appendix C - Hints for Working with Large Files 
It is not uncommon for users to generate large data files (on the order of several megabytes) through some 
combination of (a) high-speed acquisitions, (b) long acquisitions, and (c) multi-channel acquisitions. Users 
frequently encounter system limitations (such as storage space limitations) and find the files are difficult and 
slow in loading to memory. 
The software that comes with your MP System stores the data in as compact a format as possible. Each 
sample takes up roughly two bytes of storage space. When a waveform (or a section of a waveform) is 
transformed (i.e., filtered or integrated) each data point takes up roughly eight bytes of storage space. As a 
result, file size can change drastically after transforming one or more waves. 

Note: AcqKnowledge 3.8.1 for Windows cannot work with graph files larger than 2GB. 
The following tips can help you get the most out of your MP System when working with large data files. 

 Use virtual memory 
Since AcqKnowledge runs under Windows® XP or Mac® System 7.0 or better, most computers are able 
to take advantage of the virtual memory feature. While this is slower than conventional memory, it will 
at least make it possible to load some files that might otherwise be impossible to load. 

 Remove waveforms 
Since each waveform adds to the total size of the file, try removing (or copying to another file) some of 
the waveforms from a multi-channel file. This is especially true if you would like to perform 
transformations of some sort on at least one of the waves. 

 Sample slowly 
Theoretical and methodological concerns will, to a large extent, dictate sampling rate. However, if you 
can reduce the sampling rate, choose to do so. Or, use Transform > Resample (page X592H247X) to resample 
data after collecting it. 

 Set preferences 
Check the “Use all available memory” and the “Draft mode for compressed waves” options under the 
Preferences menu item. This should decrease the time it takes to redraw waveforms and allow the 
software to access all available memory for storage. 

 Store to disk 
Although slightly slower than storing to RAM, acquiring data directly to disk allows you to recover 
data in the event of a power loss to the MP System. Furthermore, much larger data files can typically be 
stored directly to disk than to memory. 

 Use the Append mode 
The Append mode allows you to pause the acquisition for arbitrary periods. This can be helpful when 
recording only a few key events that will occur randomly over a long period of time, since it will reduce 
unnecessary data.  

 Stop plotting 
If the screen is taking a long time to redraw (because the data files are large), you can stop plotting and 
change the horizontal scale to a smaller number before redrawing. To stop plotting from disk or 
memory, use the ESC key on the MPWSW (PC) or + “.” on the MPWS (Mac). 

 Compress Files 
Use the File > Save As > Compressed option to store or transfer data 
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Appendix D - Customizing Menu Functionality 
AcqKnowledge now includes a powerful customization feature lets you choose the program features to display 
as menu options. If you have a specific procedure, you can limit the menu options to list only those functions 
you need, thereby reducing the chance for confusion or error in your lab. For instance, you might choose to 
remove the “Setup Triggering” and “Setup Stimulator” options from the MP menu, as shown below: 

   
Default MP menu     Customized MP menu 

Follow the simple procedure below to customize menu display for your own needs. 
1. Launch AcqKnowledge. 
2. Mac users: a) Choose Display > Preferences. 

b)  Click on “Create default menu configuration file.”  
c)  Click “Yes” when prompted about editing the file. 

PC users:  a) Display the Journal window. 

  Use on the Journal icon from the Graph Toolbar 
 Click on the Display menu, select Show, and drag to select Journal. 

b)   Click the Journal > Open icon on the Journal 
Toolbar. 

c)  Type “menu.dsc” in the “File name” entry box and click Open. (If necessary, first navigate 
to the default location, C:\Program Files\BIOPAC Systems, Inc\AcqKnowledge 3.9.) 

 
 Alternately, you can pull down the “Files of type” menu, select “All files” and then 

select the “menu.dsc” file from the default location *(C:\Program Files\BIOPAC 
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Systems, Inc\AcqKnowledge 3.9) and click Open. 

 
The “menu.dsc” file will open in the Journal window, as shown below. 

 For a complete list of the options included in the “menu.dsc” file, see the end of this section. 

 
3. Find the menu and item you want to change (scroll through list as necessary) and type “OFF” to disable the 

menu display. For example, you might change the File > New option to OFF, as shown below. 
 Note that ON/OFF is case-sensitive and you must type in ALL CAPS. 
 Deleting a file listing instead of typing OFF will not remove the feature; it will default to ON unless 

you type OFF. 

 

 
 To reactivate a menu item that you have turned OFF, just repeat the above procedure and 

type “ON” for the menu item you desire. 
 

4. Activate the Journal Save As dialog. 

PC: Click the save icon at the top of the Journal.  
Mac OS X: File > Save Journal as… 

5. Save the file in the exact same location by typing “menu.dsc” in the “File name” entry box and clicking 
Save. Leave “Save as type” set to Text (*.TXT).  
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6. You should be prompted that the file already exists. Click Yes to replace the existing file. 

 
7. Exit the AcqKnowledge program. You do not have to save any graph or journal changes—the “menu.dsc” 

file has already been saved. Click No if prompted. 

 
8. Restart AcqKnowledge. 
9. Check your menu listing. 
 
Note: Application menu customization has a corresponding effect on contextual menu display for Mac OS X. 

If a contextual menu item does not have a corresponding application menu item, the menu 
customization file identifier will begin with “IDM_CM.” 
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Appendix E—Locking/Unlocking the MP150 

for Network Operations 
The MP150 is primarily designed to work in Local Area Networks (LAN). In a LAN, each MP150 unit may be 
accessed from any workstation (PC or Mac) running an Ethernet version of AcqKnowledge software. 
Theoretically, two or more workstations (WS) could be connected to one MP150 at the same time, but the 
MP150 cannot perform independent acquisitions simultaneously, so in such cases one or all connected WS 
would receive corrupted/invalid data and/or crash. 
To prevent this, AcqKnowledge uses new “lock/unlock” technology that establishes communication between an 
MP150 and one —and only one— dedicated WS in the Network. 

 
AcqKnowledge locks an MP150 as soon as it connects to it, which tells the MP150 to only respond to 
commands from that particular computer and the communication method (serial or ethernet). The lock has a 
timeout which is reset every time the MP unit receives a command from the computer that locked it. To locate 
MP150s in the local network, AcqKnowledge sends a broadcast packet to the local area network that asks all the 
MP150s in the network to respond. All the MP150s—wheter locked opr unlocked—will respond to this prompt. 
This means that the “Select MP150” menu may allow a user to select an MP150 that is locked. In such cases, 
AcqKnowledge will fail to connect (to a locked MP unit), as expected. To resolve this issue, unlock or power 
cycle the MP unit. 
 
Locked  An MP150 becomes “locked” in operation to a WS (and unusable to other users) if 
 a) An MP150 unit is selected from “Select 

MP150.” The dialog lists all MP150 
units that are powered ON and sitting 
on the same local area network. 
Unfortuantely, this dialog cannot 
provide the locked/unlocked status of 
each MP150 in the LAN. You may refer 
to the BUSY and ACTIVITY lights on 
the MP150 to determine the status—if 
you cannot connect to an MP150 but its 
lights indicate data traffic or acquisition, 
the MP150 you are trying to connect to 
is connected to another WS. 

 b) When AcqKnowledge is launched. 
AcqKnowledge will “remember” and try 
to connect the last MP150 used by a 
WS; if the last used MP150 is not 
available, the user must pick an 
available MP150 unit from the “Select 
MP150” dialog. 

 c) With the advent of any new 
communications or the start of any type 
of acquisition to the MP150 unit. When a WS communicates with an “unlocked” MP150 unit, 
AcqKnowledge sends a “lock” command. 

When an MP150 is locked, its serial number is listed in the Select MP150 dialog but any attempt to 
select a locked MP150 will generate a Hardware Not Found prompt (shown above).  
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Unlocked An MP150 automatically “unlocks” and becomes available to other users  

a) When the user exits AcqKnowledge. 
b)  The user selectes another MP150 in the Select MP150 dialog. 
c)  The user selects the “No Hardware” option in the Select MP150 dialog. 
Other, less common conditions that may unlock the MP150 include 
d)  The MP150 is powered OFF and then ON. 
e)  The MP150 does not receive commands/data from the WS or AcqKnowledge for about 5 

minutes. This time-out can occur when 
 An AcqKnowledge dialog (About, Calculation setup, etc.) is open for a long time. 
 AcqKnowledge or the WS crashes for any reason. 
 You turn the connected WS off without exiting AcqKnowledge. 

If the MP150 becomes unlocked due to a time-out, two scenarios are possible: 
1) The MP150 is locked—If another user has locked the MP150 you had been using, you will see 

the No Hardware Prompt. Check the MP150 lights to determine its status. 
2) The MP150 is unlocked—Your WS will “lock” the MP150 as soon as you initiate 

communication or acquisition; until then, the MP150 remains unlocked and available to others. 
 

No 
Hard-
ware 

When a user selects the “No Hardware” option, the menu of available MP150 units is grayed 
out and becomes unselectable. If a user attempts to connect to a locked MP150, an error 
message will be generated to advise that the MP150 unit is locked to a different computer. 
 
 

Cannot 
lock 

 
 If you receive this “cannot lock” prompt, check that no other user on the network is using the 

MP150, power-cycle the MP150, check the current firmware version (About MP150), and, if 
necessary, update the firmware using MP150Tools (see next Appendix). 
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Appendix F—Firmware Upgrade Utility 
Windows:  AcqKnowledge 3.9.0: use MP150 menu > Update Firmware (details below) 

AcqKnowledge 3.8.2 or previous: use MP150TOOLS.EXE Utility (see Application 
Note AF-228 MP150 Firmware Upgrade) 

Mac: MP150 Tools Firmware Upgrade (see page X593H331X) 
 

You may use the MP150 Firmware Upgrade Utility from any version to any version without limitation. It is a 
very safe procedure that cannot damage the MP150. 
Before performing a Firmware Upgrade, make certain that no other users are connected to or using the MP150 
you plan to upgrade. Any attempts to communicate with the MP150 via any user’s AcqKnowledge software 
may affect the viability of the upgrade. Fluctuations in the power source during an upgrade may also affect the 
outcome.  
The MP150 is delivered with a factory-programmed firmware version that is not affected by the upgrade 
procedure—you can always restore the original firmware with the Firmware Rollback Switch (see page X594H332 X for 
details). 
To use an MP150 with UDP communication on a network with a non-Windows DHCP server, you must use 
firmware 1.1.12 or greater for the MP unit to properly be assigned an IP address. This is also true for any DHCP 
system with non-Windows operating systems, such as Unix, Linux, Mac OS X, and other DHCP-aware devices. 
MP150 > Update Firmware—for Windows users 

1. Select MP150 menu > Update Firmware and when prompted, click OK. 

 
2. Choose the firmware file (.mpb) from the default location and click Open. 

 The default location is C:\Program Files\BIOPAC Systems Inc\AcqKnowledge 3.9. 
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3. When prompted, click Start. 

 
4. A status bar will show the upgrade’s progress, and a prompt will indicate a successful firmware 

update. 

 
5. Optional: To verify firmware upgrade, close AcqKnowledge and launch it again. Select MP150 

> About MP150 to generate the About dialog with the MP150 serial number and firmware version. 
If the firmware version is not as expected, repeat the Firmware Upgrade. If the MP150 fails to operate 
after downloading a new firmware revision, use the Firmware Rollback Switch on the bottom of the 
MP150 unit and note the recent firmware date. 

 

MP150 Tools Firmware Upgrade—for Macintosh users 
1. Find the MP150 Tools Firmware Upgrade file in the BIOPAC program folder and open it. 
2. Click Next to begin the procedure. 
3. Use the connect dialog to designate an MP150 to upgrade. 

• You must connect to an MP150 to complete the firmware upgrade. 
4. Confirm the designated MP150 information and click Yes. 
5. Click Start to initiate the firmware upgrade. 

• A warning will be generated if the firmware to be installed is older than the current firmware. 
6. When the upgrade is complete, a success dialog will be generated. Click Quit to close out. 

• If the firmware upgrade was not successful, you will be prompted to “rollback” to an older 
firmware version. See below for details on the Firmware Rollback Switch. 
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Firmware Rollback Switch 

   IMPORTANT! 
Use the Firmware Rollback Switch only if the MP150 fails to operate 
after a Firmware Upgrade. 

 In all other cases, just turn the MP150 power OFF and then ON and check 
the results of the Start up/Self-Test. 

The Firmware Rollback Switch is located on the bottom of the MP150 unit and is recessed to prevent accidental 
activation. 
Activation of the Firmware Rollback Switch will cause the MP150 unit to operate under the factory-installed 
firmware version. If no upgrades have been performed (the MP150 has only the factory-loaded firmware), the 
Firmware Rollback Switch will have no effect. 
Procedure: 

1. Turn the MP150 unit ON. 
2. Use About MP150 in the AcqKnowledge software to determine the factory-installed firmware version: 

IMPORTANT! 
Factory-installed Firmware version 1.1.2 or 
previous (purchased approximately November 
2002 or before) may not reset to a level 
compatible with UDP communication. In such 
cases, you will need to install a DLC-compliant 
version of AcqKnowledge and update to UDP 
in stages; contact BIOPAC for additional 
support if necessary 
Mac OS X: Labeled “Manufacturer’s ROM” 
and “Current ROM” 

3. Turn the MP150 unit OFF. 
4. Turn the MP150 unit upside down and use a small-tipped device (an unfolded paperclip 

will do) to depress and hold the switch down. 
5. Continue to hold the switch down, and turn the MP150 unit ON. 

• One green and one yellow LED light will begin to blink simultaneously 5 times. 

 While the lights are blinking simultaneously, you may cancel the Rollback by 
releasing the Firmware Rollback Switch. If Rollback is cancelled, the MP150 
will try to load the latest firmware upgraded version. 

• Then the MP150 will perform a normal Startup/Self-Test with the factory-loaded firmware. 
6. When the simultaneous blinking stops, release the switch. 

• The MP150 is now restored to the previous version of firmware. 
• You can check the firmware version via the MP150>About MP150 menu item in AcqKnowledge. 
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Appendix G— Specialized Analysis in AcqKnowledge 3.9 
 

 

The Specialized Analysis package includes comprehensive analysis tools to 
automate analysis to save hours (or days!) of processing time and standardize 
interpretation of results. Analyze data collected on MP Systems running on 
Windows/PC or Mac OS X. 
Windows Specialized Analysis is limited to 

 
For other Specialized Analysis functions offered on Mac, please 
read about File Portability (page X595H393X). 

Mac OS X AcqKnowledge 3.9 includes a courtesy copy of the Specialized 
Analysis Package under the Transform menu. 

An analysis package is a bundle of transformations created to assist with 
analysis in a specific area of research.  
A classifier is a special-purpose transformation that defines events at well-
known points of interest on standard waveforms, such as the ECG wave 
boundary classifier and the QRS beat detector and arrhythmia detector. 

The Specialized Analysis package includes the following Analysis Packages and Classifiers:  
Detect and Classify Heartbeats 
Locate ECG Complex Boundaries 
Heart Rate Variability 
Gastric Wave Analysis 
Gastric Wave Coupling 
Chaos Analysis 

Detrended Fluctuation Analysis 
Optimal Embedding Dimension 
Optimal Time Delay 
Plot Attractor 

Correlation Coefficient 
Electrodermal Activity 

Derive Phasic EDA from Tonic 
Event-related EDA Analysis 
Locate SCRs 
Preferences: Output Display Format; Phasic EDA 

Construction Method: Smoothing Baseline 
Removal or High Pass Filter 

Electroencephalography 
Compute Approximate Entropy 
Delta Power Analysis 
Derive Alpha-RMS 
Derive EEG Frequency Bands 
EEG Frequency Analysis 
Remove EOG Artifacts  
Preferences: Output Display Format 

Electromyography 
Derive Average Rectified EMG 
Derive Integrated EMG 
Derive Root Mean Square EMG 
EMG Frequency & Power Analysis 
Locate Muscle Activation 
Preferences: Output Display Format 

Ensemble Average 
Epoch Analysis 
Hemodynamic Analysis 

Classifiers: ABP; LVP; MAP  
Arterial Blood Pressure  
ECG Interval Extraction  

 

Hemodynamic Analysis continued 
Left Ventricular Blood Pressure  
Monophasic Action Potential 
Respiratory Sinus Arrhythmia 
Preferences: Output Display Format; LVEDP Location Method; 

dP/dt pk-pk %; MAP Plateau Location Method; dP/dt MAP 
pk-pk % 

Impedance Cardiography Analysis 
Body Surface Area Ideal Body Weight 
ICG Analysis VEPT 
PEP Pre-ejection Period 
dZ/dt Derive from Raw Z 
dZ/dt Classifier: B, C, X, Y, and O Points 
dZ/dt Remove Motion Artifacts 
Preferences: Output Display Format; C-, B-, and X-Point 

Location; Stroke Volume Calculation Method; Body 
Measurement Units; Body Surface Area Method; Ideal 
Weight Estimation Method; dZ/dt Max Method 

Magnetic Resonance Imaging 
Artifact Frequency Removal 
Artifact Projection Removal 

Median Filter Artifact Removal 
Signal Blanking 

Neurophysiology 
Amplitude Histograms Classify Spikes  
Average Action Potentials Dwell Time Histograms 
Generate Spike Trains Locate Spike Episodes 
Find Overlapping Spike Episodes 
Set Episode Width & Offset 
Preferences: Detect Spike; Default Episode Width; Default 

Episode Offset; Default # of Spike Classes 
Principal Component Denoising 
Remove Trend 
Respiration 
 Compliance & Resistance 
 Penh Analysis 
 Pulmonary Airflow 
Spectral Subtraction 
Stim-Response 

Digital Input to Stim Events Stim-Response Analysis 
Waterfall Plot  
Wavelet Denoising

AcqKnowlege File Portability Windows Mac OS 10.3 or higher 
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Use Specialized Analysis to analyze AcqKnowledge data files collected on MP Systems running on Windows/PC 
or Mac OS X. Using AcqKnowledge 3.9 for Specialized Analysis allows you to open/save the following file 
formats: 
Opening files for Specialized Analysis 

Opening files 

 
AcqKnowledge 3.9 

The default file formats (Graph and .ACQ) are referred to as “AcqKnowledge” 
files. The AcqKnowledge file format is the standard way of displaying waveforms 
in AcqKnowledge. These files are stored in a compact format that retains 
information about how the data was collected (i.e., for how long and at what rate) 
and takes relatively little time to read in (compared to text files, for instance). 
AcqKnowledge files are editable and can be modified and saved, or exported to 
other formats using the Save as command. 

File Compatibility 
Windows AcqKnowledge 3.8 cannot open Mac AcqKnowledge 3.9 files. 
Mac AcqKnowledge 3.9 can open Windows AcqKnowledge 3.8 or later files. 

 Mac AcqKnowledge 3.9 can open and create PC-compatible Graph (*.acq) and Graph Template (*.gtl) 
files. Variable sampling rate information and hardware settings are retained, and Journals can be read 
from and written to PC files. 

Files must end on a multiple of the lowest channel sampling rate to be fully PC compatible. 
Saving files after Specialized Analysis 

Saving Files 

 
AcqKnowledge 3.9 

The default file format for the File>Save as command is to save files as an 
AcqKnowledge file. Selecting Graph (MPWS) or .ACQ (MPWSW) from the popup 
menu in the Save As dialog box will save a file as an AcqKnowledge file, which is 
designed to be as compact as possible. These files can only be opened by 
AcqKnowledge, but data can be exported to other formats once it has been read in. 
The Options button generates a dialog box that allows you to save only a portion of 
your file. When the “Selected Section only” option is enabled, only the data that has 
been selected with the I-beam tool will be saved. This option saves the selected area to 
another file and does not affect the current file that you are working in. 

File Compatibility  
Windows AcqKnowledge 3.9 files can be opened with Mac AcqKnowledge 3.9, but some advanced features may 
not transfer. 
Mac AcqKnowledge 3.9 can save as “Graph (Windows)” files, but it saves in Windows AcqKnowledge 3.7.1 
format. In this earlier format, all data is retained, but newer AcqKnowledge features (like dual stimulation, data 
views, embedded archives, etc.) are lost along with any settings specific to Mac AcqKnowledge (like events, 
adaptive scaling settings, etc.). 

 Mac AcqKnowledge 3.9 can save PC-compatible Graph (*.acq) and Graph Template (*.gtl) files. Variable 
sampling rate information and hardware settings are retained, and Journals can be read from and written to 
PC files. Choose the format “Graph (Windows)” to create PC-compatible files. 

The Mac version does not save PC GLP files or compressed PC files.  
Files must end on a multiple of the lowest channel sampling rate to be fully PC compatible. 

Excel Spreadsheet Export AcqKnowledge 3.9.1 Mac only—The Specialized Analysis tools have been updated to 
automatically export their results to an Excel spreadsheet if desired. The spreadsheet contents mirror the tabular 
Journal text output. All the spreadsheets are saved as temporary files, so they need to be re-saved in order to be 
saved permanently. 

• Also available for File > Save As, File > Save Journal Text As, and Find All Cycles journal. 
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Note Specialized Analysis scripts are complex and undo may not function for all steps. 
 Some of the specialized algorithms are very complex and processor intensive, so they may take a long 

(even very long) time to return a result. 
 

Detect and Classify Heartbeats 

 
This robust QRS detector is tuned for human ECG Lead II signals. It attempts to locate QRS complexes and 
places an event near the center of each QRS complex to identify the type of heartbeat event: 
 Normal The beat was recognizable as a valid heartbeat falling in a human heartbeat rate. 
 PVC The beat was shorter than the beats around it and may be a pre-ventricular contraction. These events 

can be found in the “Hemodynamic > Beats” submenu of the event type listing. 
 Unknown The beat wasn’t recognizable as a valid heartbeat. This may occur on the first beat prior to the 

QRS detector locking onto the signal. It may also occur if tracking is lost due to changes in signal quality. 
The Cycle/Peak detector may be used with these events to perform further cardiac analysis. 

 

Locate ECG Complex Boundaries 

 
This classifier performs ECG waveform boundary detection for human ECG Lead II signals. It will attempt to 
locate the boundaries of the QRS, T, and P wave and will define events for each individual complex. It will 
attempt to insert the following events; all of these complex boundaries can be found in the “Hemodynamic > 
ECG Complexes” submenu of the Event Type listing. 

Wave Type Event Placement & Description 
QRS Onset 

Peak 
End 

Before the beginning of the Q wave 
At the top of the R wave 
After the end of the S wave 

T-wave Onset 
Peak 

At the onset of T 
At the peak of the T wave 
Note: This may not be a positive peak if the T-wave is inverted. If the T-

wave seems to be bi-phasic, two T-wave events will be inserted and 
the event description will indicate that the T-wave is bi-phasic. 

 End At the end of T 
P-wave Onset 

Peak 
At the onset of P 
At the top of the P wave 

Note: This may not be the absolute maximum, but rather the likely center of 
P. 

 End At the end of P 
The Cycle/Peak detector may be used with these events to perform further cardiac analysis. 
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Heart Rate Variability 
Recording good data is essential for performing HRV analysis. The protocol for data acquisition, filtering, artifact 
detection and correction in Application Note 233 results in great improvements in HRV analysis.  

“Results reveal that even a single heart period artifact, occurring within a 2-min recording epoch, can lead to 
errors of estimate heart period variability that are considerably larger than typical effect sizes in 
psychophysiological studies.” —Berntson & Stowell, 199 
• See Application Note 233 Heart Rate Variability—Preparing Data for Analysis Using 

AcqKnowledge (online at H13Hwww.biopac.comH) 
The note explains how to optimize ECG R-R interval data for Heart Rate Variability studies by using a template 
matching approach. It also explains how to identify erroneous R-R interval values caused by signal artifact and 
shows methods for correcting the errors by using the tools in the AcqKnowledge software. The note explains how 
to:  

A. Record good ECG data 
B. Prepare data for the tachogram  

1. Filter the ECG data 
2. Transform the data using Template Correlation function  

C. Create a tachogram  
D. Identify problems with the tachogram data  
E. Correct tachogram data  

 
Windows 

 
 
 
 

 
 Windows Results 
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Mac 

   
 

Heart rate variability is the examination of physiological rythms that exist in the beat-to-beat interval of a cardiac 
signal. Heart rate variability assists in performing frequency domain analysis of human ECG Lead II data to 
extract standard HRV measures. The AcqKnowledge 3.9 algorithm conforms to the frequency domain algorithm 
guidelines as published by the European Heart Journal. HRV processing in AcqKnowledge consists of three 
stages: 

1. The RR intervals are extracted for the ECG signal. 
 A modified Pan-Tompkins QRS detector is used. 

2. The RR intervals are re-sampled to a continuous sampling rate in order to extract frequency information. 
 Cubic-spline interpolation is used to generate this continuous time-domain representation of the RR 
intervals. 

3. The frequency information is extracted from the RR intervals and analyzed to produce standard ratios. 
Power sums are reported in units of sec2. 

 A Welch periodogram is used to generate the Power Spectral Density (equivalent to Transform > 
Power Spectral Density). 

RR intervals—Select a method to locate R waves 

  

QRS detector 

The HRV analysis QRS detector uses a modified Pan-Tompkins algorithm. The algorithm normalizes the 
ECG data to 1 whereby the peak amplitude of the highest R-wave represents 1. The default threshold 
level of .5 should place the threshold in the middle of the R-wave. If the R-wave amplitude varies a lot, it 
might be necessary to adjust the threshold level. 

Pan J and Tompkins WJ. A Real-Time QRS Detection Algorithm. IEEE Transactions on 
Biomedical Engineering 32(3):230-236, 1985.  
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The standard settings should function on a wide range of data sets, but you can adjust the thresholds for 
your particular data set. Use the tachogram output to examine the output of the QRS detector. 

 Spline resampling frequency—For highest accuracy, set to no less than twice the topmost frequency 
of the very high frequency band. 

Frequency Bands—Adjust the boundaries of the frequency analysis. They are preset to the frequency 
ranges recommended by the European Heart Journal. Output of derived parameters is presented in a 
Sheet and may also be pasted as text to the Journal. 
Output Options— Create standard result presentation graphs or assess performance of the HRV 
algorithm. These Options allow access to intermediate computation data for algorithm validation and/or 
measurements. 

 Spectrum—Displays the power spectrum density (PSD) estimation from which the PSD summations 
and sympathetic/vagal ratios are computed. 

 Raw tachogram—Plots the raw R-R intervals found by the QRS detector. Perform statistical HRV 
measures on the R-R intervals without exporting the textual R-R table to excel. 

 Interpolated tachogram—Plots the resampled R-R intervals after cubic spline interpolation is applied 
and extracts the PSD from this data. 

 Presets—The preset menu can be used to save a variety of HRV settings, including: beat detection 
parameters, spline resampling frequency, and frequency band ranges. Choose a preset from the popup 
menu to apply its settings. To construct a new preset with the currently displayed settings, choose 
Add New Preset. A default preset for adult human subjects is supplied. 

Events 

Located using events in the channel of data to be analyzed. This assumes a single event is placed at each R-
wave peak and that all of the R-peak events are of the same event type. When using events, the buit-in QRS 
detector is not used; the exact positioning between the events on the channel is used to extract the RR 
intervals.  

By using events, it is possible to use other QRS detectors within AcqKnowledge for performing HRV 
analysis. It is also possible to apply spectral HRV-style analysis to data in other domains as long as intervals 
can be reduced to events.  
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Gastric Wave Analysis 

 

 

 

 Gastric Wave Analysis uses autoregressive time-frequency analysis to determine the classifications of gastric 
waves present in an EGG signal. The single wave analysis determines the percentage of gastric waves that fall 
within the frequency bands corresponding to normal, bradygastric, and tachygastric waves. The analysis also 
indicates the percentage of waves that fall outside of these boundaries and are arrhythmias. The frequency 
bands are expressed in units of “contractions per minute” and may be adjusted by the user. Presets for 
commonly used subject and wave types are predefined; you may extend these presets with your own. 
 

Gastric Wave Coupling 

   
Gastric Wave Coupling takes two EGG signals and uses autoregressive techniques to classify the 
contractions in those signals according to user-configurable frequency bands (similar to single channel 
Gastric Wave Analysis). In addition to providing classification information for the two signals, Gastric Wave 
Coupling provides a measure of the percentage of coupling between the two signals—this measure that can 
be used to determine the amount of slow-wave propagation across the stomach. 
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Chaos Analysis 

 
The “Chaos” analysis package assists the user in exploring the chaotic nature of data, including measurement 
selection and visualization of time domain attractors in the data. 
 

Detrended Fluctuation Analysis  

  
Modified root mean square analysis, useful for evaluating self-similarity in a long-term, non-stationary data 
series. Source data is mean-adjusted and then integrated; it is then split up into n segments of equal length, 
and in each segment, via linear regression, the best fit least squares line is computed. For a particular value of 
n and a number of samples N, the characteristic fluctuation of the piecewise linear fit yn. is defined as: 

F n 1
N k 1

N

y k yn k 2  

F(n) is evaluated over a user-specified range for the number of divisions. n will equal the total length divided 
by the number of divisions. A log-log plot of the interval width n in samples versus the corresponding value 
of F(n) will be created. If a linear relationship appears to exist in this graph, then the source signal displays 
some form of self-similarity. The slope of the line in this graph is related to the scaling exponent. 

 For more information on Detrended Fluctuation Analysis, see http://www.physionet.org/physiotools/dfa/ 
 
Optimal Embedding Dimension  

            

Indicates the number of times the dimensionality of the data is increased by adding additional copies of the 
data. Many of the fractal measurements take an embedding dimension parameter. Increasing the 
dimensionality of the data may improve the quality of the results. In general, embedding dimensions should 
always be less than 8. 
After the most relevant time delay for the data has been selected, Optimal Embedding Dimension assists in 
choosing the embedding dimension that appears to give the most accurate results. The embedding dimension 
is chosen to be the earliest dimension in the search range where the fractal correlation dimension measure 
reaches a local maximum. This indicates the lowest dimension where the data has the potential to exhibit the 
most self-similarity. 
 Since real data may not be fractal in nature, there may be no local maximum for the embedding 

dimension. In this case, it is not possible to determine the optimal dimension. 
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Optimal Time Delay  

   
Assists in picking a time delay that is most relevant for the data. It runs through and locates the earliest time 
delay in the specified interval range where the mutual information measurement reaches a local minimum. 
Optimizing the time delay in this fashion picks the shortest delay where the signal exhibits the most 
independence with respect to its time-delayed version. 
The new fractal dimension and other chaos-related measurements operate on a single channel of data. During 
the process of extracting these measures, a signal is compared with a time-delayed version of itself to examine 
the patterns in dynamics of the data. These measures take a fixed time delay setting to perform this analysis. 
The Optimal Time Delay transformation can be used to choose the best value for the parameter. 

 
Plot Attractor  

  
Assists in constructing X/Y plots for the attractors of time delayed data. By visually examining the shape of 
the attractor at a given time delay, To develop an intuitive sense for the underlying nature of the data and the 
dynamics of the system. 
Plot Attractor functions on the active channel of the graph. It prompts the user for a time delay and then 
constructs a new graph window with an X/Y plot of the attractor of the original signal against the time 
delayed version of the signal. It does not perform any additional computation aside from assisting in the setup 
and configuration of the attractor plot. 

 

Correlation Coefficient 

   
The correlation coefficient is a statistical measure related to the degree of variance or covariance between two 
data series. Given two data series x and y of length n, the correlation coefficient r is given by the formula: 

 
(see H14Hhttp://mathworld.wolfram.com/CorrelationCoefficient.htmlH) 

The square of the correlation coefficient can be used to determine the proportion of variance in common between 
the two signals. As the square gets closer to 1, the signals are a better statistical match for each other. 
To derive the correlation coefficient, two channels of data are compared against each other. 
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• the channels must have the same length 
• the channels must have the same waveform sampling rate 
• all of the data of the entire graph for the two channels will be used to compute the correlation 

coefficient. 
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Electrodermal Activity 

 
 
Definitions 

The prompts and analysis results of the EDA analysis package use the following terminology and units: 
µmho—the unit abbreviation for microSiemens, used in channel labels and analysis results. 
EDA (Electrodermal Activity)— the general area of skin conductance signals. Sometimes referred to by the 
older term “galvanic skin response.” 
Tonic EDA—continuous data acquired from an EDA electrode that includes all baseline offset. Sometimes 
referred to as “skin conductance level.” Averaging the tonic EDA over a specific period of time results in the 
average skin conductance over an interval. Tonic EDA is recorded using BIOPAC equipment with the 
highpass filtering set to off (DC mode). 
Phasic EDA—a continuous signal indicative of localized changes in the tonic EDA signal. Sometimes 
referred to as “continuous skin conductance response.” Phasic EDA can be thought of as AC coupled tonic 
EDA. The EDA analysis package offers multiple ways of constructing phasic EDA including smoothing and 
highpass filtering. The EDA analysis package performs the majority of its analysis on tonic EDA signals, so if 
phasic EDA is being recorded directly it is recommended that a second channel be used to record tonic EDA. 
Skin Conductance Response (SCR)—an individual localized change in the tonic EDA signal. An SCR may 
occur in response to a stimulus or may occur spontaneously. In general, there are multiple SCRs present in a 
tonic EDA signal and they can be detected as deflections from the localized baseline. 

Derive Phasic EDA from Tonic 
Given a tonic EDA signal, this transformation uses baseline smoothing or highpass filtering (the method 
currently set in Preferences) to construct a new Phasic EDA channel in the graph containing the estimate of 
the phasic EDA.  

Event-related EDA Analysis 
Many studies examine how EDA changes in response to certain stimuli. By examining changes in EDA, it is 
possible to gauge a subject's psychological response to a certain event. The Event-related EDA Analysis 
transformation script assists in the extraction of EDA measures that are linked to specific stimuli. 
In order to use the Event-related EDA Analysis transformation script, an event must be defined in the graph at 
the location of the delivery of each stimulus. This event may be defined using the Event Tool, hotkey 
insertion during acquisition, or any other method of defining events. Stimulus delivery events are located by 
event type and (optionally) by specific channel of the graph. All of the stimulus delivery locations to be 
extracted must have the same event type (e.g. “Flag”). To analyze multiple different event types, the 
transformation script must be executed multiple times. 
In addition to the stimulus delivery events, a tonic EDA signal must be present in the graph. If the tonic EDA 
signal does not already have SCR events defined on it, SCR events will be automatically constructed on the 
channel in the same fashion as the Locate SCRs transformation script. 
Each stimulus delivery event is paired with the closest SCR event. SCRs that correspond to a stimulus 
delivery are known as “specific SCRs.”  SCRs generally occur within a certain timeframe after stimuli. The 
transformation takes a maximum allowable separation interval between the stimulus and SCR response. If the 
closest SCR to a stimulus is farther away than this time interval, it is not assumed to be a response to the 
stimulus. It may be a response to a later stimulus or it may be a non-specific SCR that occurred 
spontaneously. 
For each specific SCR that is paired with a stimulus delivery event, the following measures are extracted: 

Name Abbrev. Description Units 
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Name Abbrev. Description Units 

Stimulus Delivery 
Time 

Stim 
Time 

The time within the recording where the stimulus delivery 
event was located. 

seconds 

Skin Conductance 
Level 

SCL Amplitude of the tonic EDA signal at the time when the 
stimulus was delivered. 

umho 

Response Latency Latency Time separating the stimulus delivery from the onset time 
of the corresponding SCR. 

This latency will always be less than the maximum 
allowable latency specified as a parameter for the 
analysis. 

seconds 

SCR Amplitude SCR 
Amplitud
e 

Height of the corresponding SCR as determined by the 
change in the tonic EDA from the time of SCR onset to the 
maximum tonic EDA amplitude achieved during the SCA: 

 

umho 

SCR Rise Time SCR Rise 
Time 

Time taken for the tonic EDA to reach its maximum value 
within the SCR: 

tmax  – tonset 

seconds 

 
If text output is enabled, the average value of SCL, Latency, SCR Amplitude, and SCR Rise Time will be 
included as the final row of the table. 
In addition to the above measures extracted for each specific SCR, the analysis performs rate extractions for 
specific and non-specific SCRs. By examining how the rate of SCR occurrences changes, long-term experimental 
trends can be investigated. This analysis is placed into a second set of waveforms (or a second table for text and 
Excel output). 
A fixed width window is specified as the “SCR count interval width” when performing the analysis. The entire 
recording is split up into fixed-width epochs of this granularity with the first epoch aligned at the start of the 
recording. For each fixed-width epoch, the following are extracted: 
 

Name Abbrev. Description Units 
Epoch Start Time Start 

Time 
Time location in the recording of the start of the epoch 
being examined. 

seconds 

Specific SCR Rate SRR Frequency of the occurrences of specific SCRs within the 
epoch. Specific SCRs are those SCRs that were 
successfully matched to a corresponding stimulus delivery 
event. 

Hz 

Non-specific SCR 
Rate 

NS.SRR Frequency of the occurrences of non-specific SCRs within 
the epoch. These are SCRs that occur spontaneously and 
are not paired with any known stimulus. 

Hz 

 
Locate SCRs 

Given a tonic EDA, this transformation defines event triplets for each skin conductive response in the tonic 
EDA. SCR location is a two stage process. 

1. First, all potential SCR occurrances are located on the signal. 
2. Second, all potential SCR occurrances that are not large enough are rejected. 

Potential SCR occurrences are detected by performing thresholding positive peak detection on the phasic 
EDA signal (using H and P as set via Preferences): 

1. Given a detection threshold H (expressed in umho), search for a positive threshold crossing in the 
phasic EDA signal. This position, tonset is recorded as the start of the potential SCR. 



Part D—Appendices 345 

2. Starting at tonset, continue examining the phasic EDA until the first negative threshold crossing of 
0 umho occurs. This position, tend is recorded as the end of the potential SCR. 

3. Return to step 1 to continue searching for more potential SCRs occurring after tend. 
After all of the potential SCRs have been located, the set of valid SCRs is constructed as follows: 

1. Determine the overall maximum amplitude of the phasic EDA signal within all potential SCRs. 
2. Given a percentage P, construct a threshold level T of P percent of the overall maximum phasic 

EDA signal value located in step 1. 
3. Examine each potential SCR. Find the maximum phasic EDA m within [tonset , tend ]. If m < t, 

discard the potential SCR. If m > t, mark the potential SCR as a valid SCR. 
This transformation requires a tonic EDA signal. If a phasic EDA has already been constructed for this tonic 
EDA, it may be used; otherwise, the transformation will create a phasic EDA automatically according to the 
settings in the Preferences. 
If the tonic EDA channel chosen for analysis already has SCR events defined on it, the SCR events will be 
replaced with the newly detected SCR events. No existing SCR events will be erased without a confirmation. 
Once SCR events have been defined, they can be used in conjunction with the Cycle Detector for performing 
further data reduction. The “event count” measurement can be used to estimate SCR frequency during 
individual time ranges of the experiment. 

 
Events on Tonic EDA 

After valid SCRs are located using the algorithm above, events are inserted into the graph that can allow for 
further data analysis around the SCR positions. Three events are defined on the tonic EDA waveform for each 
individual valid SCR: 

1. “General > Waveform onset” event at the SCR onset time tonset. This is the point where the threshold 
H was crossed in the phasic EDA. 

2. “EDA > Skin conductance response” event at the time tmax where the tonic EDA reaches its maximum 
value within the SCR (max in time range [tonset , tend ]). 

3. “General > Waveform end” event at the ending SCR time tend. This is the point where the zero 
threshold was crossed in the phasic EDA. 

Events for SCRs will always occur in the above triplets, in the order shown. 
 
Preferences… 
The following preferences can be configured and will be applied to all options in the analysis package: 

• Output: text, graph channels, or Excel 
• Phasic EDA options: Highpass Filtering or Smoothing Baseline Removal 

o Highpass Filtering—Highpass filtering constructs phasic EDA by applying a digital IIR highpass 
filter (f = 0.05 Hz, Q = 0.707) to the tonic EDA signal. This highpass filter essentially AC couples the 
tonic EDA signal similar to using the highpass hardware filter available on the GSR100C module. 
When using highpass filtering, the first few seconds of the phasic EDA may not be centered around 
zero and will appear to contain invalid data.; this artifact is related to the long time constant of this 
filter and is expected. 

o Smoothing Baseline Removal—Smoothing baseline removal constructs phasic EDA by subtracting 
an estimate of the baseline conductance from the tonic EDA. The estimate of the baseline is generated 
using median value smoothing. This is more computationally intensive than highpass filtering but 
does not illustrate artifact at the start of the signal. 
Additionally, its sensitivity can be adjusted by varying the window size. The width of the window is 
customizable in the preferences. 
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• Larger windows will decrease the sensitivity and show only large changes. 
•  Smaller windows will increase sensitivity and show more localized responses. 

• SCR detection parameters: threshold detection level H and percentage P 
o The default values are H = 0.02 umho, P = 10. 
o Setting H to 0 and P to 10% will approximate the referenced SCR detection algorithm. 
o Setting P to 0% will retain all potential SCRs (none will be rejected in the second phase). 
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Electroencephalography 

 
Compute Approximate Entropy 

 

   
Approximate entropy is a statistical measure that attempts to quantify the predictability of a data sequence. A 
perfectly predictable data series (such as a pure sine wave) has an approximate entropy of zero. Several 
studies are beginning to examine approximate entropy of EEG data and its relationship to external factors 
such as drugs and sleep states. 
The Compute Approximate Entropy script divides an EEG signal into fixed-width epochs and computes the 
approximate entropy for each epoch. Derivation of the approximate entropy is a computationally intensive 
process and may take several minutes or hours to complete. To obtain only the sub-ranges of the EEG data, 
copy and paste the ranges into new graph windows to restrict the approximate entropy computations to that 
data range; the analysis is performed for all of the data in the graph window regardless of the selected area. 

Delta Power Analysis 

 
Delta power is the total power of the EEG signal that occurs within the delta frequency band as configured in 
the Preferences. Delta power has been examined in a number of various EEG studies as an indicator of 
sleep/wakefulness and other conditions. By examining changes in the delta power, it may be possible to 
correlate delta power with effects of external factors. 
The Delta Power Analysis script divides an EEG channel into fixed-width epochs. For each epoch, the power 
spectral density is computed and the total power within the delta frequency band is derived from the PSD. 
This delta power value is then placed into the graph or into the journal as specified by the output preferences. 
Delta power can be measured from either a filtered or unfiltered EEG channel. To compute delta power for 
individual frequency bands, they must be derived prior to running the Delta Power Analysis script. 

Derive Alpha RMS 
The Derive Alpha RMS script constructs a standard alpha RMS waveform from an alpha EEG signal. Alpha 
RMS is the windowed root mean square value of the signal using a window width of 0.25 seconds. 

Derive EEG Frequency Bands 
The Derive EEG Frequency Bands script applies filtering to an unfiltered EEG lead signal to generate the 
following five standard EEG bands: 
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• Alpha 
• Beta 
• Theta 
• Delta 
• Gamma 

The frequencies used for each band are taken from the analysis package preferences. Filtering is performed 
using IIR lowpass+highpass combinaton filters. 
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EEG Frequency Analysis 

  
EEG may be characterized in terms of frequency and the power within specific frequency bands. The EEG 
Frequency Analysis script performs various feature extractions from EEG signals using FFT and other 
techniques to examine the power within the EEG signals. This analysis may be performed for multiple EEG 
leads simultaneously, allowing for either analysis of multiple leads or analysis of multiple EEG alpha, beta, 
theta, or delta bands from a single raw lead. 
The EEG Frequency Analysis script divides the EEG signals into fixed-width time epochs. For each 
individual time epoch, AcqKnowledge’s Power Spectral Density function is used to estimate the power 
spectrum of that epoch using a Welch periodogram estimation method. From this PSD the following measures 
are extracted for each epoch: 

Name Abbrev. Description Units 

Mean Power MeanP The average power of the power spectrum within the 
epoch. 
(Units Note: V will be replaced with the voltage units in 
which the EEG was recorded) 

V 2

Hz  

 

Median 
Frequency 

MedianF Frequency at which 50% of the total power within the 
epoch is reached. 

Hz 

Mean 
Frequency 

MeanF Frequency at which the average power within the epoch 
is reached. 

Hz 

Spectral Edge Spectral 
Edge 

Frequency below which a user-specified percentage of 
the total power within the epoch is reached. This 
percentage can be set using “Preferences” and defaults 
to 90%. 

Hz 

Peak 
Frequency 

PeakF Frequency at which the maximum power occurs during 
the epoch. 

Hz 

Remove EOG Artifacts  

  
Some EEG recordings involve subjects performing various visual tasks such as reading or watching video. 
Under these conditions, EEG may be susceptible to interference from the much stronger EOG signal arising 
from eye motion, particularly if EEG is recorded from near the front of the skull. Remove EOG Artifacts 
helps remove EOG interference from the EEG signals, recovering the EEG data for use in further analysis. 
EOG removal is performed using a blind signal separation technique known as Independent Component 
Analysis. ICA is used to split up statistically independent signals that have been mixed together during 
recording. Since EOG is independent of EEG, ICA can be used to remove it.  
In order to use Remove EOG Artifacts, a distinct EOG signal must be acquired in addition to the EEG signals. 
The EOG signal is required to identify the components correlated to eye motion. 
EOG artifact removal functions better when it is performed on multiple EEG leads simultaneously. Better 
results may be obtained by including EEG leads that do not exhibit EOG interference since the increased 
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number of leads allows for more fine-grained signal separation. Good results can be seen with as few as two 
EEG leads and one EOG lead. While this technique can be performed with a single EEG lead, the results will 
not be as dramatic. 
Note ICA is a non-deterministic technique, so it may not be possible to automatically separate the signals 

for every EOG/EEG data set. For ICA to be successful, it may be necessary to fine-tune the parameters 
of the ICA search procedure to match the data, use a different electrode configuration, or use fewer or 
more leads. 

Preferences… 

   
 

  
Adjust the EOG ICA Tolerance level and the EOG ICA maximum number of iterations by accessing 
Transform > Specialized Analysis > Electroencephalography > Preferences. EOG ICA Tolerance is used as 
the termination condition of ICA signal separation. The EOG ICA maximum number of iterations is another 
termination condition of ICA signal separation and represents the maximum point at which the search is 
aborted. For more information on these settings, see the documentation for the Independent Component 
Analysis transformation. 
Because ICA is a stastical technique, any filtered data produced with Remove EOG Artifacts should be 
carefully verified against other information to ensure that the approximations produced via ICA represent 
information that is truly correlated to the expected ECG. 
The spectral edge percentage indicates the cutoff percentage of the total power at which spectral edges will be 
placed. The default value is 90%. 
The frequency bands of alpha, beta, delta, and theta may be modified to match different analysis protocols. 
The default frequency ranges are:  

• Alpha—8 Hz-13 Hz 
• Beta—13 Hz-30 Hz 
• Delta—0.5 Hz-4 Hz 
• Theta—4 Hz-8 Hz 
• Gamma—36 Hz-44 Hz 
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Electromyography 

 
Derive Average Rectified EMG 

  
Average rectified value (ARV) is defined as a time windowed mean of the absolute value of the signal. ARV 
is one of the various processing methods used to construct derived signals from raw EMG data that can be 
useful for further analysis. 
To perform ARV, a time window must be specified for the sliding mean. The default time window setting is 
30 milliseconds, but this value can be adjusted depending on the desired amount of smoothing effects. It is 
advisable to closely examine results for time windows larger than 30 milliseconds as it is possible for delay to 
be introduced into the result. 
The ARV is computed using the Integrate transformation with a Rectified Average over Samples 
configuration. 

Derive Integrated EMG 

  
Integrated EMG (iEMG) is defined as the area under the curve of the rectified EMG signal, that is, the 
mathematical integral of the absolute value of the raw EMG signal. When the absolute value of the signal is 
taken, noise will make the mathematical integral have a constant increase. Integrated EMG splits up the signal 
into fixed-width timeslices and resets the integral at the start of each timeslice. To derive iEMG, the width of 
this timeslice must be specified. Similar to ARV, timeslices longer than 30 milliseconds may introduce delay 
into the result. 
The integrated rectified EMG signal will appear like a “sawtooth” style wave. In addition to the true iEMG, 
this script will output a second waveform whose value is the maximum value of the iEMG signal in each 
timeslice. This Maximum iEMG is easier to interpret visually and approximates the envelope of the iEMG 
signal. 
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Derive Root Mean Square EMG 

 
Root Mean Square EMG (RMS EMG) is defined as the time windowed RMS value of the raw EMG. RMS is 
one of a number of methods used to produce waveforms that are more easily analyzable than the noisy raw 
EMG. 
To construct the windowed RMS signal, a time window must be specified for the sliding mean. The default 
time window setting is 30 milliseconds, but this value can be adjusted depending on the desired amount of 
smoothing effects in the RMS EMG. It is advisable to closely examine results for time windows larger than 
30 milliseconds as it is possible for delay to be introduced into the result. 
RMS EMG is computed using the Integrate transformation in a Root Mean Square Average over Samples 
configuration. 

EMG Frequency & Power Analysis 
Several frequency domain techniques may be used for data reduction of EMG signals. The EMG Frequency 
& Power Analysis script extracts several measures derived from the power spectrum of an EMG signal. The 
EMG signal is split up into a fixed number of time periods; within each window, the power spectrum is 
computed using the Power Spectral Density transformation. For each time period, the following measures are 
extracted: 

Name Abbrev. Description Units 

Median 
Frequency 

MedianF Frequency at which 50% of the total power within the epoch 
is reached. 

Hz 

Mean 
Frequency 

MeanF Frequency at which the average power within the epoch is 
reached. 

Hz 

Peak 
Frequency 

PeakF Frequency at which the maximum power occurs during the 
epoch. 

Hz 

Mean Power MeanP The average power of the power spectrum within the epoch. 
(Units Note: V will be replaced with the voltage units in 
which the EMG was recorded) 

V 2

Hz  

Total Power TotalP The sum of the power at all frequencies of the power 
spectrum within the epoch. 
(Units Note: V will be replaced with the voltage units in 
which the EMG was recorded) 

V 2

Hz  

Locate Muscle Activation 

  
When performing gait analysis, exercise physiology, or other research, identification of periods where the 
muscle is active can allow for correlation of external factors to muscle activity. Locate Muscle Activation 
attempts to identify various periods of muscle activity using statistical methods. The transformation requires a 
raw, unfiltered surface EMG channel. It is important that the muscle being examined is relaxed for the first 
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0.25 seconds of the recording to provide an estimate of the “background noise” during areas of muscle 
relaxation. This quarter-second period is used to estimate baseline parameters that affect the entire process. 
This transformation implements a variation of the Hodges and Bui detection algorithm as described in: 
P. W. Hodges and B. H. Bui, “A comparison of computer-based methods for determination of onset of muscle 
contraction using electromyography,” Electroenceph. Clin. Neurophysiol., vol. 101, pp. 511-519, 1996. 
The variation implemented is a threshold-based algorithm roughly consisting of the following steps: 

1. Determine mean value  and resting standard deviation  of the first 0.25 seconds of the signal. 
2. Construct a filtered ARV EMG signal, z. 
3. Extract the variance of the signal with respect to the noise with the formula 

 
4. Using a threshold h, determine when the signal g lies below and above the threshold. Portions of time 

above the threshold are periods of muscle activity. 
5. Discard any transitions across the threshold if they are shorter in duration than a user-specified time, t. 

There are two methods of specifying the threshold h. An adaptive method examines the signal g and chooses 
the threshold to be the median of g over the entire waveform. Alternatively, the threshold can be specified 
manually. Using a manual threshold can be useful in adjusting the detection to better match specific EMG 
data. A suggested threshold is 2.5. By lowering the threshold, a larger quantity of data will be considered as 
muscle activity. By raising the threshold, a larger quantity of data will be considered to be noise. 
The transition discard time t is specified in seconds. The default value of t is 0.1 seconds. If muscle activity is 
being inaccurately identified as inactivity for short periods within active times, try increasing the value of t. 
Do not set t to be greater than the smaller of either the shortest duration of a single muscle contraction or the 
shortest rest interval inbetween consecutive muscle contractions. 
There are two outputs from the Locate Muscle Activation script.  

• A new waveform, Muscle Active, will be added to the graph. The value of this wave will be zero 
when the muscle is at rest and one when the muscle is active. This wave can be used to quickly 
visually examine the record for periods of activity.  

• Events are also generated on the raw EMG waveform. A Waveform Onset event is placed at each 
transition from inactive to active, and a corresponding Waveform End event is placed at each active-
to-inactive transition. You can use these events in conjunction with the Cycle Detector to perform 
further data reduction based on muscle activity. 

The detection of muscle activation onset and end from surface electrode EMG is an imprecise process. The 
output of this location should be visually examined for misidentification of activation periods that are too 
short, too long, overlapping, or missed. 

Preferences… 
The Preferences allow the type of output to be chosen for displaying results: text, graph channels, or Excel. 
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Ensemble Average 

 

 

 

 

 

 

 

 
Ensemble Average assists in performing offline averaging. Offline averaging produces an average waveform 
from a number of cycles, also known as an ensemble average. Averages of multiple channels can be extracted 
simultaneously and be consolidated into a single graph window showing the results. 
This option provides two methods for locating individual members of the ensemble. 

 Data-driven peak detection with positive or negative peaks in the data. This method automatically 
derives appropriate threshold levels from a user-selected peak and is useful for constructing averages 
keyed to periodic signals with strong spikes, such as ECG. 

 Place members of the ensemble surrounding events in the waveform. Events must be previously defined 
by the user, either manually or through another automated process. This method is useful for 
constructing averages keyed to any types of events in a graph. 
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Epoch Analysis  

  

  

  

  

 
Extracts basic measures from fixed-width time segments of data. A fixed-width time segment of data is 
known as an epoch. The location of these fixed-width intervals can either be keyed off of locations of events 
in the graph or tied to regular time intervals (e.g. occurring at a constant frequency). All of the standard 
AcqKnowledge measurements can be extracted on an epoch-by-epoch basis with the exception of calculation 
measurements. 
Epoch-by-epoch measurement results can be viewed either as channels of data in the graph, a textual 
summary, or on an Excel spreadsheet; textual summaries include a final row with an overall average of each 
extracted measurement. 
Times output by Epoch Analysis are always expressed in seconds; all other units correspond to the current 
preferred measurement unit settings accessible under Display > Preferences. 
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Hemodynamic Analysis 
Hemodynamics is the study of blood and circulation related data. This analysis package concerns itself with 
interpretation of ECG, blood pressure, and monophasic action potential data. 
IMPORTANT: These routines are designed specifically for human subjects and may not function well, or at 

all, on animal subjects, particularly small animals. 
The Hemodynamic analysis package consists of:  

a)  ABP Classifier 
b)  Arterial Blood Pressure 
c)  ECG Interval Extraction 
d)  Left Ventricular Blood Pressure 
e)  LVP Classifier 
f)  MAP Classifier 
g)  Monophasic Action Potential 
h)  Respiratory Sinus Arrhythmia 
i)  Preferences 

The time units reported by all of these transformations are in seconds unless otherwise noted. 
 
ABP Classifier  

   

 
Places systolic and diastolic events at appropriate locations on a continuous arterial blood pressure signal 
recording using either invasive means or a continuous noninvasive pressure monitoring system. The ABP 
classifier functions directly on the pressure data and may fail for signals that exhibit strong noise 
characteristics or large baseline drifts. Pre-filtering the signal may improve classification accuracy. 
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Arterial Blood Pressure  

  

  
Extracts various cycle-by-cycle measures from arterial blood pressure (ABP) and ECG signals. It can function 
on an individual ABP signal or, when used in conjunction with an ECG Lead II signal, extract additional Q 
relative measurements. 
 If the ECG and ABP signals have not been classified when this analysis is performed, events for diastolic, 

systolic, and ECG boundaries will be inserted as necessary. 
 If systolic, diastolic, and Q events are already present on the signals, however, they will be used. 

On a cycle-by-cycle basis, the arterial blood pressure analysis transformation extracts the following measures: 
Name Abbrev. Description 

Diastolic - Minimum pressure occurring during the cycle 

Ejection time ET Time interval between the diastolic pressure and the minimum of dP/dt 

Heart rate HR Heart rate in BPM as extracted from the diastolic-to-diastolic time interval for a 
given cycle 

Maximum dP/dt dP/dt max Maximum amount of the change in the pressure during the cycle 

Mean blood 
pressure 

MBP Mean blood pressure: 

Pdiastolic +
Psystolic − Pdiastolic

3
 

Minimum dP/dt dP/dt min Minimum amount of change in the pressure during the cycle 
 

QA Interval QA Time interval between ECG Q wave and the diastolic pressure 

Recovery 
interval 

%REC Time required for the pressure signal to decrease by a user specified percentage of 
the pulse height 

Systolic - Maximum pressure occurring during the cycle 

Time to peak 
pressure 

TTPK Time interval between the diastolic and the systolic pressures 

When textual output is used, the average of all of these measures will be output as the last row of the table. 
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ECG Interval Extraction  

 
Extracts cycle-by-cycle time and voltage measurements for various points and intervals between waveforms 
in the cycle on ECG Lead II signals. This interval extraction is based off of the waveform boundary locations 
with additional logic for defining explicit Q and S wave events. QRS peak events as output for boundary 
location are used as the R peak location. 
 If the ECG signal was not classified before running the interval extraction analysis, it will be classified 

automatically. 
This analysis extracts the following cycle-by-cycle measures: 

Name Abbrev. Description 

Corrected QT 
interval 

QTC QT interval divided by the square root of the RR interval 

Heart rate HR RR interval expressed in BPM 

P height P-H Amplitude at the peak of the P wave in a cycle 

PRQ interval PRQ Time between the onset of the P wave to the Q wave 

QRS width QRS Time between onset of the QRS complex and the end of the QRS complex. Equivalent 
to the time between onset of Q and end of S 

QT interval QT Time between the beginning of the Q wave and the end of the T wave 

R height R-H Amplitude of the R wave in a cycle 

RR interval RR-I Time between consecutive R peaks in the waveform 

ST interval ST Time between the S wave to the end of the T wave 

At the end of the text table output, the average of all of the cycles will be displayed. Additionally, both text 
and Excel output will indicate the number of cycles that did not have all three of the QRS, P, and T waves 
defined. These are cycles where the classifier missed a boundary and are listed as “Bad cycles,” which may 
happen due to noise or other artifacts in the signal. 

Left Ventricular Blood Pressure 

 

  
Extracts various cycle-by-cycle cardiac measures of left ventricular blood pressure data, optionally in 
conjunction with an ECG Lead II signal. Examines the LVP signal, ECG, and derivative of the LVP signal. 
 If the LVP and ECG signals have not been classified before this analysis is executed, they will be 

classified automatically. 
 Derivatives of the LVP signal can be pre-existing or can be constructed automatically. 
 If an ECG signal is not included, only pressure related measures will be extracted. 

The analysis outputs the following information on a cycle-by-cycle basis and the textual output cites the 
average of all of these cycle-by-cycle measurements: 

Name Abbrev. Description 
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Name Abbrev. Description 

Contractility 
index 

CI maximum value of dP/dt during the cycle divided by the pressure at that time 
location 

Developed 
pressure 

DP Interval between end diastolic pressure and systolic pressure 

dP/dt Max - Maximum change in pressure over the cycle 

dP/dt Min - Minimum change in pressure over the cycle 

End diastolic 
pressure 

LVEDP the end diastolic pressure for the cycle. This is not necessarily the minimum 
pressure during the entire cycle. 
LVEDP is located on the LVP signal using the method set in the preferences. 

Minimum 
pressure 

MIN Absolute minimum pressure occurring during the entire cycle. This is not 
necessarily equivalent to the end diastolic pressure 

QA Interval QA Time interval between the Q wave of the ECG and the end diastolic pressure 

Rate - heart rate in BPM as extracted from the time interval between consecutive end 
diastolic pressure locations 

Recovery time %REC Time it takes for dP/dt to increase from the minimum dP/dt location to a user 
specified percentage of that minmum value 

Systolic pressure SYS Maximum pressure occurring during the entire cycle 

Tau - the monoexponential time relaxation constant tau computed on a cycle by cycle 
basis.  
See “Computation of Tau” on page X596H359X for specifics. 

Tension time 
index 

TTI Integral of the pressure between end diastolic and the time of minimum dP/dt 

Computation of Tau 
There are many different methodologies used to extract the time constant from LVP data. The time constant is 
extracted from a best fit parameter of a model to the trailing edge of LVP data on a cycle by cycle basis. This 
analysis uses a monoexponential model of zero asymptote for computing tau. The relaxation period is defined 
as the range of data between the time of minimum dP/dt in the cycle to the point where the LVP pressure 
signal drops below the previous LVEDP level. Within this range, the following model is fitted to the data 
using the simplex search method: 

τ
t

eP0  

where P0  is the value of the LVP signal at the time of dP/dt minimum and t is the time coordinate shifted 
such that t is 0 at the time of dP/dt minimum. The best fit value from this model is used as the value of the 
relaxation time constant. 
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LVP Classifier  
Operates on left ventricular blood pressure (LVP) data to define events at the systolic pressure and the left 
ventricular end diastolic pressure for each cycle. 

 
The location of these points is performed using filtered derivatives of the original LVP signal. Pre-filtering 
the signal (lowpass of 50 Hz or less) or smoothing the signal before running the classifier may improve 
accuracy. 
The LVP classifier locates LVEDP (left-ventricular end diastolic pressure) by examining the derivative of the 
pressure signal based upon the location method specified in Preferences: 
 Adaptive threshold of 0 plus a percentage of the peak to peak change in pressure. The percentage is user-

specified; the default is 1%. If the LVP signals do not have “flat” valleys, this percentage may need to be 
increased to fine-tune positioning of LVEDP. 

 First zero crossings before contraction. 
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Monophasic Action Potential  

  
Performs classification of MAP data acquired from a human or animal subject and extracts various cycle by 
cycle intervals. Locates upstroke, maximum, 100% recovery, and user-specified recovery points on the action 
potential.  
 Classification is performed using the action potential with its smoothed derivative; pre-filtering noise with 

lowpass filters may improve classification. 
 If upstroke, maximum, and plateau events are already defined on the MAP signal, the classifier is not 

invoked and only recovery events are defined. 

Plateau position 
To better handle animal subjects and different potential morphologies, there are two methods for locating the 
plateau position in monophasic action potential data; use Preferences to set the method. Each method defines 
recovery percentage time locations depending on the signal between its maximum and the beginning of the 
plateau. The plateau is located by examining the derivative of the MAP immediately following its maximum 
value after an upstroke.  
 The first method uses an adaptive threshold of zero plus a percentage of the peak to peak change in the 

derivative between the maximum and the first zero crossing after the maximum. If the signal remains 
above the upstroke voltage in this interval, a quick algorithm is used to locate 100% recovery and user-
specified percentage levels. The default percentage is 0.1%, which will place the plateau position very 
close to the second zero crossing. This slight window around zero helps place plateau start events better 
for MAP data that has plateaus that continue increasing after their starting position. 

 Searches for the second zero crossing after the maximum. If the signal drops below the voltage level of 
the upstroke in this interval, a different (slower) algorithm is used to ensure the recovery percentage is 
relative to the upstroke voltage and not the minimum occurring between the maximum and plateau. 

The analysis outputs the following information on a cycle-by-cycle basis and the textual output cites the 
average of all of the cycle-by-cycle values: 

Name Abbrev Description 
100% recovery 
period 

100% 
REC 

Time interval from the upstroke for the signal to recover back to the upstroke voltage 
level 

dV/dt maximum dV Max Maximum change in voltage over the cycle 
dV/dt minimum dV Min Minimum change in voltage over the cycle 
End diastolic 
voltage 

EDV The value of the signal at the beginning of the upstroke 

Max voltage MAX The maximum value of the signal over a single cycle 
Minimum 
voltage 

MIN The minimum value of the signal over a single cycle. This may be less than the 
upstroke voltage depending on the morphology of the action potential 

Plateau voltage PLAT The value of the signal at the start of the plateau after the completion of the upstroke 
Rate - This is the heart rate in BPM as extracted from the time interval between consecutive 

upstrokes 
Stroke amplitude AMP Voltage interval between the plateau and the upstroke voltage 

User recovery 
period 

%REC Time interval from the upstroke for the signal to recover a specific percentage of the 
interval between the upstroke and the maximum voltage between the upstroke and the 
plateau 
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MAP Classifier  
The classifier portion of Monophasic Action Potential only – defines upstroke, plateau, and percentage 
recovery events on MAP signals without performing the additional MAP data extraction. 

 
The start of the plateau is located using either the second zero crossing of the derivative or a percentage of the 
cyclic peak-to-peak distance of the derivative. The plateau location method can be configured in Preferences. 

Respiratory Sinus Arrhythmia 
Respiratory Sinus Arrhythmia is used to explore the connection between respiration and changes to heart rate. 
Variations in the heart rate can be directly correlated with vagal tone. The RSA index can be used to 
investigate changes in this connection during recording. 
This RSA index is computed using the peak-valley method as outlined in: 

Grossman, P., van Beek, J., & Wientjes, C. (1990). A comparison of three quantification methods for 
estimation of respiratory sinus arrhythmia. Psychophysiology, 27, 702-714. 

This method uses both a recorded ECG Lead II signal and a respiration signal. By using respiration 
information, this analysis method can provide breath-to-breath analysis that does not require parameter 
tweaking for individual subjects. 
While designed for use with the RSP100C/TSD201 respiration module and transducer combination, it should 
be possible to use other estimates of respiration. The respiration signal is used to locate periods of inhalation 
and exhalation. Inhalation begins at valleys in the signal while expiration at peaks. Any respiration estimate 
that exhibits this morphology should be sufficient. 
The RSA index outputted by this analysis is linearly scaled as per the recommendations in Grossman et. al. 
For comparison to other methods or studies using logarithmic scaling, Transform > Math Functions > Ln 
transformation can be used after analysis to convert results to logarithmic scaling. 
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RSA results are triggered from the respiration cycle. The RSA analysis outputs the following measures: 
Cycle Index of the respiration cycle in the analysis. 
Time Location of the start of the respiration cycle on the time axis. 
Min Rate Minimum heart rate occurring during the inspiration window of the respiration cycle, 

expressed in milliseconds (IBI). 
• If a respiration cycle is invalid, this measure will be set to 0. 

Max rate Maximum heart rate occurring during the expiration window of the respiration cycle, 
expressed in milliseconds (IBI). 

• If a respiration cycle is invalid, this measure will be set to 0. 
RSA RSA index for the respiratory cycle, expressed in milliseconds. This is the max rate minus 

the min rate. This is output in linear scaling. Conversion to logarithmic scaling must be 
performed manually, if desired. 

• If a respiration cycle is invalid, this measure will be set to 0. 
Preferences 

 

Display results as 
Several of these transformations produce large amounts of cycle-
by-cycle derived measures. Results can be displayed as a tab 
delimited table in the journal, as waveforms in the graph, as an 
Excel spreadsheet or various combinations. Results are displayed 
as text-only by default. 
 

 
 

LVEDP location method – see page X597H360 X 

- adaptive threshold of 0 plus a % of pk-pk change in pressure 
- first zero crossings before contraction on the dP/dt signal 

 

 

MAP Plateau location method – see page X598H361X 

- adaptive threshold of 0 plus a % of pk-pk change in the 
derivative between the max and the first 0 crossing after the max 

- second zero crossing after the maximum 
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Impedance Cardiography Analysis 
The Impedance Cardiography analysis package assists in the analysis of cardiac output and other 
hemodynamic parameters using noninvasive bioimpedance monitoring techniques. It offers a variety of 
approaches for estimation of cardiac measures. 

 
Body Surface Area  

Determines the body surface area estimation in square meters for a subject of a given height and weight, using 
the formula set in Preferences. Prompts require height and weight of the subject in the preferred units. It can 
be used to calculate body surface area independent of any of the other analysis routines, which may be useful 
for validation purposes or other derived calculations. 
Body Surface Area equation 
Use the Preferences option to select an algorithm for estimating body surface area of a subject and deriving 
stroke volumes from impedance data. 

Method Formula 

Boyd BSA = 0.0003207× Height(cm)0.3 ×Weight(g)0.7285−0.0188 log(Weight(g ))  

DuBois and DuBois BSA = 0.20247 × Height(m)0.725 ×Weight(kg)0.425  

Gehan and George BSA = 0.0235 × Height(cm)0.42246 ×Weight(kg)0.51456 

Haycock BSA = 0.024265 × Height(cm)0.3964 ×Weight(kg)0.5378  

Mosteller BSA =
Height(cm) ×Weight(kg)

3600
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dZ/dt Classifier  
Places events at common inflection points on a dZ/dt waveform to derive other measures. 

 
The classifier will attempt to locate the following points on the ICG signal: 
 B point – opening of aortic valve (set location in Preferences) 
 C point – Maximum left ventrical flow (set location in Preferences) 
 X point – Closing of aortic valve (set location in Preferences) 
 Y point – Closing of pulmonal valve 
 O point – Widest opening of mitrial valve 

The algorithm for locating these points on the ICG signal examines local minima and maxima in the dZ/dt 
signal as well as values of its second derivative. Filtering is applied to the second derivative signal to improve 
accuracy. 
 Prefiltering the dZ/dt signal may improve accuracy slightly. 

In a particular cardiac cycle, if there is not enough definitive change in the ICG signal to locate a particular 
point, the point will be omitted. This may most commonly occur with the Y point since its inflection between 
X and O is subtle and may be lost. 
The location routine, as with impedance cardiography measurements in general, is sensitive to motion 
artifacts. It is intended to function on signals acquired from subjects at or near perfect rest. Swings in the 
dZ/dt signal may cause the classifier to fail. It is recommended that motion artifacts be removed before 
running the dZ/dt classifier or any other ICG analysis tools that may invoke the classifier on an ICG signal. If 
artifacts are present within the signal, the template matching cycle location method will exhibit better 
behavior than the fixed threshold method. The choice between these two methods can be made with the 
Preferences option of the analysis package. 
B-point Location—Use Preferences to set the dZ/dt B-point location method. 

There is no standard method generally accepted for programmatically locating B-points on an ICG 
waveform. The appropriate choice of B-point location method may depend on the data or on subjective 
preference. On average, all three methods will produce similar results for clean data. ICG Preferences has 
three options for B-point location: 
 Second derivative classification – Given a C peak, it searches within a 150ms to 100ms time window 

before the C peak for the maximum of the second derivative of impedance ( Z ). The B point is 
placed at this maximum. 

 Third derivative classification – Given a C peak, it searches for the maximum value of the third 
derivative of impedance ( Z ) within 300ms before the C peak. The B point is placed at this 
maximum. 

 Cycle-by-cycle ‘Isoelectric’ crossings – Given a cycle defined by two C peaks, the mean of the dZ/dt 
signal is computed over the cycle. The B point is then placed at the closest time to the right C peak 
that is still underneath this baseline zero level. 
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C-point Location—Use Preferences to set the dZ/dt C-point location method. 
In several of the ICG analysis scripts, the B, C, X, Y, and O points will need to be located on the dZ/dt 
waveform. The starting point of this process is locating individual cycles on the dZ/dt waveform to define 
the C points. Use Preferences to set the cycle location method: 

 Template Matching – the user is expected to select a representative cycle of the dZ/dt waveform. 
The entire cycle should be selected (e.g. visually to approximate a C-C interval, a X-X interval, 
etc.). The entire dZ/dt signal is then correlated with that representative cycle, and individual cycles 
are picked out from locations of maximum correlation. 

 Fixed Thresholding – the user is prompted to select one of the C peaks of the dZ/dt waveform. The 
voltage level of this peak is then used to compute an Ohms/sec thresholding level. Peak detection is 
then run on the dZ/dt waveform using that voltage level as the threshold. 
Since ICG is subject to many artifacts such as respiration components and motion artifacts, the 
default method used is template matching. For extremely clean ICG signals, however, fixed 
thresholding can be used effectively as well and will provide a quicker analysis. 

 Adaptive template matching – the user is prompted to select a representative cycle of the dZ/dt 
waveform. This is used as a basis for an adaptive match to locate cycles. Adaptive template 
matching will adapt to changes in the dZ/dt waveform as conditions change within the experiment. 
Two parameters may be set. The window size is the number of ICG cycles to use for estimating the 
next template. Smaller values will track changes more quickly; larger values will reduce 
interference from artifact. The correlation threshold is the value above which a match is found. It 
refers to the normalized cross correlation of dZ/dt with the template and should be between 0 and 1. 
Values closer to 1 will require precise matches and skip artifacts. Values closer to 0 will use looser 
match constraints and may be required if the ICG is changing rapidly.  

X-point Location 
There are two methods that may be used to locate the X point of the ICG waveform at the closing of the 
aortic valve. The choice of appropriate X point location method is dependent on the electrode 
configuration that is used to acquire the ICG signals. In certain electrode configurations, the dZ/dt 
minimum may actually occur closer to A than to X, making the first (and default) option of searching for 
the first turning point a more reliable solution. You may want to acquire a phonocardiogram in 
conjunction with ICG to help determine which method will be more accurate at locating X. 

 Search for the first turning point in the dZ/dt signal that occurs after the C point location and place X 
at the first positive zero crossing in the second derivative of impedance (d2Z/dt2).This is the default X 
point location method. 

 Locate the X point at the minimum value of dZ/dt over each cardiac cycle. 
 
dZ/dt Derive from Raw Z  

This is a convenience utility for working with impedances recorded using the BIOPAC EBI100C amplifier or 
the raw impedance output of the BIOPAC NICO100C module. When computing derivatives from raw 
impedance signals from an EBI100C, this will apply appropriate filtering for a thoracic impedance signal and 
properly invert the derivative to match traditional dZ/dt presentation. 
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dZ/dt Remove Motion Artifacts  
Applies SFLC motion artifact removal to a dZ/dt signal. Uses cycle information from an ECG signal to 
construct a sinusoidal model of the ICG signal containing only components that are correlated to the heart 
rate. 

 
IMPORTANT 
Motion artifact removal will affect the amplitudes of the dZ/dt signal, so results derived from a motion 
filtered dZ/dt signal should be additionally verified for accuracy. 
This tool performs the same type of filtering as the ICG Analysis and Pre-ejection Period tools when the 
Motion Filtering preference is enabled. 

 
ICG Analysis  

Performs a full impedance cardiography analysis on data, extracting intervals and derived cardiac measures. 
The minimal set of signals required to run this analysis is an ECG Lead II signal and either a raw impedance 
signal or a dZ/dt signal. 
 If a raw impedance signal is present from an EBI100C or NICO100C and no derivative has been 

constructed, the analysis will automatically construct the appropriate derivative and perform 
classification. 

 If both a raw impedance and a dZ/dt signal are present, the baseline impedance will be derived on a cycle-
by-cycle basis to improve the accuracy of the analysis. 

 If no raw impedance signal was acquired, a default fixed baseline impedance can be used. 
 If a NICO100C amplifier is used, it is recommended that both the raw impedance and dZ/dt signals be 

acquired to improve analysis accuracy. 
 To automatically apply motion filtering to the dZ/dt signal, use Preferences to enable Motion Filtering 

(see page X599H372 X). 
In addition to the minimal set of signals, it is also possible to use arterial blood pressure, central venous 
pressure, and pulmonary arterial pressure signals to improve the quality of the algorithm results. If any of 
these signals are not present, default fixed estimated values can be substituted for the mean pressures instead 
of deriving pressures on a cycle-by-cycle basis. 
ICG Analysis may potentially perform classification of both the dZ/dt and the ECG Lead II signals. The 
various notes for understanding the limitations of these classifiers apply and should be understood to properly 
interpret failures in the analysis. 
ICG Analysis will produce the following information on a cycle-by-cycle basis: 
At the end of the textual table an average of all of the cycle-by-cycle values will be appended. 
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Name Abbv. Description Units Formula 

Acceleration index ACI Maximum blood acceleration 1 / sec^2 d2Z

dt 2
max

TFI
 

Cardiac index CI Normalized cardiac output m^2 / min CO

BSA
 

Cardiac output CO Volume of blood pumped each 
minute 

l / min SV × HR 

Heart rate HR Heart rate in BPM as computed 
from the RR interval. 

BPM 60
RRi

 

Left cardiac work LCW Work exerted by the left ventricle 
each minute 

kg m MAP − PAP( )× CO × 0.0144  

Left cardiac work 
index 

LCWI Normalized left cardiac work kg m / m^2 MAP − PAP( )× CI × 0.0144  

Left ventricular 
ejection time 

LVET Interval between B and X. 
Time interval between aortic valve 
open and close. 

sec Not applicable 

Mean blood pressure MBP Mean blood pressure as measured 
on the arterial blood pressure 
signal, or fixed estimate if no ABP 
signal is present. 

mmHg 
Pdiastolic +

Psystolic − Pdiastolic

3
 

Mean central venous 
pressure 

CVP Mean central venous pressure over 
cycle, or default value if no CVP 
signal is present. 

mmHg Not applicable 

Mean pulmonary 
arterial pressure 

PAP Mean value of the pulmonary 
arterial pressure of a cycle, or 
default value if no PAP signal is 
present. 

mmHg Not applicable 

Pre-ejection period PEP Interval between the Q wave of the 
ECG and the B point of the ICG. 
Time interval between systole and 
aortic valve open. 

sec Not applicable 

RR interval RR-i Interval between R peaks in the 
waveform. 
 

sec Not applicable 

Stroke index SI Normalized stroke volume (ml / beat)/ m^2 SV

BSA
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Name Abbv. Description Units Formula 

Stroke volume SV Volume of blood pumped by left 
ventricle in a single beat 

ml / beat Set equation in Preferences: 

Kubicek—Estimates SV from the 
derivative of the impedance signal 
and blood resistivity: 

SV = ρ ×
L2

Z0
2 ×

dZ

dt max

× LVET  

Note  may be either the absolute 
maximum or the BC delta in 
amplitude, as set in Preferences. 

 Sramek—Estimates SV from the 
derivative of the impedance signal and 
the estimated volume of electrically 
participating fluid (VEPT): 

SV =
VEPT

Z0

×
dZ

dt max

× LVET

o In the ICG analysis routines, 
VEPT is estimated using a 
truncated cone model. 

VEPT =
0.17H( )3

4.25
 

     Sramek-Bernstein—Estimates SV 
from the volume of electrially 
participating tissue scaled according to 
body habitus. The SV equation is: 

LVET
dt
dZ

Z
VEPTSV ××=

max0

)(δ  

where 

( )
25.4

17.0)(
3H

weight
weight

VEPT
ideal

actual ×=δ  

Ideal body weight is computed using the 
method set in the Preferences. To best 
match the original Sramek-Bernstein 
equation, use the Met Life Tables ideal 
body weight method. 

Systemic vascular 
resistance 

SVR Afterload; arterial flow resistance dynes sec / 
cm^5 80 ×

MAP − CVP

CO
 

Systemic vascular 
resistance index 

SVRI Normalized afterload dynes sec m^2 / 
cm^5 80 ×

MAP − CVP

CI
 

Systolic time ratio STR Ratio between electrical and 
mechanical systole 

none PEP

LVET
 

Thoracic fluid content TFC Electrical conductivity of the chest 
cavity 

1 / Ohms 1

TFI
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Name Abbv. Description Units Formula 

Thoracic fluid index TFI Mean value of the raw impedance 
over the cycle, or fixed baseline 
value if no raw impedance signal is 
present. 

Ohms Not applicable 

Velocity index VI Maximum velocity of blood flow 
in the aorta. 

1 / sec dZ

dt max

TFI
 

Note  may be either 
the absolute maximum 
or the BC delta in 
amplitude, as set in 
Preferences. 
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Ideal Body Weight  
Body Weight is derived from a person’s height, gender, and (for the Met Life method) frame size. It describes 
the ideal weight based upon various estimates. Ideal body weight is subject to much interpretation, so a 
number of methods are provided. Ideal Body Weight results are always expressed in kilograms. 
Use Preferences to set the Ideal Body Weight computation method; the selected method is also used for ICG 
Analysis. 

Method Formula 

Devine Men 50 kg + 2.3 kg per inch over 5 feet 
Women 45.5 kg + 2.3 kg per inch over 5 feet 

Metropolitan Life 
Tables 

The weight is taken from the standard Metropolitan Life tables, which are based on gender, 
height, and frame size. The Metropolitan Life tables specify weight ranges; the ideal body 
weight is computed as the average of the endpoints of each weight range. Ideal weights are 
based on height with shoes on and are only defined for heights between 
Men 5' 2''and 6' 4'' 
Women 4' 10''and 6' 0'' 

Miller Men 56.2 kg + 1.41 kg per inch over 5 feet 
Women 53.1 kg + 1.36 kg per inch over 5 feet 

Robinson Men 52 kg + 1.9 kg per inch over 5 feet 
Women 49 kg + 1.7 kg per inch over 5 feet 

 
PEP Pre-ejection Period  

The pre-ejection period is the time interval between the electromechanical systole and the onset of ejection of 
blood from the left ventricle of the heart. This can be derived from standard ECG data and ICG data as the 
interval between the Q point on the ECG and the B point on the ICG. The Pre-ejection Period analysis tool 
helps extract PEP measurements from ECG Lead II and ICG data. PEP can also be computed using the full 
ICG Analysis tool on page X600H367X. 
To use Pre-ejection Period analysis, both an ECG Lead II and an ICG (dZ/dt) signal must be present. If either 
of these signals requires classification, the analysis will run the appropriate classifier to define the relevant 
events on the signals. To automatically apply motion filtering to dZ/dt, use Preferences to enable Motion 
Filtering (see page X601H372X). 
PEP analysis will output the following information on a cycle-by-cycle basis and the final line of the textual 
output will be the average of all of the cycle measurements. All time unit output is in seconds unless 
otherwise noted. 

Name Abbrev. Description 

Heart rate BPM The heart rate for the cycle as indicated in BPM. Derived from the RR interval. 

Pre-ejection 
period 

PEP Interval between the Q wave of the ECG and the B point on the ICG for the cardiac cycle. 
If the PEP cannot be computed for a particular cycle, it will have the value “----” in the 
textual output or 0 in the graphical output. 

RR interval RR-i Time interval between R peaks of a single cycle of cardiac data. 

VEPT  
Uses the truncated cone method to compute the volume of electrically participating tissue (VEPT) in cubic 
centimeters of a subject. You will be prompted to enter the height of the subject in the preferred units. It can 
be used to calculate VEPT independent of any of the other analysis routines, which may be useful for 
validation purposes or other derived calculations. 

Preferences  
The following Preferences are available in the following order. You must click through all Preferences to 
adjust a particular Preference. 
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Body surface area equation – see page X602H364X 

 Boyd; DuBois and DuBois; Gehan and George; Haycock; or Mosteller 
Ideal Body Weight method– see page X603H370X 

Stroke volume equation – see page X604H369X 

 Kubicek, or Sramek, or Sramek-Bernstein 
Output display format 

 Textual tables in the journal 
 Channels of data inserted into the graph. 

Unit system for inputting body measurements 
 English system: body height in feet and inches, distance between measuring electrodes in inches, and 

body weight in pounds 
 Metric system: body height in meters and centimeters, distance between measuring electrodes in 

centimeters, and body weight in kilograms. 
dZ/dt B-point location – see page X605H365X 

dZ/dt C-point location –see page X606H366X 

dZ/dt X-point location – see page X607H366X 

dZ/dt Motion Filtering Automatic Filtering Preference 
The Pre-ejection Period and ICG Analysis transformations have the ability to optionally apply motion 
filtering automatically to the dZ/dt signal. Motion filtering is performed using an SFLC keyed to the R 
waves of an ECG signal. The SFLC filtering approach is similar to performing cycle-by-cycle averaging 
of the dZ/dt signal. This motion filtering approach may cause errors to be introduced in derived 
calculations, so any results with motion filtering turned on should be validated additionally. 
Filter Magnitude Preference – relaxed, aggressive, and custom. 
 “Relaxed” uses a SFLC step size of .001. This allows the filter to adapt moderately quickly to 

changes in the dZ/dt signal. 
 “Aggressive” uses a SFLC setting of .0001. The filter will adapt much less quickly to changes in the 

ICG signal, allowing better filtering out of motion artifacts at the expense of a lessened response to 
changes in underlying ICG morphology. 

 “Custom” allows for an arbitrary SFLC step size. The step size must be greater then zero and much 
less than 1 for the filter to converge. 

dZ/dt Max method – Baseline drift in ICG signals can introduce drift artifacts into stroke volume, cardiac 
output, and other measures that are sensitive to changes in dZ/dt max. The Preferences offer two settings. 
“Max dZ/dt in cardiac cycle” will extract the maximum amplitude of dZ/dt as the max value. This is the 
traditional way of measuring dZ/dt max. A second estimate option, “change in voltage from B to C” will take 
the amplitude delta between B and C as the estimate of dZ/dt max. This will produce different stroke volume 
results, but is useful for removing motion artifact and improving consistency. 
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Magnetic Resonance Imaging 

 
Magnetic resonance imaging, or MRI, is often used to study the brain and other organs in the body. As access 
increases to MRI machines, researchers are beginning to combine MRI with traditional physiological signal 
recording. The strong magnetic fields used by MRI equipment can cause profound artifacts in physiological 
recordings, which can make the analysis of physiological recordings acquired in an MRI difficult. Some artifacts 
are external interference while other artifacts can be caused by currents being induced in electrode leads or even 
in the body itself. 

Artifact Location and Trigger Signals 
Most of the MRI analysis options require information to identify the positions of various artifacts. Event 
positions can be used or a “trigger signal” waveform in the graph can be used to identify periods when the 
MRI is active. Some MRI machines have a TTL output that is synchronized with periods where the MRI is 
on. 

• Whenever possible, this trigger signal should be acquired with the MP unit along with the physiological 
data. 

Trigger detection off of an MRI trigger signal waveform is performed using fixed level thresholding on the 
waveform data. The threshold level is set to be the minimum value of the entire trigger signal plus 1/10th of 
the peak-to-peak distance of the trigger signal. The threshold is kept data dependent to allow for artificial 
trigger signals to be derived from data if the MRI unit does not provide its own. The trigger signal may be 
acquired on either an analog or digital channel. 
Event driven artifact location can be useful when trigger signals are not available from the MRI or are not 
recorded. A cycle detector analysis can be used to place events at the onset of each artifact, or these events 
may be placed manually. Event based detection is also useful for applying the procedures for artifacts that are 
not directly related to the MRI trigger signal, such as for removing the cardiac interference from EEG data 
caused by the magnetic field of the MRI machine. 

Artifact Frequency Removal 
MRI > Artifact Frequency Removal 
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Two large sources of interference in MRI recordings are the current induced by the MRI magnetic field and 
the RF pulses used for triggering molecule alignment. While the overlap of this interference may be difficult 
to separate in the time domain, the MRI interference may have a distinctive signature in the frequency 
domain. 
Artifact Frequency Removal is a frequency domain adaptation of the ensemble projection removal of the 
Artifact Projection Removal transformation. It attempts to cancel out MRI artifact by removing the 
frequencies most strongly associated with the MRI signal. 
For each channel of data to be denoised, either the MRI trigger signal or event positions are used to locate 
periods of MRI activity for constructing an ensemble average. The FFT of this ensemble average is computed, 
and the magnitude of the average FFT is set as the reference. Cyclic mean removal is applied to each period 
of artifact to compensate for baseline drift or signals with expected DC offset. A second pass is then made 
through the data. For each individual artifact, the FFT of that artifact is computed and the projection of that 
FFT onto the average FFT is removed. After projection removal, negative Fourier components are discarded 
and a time-domain signal is reconstructed using the inverse Fourier transform. This reconstructed, filtered 
signal is used to replace the MRI artifact in the original data. 
Application of projection removal in the frequency domain has similar limitations to applying it in the time 
domain, that is, it assumes that the MRI interference is stationary (which is not necessarily the case). 
Variations in the MRI interference may cause this method to fail. 
IMPORTANT Artifact Frequency Removal requires an MRI triggering signal or artifact onset events to 

locate artifact positions. 
Artifact Projection Removal 

Artifact Projection Removal attempts to remove the noise components from the artifacts within a signal. An 
ensemble average is made for each period of MRI artifact in a channel. Cyclic mean removal is applied to 
each period of artifact to compensate for baseline drift or signals with expected DC offset. As the artifacts are 
averaged together, the actual interference with the physiological signal caused by the MRI should become the 
dominant feature if a sufficient number of artifacts are present. A second pass is made through the artifacts to 
remove this average MRI artifact from each individual period. 
The average artifact is removed using the Remove Projection transformation. This performs a vector 
projection of the signal onto the averaged artifact estimation and subtracts this projection. This is an 
improvement over straight subtraction of the average artifact as vector projection can compensate for changes 
to amplitude that may occur over time. 
Artifact projection removal cannot compensate for MRI interference that varies in frequency due to changes 
in orientation of electrode leads within the MRI or other factors that may alter the MRI artifact. 
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Artifact projection removal is an adaptation of a denoising technique described in: 
M. Samonas, M. Petrou and A. Ioannides, “Identification and Elimination of Cardiac Contribution in 
Single-Trial Magnetoencephalographic Signals,” IEEE Trans. Biomed. Eng., vol. 44, no. 5, pp. 386-393, 
1997. 

IMPORTANT Artifact Projection Removal requires an MRI triggering signal or artifact onset events to locate 
artifact positions. 

Median Filter Artifact Removal 
Median Filter Artifact Removal provides a basic artifact removal suitable for slow moving signals such as 
respiration, GSR, or temperature. It performs a windowed median transformation on the source channel with a 
window width of 1/10th of the acquisition sampling rate. 
This median filtering approach is explained in the BIOPAC MRI application note AH223. 
Median Filter Artifact Removal does not require an MRI triggering signal. 

Signal Blanking 
MRI artifact can grossly distort low level physiological signals, and this distortion can be several orders of 
magnitude larger than the signal of interest. A common practice for analyzing the physiological data is to 
discard the MRI artifacts and only examine the portions of the signal in between the MRI artifacts. One 
approach for this is outlined in BIOPAC MRI application note AH223. 
Signal Blanking provides an alternate approach for discarding MRI artifacts from the signal. Using the MRI 
triggering signal or artifact event locations, this analysis option will locate the periods of MRI activity and 
“blank” the physiological signal during this period. 
Two types of “blanking” can be performed: 

• Set value to zero – The waveform is set to zero during each artifact. 
• For integrated measures, zeroing the signal may be preferable as it will have no effect on the 

running sum. 
• Connect endpoints – For each artifact, a selection is made and the values within the interval are replaced 

with a line connecting the signal value before the MRI artifact to the signal value at the end of the 
interval. 

• For statistical measures or DC coupled signals, connect endpoint (linear interpolation within the 
interval) may be preferable to avoid causing the output to trend towards zero. 

IMPORTANT Signal Blanking requires an MRI triggering signal or artifact onset events to locate artifact 
positions. 

Neurophysiology 
The Neurophysiology analysis package assists in the analysis of spikes within extracellular microelectrode 
recordings, such as those recorded using an MCE100C module. All of these analysis options require a continuous 
recorded single channel of microelectrode data. 

• A spike is a deviation from the baseline caused by a neuron action potential. Frequently extracellular spikes 
will resemble exponentials. The point of maximum value of the spike will be used to locate neuron firing. 

• A spike episode consists of a fixed time window around a spike that aims to capture the underlying neuron 
firing time. The episode consists both of the rise time (the time taken to reach maximum) and the relaxation 
period around the spike. 

 

Amplitude Histograms 
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IMPORTANT To run this analysis option, the signal must first be transformed by the Locate Spike Episodes 
option or the Classify Spikes option. 

Amplitude histograms show the population density of the maximum amplitude of neuron firing events. They may 
be used to interpret changes in neuron firing due to drug response or as rough indicators of the approximate 
number of classes of action potentials in a signal. Amplitude histograms can be generated on classified or 
unclassified signals. 

• On classified signals, an overall amplitude histogram will be created for all of the spikes in addition to a 
single amplitude histogram per class (reflecting only the episodes of that class. 

• On unclassified signals, a single amplitude histogram will be created from the maximum voltage within all 
of the spike episodes. 

Average Action Potentials 

 
IMPORTANT To run this analysis option, the signal must first be transformed by the Locate Spike Episodes 

option or the Classify Spikes option. 
After a classification has been completed for a spike signal, to assign spike episodes to different groups, users 
may wish to view the average shape of the waveforms of each class. Examining the shape of the different 
classes provides visual feedback as to the efficiency of the clustering, can allow for identification of certain 
classes as noise or artifacts, and helps to determine if the identified classes are indeed unique. Average Action 
Potentials can be generated on classified or unclassified signals. 
• On classified signals, the resulting ensemble averages will have multiple channels. 

o The first channel will be the overall average of all of the spike episodes. 
o The remaining channels show the average of the members of each individual spike class. 

• On unclassified signals, a graph will be produced with a single channel showing the average of all of the 
spike episodes. 
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Classify Spikes 

  
This analysis option will automatically classify action potentials in microelectrode data and divide them into 
different spike classes. 
A single-feature k-means clustering classifier is used, and the entire data set is used for the clustering portion 
of the algorithm. The determining feature is the Sum criteria— that is, the sum of all of the data points within 
the waveform segment; this was one of the first features used in early action potential classifiers. 
If the Locate Spike Episodes option has not been used to find spikes before this option was selected, the 
Locate Spike Episodes option will be automatically performed prior to the clustering. 
The analysis routine will ask for a number of spike classes and then use k-means clustering to group each 
spike episode into a class. The clustering may not produce meaningful classes, so results should be examined 
for accuracy. 
This style of classifier is for rudimentary spike analysis. For more advanced classification techniques, use the 
clustering algorithm in the peak detector. 

Dwell Time Histograms 

   
 
IMPORTANT To run this analysis option, the signal must first be transformed by the Locate Spike 

Episodes option or the Classify Spikes option. 
A dwell time histogram shows the population density of the duration of a neuron firing event. Dwell times 
can be approximated for an action potential by measuring the absolute value of the time interval between their 
maximum and minimum voltage levels reached during the firing of the neuron. After the minimum value in 
the firing recording has occurred, the neuron will be returning to its resting state, so the time difference is a 
good approximation for the firing duration. The dwell time histogram plots this time difference versus number 
of action potentials that have similar time differences. Examining varieties in dwell times can help to illustrate 
drug responses or to perform rudimentary classification of action potentials. 
Dwell times will be defined as the time difference between the positions of the maximum signal value and 
minimum signal value within a spike episode. Since dwell time histograms can be used for classification 
purposes, they can be run on classified or unclassified microelectrode signals. 

• On classified signals, an overall dwell time histogram will be constructed for all of the spikes in addition 
to a single histogram per class, showing times of only the spikes in that class. 

• On unclassified signals, a single dwell time histogram will be created for all of the spikes. When run on a 
classified signal. 

Find Overlapping Spike Episodes 
IMPORTANT To run this analysis option, the signal must first be transformed by the Locate Spike Episodes 

option or the Classify Spikes option. 

IMPORTANT If cluster events from a 
previous spike classification 
are already defined on the 
recorded waveform, this 
option will erase them and 
replace them with the new 
classification of the potentials.
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In many extracellular recordings, it is frequent for there to be more than one neuron firing in response to the 
same stimulus. This can result in overlapping spike episodes when both neurons fire in close succession. 
Some types of analysis and spike classification are not able to produce meaningful results if too many 
overlapping episodes occur. “Find Overlapping Spike Episodes” can be used to locate overlapping episodes. 
After the spikes have been located in a signal, this option can be used to iterate only to those that are 
overlapping.  
“Next Overlap” and “Cancel” buttons are available in the toolbar of the graph window to allow for iteration 
through the episodes. 
Note This option is “view only.” Overlapping episodes are not affected by the analysis and will need to be 

manually removed manually to delete them from the file. 
Generate Spike Trains 

 
IMPORTANT To run this analysis option, the signal must first be transformed by the Locate Spike Episodes 

option or the Classify Spikes option. 
Spike trains are good visual indicators of when action potentials are firing and are good synchronization 
waves for further analysis and data reduction. A spike train is a channel in a graph whose value is 0 if no 
spike is firing and 1 if a spike is firing. 
Spike train generation will operate only on signals whose action potentials have already been classified.  
A single spike train will be generated as a channel in the graph for each class of action potential in the signal. 
If text output is enabled, the spike trains will be pasted as tables in the journal with one table per spike class. 
If spreadsheet output is enabled, the tables will be placed side by side so index 1 of the tables lines up for each 
action potential. 

Locate Spike Episodes 
Neurophysiology > Locate Spike Episodes  
 

  
 
This option provides the basic spike detection for a microelectrode signal. Spike detection is performed using 
the following steps: 
1. Obtain mean value of the entire signal. 
2. Obtain standard deviation of the entire signal. 
3. Detect spikes where the signal rises above a fixed threshold determined by adding a multiple of the 

standard deviation to the mean. 
4. Position the episode around the threshold crossings according to the width and offset entered previously. 
A “Spike Episode Begin” event will be placed at the start of each spike episode and will be located offset 
milliseconds away from the threshold crossing. A “Spike Episode End” event will be placed at the end of each 
episode. 
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If text output is enabled, a table of the start time of each episode will be placed in the graph’s journal. 
If spreadsheet output is enabled, a new spreadsheet will be created with the start time of each episode. 
Spike episodes may also be located manually by using the Cycle Detector to define “spike episode begin” and 
“spike episode end” events in the graph. 

Set Episode Width & Offset 

   
The first time spike detection is performed on a graph, the episode width and offset need to be entered. This 
width and offset is remembered and is used for all future spike detections in the graph performed by “Locate 
Spike Episodes” and other transformations. The width and offset that are entered are retained even if the file 
is saved and reopened. 
Use this option to view or change the current width and offset. 

Preferences 

    
 

  
 

Preference Description Default 
Setting 

Output type Determines whether analysis results will be displayed as graph 
channels, textual tables in the journal, or Excel spreadsheets. Not all of 
the output types are applicable for each Neurophysiology analysis 
option. 

Text output to 
journal only. 
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Preference Description Default 
Setting 

Mac 
AcqKnowledge 
3.9.2 and later—
Spike Location 
Method 

Choose how spikes are searched for in the signal.  
Mean + Stddev—uses fixed level peak detection with a level that is 
computed from the mean value plus a configurable number of standard 
deviations of the data.  
Amplitude/Half-width Discriminator—allows for basic isolation of 
spike shapes that have peak voltages within a configurable range and 
spike half-widths within a configurable range; uses the amplitude of 
the spike as well as the width of the spike to determine what 
constitutes a valid spike event. 
Half-width For a given spike, the discriminator searches from the 

maximum value of the spike to both the left and right 
of the maximum for the sample positions where the 
value has dropped below 50% of the maximum. The 
time interval between these sample positions is 
defined as the estimate of the half width. The 
acquisition sampling rate can be increased to improve 
accuracy of the spike half width estimates as neuron 
firing events involve high frequency components. 

 
Each time the discriminator is run, the user must input the 
amplitude low and high values as well as the minimum and 
maximum spike width. The discriminator searches for spikes in a 
signal x as follows: 

1. Performs regular peak detection on x using a fixed 
threshold alow. This locates the local maxima occurring after 
each threshold crossing of the low amplitude area. This 
results in a sequence p of potential spike locations. 

2. Computes the half-width time interval for each potential 
spike location p. 

3. Accepts the spike for each potential spike location p as a 
valid spike s if, where a is amplitude and t is time window: 

 
4. For each valid spike location s, positions the spike episode 

start output at s+offset and the spike episode end output at 
s+offset+width . 

The spike discriminator generates output only for spikes that fall 
within the bounds of the amplitude and offset windows. If a spike 
candidate falls outside the windows, no output is generated. 

Mean + 
Stddev 

Spike Detection 
Level 

Spikes are located in the signal by looking for locations where the signal 
deviates from its baseline by a certain number of standard deviations. 
This multiplier is set in this preference. 

4 standard 
deviations 

Default Episode 
Width 

The first time that any of the spike detection is run on a graph, the width 
of each fixed width episode must be specified. This preference provides 
the default value that is seeded in the dialog. 
The episode width for an individual graph does not need to match this 
default. 

10 
milliseconds 
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Preference Description Default 
Setting 

Default Episode 
Offset 

Each fixed width episode is located around one of the spikes in the 
signal. The offset allows for the episode to begin before (or after) the 
spike threshold crossing so the leading edge of the spike can be 
captured. 
Negative numbers indicate episodes are to start before the spike 
threshold crossing, positive numbers indicate episodes that start after. 

-2 
milliseconds 

Default Number 
of Spike Classes 

The Classify Spikes script requires the user to input the number of 
classes into which the spikes will be partitioned. This preference allows 
the default number to be modified. 
The number of classes that wind up being used does not need to match 
this default. 2

 
Principal Component Denoising 

  
Removes noise from certain types of signals. For principal component denoising to be effective, more than 
two signals should be used as sources and all source channels must have identical waveform sampling rates. 
PCA denoising is most effective on signals that are known to contain a high degree of similarity, such as 
multiple ECG leads or multiple EEG leads. PCA denoising should not be used on signals of different types or 
units as all of the principal components may be needed to fully capture the differences in the signals. 

 To determine if PCA denoising will be effective on a particular set of data or to compute a appropriate 
variance percentage for denoising, examine the principal components directly with “Transform > 
Principal Component Analysis” before selecting this option. 

Given a set of signals, a principal component analysis is performed. The strengths of the components are then 
analyzed, and the original signals are reconstructed from a subset of the principal components that capture a 
certain percentage of the total variance of the signals. This essentially eliminates one or more of the higher-
order principal components. For certain types of signals, these principal components are the ones that model 
the noise inherent in the signals. 
1. Check the “Denoise” column for the channels to be denoised. 
2. Enter the overall percentage of the variance. 
3. After the percentage is entered, the denoising process will begin. 
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Remove Trend 
Helps to remove baseline drift or other linear trends from data. This tool makes it easier to apply trend 
removal to only specific segments of a waveform. Given a selected segment of data, or an entire waveform, it 
computes the trend between the two endpoints (similar to the Slope measurement), and then removes this 
trend from the selected area such that the endpoints of the selection lie at the same voltage. 
Select which endpoint will remain fixed: 
 Left keeps the starting point of the selection fixed at the same voltage. The software adjusts the data from 

left to right such that the right endpoint is aligned with the initial starting voltage. 
 Right keeps the ending point of the selection fixed at the same voltage. The software adjusts the data from 

right to left such that the left endpoint is aligned with the initial ending voltage. 
Respiration 

 
The respiration analysis package helps to analyze respiration- and airflow-related data. Other tools exist for 
respiration related analysis including AcqKnowledge transformations and the Respiratory Sinus Arrhythmia 
analysis in the Hemodynamics analysis package. 

Compliance & Resistance 

      
 

          
The Compliance & Resistance analysis follows the flow conventions of the recommended BIOPAC 
connections for a TSD107 pneumotach or a TSD117 airflow transducer. Positive flow is assumed to indicate 
inhalation; negative flow is assumed to indicate exhalation. 
The Compliance & Resistance analysis can be used to extract pulmonary resistance and pulmonary 
compliance in addition to basic airflow measures. This analysis requires an airflow signal and a pressure 
signal. The analysis will extract all of the measures of the Pulmonary Airflow analysis for the airflow signal. 
It also will locate apnea periods after exhalation using the same user-configurable threshold method as the 
Pulmonary Airflow analysis. 
Pulmonary resistance is computed using the isovolumetric method. On both sides of the tidal volume peak for 
a breath, the position where the volume reaches a user-specified percentage of the tidal volume is located. The 
pulmonary resistance is defined as the difference in pressure divided by the difference in flow at these two 
isovolumetric positions. Due to the discrete nature of sampled data, these points may not be exactly equal in 
volume. To improve the accuracy of the isovolumetric method, increase the sampling rate used to acquire 
data. 
Dynamic pulmonary compliance is extracted on a breath-by-breath basis by dividing the tidal volume by the 
change in pressure between the exhale start and inhale start locations of the breath. 
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Individual breaths are defined as the period between consecutive Inhale Start events. Airflow units are 
assumed to be the standard liters/sec and pressure units mmHg. For each breath period, the analysis will 
define the following events: 

• Inhale Start event on flow signal at start of inhale 
• Exhale Start event on flow signal at start of exhale 
• Apnea Start event on flow signal at beginning of apnea period (if present) 
• Recovery events on volume signal at isovolumetric positions to left and right of tidal volume peak 

If Inhale Start and Exhale Start events are already present on the flow signal at the start of analysis, those 
events will be used to define the breath periods. Apnea Start and Recovery events will always be regenerated 
by the analysis. 
The analysis will extract the following measures from the data: 

 
Name Abbrev. Description Units 

Cycle  Index of the breath in the data, beginning 
at 1. 

 

Time  Starting time of the inhale of the breath. seconds 

Peak Inspiratory Flow PIF Maximum absolute flow occurring 
during the inhale portion of the breath. 

liters/sec 

Peak Expiratory Flow PEF Maximum absolute flow occurring 
during the exhale portion of the breath. 

liters/sec 

Tidal volume TV Total volume of air inhaled during the 
breath. 

liters 

Minute volume MV Volume of air that would be inspired 
during a minute given the tidal volume 
and breathing rate of this breath. 

TV * BPM 

liters/ 
minute 

Breaths per minute BPM Breathing rate. 

60
TT  

BPM 

Inspiration time IT Time interval between the start of inhale 
and the start of exhale. 

seconds 

Exhalation time ET Time interval between the start of exhale 
and either: 

● start of apnea (if apnea present) 

● start of subsequent breath (if no 
apnea present) 

 

seconds 

Total breath time TT Time interval between the start of inhale 
and the start of inhale of the following 
breath. This is the sum of the inhalation 
time, exhalation time, and apnea time. 

seconds 

Apnea time AT Time after end of exhalation where the 
airflow signal remained within the apnea 
threshold defined at the start of the 
analysis. 

seconds 
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Name Abbrev. Description Units 

Pulmonary resistance RES Change in pressure divided by change in 
flow at the isometric volume locations: 

 

mmHg/ 
(liters/ 
sec) 

Pulmonary compliance Cdyn Tidal volume divided by the change in 
pressure between exhale and inhale 
locations in the breath: 

 

liters/ 
mmHg 

 
If text output is being generated, an additional row will be added containing the average values of the 
measures. Time and count are not output as waveforms in the graph since they can be found in the horizontal 
axis. 

Penh Analysis 
Penh Analysis script assumes standard recording methodology for a full body plethysmograph. Positive flow 
is treated as exhalation and negative flow is treated as inhalation. 
Penh Analysis extracts measures from data recorded in a full body plethysmograph. It operates on a single 
channel of data recorded from an airflow transducer connected to the plethysmograph. The analysis takes a 
single parameter: the Rt percentage. This percentage is used to locate the plateau, or “pause,” in the airflow 
signal. The pause begins at the time when the Rt percentage of the exhalation volume has been reached. The 
Rt percentage may be adjusted by the user and is set to a default of 65%. This analysis will place Inhale Start 
and Exhale Start events on the airflow signal. If these events are already present when the analysis starts, the 
user-defined inhale and exhale events will be used. This allows for the analysis to be repeated after manual 
inspection and correction of inhale and exhale locations and allows for different methods to be used to define 
the breathing boundaries. 
Penh analysis will place Recovery events on the airflow channel at the time positions where the 
corresponding percentage of the volume has been exhaled. The percentage used for the analysis is displayed 
in the label of the Recovery events. 
For each exhalation period, the Penh Analysis will extract the following: 

 
Name Abbrev. Description Units 

Cycle  Index of the exhalation cycle in the 
data, beginning at 1. 

 

Time  Starting time of the exhale for the 
cycle. 

This is the location of the Exhale 
Start event. 

Seconds 

Peak inspiratory flow PIF Maximum absolute airflow 
occurring in the inspiration cycle 
immediately preceding the 
exhalation cycle. 

This measure is recorded as an 
interval, so its value is always 
positive. 

Airflow 
channel units 

Peak expiratory flow PEF Maximum airflow during the 
exhalation cycle being examined. 

Airflow 
channel units 
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Name Abbrev. Description Units 

Exhalation time Te Total time elapsed between the start 
of the exhalation cycle and the end. 

This is the time interval between the 
Exhale Start and following Inhale 
Start events. 

Seconds 

Relaxation time interval Rt Time required for the subject to 
exhale the specified percentage of 
the total exhaled air. 

This is the time interval between the 
Exhale Start and the subsequent 
Recovery event. 

Seconds 

Pause  Numerical factor describing the 
characteristics of the plateau at the 
end of the expiration cycle. 
Computed using the formula: 

Te
Rt
− 1  

 

Enhanced pause Penh Pause scaled to be relative to the 
strength of the inhale and exhale.  
This helps take breathing variability 
into account.  Computed using the 
following formula: 

 

 

 
The Penh analysis excludes the following exhale cycles from the analysis: 

• Exhale cycles that do not have a preceding inhale (may occur for partial cycles at the start of the data 
recording). 

• Exhale cycles that do not have a corresponding recovery time (often occurs during apnea). 
In addition, during periods of apnea, the analysis may produce invalid results, such as zero width recovery 
times. These results may be excluded from the analysis by either using waveform editing to remove apnea 
periods, discarding all events during apnea periods and rerunning the analysis, or deleting the corresponding 
rows from the Excel output. 

Pulmonary Airflow  
The Pulmonary Airflow analysis follows the flow conventions of the recommended BIOPAC connections for 
a TSD107 pneumotach or a TSD117 airflow transducer. Positive flow is assumed to indicate inhalation; 
negative flow is assumed to indicate exhalation. 
The Pulmonary Airflow analysis extracts basic parameters from a calibrated airflow signal, such as would be 
recorded using a pneumotach or airflow transducer. In addition to inspiration and expiration, Pulmonary 
Airflow also can be used to examine apnea. Apnea is defined in this analysis as pauses in breathing that occur 
after an exhalation. 
When performing the analysis, an airflow signal ƒ is chosen. An apnea threshold  fa is also entered. 

Inhalation is defined to begin at the point where . Exhalation is defined to begin at the point where 
. Apnea is defined to be the period between exhalation and inhalation where the flow lies within the 

apnea threshold: . At least two consecutive samples must occur within the apnea threshold for a 
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period of apnea to be defined. This allows for valid transitions from exhalation to inhalation to occur even if 
one of the samples in the transition happens to fall within the apnea threshold due to sampling. 
The Pulmonary Airflow analysis will generate a tidal volume waveform if it is not present in the graph. It also 
will add Inspire Start and Expire Start events on the airflow signal if they are not present. New Apnea Start 
events will be defined each time the analysis is performed. 
Individual breaths are defined as the period between consecutive Inhale Start events. Airflow units are 
assumed to be the standard liters/sec.  
For each breath period, the analysis will extract the following: 

 
Name Abbrev. Description Units 

Cycle  Index of the breath in 
the data, beginning at 1.

 

Time  Starting time of the 
inhale of the breath. 

seconds 

Peak Inspiratory Flow PIF Maximum absolute 
flow occurring during 
the inhale portion of the 
breath. 

liters / sec 

Peak Expiratory Flow PEF Maximum absolute 
flow occurring during 
the exhale portion of 
the breath. 

liters / sec 

Tidal volume TV Total volume of air 
inhaled during the 
breath. 

liters 

Minute volume MV Volume of air that 
would be inspired 
during a minute given 
the tidal volume and 
breathing rate of this 
breath. 
TV �BPM  

liters / minute 

Breaths per minute BPM Breathing rate for the 
breath. 

60
TT  

BPM 

Inspiration time IT Time interval between 
the start of inhale and 
the start of exhale in the 
breath. 

seconds 
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Name Abbrev. Description Units 

Exhalation time ET Time interval between 
the start of exhale and 
either: 

● start of apnea (if 
apnea present) 

● start of 
subsequent breath 
(if no apnea 
present) 

seconds 

Total breath time TT Time interval between 
the start of inhale and 
the start of inhale of the 
following breath. This 
is the sum of the 
inhalation time, 
exhalation time, and 
apnea time. 

seconds 

Apnea time AT Time after end of 
exhalation where the 
airflow signal remained 
within the apnea 
threshold defined at the 
start of the analysis. 

seconds 

If text output is being generated, an additional row will be added containing the average values of the 
measures. Time and count are not output as waveforms in the graph as they can be found from the horizontal 
axis. 

Preferences 

 
 
Spectral Subtraction 
Spectral subtraction is a denoising technique that operates on data projected into the frequency domain. It is 
frequently used in speech analysis denoising applications. Spectral subtraction examines a reference noise signal 
and performs a Fourier transform to get the noise frequency distribution. To denoise a signal, the Foruier 
transform of the signal is performed. The noise estimate frequency distribution is then subtracted from the source 
signal. The resulting processed spectrum with the noise frequencies removed is then reconstructed into a time 
domain signal using the inverse Fourier transform. 
Spectral subtraction performs noise removal on the entire channel in a single Fourier transformation, which 
allows for denoising where the noise is stationary; there is no provision for sliding window spectral subtraction at 
this time. 
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The spectral subtraction is performed using a formula with two adjustable parameters. Given a frequency 
spectrum Fnoise and a mixed signal Fmix, the denoised frequency spectrum is computed using the following 
formula: 

 
where 

Alpha is the “scaling factor” and can be used to adjust the strength of the noise estimate. 
Gamma is the “power factor” and can be used to vary how the noise is removed. Gamma = 1 allows for 
pure subtraction, Gamma = 2 allows for Euclidean distance formulas, and so on. 
Any Fdenoise that is less than zero is discarded and replaced by zero to maintain a valid set of Fourier 
coefficients for the reconstruction. 

When spectral subtraction is being used in practice, the noise signal may not always match the length of the 
signals to be denoised. To define the subtraction formula, the spectrum of the noise must have the same number of 
points as the spectrum to be denoised. If there is a length mismatch, the noise spectrum is resampled 
automatically to match the length of the spectrum to be denoised. Cubic spline interpolation is used during the 
resampling to provide a better estimate of the overall noise spectrum. 
Stim-Response 

 
The Stim-Response analysis package can aid in analysis of stimulus-response studies. It allows for measurements 
to be extracted in tabular format for multiple stimulus classes. 

Note: Excel spreadsheet generation is only supported with AcqKnowledge 3.9.1 and higher. 
Digital Input to Stim Events 

 
Several stimuli delivery applications can either trigger stimulus through TTL level signals or emit synchronized 
TTL pulses with stimulus delivery. Examples of such software applications include SuperLab and the Inquisit 
programming environment. 
This analysis option converts TTL data acquired on the digital channels of an MP device into stimulus events. 
Stimulus delivery events are defined in the graph for each low to high transition of the digital data, the indications 
of stimulus delivery. The digital channels are interpreted as a binary number. Each stimulus event placed into the 
graph has the corresponding number included with its label. This allows further analysis to distinguish between 
different type of stimulus events by using the Cycle Detector’s label matching capability. 
Digital line decoding can be two byte (using all 16 digital lines) or single byte (on either the low eight or high 
eight digital lines). Big endian bit and byte ordering are used, with digital line 0 representing the least significant 
bit. 
When the stimulus labels are constructed, all numbers are zero-prefixed. All stimulus events will have the same 
number of base-10 digits with leading zeros, regardless of magnitude. This provides each stimulus event type with 
a unique label that can be used with the Cycle Detector (which uses substring matching). 
Some systems that trigger digital lines such as parallel ports may not be able to do so instantaneously; they may 
require a time window before the transition from one state to another is fully complete. A “transition latency” 
time window can be given to the analysis. If non zero, any transitions that are separated by less than this latency 
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are treated as a single transition and only one stimulus event is inserted. The decoded value used for the transition 
is the maximum value observed during the transition latency window. 
Stim-Response Analysis 
Stim-Response Analysis allows for extraction of measurements within fixed width intervals occurring at Stimulus 
Delivery events. The Stimulus Delivery events may be defined either manually, with the Cycle Detector, or using 
the Digital Input to Stim Events analysis option. The information that can be extracted includes the majority of the 
measurements available from the graph window measurement toolbar, matching the Epoch Analysis analysis 
options. 
Unlike Epoch Analysis, the Stim-Response Analysis splits the analysis based upon the event labels. Stimulus 
Delivery events with different labels are interpreted as different stimulus types. Analysis results for each 
individual stimulus type are summarized in separate tables. Each independent text table has its own average of the 
measurements over that stimulus type. 
Additional options are available for positioning the fixed width interval where measurements should be made: 

• At each stimulus event – The measurement interval is aligned so the start of the measurement matches the 
time of the Stimulus Delivery event. 

• At fixed interval offset before or after stimulus – The measurement interval begins a fixed amount of time 
either before (for pre-stim studies) or after the time of the Stimulus Delivery event. This allows measurements 
to be made at a time relative to each stimulus onset and may be useful for measurements focusing on a 
specific time range (e.g. P300). 

• At matching response event – This option assumes that a second set of Response events have been defined for 
each stimulus either manually or using the Cycle Detector. Each Stimulus Delivery event is paired with the 
closest Response event occurring after it. The fixed width measurement interval is aligned so the start of the 
measurement window is the time of this matching Response event. 

• To use the “at matching response event” window positioning option, Response events must be defined in 
the graph. Response events are in the “Stimulus/Response” event submenu. These events are not defined 
automatically. 

• Response events can be inserted manually into the graph using the Event tool. 
• Response events can be inserted using the event output of a data-driven Cycle Detector analysis. 

Note If EDA/SCR signals are being analyzed in response to stimulus delivery, also examine the “Event-related 
EDA Analysis” transformation loctated under Specialized Analysis > Electrodermal Activity. 

Waterfall Plot 
Assists in configuring the Peak Detector for 3D surface generation. These surfaces showing cycle-by-cycle 
data of the graph are commonly known as waterfall plots. Cycles are located in the graph using the same 
sequence of steps as the Ensemble Average transformation script. Instead of generating the averaged graph, 
however, a number of 3D surfaces are generated. One surface is generated for each channel that is selected by 
the user. 

Wavelet Denoising 

 

Sample output  
Wavelet Denoising applied to heart 
sounds data may help clarify S1 and 
S2, as shown: 

Wavelet Denoising uses the forward and reverse wavelet transformations to project source data into the 
wavelet domain, modify the wavelet coefficients (called “shrinking” the coefficients), and then reconstruct the 
data from the modified coefficients. Wavelet Denoising allows for noise to be removed from a signal while 
minimizing effects on portions of the signal that strongly adhere to a wavelet’s shape. 
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To perform wavelet denoising: 
1. Choose the wavelet type to use for the denoising. 

Certain signals may work best with different wavelet types. 

   
2. Enter the number of iterations to use in the wavelet decomposition. 

Different numbers of iterations will have different effects on the results. 
3. Choose which type of thresholding should be used to shrink the wavelet coefficients. 

 Hard thresholding replaces coefficients below the threshold with zero while leaving all other 
coefficients unmodified. 

 Soft thresholding zeroes out coefficients below the threshold and subtracts the threshold for coefficients 
that are above it. 

Soft thresholding may be useful for reducing edge effects, but hard thresholding will affect amplitudes 
less. 

  
4. Choose the threshold level to use for shrinkage. 

 Fixed threshold for all levels. If you choose a fixed threshold, an additional window will appear into 
which you can type your threshold. 

 Adaptive threshold level based on the number of coefficients in the DWT iteration (a VIS shrink 
procedure). 

 
ECG Analysis Algorithm References 
AcqKnowledge 3.9 software implements the open source ecgpuwave H15HECG boundary locationH software and the 
open source H16HOSEA QRS detectorH and beat classification library for ECG analysis. 
Automated ECG Waveform Boundary Location 

 ecgpuwave ECG boundary location software 
AcqKnowledge 3.9 software incorporates the ecgpuwave ECG boundary location software. Ecgpuwave is 
an implementation of a waveform boundary detection algorithm primarily developed by Pablo Laguna at 
the University of Zaragoza in Spain. This algorithm incorporates a variant of the Tompkins QRS detector, 
but contains additional rules that allow it to automatically extract the following characteristics of an ECG 
signal on a cycle by cycle basis: onset of P, P peak, end of P, onset of QRS, peak of QRS, end of QRS, 
onset of T, peak of T, and end of T. 
The algorithm is tuned to human ECGs through comparison with manual classification. Particularly, it 
seems to be within the standard deviation of human examiners for the onset and end of T waves, a 
particularly difficult feature to extract from an ECG complex. It also has the ability to take multiple ECG 
leads into account to reduce errors and misclassifications and appears to function for one to twelve lead 
ECGs. The algorithm is well documented in a number of papers. This algorithm development was 
sponsored by several government agencies including CICYT in Spain and the NIH. 
The ecgpuwave tool is distributed from the PhysioNet NIH servers ( H17Hhttp://www.physionet.orgH). This is a 
tool written in Fortran that will read WFDB formatted files. It will then output a series of annotations in 
WFDB format indicating the locations of the various ECG complexes within each cycle. It also depends 
on another tool, sortann (available from PhysioNet), to perform post-processing. This software reads and 
writes PhysioBank formatted files. This tool is only available on OS X. 
AcqKnowledge can automate the process of running ecgpuwave on source data and import its output back 
into AcqKnowledge. To run ecgpuwave on an ECG signal from within AcqKnowledge, first make the 
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ECG channel the active channel and then choose Transform > Specialized Analysis > Locate ECG 
Complex Boundaries. AcqKnowledge will execute ecgpuwave on that signal and read in its waveform 
boundary location output, placing events on the channel. You will only be able to see this output if you 
have events shown. 
Alternatively, you can save your file to PhysioBank format, run ecgpuwave manually from a Terminal, 
save the annotations to “atruth” and then reopen that PhysioBank file to see the ecgpuwave results; this is 
the same process that AcqKnowledge performs. 
Source code for ecgpuwave detector is released under a H18HGPL licenseH and can be found on the 
AcqKnowledge CD. 
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OSEA QRS Detector 
 OSEA QRS detector and beat classification library 

AcqKnowledge 3.9 software incorporates the open source OSEA QRS detector and beat classification 
library. 
The OSEA library is a set of routines provided by EP Limited (H19Hhttp://www.eplimited.comH). This C++ 
based software library provides robust QRS complex detection and rudimentary beat classification. This 
library is well documented and tested. The QRS detector uses a standard Tompkins-based filtering and 
derivative detection algorithm and has been in development for about 15 years; the beat classifier has 
been developed for about a year or two. This algorithm development is sponsored by the NIH. 
This algorithm is fairly robust against arrhythmias, baseline drifts, discontinuities, and other artifacts in 
the ECG signal. It achieves a 90% success rate on identifying QRS complexes on sample arrhythmia 
databases. The algorithm is tuned to human ECGs. 
The QRS detector is optimized for 200 Hz sampled data. If the sampling rate is lower or higher, data will 
be internally resampled to 200 Hz before processing. The sampling rate difference may result in slightly 
different placement of beat events for different sampling rates. 
QRS detection can be performed by selecting the desired channel of ECG data and choosing Transform > 
Specialized Analysis > Detect and classify beats. AcqKnowledge will execute the OSEA beat detector on 
the source data and output a sequence of events on that channel of ECG data. You will only be able to see 
this output if you have events shown. 
Source code for the QRS detector is released under an H20HLGPL licenseH and can be found on the 
AcqKnowledge CD. 

 
Open Source Licensing 

The ecgpuwave and OSEA algorithms are available as open source, which means that their source code is 
publicly available. The source code can only be used, however, under conditions of their licenses. 

 ecgpuwave is under the GPL license 
 OSEA is under the LGPL license 

For the full text of both licenses, visit the Free Software Foundation (H21Hhttp://www.fsf.org H). 
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A Note About Specialized Analysis for Windows/PC Users 

 

 
You can unlock powerful analysis tools & automation with 

Specialized Analysis 
for AcqKnowledge data files 

 
Analyze data collected on MP Systems 
running on Windows/PC or Mac OS X 

Analyze AcqKnowledge data files collected on MP Systems running on Windows/PC or Mac OS X. These 
powerful, comprehensive analysis tools automate analysis to save hours (or days!) of processing time and 
standardize interpretation of results. If you need still more analysis options, save the data as MatLab, Igor Pro, 
PhysioNet, raw, or text format—or compress the file to reduce file size by about 60%. 
For a fraction of the cost, you’ll have extensive post-acquisition analysis options similar to modules from 
Mindware Technologies, PONEMAH Physiology Platform, EMKA Technologies, SA and other advanced analysis 
applications. The Specialized Analysis package is detailed on page X608H333X. 

 

  
Mac PC/Windows 

The Specialized Analysis features work with files generated by AcqKnowledge on a PC running Windows or on a 
Mac. While the data is portable, AcqKnowledge for Windows includes only limited Specialized Analysis tools, so 
you must use the Mac software to benefit from the full range of Specialized Analysis tools. Mac computers are 
network compatible and Ethernet ready, so it’s easy to add one to an existing setup and take advantage of these 
powerful tools. If you’re ready to add Specialized Analysis to your AcqKnowledge analysis options, please contact 
BIOPAC to discuss the possibilities and benefits of this Mac-based solution—or H22Hlet us know you’re interested H and 
we’ll contact you. 

 To learn more about Macintosh and Mac OS 10.3 or higher, visit the H23HApple Store for EducationH or H24HApple® 
web storeH. 

H25HReturn to Specialized Analysis OverviewH 
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Appendix H – Network Data Transfer 

Network Data Transfer allows users to access the data being acquired into a graph by AcqKnowledge in an 
external application. 

The hardware API was developed to allow customers writing custom applications to control an MP unit directly 
and obtain data during acquisitions. Using the hardware API requires the application developer to perform 
appropriate configuration of the MP unit and its channels, visual graphing and data plotting, data analysis (e.g. 
filtering, beat detection), and persistent data storage within their application. 

Some developers do not wish to undertake these additional responsibilities in their own application and prefer the 
ease of configuration provided by the AcqKnowledge graphical interface. Some development environments may 
also not provide enough facilities for performing all of these tasks. 

For these types of situations, integration with the existing AcqKnowledge environment may be preferred over the 
more low-level hardware API. 

Objectives 

• To develop a basic method for allowing third party applications to tap into the data stream being 
generated by both the MP unit and AcqKnowledge during data acquisitions. 

• To provide networking facilities that allow for integration into a distributed application environment. 

• To provide basic control facilities to allow external applications to query and control the AcqKnowledge 
application state. 

Overview 

The real-time data transfer system is split into two types of connections: 

Data connections deliver data from AcqKnowledge to external applications during acquisitions. 

Control connections are made from external applications to AcqKnowledge to query application state and 
adjust data connections. 

The server refers to the AcqKnowledge process and the computer on which it is running. The client refers to the 
custom application that is to receive data from AcqKnowledge and the computer on which it is running. Note that 
the computer used to run the AcqKnowledge process and the custom application may be the same computer. 

All connections will be made using standard network protocols, either TCP or UDP. Single system image 
architectures should make connections using the loopback interface. It will be assumed that network 
implementations will have appropriate IP networks in place with routing between machines that can be identified 
either by IP address or by hostname. Firewalls must be properly configured to allow network communications 
between the client and server. Appropriate network configuration is beyond the scope of this document and 
BIOPAC Systems, Inc. 

Data Connections 

Data connections are used to deliver data from the AcqKnowledge server to the client application. Data 
connections stream both data acquired from an MP unit and computed data from AcqKnowledge calculation 
channels. Data connections are available in a variety of formats and can be configured to meet the needs of the 
client application and bandwidth requirements. 

Data connections are created only at the start of acquisitions. It is not possible to “attach” to data acquisitions that 
are already in progress. 

XML-RPC calls for retrieving data are also described in this section. These connections are not persistent and not 
established from server to client, but rather a request made from client to server. The recommended mode of 
operation is regular TCP or UDP operation. 
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Variable Sampling Rates 

AcqKnowledge uses variable sampling rates that allow different channels of data to be acquired at different 
sample rates. This allows fast moving signals (such as EMG) to be acquired at high sampling rates while 
simultaneously recording slow moving signals (such as respiration) at lower sampling rates. 

The primary use of variable sampling rate is to optimize storage requirements by minimizing space spent 
retaining slow moving data. In addition to the storage optimizations, variable sampling rates are also used to 
optimize data connections. Channels that are sampled at lower rates require less network bandwidth to transfer 
from client to server. If channels of data cannot be disabled and overall bandwidth is limited, variable sampling 
rate can be used to lower the bandwidth required to move data between the server and the client. 

The use of variable sampling rates requires the client to be aware of downsampled channels and handle data 
accordingly. Variable sampling rate may also affect the interpretation of the incoming data connection stream, as 
indicated below. 

Transfer Types 

Clients may choose between two different transfer types: 

single connection—uses one data connection between the server and the client to deliver all data 

multiple connection—uses multiple data connections delivering data simultaneously 

Single Connection 

The single connection transfer type uses a solitary connection between the server and the client to deliver 
data. When multiple channels of data are being delivered, all data will be sent over the single connection in an 
interleaved format. The interleaved format mingles the data of all channels in order. 

• For example, an interleaved representation of two samples from three channels of data would be: 

C1 C2 C3 C1 C2 C3. 

This is equivalent to two sample frames where a frame contains the data at a particular sample 
location for all of the channels, in this case “C1 C2 C3”. 

Frames are delivered sequentially over the data connection. 

The single connection transfer type allows for all data to be processed from a single location and uses only 
one network connection resource. Single connection transfer has drawbacks including the need for the client 
to demux the data stream as well as account for variable sampling rates. 

Variable Sample Rate Considerations 

When variable sampling rate is being used, the single connection transfer type has the characteristic where not 
all frames have the same size. If a frame occurs at a sample position where a channel is not being sampled, 
that channel will not be included in the frame. 

All downsampling within the AcqKnowledge variable sampling rate environment occurs at integer divisions 
of the base sampling rate. Only frames with indexes (zero-based) that are evenly divisible by the 
downsampling divider will contain data for that channel. 

It is the responsibility of the client to compute and retain the frame index and to properly 
check channel dividers against the frame index to determine which channels are 
represented in that frame. 

Frame 0 always contains a data point from every channel. 

• For example, consider a three channel acquisition. Channels 1 and 3 have a downsampling divider of 
1, that is, they are being acquired at full speed. Channel 2 has a downsampling divider of 2, that is, 
channel 2 is being acquired at half speed. The first five frames of data in the single connection 
transfer type will appear as follows: 
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C1 C2 C3 | C1 C3 | C1 C2 C3 | C1 C3 | C1 C2 C3 

Note how frames 1 and 3 are shorter as they occur at positions where channel two is not defined. 

If variable sampling rate is being used, clients are required to perform proper frame indexing in order to 
demux the interleaved data stream. If clients cannot handle variable sampling rate correctly and are using the 
single stream transfer type, clients should check all of the downsampling dividers using the control 
connection to AcqKnowledge and warn the user if the configuration cannot be supported with that client. 

Multiple Connection 

The multiple connection transfer type uses a single connection from server to client for each channel of data 
that is being delivered. Using multiple connections offers the benefit of avoiding the client having the need to 
demux all of the data from each sample. If the client is operating in a high-load environment, the elimination 
of the demuxing may be useful in reducing processor overhead. It also allows client code to be simpler if 
variable sampling rate is being used. 

The primary disadvantages of using the multiple connection transfer type are the usage of more network ports 
and the client assuming responsibility for synchronization of data across multiple channels. The data 
immediately available on one network connection may not be guaranteed to be the identical sample index of 
data being received for another channel. The client must keep track of sample index on an individual channel 
basis to properly synchronize data across multiple channels. 

Variable Sampling Rate Considerations 

Using variable sampling rate in a multiple connection transfer type is significantly easier. Each individual 
channel's connection delivers data at that channel's sampling rate. On a given connection, all samples have an 
identical length. 

Clients still must be aware of variable sampling rates. The sampling rate of information on a downsampled 
channel connection will be different than the sampling rate of information on an upsampled channel 
connection. If the client is performing any time domain measurements or other computations involving the 
sample interval, the difference in inter-sample-interval must still be taken into account. 

XML-RPC 

The XML-RPC transfer type allows clients to explicitly request data from the server. Instead of data being 
automatically pushed to clients, the client must post an XML-RPC function call to the server. This will allow 
the client to query the server for the most recently acquired data sample value for a particular channel. This 
communication method is for clients that do not require continual data streams or that interact with only slow 
moving data. This method returns values only; no information about sample indexes or lengths is returned. 

XML-RPC has significant overhead for both client and server, so this transport method cannot handle more 
than a few requests per second. If faster response time is required, the client should implement either the 
single connection or multiple connection streaming methods. 

XML-RPC is not a true data connection as it does not involve the server constructing a streaming connection 
to the client. 

Transport Protocol 

Data connections will offer a choice of using either TCP or UDP as the transport protocol for delivering data to 
the client. Choice of protocol depends on application requirements. When a client is receiving data, it is assumed 
that all data connections are using the same transport protocol. 

TCP/IP 

TCP is the preferred transport protocol. As TCP guarantees reliable, ordered delivery, all data is simply 
transferred from the server to the client without any additional information. Data will be streamed 
continuously as it becomes available. TCP is recommended for all clients that require a guarantee of receiving 
all information. It is also recommended for any configuration using up to two computers. 
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The port number used for data connections is specified by the client using the control connection prior to the 
start of acquisition. Once a client passes along port information, the client should begin listening for 
connections on that port. 

When using TCP data connections, the start of acquisition is signaled to clients by the establishment of a 
connection on an appropriate port to the client. The end of an acquisition is signaled by the termination of the 
connection. 

UDP 

UDP is a connectionless protocol that does not guarantee either delivery or properly ordered reception of 
packets by clients. Data connections will be allowed to be switched to UDP delivery mode. The primary 
benefit of using UDP datagrams is that a single data stream can be multicast to a number of computers. 
Multicasting is not offered implicitly by the AcqKnowledge data connection protocol but can be achieved 
implicitly by requesting a data connection be bound to a broadcast address. 

Since UDP is unordered, datagram delivery of data will include an additional four bytes prior to the data 
contents of the packet. These four bytes will indicate the starting sample position of the samples (or frames 
for single connection transfer type). The four bytes will always be in network order to allow for platform 
flexibility. If the client will perform interpretation of the sample index, htonl()/ntohl() should be used 
to convert from network order into host endian.  

As sample positions are always monotonically increasing, the sample index tag can be used to reassemble 
datagrams into correct order, if required. The sample index will still need to be swapped to host order from 
network order for the sequence to be increasing in magnitude. 

There are no provisions for clients to request retransmissions of packets from the server. Clients should be 
aware that data may not be delivered when using UDP and should be prepared to examine sample indexes at 
the beginning of each packet and handle missing data accordingly (padding, warning user, etc.). 

The port on which datagrams will be delivered is specified by the client prior to the beginning of acquisition 
on the control connection. Once the client specifies its port, it should begin listening for datagrams delivered 
to that port. The start of acquisition will be signaled by the first datagram that is sent to that port. The sample 
index of the first datagram will correspond to the first hardware sample of data acquired by AcqKnowledge. If 
the graph is initially empty, the index will be zero. 

Unlike TCP connections which get explicitly disconnected at the end of acquisitions, there is no direct 
messaging for UDP delivery indicating the end of acquisitions. Datagrams will not be sent to the client after 
the end of acquisition. Clients requiring explicit termination notification should either use TCP or implement 
a timeout mechanism combined with an XML-RPC getAcquisitionInProgress call on the control connection 
to locate the end of acquisitions. 

XML-RPC 

The XML-RPC “get most recent data sample” call will use standard XML-RPC connection semantics 
involving the client making an HTTP POST request to the server and interpreting the response as appropriate. 
Handling of XML-RPC can be performed by a library in the client's appropriate implementation language. 

Real-time Delivery Guarantees 

No delivery time guarantees exist for any data connection. Data is delivered to the client as it becomes available. 
The overall latency of the system from physical sample time to data delivery is dependent on a number of factors 
including network load, AcqKnowledge overhead (which is variable due to calculation channel processing time, 
user interface activity, thread scheduling, and other operations), system load, and other factors. The actual 
sampled data itself is guaranteed to be accurate; the sample time of a signal acquired into the MP unit is always 
accurate. It is only the time between the physical time corresponding to a sample and its delivery to the client 
application that is variable. If strict real time guarantees or more predictable latencies are required, users may 
need to consider using the hardware API on their local machine. 
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Data Formats 

It is assumed that the data transfer feature will be used in a mixed host environment, potentially with clients 
running in environments that have restricted data types. The sampled information delivered by a data connection 
will be allowed to be controlled to appear in a variety of different formats for the client: 

• 64 bit floating point—always available for all channels and may be delivered in either big endian byte 
order or little endian byte order. This is equivalent to a C style double data type. 

• 32 bit floating point—always available for all channels and may be delivered in either big endian byte 
order or little endian byte order. This data type is not native to AcqKnowledge, so the precision of 
received data may differ from data as recorded by AcqKnowledge. This is equivalent to a C style float 
data type. 

• Signed 16 bit integer—available only for analog data channels. It may be delivered in either big endian 
byte order or little endian byte order. This is equivalent to a C style short data type. Clients receiving data 
in 16 bit integer format should use the control connection to determine appropriate floating point scaling 
factors that need to be applied to the data to convert into actual units. 

Data formats should be specified by the client prior to the start of acquisition. If left unspecified, the default data 
format depends on channel type: 

Channel Type Default Data Type 
Analog 16 bit signed integer little endian 
Digital 16 bit signed integer little endian 
Calculation 64 bit floating point little endian 
XML-RPC get most recent sample requests will always return the double type 

of XML-RPC (in ASCII notation) 

Default Data Connection Settings 

If the client does not modify any data connection settings, the following will be used: 

• Single connection transfer type 
• TCP/IP transport protocol 
• Port 15020 for single connection 
• For multiple connections, each channel type (16 channels per type) will be set as follows: 

o analog channels [15020-15035] 
o digital channels [15040-15055] 
o calculation channels [15060-15075] 

• Default data formats for each channel type as indicated in the “Data Formats” section 
Note that no channels are enabled for delivery by default. Both data connection delivery and get most recent 
sample tracking are disabled. Clients will still need to enable channels in order to receive data. 

Locating AcqKnowledge Servers 

It is possible that clients and servers may be located on networks with dynamic IP addresses or other feature that 
make establishing the connection between machines difficult. In this case, a simple UDP broadcast mechanism 
can be used to locate known servers. 

AcqKnowledge will listen for incoming UDP packets on port 15012. If the UDP packet contains the sequence of 
ASCII characters “AcqP Client” and only that sequence, it will send a broadcast packet containing “AcqP Server 
Port:” followed by the port number on which the server is listening for control connections. The port number will 
be expressed in base 10 ASCII notation. 

It will be possible to configure AcqKnowledge to not acKnowledge discovery requests for security purposes. 
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Control Connections 

Clients connect to an AcqKnowledge server using control connections. A control connection allows the client 
process to control how data is going to be delivered to it, query settings, modify settings, and perform other basic 
operations without requiring graphical interaction with the AcqKnowledg environment. 

On the start of an acquisition, all data connections are established to the client that most recently established a 
control connection. 

It will be possible to configure AcqKnowledge to not respond to any control connections for security purposes. 

The majority of all control connections use XML-RPC. The XML-RPC specification can be located at 
http://www.xmlrpc.com/spec. XML-RPC consists of an HTTP POST request being assembled by the client along 
with data content expressed in the XML-RPC notation. The remote procedure call will then return with an 
appropriate response to the caller. By design, XML-RPC is client and platform agnostic. 

XML-RPC implementations exist for a number of languages. If there is no implementation in the client's 
language, hardcoded requests can be embedded or a small helper application or shared library can assist in 
providing the control connection interface. 

The URI that should be used when connecting to the server is the recommended “/RPC2” for XMLRPC. 

o For example, a URL for localhost control connections would be “http://localhost/RPC2”. 

TCP Port 

Only one control connection may be opened by a client to a server at a time. The server will listen on port 15010 
by default. As this port may conflict with other network services or may need to be modified for firewall 
accessibility, AcqKnowledge will allow the server port to be modified by the user in the Display > Preferences 
panel. Clients should be aware that control connection port numbers are not fixed and should either allow users to 
change the port number from the client or use the dynamic discovery mechanism for locating AcqKnowledge 
servers. 

Control Procedure Calls 

Control procedure calls are remote procedure calls with a set method name and response. All method names and 
strings are case sensitive. The available control calls are roughly split up into querying acquisition parameters, 
configuring data delivery, and limited calls for modifying acquisition parameters and affecting application state. 

Channel Index Parameter Structures 

Some procedure calls take a channel index structure as a parameter. This is an XML-RPC structure that consists 
of the channel type and index. The channel type is a string member named “type” that is one of the following 
strings: analog, digital, calc. The channel index is an integer member named “index” and contains a zero-based 
index indicating the channel. For example, the following channel index parameter structure can be used to refer to 
calc channel 2 (recall, in AcqKnowledge calc channels are indexed from zero): 

<struct> 
<member> 

<name>type</name> 
<value><string>calc</string></value> 

</member> 
<member> 

<name>index</name> 
<value><int>2</int></value> 

</member> 
</struct> 
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Querying Acquisition Parameters 

The calls for querying acquisition parameters are intended to allow clients to request information required for 
them to fill out appropriate parameters and to verify that previous control requests have been properly applied. 
The following control calls are recognized: 

getMPUnitType 

Method name: acq.getMPUnitType 
Parameters: None 
Return value: int 

Retrieves the type of MP unit to which the server is connected. This may be zero (indicating no 
unit is connected, e.g. “No Hardware” mode) or one of the following: 100, 150, 35, 45. The client 
can use this value to decide between appropriate templates to download or other channel settings. 

getEnabledChannels 

Method name: acq.getEnabledChannels 
Parameters: string 
Return value: array populated with int 

Retrieves the channels that are available for acquisition and data delivery over a data connection 
to the client. The type of channels that are to be returned are specified in the string parameter. The 
string parameter may be one of the following: analog, digital, calc. The type must be lowercase. 

“analog” returns information about analog channels 
“digital” digital channels 
“calc” calculation channels 

The enabled channels are returned as an array of channel indexes, zero-based. These are the 
indexes that can be validly used in calls for configuring data connection parameters. 

getChannelScaling 

Method name: acq.getChannelScaling 
Parameters: channel index parameter structure 
Return value: struct containing scaling 

For channels that can be delivered in short integer format, the channel scaling provides the scale 
factor and offset used to convert the short into physical units using the formula: 
sample*scale+offset. 

The scaling is returned as a structure containing two double-valued members: “scale” contains the 
multiplication factor, “offset” contains the offset factor.  

Channels that cannot be delivered as short integers cannot be scaled. If this method is called with 
an invalid type of channel, a fault response will be returned. 

getSamplingRate 

Method name: acq.getSamplingRate 
Parameters: None 
Return value: double 

Returns the current sampling rate expressed in Hz. This is the rate at which data is sampled for a 
channel whose downsampling divider is 1. 

getDownsamplingDivider 

Method name: acq.getDownsamplingDivider 
Parameters: channel index parameter structure 
Return value: int 
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Retrieves the downsampling divider for a particular channel. A channel is sampled at the base 
sampling rate divided by this factor. This factor is also used to determine which frames contain 
samples for this channel. 

Data Connection Configuration Commands 

While it is possible to configure data connection parameters using AcqKnowledge, frequently clients may need to 
alter data connection configurations based upon dynamic information regarding the machine on which they are 
running (e.g. port collisions with other services, unexpected endian changes, etc.). The following commands may 
be used to configure how data is delivered to the application. 

getDataConnectionMethod 

Method name: acq.getDataConnectionMethod 
Parameters: none 
Return value: string 

Returns the method currently being used for data connections between the server and client. The 
string value is either: single, multiple. 

“single” corresponds to a single data connection being made between the server and the 
client with all data interleaved over that connection. 

“multiple” corresponds to opening an individual connection to the client for each 
channel. 

changeDataConnectionMethod 

Method name: acq.changeDataConnectionMethod 
Parameters: string 
Return value: 0 on success, or fault code 

Changes the method used to deliver data to the client. The parameter is a string that is one of the 
following: single, multiple. 

“single” opens up a single data connection and sends data in an interleaved fashion. 

“multiple” opens up an individual data connection for each channel. 

getTransportType 

Method name: acq.getTransportType 
Parameters: None 
Return value: string 

Retrieves the transport type that is being used to deliver data from the server to the client. The 
transport type is a string that is one of the following: tcp, udp. Note that the XML-RPC data 
delivery method may be used in addition to this transport type if channels are enabled. 

changeTransportType 

Method name: acq.changeTransportType 
Parameters: string 
Return value: 0 if successful, else fault code 

Change the transport type that is used to deliver data from the server to the client. The transport 
type is a string that has one of the following values: tcp, udp. XML-RPC last value data delivery 
may be used in addition to this type provided channels are enabled properly. 

getUDPBroadcastEnabled 

Method name: acq.getUDPBroadcastEnabled 
Parameters: None 
Return value: boolean 
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Determine if UDP packets are sent only to the client or are broadcast to the broadcast IP of the 
network. Broadcasting is supported only when the transport type is UDP. 

changeUDPBroadcastEnabled 

Method name: acq.changeUDPBroadcastEnabled 
Parameters: boolean 
Return value: 0 if successful, fault code on error 

Modify whether UDP packets are sent only to the client or are broadcast to the broadcast IP of the 
network. Broadcasting is supported only when the transport type is UDP. 

getSingleConnectionModePort 

Method name: acq.getSingleConnectionModePort 
Parameters: None 
Return value: integer 

Returns the port number on which the server will connect to the client to deliver data. This port is 
used only when the connection mode is set to “single” which interleaves all data over a single 
connection. 

changeSingleConnectionModePort 

Method name: acq.changeSingleConnectionModePort 
Parameters: integer 
Return value: 0 on success, else fault code 

Modifies the port on which the server connects to the client to deliver data. This port is used only 
when the connection mode is set to “single” which interleaves all data over a single connection. 

getDataDeliveryEnabled 

Method name: acq.getDataDeliveryEnabled 
Parameters: channel index parameter structure 
Return value: boolean 

Query whether a channel is enabled for data delivery. Channels must be enabled for data delivery 
in order for their data to be delivered to the client. Not all channels that are being acquired are 
required to be delivered to data delivery. 

changeDataDeliveryEnabled 

Method name: acq.changeDataDeliveryEnabled 
Parameters: channel index parameter structure, boolean 
Return value: 0 for success, else fault code 

Change whether or not data delivery is enabled for a particular channel. Data delivery can only be 
changed prior to the start of an acquisition. Changes to data delivery enabling are only applied on 
the next start of acquisition. 

getMostRecentSampleValueDeliveryEnabled 

Method name: acq.getMostRecentSampleDeliveryValueEnabled 
Parameters: channel index parameter structure 
Return value: boolean 

Query whether a channel is enabled for most recent data sample requests. If a client wishes to use 
the XML-RPC calls to fetch the most recent value of data acquired of a channel, the channel must 
be enabled for this functionality prior to the start of acquisition. 
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changeMostRecentSampleValueDeliveryEnabled 

Method name: acq.changeMostRecentSampleDeliveryValueEnabled 
Parameters: channel index parameter structure, boolean 
Return value: 0 for success, else falut code 

Change whether or not a channel is enabled for most recent data sample requests. When a channel 
is enabled, XML-RPC calls can be used during an acquisition to return the most recent sample of 
data acquired (or computed) for the channel. Any changes to the enabled state of a channel will 
be applied on the start of the next acquisition. If a client wishes to use XML-RPC calls to read the 
value of a channel, that channel must be enabled prior to the start of the acquisition. 

getDataConnectionPort 

Method name: acq.getDataConnectionPort 
Parameters: channel index parameter structure 
Return value: int 

Retrieves the port on which the the server will deliver the data for the channel specified in the 
parameters to the client. Per-channel data connections are only used if the data connection 
method is set to “Multiple”. 

changeDataConnectionPort 

Method name: acq.changeDataConnectionPort 
Parameters: channel index parameter structure, integer 
Return value: 0 for success, else fault code 

Changes the port on which the individual connection is made by the server to the client to 

deliver the data for the channel specified in the parameters. This style of connection is used only 
if the data connection method is set to “Multiple”. 

getDataType 

Method name: acq.getDataType 
Parameters: channel index parameter structure 
Return value: structure 

Returns the data type that is being used in the binary data streams for the channel's data. The 
return value is a structure with a type and endian member. The type member, named “type”, is a 
string and contains one of the following values: short, double, float. These strings correspond to 
their matching C-style data types. The endian member, named “endian”, is a string and contains 
one of the following values: little, big. “little” corresponds to little endian byte order, big endian 
bit order. “big” corresponds to big endian byte order, big endian bit order. 

changeDataType 

Method name: acq.changeDataType 
Parameters: channel index parameter structure, type structure 
Return value: 0 on success, or fault code 

Changes the data type that is used for binary data streams of the channel's data. The type structure 
is a struct containing two members. The “type” member is one of the following strings: double, 
float, short. Each string corresponds to the matching C-style data type. The “endian” member is 
one of the following strings: little, big. Each corresponds to the matching byte endian. Bit order 
within a byte will always be big-endian. Not all channels may be able to support all data types. If 
the channel cannot be transmitted in the requested data type, a fault code will be returned. 
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Reading Data During Acquisition 

Normally data is delivered to clients during acquisitions using data connections. Data connections are either TCP 
or UDP connections established from the server to the client over which the server streams the incoming data. In 
some languages and environments however, it may not be possible to handle continuous data streams. The 
following XML-RPC commands are offered to assist these types of clients. Due to the large overhead of 
processing connections and XML-RPC requests, this data transfer type is not recommended and TCP/UDP should 
be used wherever possible. 

getMostRecentSampleValue 

Method name: acq.getMostRecentSampleValue 
Parameters: channel index structure 
Return value: double, or fault code 

This procedure allows clients to read the most recent data value of a specific channel during 
acquisitions. In order for this call to be successful, a data acquisition must be in progress and the 
channel must be enabled for most recent sample value data delivery. Issue a 
changeMostRecentSampleValueDeliveryEnabled call prior to acquisition to allow this procedure 
to be used. 

getMostRecentSampleValueArray 

Method name: acq.getMostRecentSampleValueArray 
Parameters: none 
Return value: array of structures with channel info and values, or fault code 

This procedure allows clients to retrieve the most recent data values of all channels during 
acquisitions in a single call. If clients are interested in the values of multiple channels, using this 
method is more efficient than performing consecutive getMostRecentSampleValue calls (which 
require an individual POST request per call). 

Only channels that are enabled for most recent sample value data delivery will be returned. 

Issue a changeMostRecentSampleValueDeliveryEnabled call for each desired channel prior to 
acquisition in order for this to return the value for a channel. 

The return value is an array of structures, one per channel. Each structure contains two members. 

 “channel” member contains a channel index structure with members set to appropriate 
type and index information for the channel. 

 “value” members is a double that contains the most recent sample value of the channel 
specified in the “channel” member. 

This procedure cannot be called unless there is an acquisition in progress and there is at least one 
channel enabled for most recent sample value delivery. 

Other Control Connection Commands 

Control connections will also allow for the following additional commands to be used by clients: 

loadTemplate 

Method name: acq.loadTemplate 
Parameters: base64 encoded binary AcqKnoweldge graph template 
Return value: 0 on success, or fault code 

Attempts to open the passed template within the AcqKnowledge environment. The parameter is a 
base 64 encoded AcqKnowledge “gtl” graph template file. This command can only be used with 
templates in AcqKnowledge 3.7.1-Windows or AcqKnowledge-Mac graph templates. The 
parameter must include the entire contents of the template file. 
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The parameter in the XML-RPC call should be a base64 parameter with the raw binary contents 
of a graph template file. When this parameter is decoded, it should correctly provide the contents 
of a template file on disk. 

This function will return 0 on success; otherwise a fault code if the template could not be loaded. 
Once a template is loaded, the hardware settings contained within that template will be used for 
subsequent data acquisitions. Templates for AcqKnowledge 3.9.2-Mac and higher will retain any 
data connection settings that have been specified by clients. After loading a template, clients 
should re-send any configuration information for ports and data connection methods if they do 
not match the new settings from the template. 

If the template data is corrupted or is incompatible with AcqKnowledge, user interaction may be 
required on the server computer to dismiss any error messages when attempting to load the 
template. If user interaction is required on errors, this call may not return until the user interaction 
has completed. 

Clients who are using XML-RPC bindings that offer timeout services may wish to use them with 
this function. 

getAcquisitionInProgress 

Method name: acq.getAcquisitionInProgress 
Parameters: none 
Return value: boolean 

Query whether data acquisition is currently in progress or not. A value of true is returned if data 
acquisition is occurring in any open AcqKnowledge graph window. 

toggleAcquisition 

Method name: acq.toggleAcquisition 
Parameters: none 
Return value: 0 on success, else fault code 

Toggles data acquisition in the frontmost graph. If data acquisition is in progress, it is halted. If 
none is in progress, data acquisition is started in the graph. 

Note that this function invocation may block if physical user interaction is required to start the 
acquisition in the graph, such as dismissing an overwrite warning, warnings on incompatibilities 
between different MP unit types, specifying a save location for acquisition to disk, etc. If the 
implementation of the XML-RPC binding used by the client supports timeout capabilities, it is 
highly recommended to enable timeouts for this function. 

Implementation Notes 

The network data transfer feature will be incorporated into AcqKnowledge as a new realtime processing object 
invoked in fashions similar to audio playthrough engines. The application will be extended with third party 
libraries to allow for XML-RPC operation. New preemptive threads will be added to the application to handle 
server discovery requests, control connection requests, and data transfer during acquisitions. 

External Libraries 

AcqKnowledge will use external libraries to assist in implementing the ability to perform network data transfer 
and respond to XML-RPC requests. 

xmlrpc-c 

The XML-RPC layer will be implemented using the xmlrpc-c library (http://xmlrpc-c.sourceforge.net). 

This library is a small layer that allows for implementation of both clients and servers in C and C++ applications. 
For servers, the library also includes a version of the abyss web server that will handle listening for connections 
and can use a number of external libraries for posting new XML-RPC requests. 
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xmlrpc-c will be kept in the Other subdirectory of the repository. An Xcode project will be made for xmlrpc-c to 
allow it to be included directly as a dependency in other projects. To facilitate builds, the default configuration 
will be renamed to “Imported CodeWarrior Settings”. The output will be a series of static Universal binary 
libraries that can be linked directly into applications. 

On Mac OS X, the libcurl library is provided at the system level. xmlrpc-c will be configured to use libcurl to 
perform its client functions. 

Licensing 

xmlrpc-c is licensed using a variety of licenses including the main xmlrpc-c license, the expat license, the python 
license, and the abyss web server license. All of these licenses allow for direct linking of the library with a 
commercial application. Appropriate copyright notices will be added to the About dialog and into the 
documentation, where appropriate. 

Threading Constructs 

Wherever possible, the implementation of the network data transfer feature will use preemptive threads. The 
Carbon Multiprocessing library will be used to spawn the threads. This will allow the threads to use 
MPRemoteCall to schedule functions for execution on the main thread. Main thread scheduling will be required 
for any operations that have application state side-effects for non mutex guarded structures or operations that 
result in user interface change. 

Network Configuration Storage 

The main preferences dialog accessed through Display > Preferences will allow the user to toggle network access 
on and off, change the default control connection TCP port, and disable automatic server discovery. These 
settings will be stored in the user preferences file and will be modifiable on a per user-account basis. 

Additional network configuration storage will be stored in a new structure incorporated into the hardware 
acqStruct. This storage will include the data transfer settings (both global and channel specific), the data type 
requested for each channel, and other configuration. These settings will be retained in the creator handle and 
graph files. No visible user interface will be added for these settings and they can only be modified by a client 
using the XML-RPC requests over the control connection. 

The connection settings may be different from graph to graph and can be modified after loaded from a graph file. 
This allows clients to send over a template with the majority of their settings already intact, leaving clients to 
change only specific dynamic values such as client IP address. 

Since the network configuration storage settings may be accessed from multiple preemptive threads, a preemptive 
safe mutex will be used to guard all access to the settings from all threads. Additionally, switching of the 
hardware parameters as different graphs are brought to the front will also respect this mutex and not change any 
values while they are being read by another thread. 

Control Connection Server 

Control connections are made from clients to the server through XML-RPC requests. AcqKnowledge will 
implement the control connection server using the xmlrpc-c library with the built-in abyss web server used to 
listen for connections. To improve both response time for both clients as well as the AcqKnowledge application, 
the server listening for control connections will be implemented on its own preemptive thread. The server will use 
the runConn() method of the C++ server class while handling its own socket generation with accept in order to 
keep track of the most recently connected client. 

While this limits processing to one RPC at a time, it is the only method that will keep the RPC invocations within 
the AcqKnowledge address space, required to modifiy settings of in-memory graph structures. If the network 
server is enabled in the user preferences, the thread will be created when the application is launched and will 
persist until the application exits. Any changes to listening port for control connections in the application 
preferences will cause the thread to be stopped and recreated to listen on the new port. 
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The control connection protocol does not include any type of graph identifier for each call. The procedure calls 
that are available will always refer to the topmost graph window. There will be no way for clients to change the 
top graph remotely. 

An exception to the graph ordering is the “loadTemplate” command. When issued, the data sent will be decoded 
by AcqKnowledge and will be used to construct a new topmost graph. As the control connection thread is 
preemptive, this process will be scheduled on the main thread. The XML-RPC call will be treated as blocking and 
will not return until either the template has opened or the main thread has delivered an error code back to the 
service. This cross-thread call will be handled at the same location as the scheduling of macro invocations on the 
main thread. 

The toggleAcquisition XML-RPC command will be similarly scheduled onto the main thread as 
ToggleAcquisition() assumes the cooperative threading environment for proper data structure access 
restrictions. 

Server Discovery Thread 

The design includes a rudimentary method that clients can use for locating AcqKnowledge servers on their LAN. 
It consists of listening for UDP broadcasts and replying with appropriate UDP broadcasts, similar to the MP150 
discovery mechanism. If the server feature is enabled when the application is launched, a new preemptive thread 
will be spawned to respond to discovery requests. The preemptive thread will live for the duration of application 
execution while networking is enabled and will be terminated on application exit. 

Network Data Transfer Engine 

The network data transfer engine will be implemented as a new NetworkDataTransferEngine object in 
corresponding files. This engine will have a ProcessIncomingData() method that will be invoked during 
acquisitions at the same time as audio playthrough. It will examine the graph structure directly, keeping track of 
buffer lengths of channels inbetween successive calls. When new data is encountered, it will be copied onto a 
second set of buffers that are private for the network data transfer engine and onto an array holding the most 
recent sample values. 

Similar to the audio processing engines, there will be one network data transfer engine created for each hardware 
structure and will live for the lifetime of the structure. The engine will use the AcquisitionEventListener 
framework to respond to starts and stops of acquisitions.  

At the start of acquisitions, the data transfer engine will be configured to match the network transfer settings as 
currently stored in the hardware structure. These settings will not be allowed to be modified while the acquisition 
is in progress. 

After initialization, the engine will attempt to establish any requested data connections as BSD sockets, either 
TCP or UDP as configured by the client. Once all connections are successfully established, a preemptive thread 
will be spawned to handle the actual data transfer. This thread will examine the private network data transfer 
buffers. Whenever new data is encountered in these buffers, the preemptive thread will assemble that data for 
delivery to the client. A single preemptive thread will handle all connections. The preemptive thread will be killed 
at the end of the acquisition, and any system resources will be gracefully released prior to the thread exit. 

To support the XML-RPC get most recent data sample functionality, the engine will maintain an array of doubles 
with the most recent sample that was copied into the network transfer buffers. This double valued array can be 
accessed by other threads to obtain the sample values. The actual XML-RPC calls for returning the most recent 
value will be handled by the XML-RPC thread and not the network data transfer thread. 

All buffers that are allocated will be circular buffers and will not be reallocated during the lifetime of the thread. 
The ProcessIncomingData() method called from the acquisition thread will be the producer and the only 
modifier of the head pointer. The preemptive thread will be the consumer and the only modifier of the tail pointer. 
This one to one producer/consumer arrangement alleviates the need to perform any mutex locking on the buffers. 
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GLP Awareness 

While the majority of settings can only be configured over the client connection, several settings may be altered 
by the user in the preferences dialog. As these settings may affect security and network accessibility of the 
application, new GLP operations will be added for the network data transfer preferences: 

Operation  Class  Description 

Toggle Networking  Other  Invoked when the user changes the value of the overall 
enabled network state. This turns the response to network 
requests on or off. 

Change Networking Control TCP Port Other  Invoked when the user modifies the port on which the 
application will listen for control connections allowing other 
applications to modify the data transfer state. 

Toggle Networking Auto-discovery Other  Invoked when the user turns on or off the ability for other 
applications to locate AcqKnowledge servers via UDP 
broadcast. 
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3D Output, Cycles/Peaks detect, 275 

A 
A/D boards (third party), 318 
About 

About AcqKnowledge, 317 
About MP1X0 (menu option), 131 

Absolute value, 82, 231 
AcqKnowledge, 16, 25–52 

Accuracy (storage and operation), 320 
Acquire checkbox, 28, 55 
Acquisition 

Acquisition Length, 29, 97 
High speed, 324 
Long, 324 
Overview, 53 
Set up, 29, 59 
Start acquisition, 30 
Troubleshooting, 320 

Active Segment Color, 300 
Adaptive filtering 

Calculation channel, 90 
Transformation, 219, 224 

Adaptive scaling, 141 
Adjust grid spacing, 299 
Alpha waves, 219, 261 
Amplitude scale, 21, 60, 139 
Analog channels, 28, 59–60 
Analog triggers, 105 
Analysis functions, 136 
Annotation, text, 144 
Append mode, 92, 324 
Application Notes, 24 
arbitrary curve fitting, 158, 253 
Arbitrary sample rate, 247 
Arbitrary scale (units), 301 
Arbitrary stimuli, 116 
Arc cosine, 82 
Arc sine, 82 
Arc tangent, 82, 231 
Archive options, 49 
Area (measurement), 151, 290 
Artifact rejection, 101, 269 
Atan. See arc tangent 
Attenuation, Manual Control, 126 
Audio, play data as, 122 
Auditory Brainstem Response testing, 24 
Auto threshold detect, 291 
Automated Tissue Bath Analysis, 24 
Automator (Mac OS feature), 18 
Automator Integration and Scripting, 19 
Autoplot, 127 
Autoposition Hidden Annotations, 144 
Autoregressive modeling, 255 
Autoregressive Modeling, 255 

Autosave file, 92, 103 
Autoscale after transformations, 311 
Autoscale final frame, 51 
Autoscale horizontal, 43, 298 
Autoscale waveform, 44 
Autoscale waveforms, 296 
Averaging 

Advanced Averaging setup, 102 
Average (moving), 63 
Average over samples, Integrate option, 63 
Averaging Application Note #AS131, 24 
Averaging mode, 29 
Averaging setup, 100 
AVG Advanced Averaging files 

Open, 193 
Save As, 201 

Off-line Cycle/Peak Detector (MAC), 274 
Off-line Find Peak option (Widows/PC), 269 
Overview, 99 

Axis adjustment. See horizontal scale, vertical scale 

B 
Band filter, 221 
Base 10 logarithm, 83, 232 
Baseline drift, 292 
Blood pressure analysis. See rate calculations 
BPM 

BPM calculation, 290 
BPM measurement, 152 
BPM, Rate function, 70 

BSL File Import, 190 

C 
Calculate (measurement), 152 
Calculation channels, 28, 61–62 
Calibration, 59–60 
center horizontal, 32 
center vertical, 32 
Channel 

Channel boxes, 142, 302 
Channel label, 142 
Channel sample rate, 29 
Channel Sample Rate, 57 
Channel setup, 28, 55, 59 

Chaos Analysis 
Detrended Fluctuation Analysis, 340 
Optimal Embedding Dimension, 340 
Optimal Time Delay, 341 
Plot Attractor, 341 

Chart mode, 302 
Chart recorder output, 181 
chooser, 208 
Clear, 212 
Clear all, 212 
Clip data, Calculation channel Function, 74 
Clipboard, 150, 215 
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Close prompts, 196 
Clustering, 279 
Coefficients (FIR filters), 222, 321 
Collecting data, 27 
Color, 300 
Comb Band Stop 

Calculation channel, 76 
Transformation, 225 

Compare waveforms, 297 
Compression 

down sampling, 247 
Save As option, 198 

Connect endpoints, 231 
Connected to…, 37 
Constant (K), Calculate measurement option, 

152 
Control channel 

Calculation channel, 85 
Find Peak Averaging option, 269 
Integrate Calculation option, 66 

Convolution, 235 
Copy, 211 

Acquisition Settings, 215 
Graph, 215 
Measurement, 215 
Wave data, 215 

Correlate (measurement), 153 
Correlation, 233, 235 
Correlation Coefficient 

Specialized Analysis, 341 
Cosine, 82 
Count peaks, 290 
Create Original Data Snapshot, 49 
Cubic spline interpolation, 248 
Cursor 

Cursor functions (Find Peak setup), 283 
Cursor tools, 143 

Customizing menu display, 313, 325 
Cut, 211 
Cutoff frequency, 222 
Cycles/Peaks tab, Cycles/Peaks detect, 271 

D 
Data collection, 27 
Data View, 35 
Delay 

Calculation channel option, 84 
Trigger Set up, 106 
Video Playback, 133 

Delta measurements, 154 
Derivative, 239 
Difference 

online calculation, 69 
transformation function, 245 

Digital 
Digital channels, 28, 60–61 
Digital filters, 219–24, 322 
Digital I/O channels, Manual Control, 125 
Digital output, 85 

Digital triggers, 104 
Disk 

Space, sampling rate impact, 29, 96 
Space, storage mode impact, 187 
Storage option, 29, 94, 324 

Display 
Menu commands, 294 
Modes, 31 
Preferences, 324 

DLC, Ethernet protocol, 313 
Draft mode, 311 
Duplicate waveform, 213 
dZ/dt Specialized Analysis 

Analysis 
dZ/dt Motion Filtering, 372 

Classifier, 365 
Derive from raw Z, 366 
Remove motion artifacts, 367 

E 
ECG Analysis 

Automated ECG App Note, 24 
Detect and Classify Heartbeats, 335 
ECG Interval Extraction, 358 
Heart Rate Variability, 337 
Locate ECG Complex Boundaries, 335 

edge effects, 322 
Editing 

Cursor tool, 143 
Edit menu, 209 
Features, 136 

EGrid cursor, 143 
Eigenanalysis (PCA), 262 
Embedded archive, 49 
Ensemble Average, 354 
Epoch Analysis, 355 
Equation Generator, 76–88, 249 
Erase Appended Segment(s), 37 
Ethernet card configure, 129 
Ethernet protocol, 313 
European Data Format (EDF) 

Open, 195 
Save, 205 

Event (Mac OS X) 
Graph Selection, defining via, 178 
Graph Selection, display impact, 177 
Hotkey Setup, 167 
Location, 169 
Measurements, 174 
Overview, 164 
Palette, 168 
Preferences, 166 
Printing, 176 
Selection, 177 
Toolbar, 164 
Tooltips, 165 
Variable Sampling Rate and, 178 
Waveform editing, 178 

Event definition cursor, 144 
Event marker, 22 
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ex power of a data point, 82 
Excel Spreadsheet Export, 203, 334 
Exp Exponential, 231 
Exporting data, 49, 191 
Expression, 249 
Expression evaluator, 76–88 
External trigger, 100 

F 
FAQ, 318 
Fast Fourier transformations. See FFT 
FFT, 257–61, 322 
File Compatibility for Specialized Analysis, 334 
File menu commands, 187 
File size, 319, 324 
Filter 

Calculation, 75 
characteristics, 321 
response, 223 

Find, 287 
Find all, 284 
Find Cycle/Peak, Mac OS X, 270 
Find Peak, 264 

Finite impulse response filters. See FIR filter 
FIR filters, 219, 222, 321 
Firmware Rollback Switch, 332 
Firmware Upgrade, 330 
Font, journal, 314 
Formula 

Area, 151 
BPM, 152 
Correlation, 153 
Delta, 154 
Delta T/F/X, 154 
Freq (Frequency), 155 
Integral, 156 
Lin_reg (Linear regression), 157 
Mean, 157 
Slope, 159 
Stddev (Standard deviation), 160 
Threshold, 74 

Fourier 
FFT Fast Fourier transformation, 257 

Fourier Linear Combiners 
Calculation Channels, 89 
Transformations, 229 

Frequency 
frequency spectrum, 261 
Horizontal scale, 301 
measurement (Freq), 155 
rate calculation (Hz), 290 

Frequently asked questions, 318 
Friendly Grid Scaling, 140 
Function 

Calculation, 74, 77 
Equation (Expression) commands, 82 

G 
Gastric Wave Analysis, 339 

Gastric Wave Coupling, 339 
Getting Started, 16 
GLP audit 

include timestamp, 314 
mark selection with Events, 314 

GLP guidelines, customizing menus for, 20 
Graph template files (gtl) 

Open, 193 
Quick Start Files, 58, 193 
Save As, 200 

graph window, 27 
Graph window, 27 
Gray non-selected waves, 311 
Grid, 138 

Adjust spacing, 299 
GridReset, 299 
Grids 

Clinical grid settings, 181 
Display > Show, 179 
Grid Options, 182 

H 
Hardware. See note on page 10 
Heart Rate Variability, 24, 337 
Help menu, 317 
Hemodynamic Analysis, 356 

ABP Classifier, 356 
Arterial Blood Pressure, 357 
ECG Interval Extraction, 358 
Left Ventricular Pressure, 358 
LVP Classifier, 360 
MAP Classifier, 362 
Measurements App Note, 24 
Monophasic Action Potential, 361 
Preferences, 363 

High pass filter, 220 
Histogram, 246 
Hold button, SIV, 119 
Hold relative position 

Horizontal Scale, 138 
Horizontal 

Axis, 21, 301 
scale, 42 
Scale, 42, 137 
Scroll bar, 137 

Hyperbolic 
Cosine, 82 
Sine, 83 
Tangent, 83 

I 
I/O channels, Manual Control, 125 
I-beam tool 

selection cursor, 143 
IBI Inter-beat Interval, 70, 290 
IFFT. See inverse FFT 
Igor Pro Experiment 

Open (import), 194 
Save As (export), 202 
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IIR filters, 219, 225, 321 
Impedance Cardiography Analysis, 364 

Body Surface Area, 364 
Derive dZ/dt from raw Z, 366 
dZ/dt Classifier, 365 
dZ/dt Motion Filtering, 372 
dZ/dt remove motion artifacts, 367 
ICG Analysis, 367 
Ideal Body Weight, 371 
Pre-ejection Period, 371 
Preferences, 371 
VEPT, 371 

Independent Component Analysis, 263 
INF (measurement value), 147 
Infinite impulse response filters. See IIR filters 
Initial offset, 137 
Input Values Setup (SIV), 119 
Insert 

Markers, 47, 161 
Waveform, 212 

Installation. See note on page 10 
Integral 

measurement, 156 
Transformation function, 239 

Integrate 
formulas, 242 

Integrate Calculation (online), 63 
inter sample interval, 194, 200 
Interpolate pastings, 311 
Interpolation method, resampling, 248 
Intraventricular Pressure Wave analysis, 24 
Inverse mean square error, 235 

J 
Jewett Sequence, ABR testing for, 24 
Journal, 48 

Copy Measurements, 150 
Marker Summary Preferences, 163 
Paste options, 216 
Preferences, 313 
Show Journal, Mac OS X, 216 

Jump-to tool (correlates data views), 144 

K 
K (Constant), Calculate measurement option, 

152 
K-means Clustering, 279 

L 
Latency, 99 
Left Ventricular Pressure, 358 

LVP Classifier, 360 
Limit data, Calculation channel Function, 74 
Limit math command, 232 
Lin_reg (linear regression measurement), 157 
line plot, 303 
Linear (FFT option), 260 

Linear interpolation, 248 
Ln natural logarithm, 232 
Locate SCRs, 344 
Lock tool, 143 
Locked MP150, 328 
Log, 82, 232 
Low pass filter, 220, 239 
Lung Volume analysis, 24 
LVP Analysis, 24 

M 
Mac on Intel, 18 
Macintosh® system requirements, 18 
Magnetic resonance imaging 

Specialized Analysis, 373 
Manual Control (digital I/O), 125 
Manual stimulator controls, 109 
Markers, 47, 161 

Preferences for Windows/PC, 162 
Printing markers, 161 
Windows/PC functionality, 161 

Math 
Calculation, 72–73 
Functions (Transformation), 231 
Waveform Math, 250 

MATLAB 
Open (import), 193 
Save As (export), 200 

Max measurements, 157 
Maximum frame rate, 51 
Mean 

Mean square error, 235 
Measurement, 157 
Reference, Tracking option, Find Peak, 266 
Removal, 234, 259 
Use mean value, Scaling option, 60 

Mean subtraction, Integrate option, 66 
Measurement, 46, 147 

Preferences, 310 
Preferences for Journal, 313 
Table of Explanations, 151 

Measurements, Cycles/Peaks Output, 274 
Median measurements, 158 
Memory 

Load all data into, 316 
Storage option, 29, 94 
Use all available memory, 311 

Menu configuration file, 313 
Menu display, customizing, 313, 325 
Merge Graphs, 214 
Min (minimum) measurement, 158 
Modeling 

Linear 
Autoregressive transform, 255 
Lin_reg measurement, 157 

Nonlinear, 253 
NLM measurement, 158 

Modeling, Autoregressive, 255 
Monophasic Action Potential, 361 

MAP Classifier, 362 
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Mouse controls, 40 
Moving average, 244 
MP System 

Overview, 16 
MP System Requirements, 18 
MP, data storage option, 94 
MP100 System 

Features, 20 
MP150 

Locked/Unlocked, 328 
MP150 Serial Number, 130 
MP150Tools.exe upgrade utility, 330 
Multiple hardware, 98 

MP1X0 Info (menu option), 131 

N 
Natural logarithm, Ln, 232 
Network Data Transfer, 394 
Network, select adapter, 129 
Neurophysiology 

Specialized Analysis, 375 
New 

Data View, 187 
Graph, 187 

No hardware mode, 130 
Noise, 320 

Calculation channel Function, 74 
Math command, 232 
Rejection (auto threshold detect, 291 

None (measurement option), 159 
Nonlinear modeling, 253 

NLM measurement, 158 
Normalized cross correlation, 236 

O 
Off-line Averaging, Cycle/Peak Detector (MAC), 

274 
Off-line Averaging, Find Peak option (Windows/PC), 

269 
Offset, Expression notations, 78 
Online filtering, 75 
Open (file command), 190 
Options button, Open Text file, 191 
Options, Input Values, 119 
Organize Channel Presets, 128 
Output continuously. Stim. Setup, 109 
Output tab, Cycles/Peaks detect, 274 
Overlap 

Overlap Segment mode, 33 
Overlap waveforms, 297 

P 
P300 measurements, 102, 269 
Pad with…, 257 
Padding (resampling interpolation), 248 
Paste, 211 

Acquisition settings, 216 
Measurement, 216 

Wave data, 216 
Pause mode (Append to disk), 93 
PC-compatible files, 190, 197 
Peak 

Detect (Find Rate option), 291 
Find Cycle (Peak Detector), Mac OS X, 270 
Find Peak (Detector), 264 
Minimum, 290 
Reference, Tracking option, Find Peak, 266 

Peak-to-Peak (P-P measurement), 159 
PEP Pre-ejection Period, 371 
Performance, Preference, 315 
Phase, 260 

Distortion, 321 
Phasic EDA options, 345 
PhysioNet 

Save As (export), 202 
PICT files, 49, 215 
Playback mode, 33, 52 
Plotting data, 28, 55, 127 
Power Spectral Density, 255 
Power supply, 320 
P-P (peak-to-peak measurement), 159 
Preferences 

Display Preferences, 310 
Hardware options, 313 
Journal preferences, 313 
Markers, 162 
Menu configuration file, 313 
Undo max, 312 

Presets, 56 
Organize Channel Presets, 128 

Pretrigger, 106 
Principal Component Analysis, 262 
Principal Component Denoising, 381 
Print, 22, 50, 180, 207 

Markers, 161 
pulse stimuli, 107–14 

Q 
Q coefficient, filter setting, 75, 225, 226, 321 
Questions, frequently asked, 318 
QuickTime movie of AcqKnowledge, 51 

R 
Ramp waves, 115 
Rate 

calculation, 69–72, 287–94 
detector algorithm, 24 

Raw data 
Open (import), 194 
Save As (export), 203 

Record/Record last, 92 
Recursive formulas, 79 
Remove 

last appended segment, 213 
mean, 234, 259 
trend, 259 
waveform, 212, 213, 324 
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Remove Projection, 235 
Remove Projection Template, 235 
Remove Trend, Specialized Analysis, 382 
Repeat mode, 103, 127 
Repositioning Events (Mac OS X), 169 
Resample, 247 
Resampling Interpolation, 248 
Reset 

Append acquisition button, 93 
reset chart boundaries, size window, 316 
Reset chart display, 298 
reset thresholds, Integrate setup, 66 
reset trigger, Integrate setup, 66 
reset via channel, Integrate setup, 63 
Stimulator setup, 108 

Reset Grid, 299 
Resource allocation, 315 
Respiratory Sinus Arrhythmia, Specialized Analysis, 

362 
Rewind, 37 
RS-232/RS-422 signal, 318 

S 
Safety Notice, 14 
Sample 

measurement, 159 
Rate, 94–97, 319, 324 
Rate, Acquisition rate, 29 
Rate, Channel, 28, 29, 57 
Rate, Stimulation signal output, 107 

Save, 49 
Save (File command), 197 
Save as (File command), 197 
Save as TIFF, 3D output, 275 
Save once (Acquisition setup), 92 

Scale, 137 
Scaling, 59–60 
Scaling, Friendly Grid Scaling, 140 
Scope mode, 31 
Screen, scale setting, 139, 140 
Scroll, 42, 136 

Menu option, 127 
Update screen interval, 312 

Segments, show (appended), 33 
Select 

All, 212 
Area, 45, 209 
Area for measurement, 148 
Channel, 44, 142 
Cursor tool, 143 
Network Adapter, 129 
Waveform, 44, 142 

Selection Palette, 303 
Selection tab, Cycles/Peaks detect, 273 
Serial number, MP150, 130 
Set template, 233 
Set up 

Acquisition, 29 
Channels, 28, 55, 59 

Stimulator, 107 
Triggering, 104 

Set wave positions, 299 
Shortcuts 

Contextual (Mac), 41 
Keyboard, 37 
Right-click (Windows), 40 
Toolbar, 37 

Show 
Display menu options, 302 
Hardware icon, 37 
Input values, 56 
Input Values, 118 
Input Values Setup options, 119 
Modified input, 258 
Original Data Snapshot, 49 

Signal averaging. See Averaging mode 
Sine, 83, 232 
Size window, 316 
Slope (measurement), 159 
Smoothing 

online calculation, 68 
transformation function, 244 

Smoothing Baseline Removal, 345 
Snapshot data after acquisition, Preference, 49 
Sound 

Feedback setup, 121 
Input Values button, 120 

Specialized Analysis Package, 293, 333 
File Compatibility, 334 

Specifications. See MP100 Hardware Guide 
Spectral analysis. See FFT 
Spectral subtraction, 387 
Spectrum Analyzer Palette, 306 
Spotlight Importer (Mac OS feature), 18, 19 
Square 

Square, 83 
Square Root, 83, 232 
Waves, 114 

Stacked Plot, 34 
Standard deviation measurement, 160 
Start acquisition, 30 
Statistics (Waveform Statistics dialog), 309 
Status indicator, 30 
Stddev (standard deviation) measurement, 160 
Step plot, 305 
Stimulation. Dual, 113 
Stimulator Manual Control, 126 
Stimulator setup, 107 
Stimulator, manual controls, 109 
Stimulus signal, 99, 101, 107 
STM100C Manual Control, 126 
Stop 

Stop acquisition, 30 
Stop plotting, 324 
Synchronize video, 133 

T 
Tab interval, Journal, 314 
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Tangent, 83 
Tau (time constant), 253 
Template functions, 233 
Text Annotation, 144 
Text files, 49, 192–93 
Three-D Output, Cycles/Peaks detect, 275 
Threshold 

Find Peak setting, 266 
Math command, 232 

TIFF, Save 3D output as, 275 
Tile waveforms, 295 

Tile after transformations, 311 
Time 

Expression source, 78 
measurement, 160 
Set Horizontal Time scale, 301 
Time scale after importing, 319 

Timestamp, journal preference, 314 
Tone stimuli, 114–15 
Tool Tips, 311 
Toolbars, 37 
Transform, 45 

Math commands, 231 
Menu commands, 217 
Remove Projection, 235 
Specialized Analysis Package, 293, 333 

transition latency, 388 
Triggering, 104 
Troubleshooting, 318 

U 
UDP, Ethernet protocol, 313 
Undo, 210 
User Support System, 12 

V 
Value (measurement), 160 
Values checkbox, 28, 56 

Show input values, 118 
Variable Sampling Rate, 29, 57, 107 

data processing notes, 81 
Event plotting and, 178 

VEPT, 371 
Vertical axis, 21, 60 

Vertical scale, 44, 139 
Video, 132 

Capture, 132 
Delay, 133 
Playback, 133 
Preview, 133 

Video capture, QuickTime movie of AcqKnowledge, 51 
Viewing data, 42 
Virtual memory, 324 
VO2 measurement, 24 

W 
Warning 

Before overwrite data, 127 
Hardware not found, 26 

Waterfall Plot, 389 
WAV files, 195, 204 
Waveform 

Arithmetic dialog, 152 
Color, 300 
Math transformation, 250–52 
Selection, 44, 142 
Statistics dialog, 309 

Wavelet Denoising, 389 
Window 

Find Rate option, 292 
Functions (filter, FFT), 322 
Menu, 317 

Windows® system requirements, 18 
WMF Windows Metafile format, 49, 215 
Working in AcqKnowledge, 25 

X 
X/Y mode, 31, 32 

X/Y loop area analysis, 24 
X-axis T/F/X (measurement), 160 

Z 
Zap, event cursor, 144 
Zoom 

Cursor tool, 45, 143 
Zoom previous, 298 
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COPYRIGHT 
Information in this document is subject to change without notice and does not represent a commitment on 
the part of BIOPAC Systems, Inc. This manual and the software described in it are copyrighted with all 
rights reserved. Under the copyright laws, this manual or the software may not be copied, in whole or 
part, without written consent of BIOPAC Systems, Inc., except in the normal use of the software or to 
make a backup copy. 
The same proprietary and copyright notices must be affixed to any permitted copies as were affixed to the 
original. This exception does not allow copies to be made for others, whether or not sold, but all of the 
material purchased (with all backup copies) may be sold, given, or loaned to another person. Under the 
law, copying includes translating into another language or format. This software is intended for use on 
only one machine at a time. 
Open source software: 

 Regular expression support is provided by the PCRE library package, which is open source 
software, written by Philip Hazel, and copyright by the University of Cambridge, England. 
ftp://ftp.csx.cam.ac.uk/pub/software/programming/pcre/ 

 This product includes software developed by the Apache Software Foundation 
(http://www.apache.org/). 

WARRANTY 
BIOPAC Systems, Inc. warrants its hardware products against defects in materials and workmanship for a 
period of 12 months from the date of purchase. If BIOPAC Systems, Inc. receives notice of such defects 
during the warranty period, BIOPAC Systems, Inc. will at its option, either repair or replace the hardware 
products that prove to be defective. This warranty applies only if your BIOPAC Systems, Inc. product fails 
to function properly under normal use and within the manufacturer’s specifications. This warranty does 
not apply if, in the sole opinion of BIOPAC Systems, Inc., your BIOPAC Systems, Inc. product has been 
damaged by accident, misuse, neglect, improper packing, shipping, modification or servicing, by other 
than BIOPAC Systems, Inc. 
Any returns should be supported by a Return Mail Authorization (RMA) number issued by BIOPAC 
Systems, Inc. BIOPAC Systems, Inc. reserves the right to refuse to accept delivery of any shipment 
containing any shipping carton which does not have the RMA number(s) displayed on the outside. The 
Buyer shall prepay transportation charges to the BIOPAC Systems, Inc. designated site. 
BIOPAC Systems, Inc. makes no warranty or representation, either expressed or implied, with respect to 
this software, its quality, performance, merchantability, or fitness for a particular purpose. As a result, this 
software is sold “As is”, and you, the purchaser, are assuming the entire risk as to its quality and 
performance. 
In no event will BIOPAC Systems, Inc. be liable for direct, indirect, special, incidental, or consequential 
damages resulting from any defect in the software or its documentation, even if advised of the possibility 
of such damages, or for damage of any equipment connected to a BIOPAC Systems, Inc. product. 
TRADEMARKS 
AcqKnowledge and MP150 are trademarks of BIOPAC Systems, Inc. 
Windows is a registered trademark of Microsoft Corporation in the United States and other countries. 
Mac and PowerBook are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. 
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